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1.1 

Getting Started 
About AlarmWorX 

AlarmWorX is a distributed enterprise-wide alarm and events management system. Available in the 
standard ProcessView suite of application, or as a stand-alone Open Series component, AlarmWorX 
offers the tools you need to deliver real-time alarm information throughout your system. AlarmWorX 
is a family of modular alarming products, including the Alarm Container, the Alarm Server, the Alarm 
Logger, the Alarm Viewer ActiveX, the Alarm Report ActiveX, and the Multimedia Server.  The 
Alarm Container is an ActiveX container capable of embedding various ActiveX components.  The 
AlarmWorX architecture is shown in the figure below. 
AlarmWorX is the first OPC-compliant alarming product based on the OPC Alarm and Events (AE) 
specification. It can easily "Plug and Play" not only with SMAR applications but also with other third-
party OPC alarming software.  

 
AlarmWorX Architecture 

Alarm Container 
AlarmWorX delivers a "Container" application, which can host not only the Live and Historical 
ActiveX controls, but also other third-party controls. It also offers the rich Microsoft Visual Basic for 
Applications (VBA) scripting language. Use this, or other containers (e.g., GraphWorX) to fulfill your 
alarm viewing needs. 

Alarm Server and Server Configurator 
Alarm Configuration is easy with the Alarm/Event Configurator. You can define your own alarms on 
any OPC data and/or expression (complex combinations of OPC data), choosing from analog limit 
alarms, deviation, rate-of-change, and digital alarms. In keeping with the open standards employed 
throughout the ProcessView architecture, your alarm configurations are saved to a Microsoft Access 
or Microsoft SQL Server database. 
Once the alarms are configured, the OPC Alarm Server takes care of monitoring the live data, 
posting new alarms throughout your network. This component runs in the background (even as a 
Windows NT Service if desired), and is tuned to give your system the performance required of an 
alarming system.  
The AlarmWorX Server receives field data from any OPC-compliant Data Access (DA) server and 
performs alarm detection and reporting based on the OPC data sent to any OPC Alarm and Event 
(AE) clients that subscribe. The AlarmWorX Viewer and the AlarmWorX Logger are two examples of 
clients that can receive these notifications from the server.  
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Alarm Logger 
The AlarmWorX Logger logs alarms to Microsoft Access, Microsoft SQL Server, or Oracle 
databases. It also can print out the information to one or even a redundant set of printers. You can 
create alarm reports and calculations with Microsoft's built in Visual Basic for Applications (VBA) 
scripting language. Alarm calculations can be performed on individual tags or groups of tags. 
The logger can run as an executable or a service and is able to process alarm information from 
several alarm severs locally or over a network. The database is user-configurable (i.e. it allows 
autoflushing at a specified period, autostart, circular and append logging modes, etc.). Of primary 
importance to the database issue is performance. The logger is able to handle bursts of alarms due 
to the design and implementation of the logger’s database handling. 

Live Alarm Viewer ActiveX 
The Alarm Viewer is a current-events alarm ActiveX.  Because this component is an ActiveX, it can 
be placed in any ActiveX container application, such as GraphWorX, Microsoft Visual Basic, or a 
Web page.  The Alarm Viewer displays current alarm information and handles the user interface to 
the alarm system (such as alarm acknowledgement).  The layout of information displayed, including 
sort order, color, font, and displayed data, is user-configurable. 
You can drop this ActiveX Control in the provided AlarmWorX Container, within any GraphWorX 
HMI Display, an HTML Internet/intranet-based Web page, or any other ActiveX container, and it 
automatically configures itself to deliver live alarms in a scrollable window. You can easily customize 
the view via its properties page to control the colors, fonts, columns, rows, alarm filtering, 
subscriptions, hot-links, etc. 

Alarm Report ActiveX 
Alarms logged to a database can be a chore to sort through and analyze. The powerful Historical 
Alarm Analysis (Report) ActiveX solves this problem by easily creating filtered reports, pie charts, 
bar plots, and even exporting to custom Crystal Reports. At the click of a button, you can find out 
which alarm is occurring most often and see if there are certain "trouble-spots," review downtime, 
and more.  
The Alarm Report ActiveX allows reporting (user-configured or preconfigured) and graphing of 
alarms.  The source of the Alarm data can be live alarms, alarms previously logged by the Alarm 
Logger, or a combination of both.  Because the Alarm Report is an ActiveX, you can drop it into the 
AlarmWorX Container, within any GraphWorX HMI Display, an HTML Internet/intranet-based Web 
page, or any other ActiveX container. 
 

Multimedia Server   
AlarmWorX Multimedia is a distributed enterprise-wide alarm notification system that delivers real-
time alarm information to you wherever you may be through various multimedia "agents," including 
from e-mail, pager, fax, voice, text-to-speech, phone, and marquees. AlarmWorX Multimedia can 
easily "Plug and Play" not only with SMAR Alarm and Event Servers but also with other third-party 
OPC alarming software. 

MMX Alarm Server Configurator 
Multimedia Configurator takes you through the steps to create alarm notification rules and action 
sets. There is even a step-by-step animated tutorial to help you configure your system. You can 
easily apply filters so only specific alarms trigger your multimedia announcements. When an alarm 
occurs, specify multiple notifications methods (e.g., page the technician, phone the supervisor, and 
email the QA lab.). You can also send notifications only to on-duty personnel using the built-in 
scheduling mechanism. Create sophisticated (yet easy-to-build) work schedules with vacation times, 
re-occurring patterns and more. There's even the concept of "roles" for various personnel. 
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Starting the AlarmWorX Container 
To start the AlarmWorX Container: 

1. From the Windows Start menu select Programs > SMAR ProcessView > AlarmWorX > 
AlarmWorX, as shown in the figure below.  

 
Starting the AlarmWorX Container 

2. When you start AlarmWorX, the AalrmWorX Container screen opens and a window appears, 
as shown in the figure below. If you do not install an SMAR Software License, you will only be 
able to run the AlarmWorX Container in a two hour Demo mode. If you have a software license 
and do not wish to run in Demo mode, make sure that the license is properly installed. 

 
AlarmWorX Container Screen and Alarm Window 

The table below lists the basic AlarmWorX Container screen components and their functions. Refer 
to the Screen Features section for a complete description of the menu bar, toolbar, and status bar 
functions. 
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Component Function 

Title bar  
Displays the name of the application and the name of the current screen 
displayed. To reposition the screen, click the title bar using the left 
mouse button and drag the screen to the desired location.  

Control-menu box  Displays the Windows Control menu. Refer to your Windows 
documentation for more information about the control menu.  

Minimize button  Reduces the window to an icon.  
Maximize button  Enlarges the active application window to fill the entire screen.  

Menu bar  Contains the various menus through which you can access AlarmWorX 
Container features, such as printing and saving to a file. 

Toolbar  Contains toolbar buttons for certain useful menu items. 
Work area  Displays the various AlarmWorX Container screens as you select them. 

Status bar Displays context-sensitive help, display mode, and the current time and 
date. 

AlarmWorX provides an example alarm configuration. To open this example in the AlarmWorX 
Container: 
Select Open from the File menu and browse to ...\installed directory\ ProcessView -
\Examples\AlarmWorX Examples, as shown in the figure below. Select the AlarmSample.a32 file, 
and then click Open.   

 
Opening the Alarm Sample 

1. This opens a configured Alarm Viewer file, as shown in the figure below. 

 
Sample Alarm Viewer 
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2. To configure the Alarm Viewer, click anywhere in the Alarm Viewer window. This opens the 
Alarm Viewer ActiveX Properties dialog box, as shown in the figure below. Within the 
Properties dialog, you can configure column and row settings, set filtering, and the alarm-
sorting format.   

Note: For complete information about the Alarm Viewer configuration, please see the AlarmWorX 
Viewer ActiveX Help. 

 
Configuring the Alarm Viewer ActiveX 

3. In the Alarm Container, select Runtime Mode from the Actions Menu.  The container will 
enter runtime mode and alarms will start posting in the Alarm Viewer.   Based on the 
configuration settings in the AlarmSample.a32 file, the Alarm Viewer will start the AlarmWorx 
Server.  The AlarmWorx Server will then start the Simulator OPC Server, which provides 
simulated OPC data. 

 
Alarm Viewer in Runtime 

Additionally, AlarmWorX offers the following functionality in runtime, while right clicking on the 
display:  
When you right-click on the AlarmWorX Viewer ActiveX during runtime mode, the following functions 
are available:   
Alarm acknowledgement: In the Alarm Acknowlegdement dialog box, you can choose from Point, 
Global, Visible, Filtered or Area acknowlegement.   
Sorting: The sorting feature also allows for multilevel sorting of alarm data up to five levels with 
ascending/descending specific to each level.   
ToolTips: Choose from context, help, content, and alarm line ToolTips. 
VB event: This option allows a user to trigger an automation event during runtime mode.  Using this 
event requires VBA programming tied to the user event. 
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Application: This option only appears if the you select the extra attribute associated with it. This 
attribute is server-specific (for example, when using the Alarm OPC Server, select Default Display. 
This allows you to launch applications (i.e. *.exe, *.com or *.bat files) by clicking on the 
corresponding attribute cell. 
Display options: This option only appears if the Alarm Viewer creates the display list by checking the 
extra attributes field for the registered file types. This attribute is server-specific (for example, when 
using the SMAR Alarm OPC Server, select Default Display).  All displays configured for a particular 
alarm will be displayed.  Selecting one, by clicking on the attribute cell, launches the display. 
Display Tricks 
 

Introduction 
The ability to customize visual information is an important feature of HMI software. Alarm software 
configuration has increased in its complexity, due to the vast majority of different needs, design 
tastes corporate standards, and plant processes.  This section attempts to simplify some of the 
layout process and provide some ideas for design consideration. 

Color 
Besides raw data, color is probably the single most important piece of information for an alarm 
display.  As shown in the figure below, the color configuration of the Alarm Viewer ActiveX 
Properties dialog box is based on three levels:  
Default 
Row 
Column 

 
Configuring Colors for the Alarm Viewer ActiveX 

A judicious combination of these levels can greatly simplify configuration time.  The default settings 
are applied when a column or row setting is not provided.  If a majority of the settings requires a 
background color of white, set the default background color to white.  Row settings are used a 
majority of the time to provide specific colors for various alarm states.  If severity is not important, it 
is not necessary to have multiple color configurations for severity.  On the other hand, multiple color 
configurations for severity can be used to display sub-conditions.  For example, if all High alarms 
are configured to be severity 700, then a color of purple for severity 700 would only show up for 
High alarms even though High alarms are a substate of the limit condition.   Column settings can be 
used effectively to provide constant color combinations.  This is good a place to set colors for help 
text or to set a column apart from the rest of the display. 
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ToolTips 
ToolTips are an easy way to provide extra information to the operator without constantly using 
screen resources.  ToolTip configuration in the Alarm Viewer ActiveX Properties dialog box 
involves setting the visual format and the subscription.     

 
Configuring ToolTips for the Alarm Viewer ActiveX 

 

Example 
1. Select Open from the File menu and browse to ...\installed directory\ ProcessView -

\Examples\AlarmWorX Examples, as shown in the figure below. Select the 
AlarmSample.a32 file, and then click Open.   

 
Opening the Alarm Sample 

2. This opens a configured Alarm Viewer file, as shown in the figure below. 
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Sample Alarm Viewer 

3. To configure the Alarm Viewer, click anywhere in the Alarm Viewer window. This opens the 
Alarm Viewer ActiveX Properties dialog box, as shown in the figure below. Select the 
Column tab. 
 
Note: For complete information about the Alarm Viewer configuration, please see the 
AlarmWorX Viewer ActiveX Help. 

 
Configuring Columns in the Alarm Viewer ActiveX 

4. Scroll down the list of Available columns until Attribute 3 is visible.  Select Attribute 3 and 
click the Add button to add it to the Selected Headers list. This adds the Attribute 3 to the 
column list.  Right-click on Attribute 3 and select Rename from the pop-up menu, as shown in 
the figure below. Rename Attribute 3 to "Help2." 
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Renaming the Attribute 

5. In setting up the visual format quickly, it is faster to configure all of the columns before 
configuring the rest of the visual settings.  To configure these settings go to the ToolTips tab.  
In the ToolTips tab, change the associated column for the Help ToolTip to the Help2 column.  
Do this by selecting Help2 from the drop down list, as shown in the figure below.  The Help2 
column is now associated with the Help ToolTip by choosing Comment in the ToolTip section. 

 
Configuring the Help ToolTip 

6. Now that the visual side of things is set up, it is necessary to change the subscription to 
request the additional help information.  Select the Subscription tab of the Alarm Viewer 
ActiveX Properties dialog box tab, highlight the SmarAWX Server subscription, and then click 
the Edit button, as shown in the figure below. 
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Alarm Viewer ActiveX Properties: Subscription Tab 

7. This opens the Event Subscription dialog.  Select the Attributes tab, as shown in the figure 
below, which allows you to add extra attributes to a particular event category within a 
subscription. As you can see in the figure below, the Current Value (CV) and Help Text have 
already been subscribed.  Add the Help Text extra attribute to the Subscribed list by 
highlighting Help Text under the Available list and clicking the Add button.    Please note that 
order is important.  Since Current Value (CV) is currently being used as Attribute 1 and Help2 
is assigned to the Attribute 3 column, the subscription should bring in Help Text to Atr 3, as 
shown in the figure below.  Continue this process for the Limit, Digital, and Rate of Change 
event categories by selecting the Event Category item from the drop-down list and repeating 
the above steps.  Click the OK button on the Event Subscription dialog, and then the OK 
button on the Subscription tab.   

 
Event Subscription Dialog Box: Attributes Tab 

8. Enter runtime mode by selecting Runtime from the Actions menu. 

9. Right-click on any alarm and choose ToolTips from the pop-up menu and select Help.  This 
changes the ToolTip from context sensitive to help.  The ToolTip information will match the 
information in the Help column.   

10. As an extra step, it is possible to hide the Help2 column.  Exit runtime and open the Column 
tab of the Alarm Viewer ActiveX Properties dialog box. Highlight the Help2 column, and 
press the Config button.  This opens the Set Column configuration dialog, as shown in the 
figure below. Enable the Cell override feature by checking the Cell check box.  Hide the 
column by checking the Hide check box.  Click the OK button and the OK button on the 
Column tab.  The help column will no longer be visible.  When entering runtime, it will still be 
possible to receive the help information via the ToolTips.  Simply right-click on an alarm line, 
select ToolTips from the pop-up menu, and then select the help ToolTip. The default ToolTip 
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and ToolTip width will be changed in the ToolTips tab of the Alarm Viewer ActiveX 
Properties dialog box. 

 
Configuring the Column Properties 

Miscellaneous 
Several features of AlarmView only work in conjunction with other features.  For example, the wrap 
text feature will only be visible if the line width is two or greater.  Also, it is not possible to change 
row widths during runtime if the row header is not enabled.  When sizing columns, use the default 
column size to approximate the best general settings.  Then use the column override to individually 
size any columns not exactly correct.  
Data are the most important piece of information displayed by an Alarm Viewer.  However, for a 
display to be truly effective, only pertinent information is desirable.  In alarm systems, filtering 
represents a major piece for weeding out unnecessary data.  Using the OPC Alarm and Events 
Specification, filtering is largely achieved by creating alarm subscriptions with various servers.  This 
effectively creates a server-side filter, improving speed and reducing communication traffic.  Rather 
than go over the information found in the OPC Alarm and Events Specification or the AlarmWorX 
Viewer ActiveX documentation, several filtering tricks are presented here to provide a few ideas on 
possible filtering schemes. 

Average Filter 
The process of setting up a subscription does more than just enable data to be passed from clients 
to server;  it also creates a server-side filter.  Server-side filters have the advantage of reduced 
communication traffic between the clients and the server, due to the fact that only requested 
messages are sent.  An average filter consists of multiple subscriptions to the same server.  An 
example of this might be a subscription that only requests alarms from Area1 with a subscription 
that requests only the Rate of Change alarms.   
Note: The Area can be set using the Areas tab in the Event Subscription dialog box (under the 
Subscription tab of the Alarm Viewer ActiveX Properties dialog box), as shown in the figure 
below, and clicking Browse to find the appropriate area.  
 

 
Event Subscription: Areas 
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Rate of Change is set on the Categories tab in the Event Subscription dialog box (under the 
Subscription tab of the Alarm Viewer ActiveX Properties dialog box), as shown in the figure 
below, by selecting Rate of Change as the event category.   

 
Event Subscription: Categories 

This creates a filter that will send all alarms for Area1 and all Rate of Change alarms. These filters 
can be further refined by setting severity levels and event types. By setting low severity to 500 and 
enabling condition events on the Types tab, as shown in the figure below, the filter can limit 
messages to alarms that require acknowledgment and have a severity range of 500 to 1000. 

 
Event Subscription: Types 

Filtering on High Alarms 
Due to the open architecture of the OPC Alarm and Events Specification and the use of server-side 
filtering, some of the more specific filtering capabilities are done by client-side filtering.  Server-side 
filtering operates by restricting alarm messages sent to clients.  This makes it more efficient than 
client-side filtering, which operates by hiding alarm messages.  It is possible to use only server-side 
configuration, but this requires filtering to be taken into account when configuring the alarm 
database.  An example of this would be filtering on only high alarms.  The first step is to make the 
limit condition the only requested event category in the Categories tab in the Event Subscription 
dialog box (under the Subscription tab of the Alarm Viewer ActiveX Properties dialog box), as 
shown in the figure below, by selecting Limit as the event category. Highlight the Limit selection 
and click the Add button.  Limit now shows up in the Subscribed list, as shown below.  Only limit 
alarms are requested from the server for this subscription.   
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Event Subscription: Categories 

It is still possible to have other subscriptions to the server that request other alarm categories.  To 
restrict the subscription further requires some configuration work on the server side. It is possible to 
set alarm severity for all alarm types in the SMAR OPC Alarm and Event Server.  By setting alarms 
to a specific severity range, it is possible to filter subconditions (high, lo, hihi, etc.) by filtering on 
severity.  This method uses the subscription capabilities of the alarm server while taking full 
advantage of server-side subscription (i.e. no wasted messages). 
 

Using the Mouse and Keyboard 
Mouse Functions 
In Windows, you use the mouse to move a pointer (usually an arrow) on the screen. The pointer 
shows you where you are on the screen and enables you to point to and select application items. 
In the AlarmWorX Container, you can use the mouse to:  
Select icons, buttons, and other screen objects. 
Resize AlarmWorX Container screens. 
Reposition windows and dialog boxes. 
Scroll through list boxes. 
Display context-sensitive help in the status bar for screen objects, such as icons, command buttons, 
and parameter fields. 
The table below lists various mouse functions and descriptions with which you need to be familiar.  

Function Description 

Left-click  Position the mouse pointer over an object, such as an icon or a command 
button, and press the left mouse button once. 

Right-click Inside an Alarm window, press the right mouse button once to view ActiveX 
properties. 

Double-click  Position the mouse pointer over an object, and press the left button twice in 
quick succession. 

Drag-and-drop  Click an object, and with the button still depressed, move the object to the 
desired location and release the button. 

Select  Click an object once with the left mouse button, highlighting the object 
(enclosing the object in a rectangle with a dotted rule or in reverse color). 

Move pointer over  Place the mouse pointer on top of an object, such as an icon or a command 
button, to display context-sensitive help for that object in the status bar. 
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Shortcut Keys 
The keyboard is used to enter information into dialog boxes and to select menu options. The table 
below lists the available shortcut keys and their related functions (English version only). 

Key  Function  
ALT+F  Displays the File menu options available for the displayed screen 
ALT+H Displays the available Help menu options  
ALT+T  Displays the Tools menu options available for the displayed screen 
ALT+W  Displays the Window menu, which contains a list of available AlarmWorX Container 

screens 
ALT+V  Displays the View menu options available for the displayed screen 
ALT+A  Displays the Actions menu options available for the displayed screen 
ALT+E Displays the Edit menu options available for the displayed screen 
ALT+F8 Starts the Macros dialog 
ALT+F11 Starts the Visual Basic editor 
CTRL+P  Prints the current screen 
CTRL+N  Opens a new Alarm window 
CTRL+O  Opens an existing Alarm window 
CTRL+S  Saves the currently selected Alarm window 
CTRL+T  Displays the Main toolbar 
CTRL+U Displays the status bar 
CTRL+F Sizes the Alarm window to the display 
CTRL+G Tiles all the open Alarm windows in the display 
CTRL+H Cascades all open Alarm windows in the display 
CTRL+A Toggles the current window between runtime mode and configuration mode 
CTRL+M Toggles the entire display between runtime mode and configuration mode 
Del Deletes an object from the display 
F12 Inserts a new object in the display 
F9 Launches the AlarmWorX Configurator 
F4 Displays Properties window for object inserted in the display 
F3 Opens the Display Preferences dialog  
F2 Opens the Application Preferences dialog 
F6 Launches security login in runtime mode 
F7 Starts the Security Configurator 
F1 Opens the Help topics file 

AlarmWorX Container Application 
The AlarmWorX ActiveX Container application integrates the following components.  
Alarm Logger Configurator 
Alarm Viewer ActiveX 
Alarm Reporting/Analysis ActiveX 
Alarm Reporting/Analysis ActiveX 
Alarm Server 
Alarm Server Configurator 

AlarmWorx Container Application 
This is a multiple document interface (mdi) container that integrates the various ActiveX alarm 
components and configuration tools into one user-friendly tool. Menus and toolbar items are 
provided to allow easy access to all configuration and runtime features of all of the AlarmWorX 
components. It also adds Microsoft VBA (Visual Basic for Applications) scripting support. 
AlarmWorX includes many new features that not only add functionality to the product but also make 
it easier to use. The AlarmWorX Container now has Unicode support and enhanced international 
language support, as well as global aliasing support. The Container also includes VBA 6.3 
integration.  
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 About the AlarmWorX Container 
The AlarmWorX Container is a fully VBA-enabled application, which allows for a high degree of 
customization and functionality. A container is an application that supports embedding of ActiveX 
objects, which are available from the Edit menu and the ActiveX toolbar.  
To insert an ActiveX object from the Edit menu, choose Insert New Object, or press the shortcut 
key F12. This opens the Insert Object dialog box, which is shown in the figure below. You can 
select an existing ActiveX object from the list, or you can create a new ActiveX object. You can also 
open the Insert Object dialog box by clicking the OLE button on the ActiveX toolbar. You can also 
insert an ActiveX object by choosing from the Add Trend submenu in the Edit menu.  

 
Insert Object Dialog Box 

Menus 
This section explains the various features available from the menu bar, toolbar, and status bar that 
allow you to manage your database records and use AlarmWorX easily and efficiently.  
The menus in the AlarmWorX Container enable you to change the default settings for many 
elements of the container. You can also use the menus to add new trends and open different 
elements of the AlarmWorX application.  
File menu 
Edit menu  
View menu  
Actions menu  
Tools menu  
Window menu  
Help menu  
Note: The File menu functions vary according to the screen that is displayed. (This is documented 
where appropriate.)  

Status Bar and Toolbar 
The status bar and toolbar are objects in the AlarmWorX Container screen. The information 
contained in the status bar varies depending upon the current screen displayed and the current 
system configuration and activity. The toolbars provide a convenient way to choose commands that 
are also available in the menu bar. 
Status Bar 
The status bar, shown in the figure below, is located at the bottom of the TrendWorX screen. To 
display or hide the status bar, choose the Status Bar command in the View menu, or press the 
shortcut keys CTRL+B. The left side of the status bar describes the functions of menu commands 
as you navigate through each menu. This side also describes the functions of toolbar buttons. When 
you move the mouse pointer over a toolbar button, the function of the button is displayed in the 
status bar. The status bar also indicates the display mode (runtime or configure), the number of 
open ActiveX objects, the current time, and the current date. 
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Status Bar 
Toolbar 
The Main toolbar is located below the menu bar. As shown in the figure below, the Main toolbar 
contains buttons for different functions available in AlarmWorX.  

New: Creates a new trend display. 

Open: Opens an existing trend display. 

Save: Saves the current display file. 

Print: Prints the current trend display. 

Cut: Deletes current selection, sending it to the clipboard. 

Copy: Copies the current selection to the clipboard. 

Paste: Pastes the current contents of the clipboard. 

Alarm Viewer: Inserts an Alarm Viewer ActiveX in the display. 

Alarm Report: Inserts an Alarm Report ActiveX in the display. 

Tile Objects: Fit all open windows into the container screen as non-overlapping tiles. 

Delete: Deletes the selected object from the Trend window. 

Configurator: Starts the Alarm WorX Server Configurator application. 

Security: Launches the Security Server Configurator. 

Runtime: Activates runtime mode for all Trend windows. 

The ActiveX toolbar enables you to select Active X objects. For more information, refer to the 
ActiveX Toolbar section. 

ActiveX Toolbar 
The ActiveX toolbar consists of two main parts. The OLE button is used to display the ActiveX 
Control Selection dialog, while the other buttons represent additional ActiveX controls including: 
GraphWorX ActiveX Control 
AlarmWorX Viewer ActiveX Control 
AlarmWorX Report ActiveX Control 
AlarmWorX Indicator ActiveX Control 
TrendWorX Viewer ActiveX Control 
GraphWorX Gauge ActiveX Control 
 

 
ActiveX Toolbar 

The other buttons represent common ActiveX controls, which are supported by and can be 
referenced in VBA. 
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File Menu 
The File menu commands are listed in the table below.  
Note: If an Alarm window is not open, the Close, Save, and Print commands are disabled. 

File Menu Commands 
Command Shortcut Keys Function 
New CTRL+N Creates a new alarm display. 

Open CTRL+O Opens an existing alarm display. 
Close  Closes the current alarm display. 

Save CTRL+S Saves the current display file. 
Save As  Saves current display file with a new name or file extension. 

Print CTRL+P Prints the current alarm display. 
Print Preview  Displays a preview of the screen before printing. 

Print Setup  Configures printer settings. 
Recent File  Lists the last four files opened in AlarmWorX. 

Exit  Closes the application. 

Printing 
Using AlarmWorX, you can perform any of the following printer functions: 
Print the current window. 
Preview the screen information before printing. Refer to the Print Preview section for more 
information.  
Print only the Help instructions for the currently selected trend. 
To configure a printer, you need to define the appropriate parameters in the Microsoft Windows 
Control Panel. Refer to your Windows documentation for complete information. 

Print Preview 
To preview the screen information before printing, choose Print Preview from the File menu. The 
Print Preview screen will appear as shown below. The figure below shows a print preview of the 
Alarm window. The title bar indicates the file that is currently displayed. 

 
Print Preview Screen 
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The table below lists the command buttons found in the Print Preview screen and their functions. 
These buttons enable you to view the print preview information before you print. 

Button Function 
Print Displays the Print dialog box 
Next Page Displays the next page in a multiple-page print preview 

Previous Page Displays the page that immediately precedes the current page in a multiple-
page print preview 

Two Page Displays two pages simultaneously in a multiple-page print preview 
Zoom In Enlarges the view of the Print Preview screen from normal view 

Zoom Out Decreases the view of the Print Preview screen to a full-page view, enabling 
you to see how the entire printed page will look 

Close  Exits the Print Preview screen and returns to the normal view 
To print the document, click Print to display the Print dialog box. For more information on printing, 
refer to the Printing Screen Information section. If you decide not to print, click Close to exit the 
Print Preview screen. 

Printing Screen Information 
To print the information on the screen, choose Print from the File menu, or press the shortcut keys 
CTRL+P. The Print dialog box appears as shown below. When you are ready to print, click OK. 
AlarmWorX prints all records contained within the scroll window on the screen.  

 
Print Dialog Box 

When the information is sent to the print queue, the Printing Status dialog box appears on the 
screen. The Printing Status dialog box indicates the number of records printed and the page that is 
printing. 
The Print dialog box indicates the configured printer to which this information prints. Refer to your 
Windows and printer documentation for complete information about how to configure a printer. 

Cancel Printing 
To cancel printing, click Cancel in the Printing Status dialog box. This immediately halts printing, 
and the print job is removed from the print queue. 
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Edit Menu 
The Edit menu commands are listed in the table below.  
Edit Menu Commands 

Command Shortcut Keys Function 

Cut CTRL+X Cuts the selected object from the current view and places it 
on the clipboard. 

Copy CTRL+C Copies the selected object to the clipboard. 

Paste CTRL+V Pastes the last object placed on the clipboard. 

Paste Special  Pastes the last object placed on the clipboard (with special 
options). 

Delete Object  DEL Deletes the selected object from the Alarm window. 

Insert New Object F12 Opens the Insert Object dialog box, which allows you to 
embed an ActiveX control in the Alarm window. 

Links  Edits linked objects. 
Properties  Opens the ActiveX Properties dialog box. 

 

Inserting Objects 
Selecting Insert Object from the Edit menu opens the Insert Object dialog box, shown in the figure 
below, which allows you to embed an ActiveX control in the container window. Alternatively, 
integrated ActiveX Controls can be inserted by selecting the corresponding button on the ActiveX 
toolbar. To configure the properties for an object, either double-click on that object or right-click and 
select the Properties from the pop-up menu.  
The following options are available in the Insert Object dialog box: 
Create New: Inserts the selected object into the container. Selecting this tab brings up the following 
dialog, which offers a list of object types to choose from as shown below: 
Create From File: Inserts a user-specified object into the container that is created from an existing 
file.  Click the Browse button to select a file. 
Create Control: Adds an ActiveX control to the Object Type list. Click the Add Control button to 
browse for a file.  

 
Inserting an Object Into the Container 
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ActiveX Object Pop-up Menu 
Once the object of choice is inserted in the container, right-clicking on the object displays a pop-up 
menu, as shown in the figure below. 

 
ActiveX Object Menu 

Delete 
Selecting Delete from the pop-up menu simply deletes the object from the display. Click Yes to 
delete the object, as shown in the figure below.  

 
Warning 

Show Property Window 
Selecting Show Property Window from the pop-up menu displays the Properties relevant to the 
object, as shown in the figure below.  

 
Properties Window 
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This window displays, in alphabetic or categorized form, all the properties applicable to the objects 
within the container. The Properties window contains all configurable options for the selected 
window, whether it is the ActiveX object or the ActiveX Control or the entire display.   
You can switch from window to window or from window to display by either clicking on the desired 
area that displays the Properties window or choosing it from the drop-down list at the top of the 
Properties window.  To edit an option in the Properties window, click on that field and either use 
the available drop-down list or simply type in your changes.  These properties can be also be 
modified using another the Properties dialog displayed by selecting ActiveX Object/Properties 
from the Edit menu. This item is also accessible through the Edit menu, which comes up if you 
right-click on the appropriate window.  

View Code 
Selecting View Code from the pop-up menu opens the Microsoft Visual Basic Editor as shown 
below, which allows you to both view and edit the code pertaining to the object.  

ActiveX Object Properties Dialog 
Selecting Properties from the pop-up menu opens the Properties dialog box for the specific ActiveX 
object. This menu item (specifically displaying the name of the ActiveX object inserted) also 
becomes available in the Edit menu once an object is inserted in the Container.  Note that certain 
ActiveX properties can only be configured from the ActiveX Properties dialog box.   
Note: For information about Properties for a specific ActiveX object, please see the Help 
documentation for that object.  

View Menu 
The View menu commands are listed in the table below.  

View Menu Commands 
Command Shortcut Keys Function 

Properties Window F4 
Opens the Properties window, which shows alphabetical 
and categorical properties for the currently selected 
ActiveX object. 

Display 
Preferences  F3 Opens the Display Preferences dialog.  

Application 
Preferences  F2 Opens the Application Preferences dialog. 

Main Toolbar  CTRL+T Toggles the AlarmWorX Main toolbar. 
ActiveX Toolbar  CTRL+Y Toggles the ActiveX toolbar. 

Status Bar  CTRL+U 

Toggles the status bar, which indicates the status of the 
container, which mode you are in (configuration or 
runtime), and the date and time. When navigating through 
the menu items, whichever item the mouse is over will be 
displayed in the status bar. 

Object Layout  Controls the positioning of currently selected ActiveX 
objects. 

Size to Display  CTRL+F Maximizes the size of the currently selected ActiveX object 
within the open Trend window. 

Tile to Display  CTRL+G Changes the size of all ActiveX objects to fit them evenly 
into the Trend window. 

Cascade  CTRL+H Overlaps all of the open ActiveX objects. 
Grid  CTRL+SHIFT+G Toggles the grids available in configuration mode. 

Select Language  CTRL+ALT+U 

Specifies the language to be used in the from the Select 
Language dialog box. Select the language you wish to use 
for your system and click OK. For navigation purposes, use 
the radio buttons and check boxes in the List section. 
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Properties Window 
Selecting Properties Window from the View menu displays alphabetical and categorical properties 
for the currently selected object, as shown in the figure below. This feature is discussed in the 
ActiveX Object Pop-up Menu section. 

 
Properties Window 

Display Preferences 
Selecting Display Preferences from the View menu opens the Display Preferences dialog box, as 
shown in the figure below.  This dialog allows you to configure or change the appearance of the 
Alarm Container display. 

 
Display Preferences Dialog 
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General Tab 
The General tab of the Display Preferences dialog box, shown in the figure below, sets the size of 
the display window, configures the arrangement of open windows, changes the display color, and 
configures the display for printing.   

 
Display Preferences: General Tab 

 

Window Dimensions 
The Window Dimensions field specifies dimensions (in pixels) from the left and the top of the 
window, as well as the width and the height of the window. 

New Objects 
The New Objects section positions the object with respect to the display.  You can place the object 
in the display, size the object to the display, tile the object to the display, or arrange the object in the 
cascade mode. 

Printing 
Under the Printing section, you can choose to ignore the display background and/or ignore the 
object background while printing. Ignoring the background saves ink while printing displays. 
If Ignore Display Background is checked upon printing a display, the background color of the 
entire display will be temporarily changed to white. The original display background color will be 
restored immediately after printing. If  
Ignore Object Background is checked upon printing a display, all background colors of each 
individual area within an ActiveX Viewer will be temporarily changed to white. The original colors will 
be restored immediately after printing. 

Apply to All Displays 
If checked, the parameters defined in the General tab of the Display Preferences dialog box will be 
applied to all displays. 

Tile Objects on Resize 
If checked, objects in the display are automatically tiled when the display is resized. 

Display Color 
The Display Color field allows you to choose a color for the display. Click the color box to open the 
Color Palette. 
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Runtime Tab 
The Runtime tab in the Display Preferences dialog box, shown in the figure below, configures the 
way the  window will appear in runtime mode. As you can see, the Runtime tab contains the 
following features: 
Runtime title bar options 
Runtime frame style 
Runtime start state 
Note: Checking the Apply To All Displays check box applies the settings to all currently open 
displays. 

 
Display Preferences: Runtime Tab 

Runtime Title Bar Options  
If the Show Title Bar box is checked, the title bar of the window will be displayed during runtime 
mode. Similarly, if the Override Caption box is checked, you may enter a caption that you would 
like to appear in the title bar during runtime.  
The System Menu, Minimize, and Maximize options all refer to buttons that may appear in the title 
bar during runtime. When all of these boxes are checked, all of the indicated buttons show up in the 
title bar. If you do not want a button to appear in the title bar, simply click the box that applies to that 
button to remove the check mark. Hiding these buttons helps to ensure the functionality of the 
window during runtime mode because the operator can neither close nor change the size of the 
window.   

Runtime Frame Style 
The Outer Frame Edge drop-down list enables you to choose from the following three frame styles: 
None 
Raised (resizable) 
Raised (fixed size) 
Selecting the Raised (Fixed Size) option helps to maintain the functionality of the window in runtime 
mode because the operator is not allowed to change the configured display. 
The Inner Frame Edge drop-down list gives you the option to have a sunken inner frame edge.  

Runtime Start State Section 
The Runtime Start State feature enables you to choose how the window will appear during runtime 
mode. Check the appropriate box to minimize or maximize the window. 
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Grids Tab 
The Grids tab in the Display Preferences dialog box, shown in the figure below, configures the 
type, style, size, and color of the display grid.  Selecting Show Grid makes the grid visible. 
Selecting Snap To Grid makes all borders of the display objects align with the grid lines when they 
are moved across the display area. The grids are not available when the display is in animation 
mode. 

 
Display Preferences: Grids Tab 

Application Preferences 
To configure or change the application preferences for the container, select Application 
Preferences from the View menu, or press the shortcut key F2. This opens the Application 
Preferences dialog box, as shown in the figure below. 

 
Application Preferences Dialog Box 

 



Getting Started 

1.26 

General Tab 
The General tab in the Application Preferences dialog box, shown in the figure below, enables 
you to 
Configure new displays. 
Define how a new Alarm Viewer will be placed in the display. 
Define the size of the window. 

 
Application Preferences: General Tab 

New Displays 
You can choose to have the new display by default appear either as a Blank window or as a 
window with an embedded Alarm Viewer.  
Checking Fit Object to Display maximizes the size of the object in the container window.  
Checking Tile All Displays changes the size of your objects to fit them into the evenly into the 
display window.  This is helpful if you want to compare data in different objects or if you are moving 
back in forth from object to object. 
Checking Cascade All Displays resizes all of the open objects and overlaps them so that you can 
see the top and left side of every open object window. 

Window Dimensions 
The Window Dimensions field specifies dimensions (in pixels) from the left and the top of the 
window, as well as the width and the height of the window. 

Runtime Tab 
The Runtime tab in the Application Preferences dialog box, shown in the figure below, configures 
runtime mode options for the entire AlarmWorX application. As you can see, the Runtime tab 
contains the following features: 
Runtime title bar options 
Runtime frame style 
Runtime settings 
The right side options determine how the application will start in runtime and how you want the 
application to appear in runtime mode. Additionally, the last two options let the you decide if you 
want to view the ActiveX Toolbar (described later) and if you want the save changes dialog to 
appear when you make changes in runtime and then exit the application.  If the Suppress Save 
Modified Message Box check box is checked, you will not be warned to save all changes made to 
a display while in runtime mode, and these changes will be lost.   
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Application Preferences: Runtime Tab 

Runtime Title Bar Options  
If the Show Title Bar box is checked, the title bar of the window will be displayed during runtime 
mode. Similarly, if the Override Caption box is checked, you may enter a caption that you would 
like to appear in the title bar during runtime.  
The System Menu, Minimize, and Maximize options all refer to buttons that may appear in the title 
bar during runtime. When all of these boxes are checked, all of the indicated buttons show up in the 
title bar. If you do not want a button to appear in the title bar, simply click the box that applies to that 
button to remove the check mark. Hiding these buttons helps to ensure the functionality of the 
window during runtime mode because the operator can neither close nor change the size of the 
window.   

Runtime Frame Style 
The Outer Frame Edge drop-down list enables you to choose from the following three frame styles: 
None 
Raised (resizable) 
Raised (fixed size) 
Selecting the Raised (Fixed Size) option helps to maintain the functionality of the window in runtime 
mode because the operator is not allowed to change the configured display. 

Loading Tab 
The Loading tab in the Application Preferences dialog box, shown in the figure below, enables 
you to add or delete previously created displays during startup. If Auto Load is checked, the 
selected displays will be loaded upon startup of AlarmWorX. If Auto Update is checked, AlarmWorX 
will automatically add the existing displays to the list of displays to be loaded during the next startup. 
If Auto Runtime is checked, the selected displays will automatically start in runtime mode upon 
startup. 
You can also select displays to add to the display startup list by simply clicking Add, which opens a 
Display dialog box. Similarly, you can delete a display from the startup list by selecting it and then 
clicking Delete. For this feature to go into effect, you must first save the display startup list as a .csv 
file. You can do this by clicking Save As to choose a directory for the .csv file that contains all the 
names of the AlarmWorX displays to be loaded upon startup. In addition, you can click Select to 
select a previously saved .csv file with the names of displays to be loaded the next time AlarmWorX 
starts up. 
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Application Preferences: Loading Tab 

Alarm Server Tab 
The Alarm Server tab in the Application Preferences dialog box, shown in the figure below, 
configures the behavior of the SMAR Alarm and Events Server.   

 
Application Preferences: Alarm Server Tab 

 
The server behaves according to the following selections: 
Launch on Startup: Launches the alarm and events server upon startup of the AlarmWorX 
Container application. 
Shutdown on Exit: Attempts to shut down the alarm and event server upon the shut down of the 
container.  Other applications may still keep the server running. 
Start on Runtime: Starts the alarm and events server when the alarm container enters runtime. 
Stop on Configure: Attempts to shut down the alarm and event server when the alarm container 
exits runtime.  Other applications may still keep the server running. 
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Object Layout 
To define how current objects in your display are shown, select Object Layout from the View menu 
and choose one of the following options:  
Size to Display: maximizes the size of the object in the container window. This item is not available 
if no object is selected. 
Tile to Display: changes the size of your objects to fit them into the evenly into the display window.  
This is helpful if you want to compare data in different objects or if you are moving back in forth from 
object to object. 
Cascade: resizes all of the open objects and overlaps them so that you can see the top and left side 
of every open object window. 

Selecting Languages 
The Select Language function on the View menu allows you to choose which language to use in 
your display. Choosing Select Language from the View menu opens the Select Language dialog 
box, shown in the figure below. 

 
Select Language Dialog Box 

Define the parameters listed in the table below. Then click OK to return to the work area. 
Select Language Parameters 

Parameter Description 

List 

Lists available languages.  Depending on which item you have selected, the 
view on the left will change.  If English is checked, the languages will 
appear as their English name. If Localized is checked, the languages will 
appear with the native country in parentheses (for languages with several 
dialects only). When Native is checked, the languages are displayed the 
way they would be written in that language. 

Installed Locales Only If this is checked, local languages appear in the box. 
Available Language 
Translations Only 

Checking this box allows you to choose from available language 
translations only. 

Actions Menu  
The Actions menu commands are listed in the table below.  
Actions Menu Commands 

Command Shortcut Keys Function 

Animation Mode CTRL+A Animates or deanimates the active Alarm window in the 
display. 

Runtime Mode CTRL+U Activates runtime mode for all Alarm windows.  
 
Note: You can also toggle between configuration mode and runtime mode by using the Traffic 
Light button on the Main toolbar. When the light is showing Red, the application is in configuration 
mode. When the light is showing Green, the application is in runtime mode. 
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Tools Menu 
The Tools menu commands are listed in the table below.  

Tools Menu Commands 
Command Shortcut Keys Function 
Macros ALT+F8 Runs a macro using the Macros dialog box. 
Visual Basic 
Editor ALT+F11 Opens the Visual Basic for Applications (VBA) IDE 

environment for developing customized VBA modules. 
Launch 
Configurator F9 Starts the AlarmWorX Server Configurator application, which 

has all the tools required for configuring the Alarm Server. 

Logger 
Configurator  

Starts the AlarmWorX Logger Configurator application, the 
tools required for configuring alarm logging and provides a 
comprehensive set of tools for monitoring and troubleshooting. 

Security Login F6 Opens the security login screen for logging into the Security 
Server (runtime mode only). 

Security 
Configuration F7 Launches the Security Server Configurator (configuration mode 

only). 
Set Working 
Directory F8 Specifies a custom directory in which all application 

configuration files will be stored and retrieved. 

Publish to HTML  

Launches the Web Publishing Wizard, which allows you to 
export (generate) an HTML file based on your TrendWorX 
display file and/or publish the HTML file to a Web server. For 
more information, please see the Web Publishing Wizard Help 
documentation. 

Configure for 
Windows CE  Starts AlarmWorX CE configuration mode. 

Windows CE 
Preferences  Configures settings for downloading the configuration to a 

Pocket PC or CE device. 
 
Selecting Tools > Macros > Macros opens the Macros dialog box, as shown in the figure below. 
Type a name for the macro and then click the Create button. This opens the Microsoft Visual Basic 
Editor, where you can create a new macro.  You can run an existing macro by entering the name of 
the macro in the Macro Name field and clicking the Run button. 

 
Creating and Running Macros 

The Windows CE submenu refers to the capability of configuring Pocket AlarmWorX displays to be 
downloaded to the CE device. To start AlarmWorX CE configuration mode, choose Configure for 
Windows CE from the Windows CE submenu. The Windows CE options are not available if Pocket 
AlarmWorX is not installed on your PC. The CE features are further explained in the Pocket 
AlarmWorX documentation.  



AlarmWorX 

1.31 

AlarmWorX Security 
AlarmWorX has an interface with the Security Server and currently supports the security actions 
shown in the dialog box below. 

 
Security Server 

If you do not have the appropriate security actions for the functions you want to perform, an error 
message box will appear indicating that you do not have the security level required by the action. 

Window Menu 
The Window menu commands are listed in the table below.  
Window Menu Commands 

Command Shortcut Keys Function 
Close  Closes the active Alarm window. 
Close All  Closes all open Alarm windows. 
Cascade  Overlaps all open Alarm windows. 

Tile  

Changes the size of all open Alarm windows to fit them evenly 
into the Container screen as non-overlapping tiles. This is helpful 
if you want to compare the data in different Alarm windows or 
move between Alarm windows. 

Arrange Icons  Arranges icons at the bottom of the window. 
 
The Window menu also contains a list of all open Alarm windows. In this list, the active window is 
indicated by a check mark. You can display a window by selecting it from this list. 

Help Menu 
The Help menu commands are listed in the table below.  
Help Menu Commands 

Command Shortcut Keys Function 
Help Topics F1 Launches the online help for AlarmWorX. 

About 
Application  

Launches the About Box, which contains information 
about the product version number, copyright, and available 
disk space. It also contains information about how to 
contact SMAR. 
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Downloading ProcessView Configuration Files to Your Pocket PC 
Once you have configured your application in ProcessView and saved the Pocket ProcessView 
display file, you can use the file Download to Windows CE Utility in ProcessView to download 
configuration files from GraphWorX, TrendWorX, and AlarmWorX to your Pocket or CE device. 
When developing a configuration file for a Pocket ProcessView application, this feature allows you 
to download the configuration file to a Windows CE or Pocket PC device. The file download function 
uses Microsoft ActiveSync to connect to the CE device. 

Setting up the Download  
The download to CE tool requires modules on both a desktop or workstation PC as well as a Pocket 
PC or CE device, because Microsoft ActiveSync services are used for connecting and 
authenticating the CE device. 

Configuring the Desktop  
The desktop is the only part that has to be configured. If the file download tool is installed properly, it 
will be listed in the ActiveSync Manager list of ActiveSync modules in the Sync Options tab of the 
Windows Options dialog box. You must enable the file download ActiveSync module in the 
ActiveSync Manager by checking the Download box, as shown in the figure below. 

 
Windows Options Dialog Box 

 
An association with the CE device must be created to synchronize the download ActiveSync 
modules, as shown in the figure below. When the CE device responds without any problems, the 
download synchronization module is active.  
When enabled, the file download tool immediately downloads the configuration file for Windows CE 
to the CE device. When disabled, the configured file will only be saved. 
For more information about Microsoft ActiveSync services, please refer to the Microsoft ActiveSync 
help documentation. 
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Microsoft ActiveSync 

File Download Application Configuration 
GraphWorX, TrendWorX, and AlarmWorX have their own version of the file download tool. In these 
applications, choose Tools > Windows CE > Windows CE Preferences, as shown in the figure 
below. 

 
Starting the Windows CE Download Tool 

This opens the Windows CE Preferences dialog box, which allows you to enable or disable the file 
download tool. To enable this tool, check the Download On Save check box. Then select the 
destination directory on the CE device by entering the path name in the Download Directory field, 
as shown in the figure below. 
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Setting Windows CE Preferences 

You can also click the Browse button to select the destination directory. Clicking the Browse button 
opens the Browse for Folder dialog box, which shows the CE device directories, as shown in the 
figure below.  A warning message box will be displayed when the file download ActiveSync module 
is inactive. 

 
Browsing for a Folder on the CE Device 

 
To establish a connection with the CE device, click OK, as show in the figure below. 

 
File Download ActiveSync Module 
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You can also use the Windows CE Preferences dialog box to configure other settings for the CE 
device. You can set the resolution of the target device by clicking the Resolution button. This 
displays a list of resolutions from 200 x 320 up to 1024 x 768. 

Downloading the File to the CE Device 
When you have finished configuring a display file and would like to save it to Windows CE, choose 
Save As from the File menu. This opens the Save As dialog box.  
In GraphWorX, enter the file name and select either "GraphWorX Displays for WinCE (*.gdc)" or 
"GraphWorX Templates for WinCE (*.gdc)" from the Save As Type box.  
In AlarmWorX, enter the file name and select "AWXview32 CE File (*.awv)" from the Save As Type 
box.  
In TrendWorX, enter the file name and select "TWXviewerCE File (*.tce)" from the Save As Type 
box. 
The SMAR Import File dialog box will be displayed, indicating that the files are downloading to the 
Windows CE device. 

Starting Pocket ProcessView Applications on Your Pocket PC  
Once you have downloaded your GraphWorX, AlarmWorX, or TrendWorX configuration files from 
your desktop PC to your Pocket PC or CE device, you can run the applications on your Pocket PC. 
The Pocket ProcessView client applications (Pocket GraphWorX, Pocket AlarmWorX, and Pocket 
TrendWorX) are located in the SMAR/Pocket ProcessView directory on your Pocket PC. Open the 
application you wish to run, and then select Open from the File menu. Browse for the desired .gdc, 
.awv, or .tce file. 
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Chapter 2 
 

2.1 

Introduction to the AlarmWorX Indicator ActiveX 
The AlarmWorX Indicator ActiveX, shown below, notifies you of alarms that are occurring in your 
ProcessView system. The flexible Alarm Indicator allows you to monitor alarm activity from virtually 
anywhere on your computer display, including various container applications as well as the 
Windows taskbar.  

 
AlarmWorX Indicator ActiveX 

The Alarm Indicator includes the following features: 
• Monitors the alarm status of the aggregate system 
• Configurable color, flashing, and sound parameters 
• Configuration for multiple alarm severity ranges 
• Sound suppression 
• Sizing and scaling for increased flexibility 
• Support for multiple concurrent instances 
• Global sound suppression for multiple instances 
• Ability to launch applications from Alarm Indicator 
• Configuration of alarm filters and subscriptions 
• Support for custom image files 
• Support for custom sound files 
The AlarmWorX Indicator ActiveX is included in the ProcessView installation. It can be inserted 
into any container (such as GraphWorX, AlarmWorX, TrendWorX, Microsoft Visual Basic forms, 
Microsoft Word, and Microsoft Excel) that has the capability to embed ActiveX objects.   

AlarmWorX Indicator ActiveX Properties 
To insert the AlarmWorX Indicator ActiveX, choose Insert New Object from the Edit menu in any 
of the ProcessView containers, including GraphWorX, TrendWorX, and AlarmWorX. This opens 
the Insert Object dialog box, shown below. Select AlarmWorX Indicator ActiveX from the list of 
object types in the Insert Object dialog box. Alternatively, you can click the AlarmWorX Indicator 
ActiveX button on the ActiveX toolbar. 

 
Insert Object Dialog Box 
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Double-clicking on the Indicator ActiveX (or right-clicking and then selecting AlarmWorX Indicator 
ActiveX Object from the pop-up menu) opens the AlarmWorX Indicator ActiveX Properties 
dialog box, which contains the following tabs: 
• General  
• Settings  
• Ranges  
• Subscription  

• Images  

General Tab 
The General tab of the AlarmWorX Indicator ActiveX Properties dialog box, shown below, 
allows you to specify the text for the ToolTip that appears when the mouse pointer is placed over 
the Indicator ActiveX during runtime mode. Simply enter the desired text in the ToolTip field. In the 
example below, the text "Alarm Indicator" will appear in the ToolTip during runtime mode. 

 
AlarmWorX Indicator ActiveX Control Properties: General Tab 

Configuration File 
By default, information is stored as part of the container application's document file. If the 
Configuration File check box is checked, as shown above, information is stored as part of a 
separate (.awi) file. To save the .awi file, click Save As to open the Save AWXInd File dialog box, 
shown below. Enter the name for the .awi file in the File Name field.  

 
Saving an .awi File 
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You can also open an existing configuration file by clicking the Load button on the General tab 
and browsing for the file. If Configuration File is selected, the viewer will attempt to load from the 
file listed in Filename. If both Configuration File and URL Path are selected, the ActiveX will use 
the URL path upon loading the file.   
You can also open an existing configuration file by clicking the Load button on the General tab 
and browsing for the file. If Configuration File is selected, the Report ActiveX will attempt to load 
from the file listed under File name. If URL Path is checked, the ActiveX will use the specified 
network URL path upon loading the file.   
Note: The ActiveX cannot be saved to a URL path. To create a URL file, save a report 
configuration to a local file and copy the file to the desired network location. 
Clicking the About button on the General tab opens the About Box, which contains information 
about this product. 
You can also select aliases to use for the configuration file. Clicking the ... button and selecting 
Global Alias Browser from the pop-up menu opens the Global Alias Browser, as shown in the 
figure below. Select a global alias from the Global Alias Browser, which includes all global aliases 
in the global alias database. This eliminates the need to manually type in the alias name. All global 
aliases that are configured in the Global Alias Engine Configurator are conveniently available to 
choose from inside the browser. The tree control of the Global Alias Engine Configurator is 
mimicked in the tree control of the Global Alias Browser. Select a global alias by double-clicking 
the alias name (e.g. "Floor" in the figure below). The alias name appears at the top of the browser, 
which automatically adds the <# and #> delimiters to the alias name. Click the OK button. 

 
Selecting an Alias From the Global Alias Browser 

Settings Tab 
The Settings tab of the AlarmWorX Indicator ActiveX Properties dialog box, shown below, 
allows you to configure the runtime settings for the Alarm Indicator ActiveX. Runtime options for 
the Indicator ActiveX include launching an application and suppressing the sound (if a sound is 
used to indicate an alarm) when you click on the ActiveX.  
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AlarmWorX Indicator ActiveX Control Properties: Settings Tab 

 
Launching an Application From the Indicator ActiveX 
The Doc to Launch field enables you to specify an application to be launched from the Indicator 
ActiveX. Click the Browse button to select an application file. In the Launch Doc Via field, choose 
the method by which you want the application to be launched (Single-Click, Double-Click, or 
Right-Click Context Menu). For example, suppose you want to launch a Microsoft Excel 
document by right-clicking the Alarm Indicator ActiveX when an alarm is indicated in runtime 
mode. First select your Excel document in the Doc to Launch field, and then select Right-Click 
Context Menu from the Launch Doc Via field. In runtime mode, right-click the Indicator ActiveX 
and then select Launch Doc from the pop-up menu, as shown below. 

 
Launching an Application During Runtime 

You can also select aliases to use for the Doc to Launch field. Clicking the ... button and selecting 
Global Alias Browser from the pop-up menu opens the Global Alias Browser, as shown in the 
figure below. Select a global alias from the Global Alias Browser, which includes all global aliases 
in the global alias database. This eliminates the need to manually type in the alias name. All global 
aliases that are configured in the Global Alias Engine Configurator are conveniently available to 
choose from inside the browser. The tree control of the Global Alias Engine Configurator is 
mimicked in the tree control of the Global Alias Browser. Select a global alias by double-clicking 
the alias name (e.g. "Floor" in the figure below). The alias name appears at the top of the browser, 
which automatically adds the <# and #> delimiters to the alias name. Click the OK button. 
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Selecting an Alias From the Global Alias Browser 

 

Turning off the Sound of an Alarm Indicator 
If you have configured a sound to be used when an alarm is indicated, you can turn off the sound 
during runtime mode. The Settings tab allows you to configure the parameters for sound 
suppression. The Sound Suppression Period is the duration of sound suppression (in seconds). 
In the Suppress Sound Via field, choose the method by which you want turn off the sound 
(Single-Click, Double-Click, or Right-Click Context Menu). For example, if you want to turn off 
the sound by right-clicking the Alarm Indicator ActiveX when an alarm is indicated in runtime 
mode, select Right-Click Context Menu from the Suppress Sound Via field. In runtime mode, 
right-click the Indicator ActiveX and then select Suppress Sound from the pop-up menu, as 
shown below. 
Note: The "suppress sound" method can be coupled with the "launch doc" method. For example, 
suppose Double-Click is selected in both the Suppress Sound Via field and the Launch Doc Via 
field. When the Alarm indicator is double-clicked during runtime mode, the selected application will 
be launched, and the sound will be turned off. 

 
Turning off Sound During Runtime 

 

Global Sound Suppression 
If multiple instances of the Alarm Indicator ActiveX are running concurrently and each instance is 
configured to produce a sound indicating an alarm, you can use the Global Sound Suppression 
function in the Settings tab to monitor the sound status of all instances. For example, suppose 
you have two Alarm Indicators open (Alarm Indicator 1 and Alarm Indicator 2). If Alarm Indicator 1 
sounds an alarm, and the Global Sound Suppression check box is checked, the sound of Alarm 
Indicator 2 will be temporarily suppressed until Alarm Indicator 1 stops making a sound. 
Note: The Launch Doc, Suppress Sound, and Properties commands are generally available on 
the right-click menu of the Alarm Indicator ActiveX during runtime mode (depending on the 
Security server settings). The Properties command opens the AlarmWorX Indicator ActiveX 
Properties dialog box. 
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Choosing Colors for the Alarm Indicator 
When an alarm is triggered, the Alarm Indicator ActiveX will flash repeatedly to visually indicate 
the alarm. In the Settings tab, you can set the color of the flash. First select the Normal Color by 
clicking on the color palette. The normal color is the runtime color of the ActiveX when there is no 
alarm.  
The flashing of the Alarm Indicator during runtime mode is made possible by simply replacing the 
normal color with a replacement color. Select the Replacement Color by clicking on the color 
palette. For example, if the normal color is green and the replacement color is red, the light bulb of 
the Alarm Indicator will be green when no alarms are occurring, as shown below. 

 
Example of Normal Color (No Alarm) 

If an alarm occurs, the bulb will flash red, as shown below. 

 
Example of Replacement Color (Alarm Occurring) 

Setting Up Filters 
Clicking the Filter button on the Settings tab opens the Edit Expression dialog box. For more 
information, please see the Expression Editor section.  

Expression Editor 
Clicking the Filter button on the Settings tab opens the Edit Expression dialog box, shown 
below, which contains the following options that enable you to set up alarm filters: 
• Arithmetic  
• Relational 
•  Logical 
• Bitwise 
• Functions 
• Tags 

 
Edit Expression Dialog Box  
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Arithmetic 
The Arithmetic menu symbols are shown in the figure below. 

 
Arithmetic Symbols 

The symbols '+', '-', '*', '/' and '%' use the following format:  
expression :: parameter symbol parameter 

Where  
Parameter A local variable, an OPC tag, a constant, or another expression 
Symbol + or - or * or / or % 

 
Result 
The expression results in a number of any type (float, long, etc.). 

Examples 
SYMBOL DESCRIPTION EXAMPLE RESULT 

+ Addition ~~var1~~ + ~~var2~~ 8+3 = 11 

- Subtraction ~~var1~~ - ~~var2~~ 8-3 = 5 

* Multiplication ~~var1~~ * ~~var2~~ 8*3 = 24 

/ Division ~~var1~~ / ~~var2~~ 8/3 = 2.66667 

% 
Calculates the remainder after 

division ~~var1~~ % ~~var2~~ 8%3 = 2 

( and ) Gives precedence to parts of 
the calculation 

~~var1~~ / 
(~~var2~~ + ~~var3~~) 8/(3+2) = 1.6 
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Relational 
The Relational menu symbols are shown in the figure below. 

 
Relational Symbols 

The symbols '<', '>', '<=', '>=', '==' and '!=' use the following format:  
expression :: parameter symbol parameter 

 
Where  

Parameter A local variable, an OPC tag, a constant, or another expression 
Symbol < or > or <= or >= or == or != 

 
Result 
The expression results in a Boolean value (0 or 1). 

Examples 
SYMBOL DESCRIPTION EXAMPLE RESULT 

< Less than ~~var1~~ < ~~var2~~ 8<3 = 0 

> Greater than ~~var1~~ > ~~var2~~ 8>3 = 1 

<= Less than or equal to ~~var1~~ <= ~~var2~~ 8<=3 = 0 

>= Greater than or equal to ~~var1~~ >= ~~var2~~ 8>=3 = 1 

== Equal to ~~var1~~ == ~~var2~~ 8==3 = 0 

!= Not equal to ~~var1~~ != ~~var2~~ 8!=3 = 1 
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Logical 
The Logical menu symbols are shown in the figure below. 

 
Logical Symbols 

The symbols '&&' and '||' use the following format:  
expression :: parameter symbol parameter 

 
The symbol '!' uses the following format: 

expression :: symbol parameter 
Where  
Parameter A local variable, an OPC tag, a constant, or another expression 
Symbol && or || or ! 

 
Result 
The expression results in a Boolean value (0 or 1). 
 
Truth table 

  
 
Examples 

SYMBOL DESCRIPTION EXAMPLE RESULT 
&& And ~~var1~~ && ~~var2~~ 8 && 3 = 1 

|| Or ~~var1~~ || ~~var2~~ 8 || 3 = 1 

! Not !~~var1~~ !8 = 0 
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Bitwise 
The Bitwise menu symbols are shown in the figure below. 

 
Bitwise Symbols 

 

The symbols '&', '|', and '^' of the bitwise group use the following format:  
expression :: parameter symbol parameter 

 
The symbol '~' of the logical group uses the following format:  

expression :: symbol parameter 
 
The symbols 'shl' and 'shr' of the bitwise group use the following format: 

expression :: symbol (value, shift by) 
 
Where  

Parameter A local variable, an OPC tag, a constant, or another expression 
Symbol && or || or ^ or shl or shr or ~ 

 
Result 
The expression results in a number when the parameters used contain numbers. 
 
Bit Table 
 BINARY (DECIMAL) BINARY (DECIMAL) 

~~var1~~ 0000.0000.0000.1000 - (8) 0000.0000.0110.0000 - (96) 

~~var2~~ 0000.0000.0000.1010 - (10) 0000.0000.0000.1000 - (8) 

~~var1~~ & ~~var2~~ 0000.0000.0000.1000 - (8) 0000.0000.0000.0000 - (0) 

~~var1~~ | ~~var2~~ 0000.0000.0000.1010 - (10) 0000.0000.0110.1000 – (104) 

~~var1~~ ^ ~~var2~~ 0000.0000.0000.0010 - (2) 0000.0000.0110.1000 - (104) 

shl (~~var1~~,3) 0000.0000.0100.0000 - (64) 0000.0011.0000.0000 - (768) 

shr (~~var1~~,3) 0000.0000.0000.0001 - (1) 0000.0000.0000.1100 - (12) 

~(~~var1~~) 1111.1111.1111.0111 - (-9) 1111.1100.1111.1111 - (-97) 

bittest(~~var1~~,3) 0000.0000.0000.0001 - (1) 0000.0000.0000.0000 - (0) 
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Examples 
SYMBOL DESCRIPTION EXAMPLE RESULT 

& Bit And ~~var1~~ & ~~var2~~ 8 && 3 = 0 

| Bit Or ~~var1~~ | ~~var2~~ 8 || 3 = 11 

^ Bit eXclusive Or ~~var1~~ ^ ~~var2~~ 8^3=11 

shl Bit shift left shl(~~var1~~,3) 8<<3=64 

shr Bit shift right shr(~~var1~~,3) 8>>3=1 

~ Not (two's complement) ~(~~var1~~) !8 = -9 

bittest Bit Test bittest ( 5 , 0 ) 1 

 
Note: The bittest function requires you to specify the position of the bit to be tested. You must 
indicate that it starts from 0. In other words, a bit position of "0" indicates the "less significant" bit. 

 

Functions 
The Functions menu options are shown in the figure below. 

 
Functions Menu Options 
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The symbols 'sin', 'asin', 'cos', 'acos', 'tan', 'atan', 'log', 'ln', 'exp', 'sqrt', 'abs', 'ceil', and 'floor' use 
the following format: 

expression :: symbol (parameter) 
 
The symbols 'pow', 'min', and 'max' use the following format: 

expression :: symbol (parameter,parameter) 
 
The symbol 'if' uses the following format: 

expression :: symbol (parameter,parameter,parameter) 
Where  

Parameter A local variable, an OPC tag, a constant, or another expression 
Symbol sin, asin, cos, acos, tan, atan, log, ln, exp, sqrt, abs, ceil, floor, min, max, pow, or if 

Result 
The expression results in a number. 
Examples 

Symbol Description Example Result 
sin sine of an angle in radians sin(~~var1~~) sin(0.785)=0.71 

cos cosine of an angle in radians cos(~~var1~~) cos(0.785)=0.71 

tan tangent of an angle in radians tan(~~var1~~) tan(0.785)=1.0 

asin arc sine returns an angle in radians asin(~~var1~~) asin(0.5)=0.52 

acos arc cosine returns an angle in radians acos(~~var1~~) acos(0.5)=1.05 

atan arc tangent returns an angle in radians atan(~~var1~~) atan(1)=0.785 

sqrt Returns the square root sqrt(~~var1~~) sqrt(100)=10 

pow Returns value 1 raised to the power value 2 pow(~~var1~~,~~var2~~) pow(100,1.5)=1000 

log 10 based logarithm log(~~var1~~) log(100)=2 

ln e based logarithm ln(~~var1~~) ln(7.389)=2 

exp Exponential  exp(~~var1~~) exp(2)=7.389 

abs Absolute value abs(~~var1~~) abs(-1)=1 

ceil Integer ceiling ceil(~~var1~~) ceil(7.39)=8 

floor Integer floor floor(~~var1~~) floor(7.39)=7 

min Lowest value of two min(~~var1~~,~~var2~~) min(10,5)=5 

max Highest value of two max(~~var1~~,~~var2~~) min(10,5)=10 

if Conditional statement if(~~var1~~<~~var2~~, ~~var1~~,~~var2~~) if(5<8,5,8)=5 

like Wildcard string compare Like(string, pattern, casesensitive')  

quality Quality of tag or expression See below. See below. 

tostring Type conversion See below. See below. 

0x Hexadecimal constant x=0x11   17 

0t Octal constant x=0t11   9 

0b Binary constant x=0b11 3 
 

Note: For the like operator: "string" equals the string to search in; "pattern" equals the string to 
search for (can include wildcards); nonzero for case-sensitive search; zero for case-insensitive 
search. String syntax is $"string"$. 
You can use these special characters in pattern matches in string:  

• ? Any single character.  
• Zero or more characters.  
• # Any single digit (0-9).  
• [charlist] Any single character in charlist.  

• [!charlist] Any single character not in charlist. 
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Quality 
The quality option on the Functions menu of the Expression Editor is used to evaluate the 
quality of an OPC tag or an expression.  
The following general syntax is used for quality expressions: 
x=quality(expression) 
Note: The "(expression)" can also be a simple expression composed of a single tag. 
 

The quality function returns the OPC quality of the string between parentheses as one of the 
following results: 

• 192: quality is GOOD 
• 64: quality UNCERTAIN 

• 0: quality BAD 
 

Note: The OPC Foundation establishes the value ranges for quality. There are actually varying 
degrees of quality:  

• GOOD: 192-252 

• UNCERTAIN: 64-191 
• BAD: 0-63 
 

For more information, refer to the OPC Data Access Custom Interface Standard available for 
download at the OPC Foundation's Web site, www.opcfoundation.org/. 
 

Example Quality Expression 
EXPRESSION RESULT 
x=quality({{Smar.Simulator.1\SimulatePLC.PumpStatus}}) 192 (Quality GOOD) 

 

The quality of an expression is determined through the evaluation of each single tag in the 
expression. Thus, if you have multiple tags in an expression (and each tag has a different quality), 
the result of the expression (i.e. 192 [GOOD], 64 [BAD], or 0 [UNCERTAIN]) corresponds to the 
quality of the tag with the lowest quality. If an expression contains a conditional statement (e.g. if, 
then, or else), then the result of the expression is affected only by the quality of the branch being 
executed. 
 

Consider the following sample expression: 
x= if ( quality({{Tag1}}) == 192, {{Tag1}}, {{Tag2}}) 

This expression can be read as follows:  
"If the quality of Tag1 is GOOD (i.e. 192), then the expression result (x) is the value of Tag1. In all 
other cases (i.e. the quality of Tag1 is UNCERTAIN or BAD), the expression result (x) is the value 
of Tag2." 
We can calculate the results for this expression using different qualities for Tag1 and Tag2, as 
shown in the figure below. 
 

CASE TAG1 QUALITY TAG2 QUALITY RESULT RESULT QUALITY 
1 GOOD GOOD Tag1 192 (GOOD) 

2 GOOD UNCERTAIN Tag1 192 (GOOD) 

3 GOOD BAD Tag1 192 (GOOD) 

4 UNCERTAIN GOOD Tag2 192 (GOOD) 

5 UNCERTAIN UNCERTAIN Tag2 64 (UNCERTAIN) 

6 UNCERTAIN BAD Tag2 0 (BAD) 

7 BAD GOOD Tag2 192 (GOOD) 

8 BAD UNCERTAIN Tag2 64 (UNCERTAIN) 

9 BAD BAD Tag2 0 (BAD) 
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In cases 1-3 above, the quality of Tag1 is GOOD, and therefore the result of the expression is 
GOOD. Thus, the result of the expression is not affected by the quality of Tag2 (the “else” branch 
of the expression), which is ignored.  
In cases 4-6, the quality of Tag1 is UNCERTAIN, and therefore the result of the expression is the 
quality of Tag2.  
In cases 7-9, the quality of Tag1 is BAD, and therefore the result of the expression is the quality of 
Tag2. 
Note: The “quality()” function returns a value that represents the quality of the expression within 
the parentheses but is always GOOD_QUALITY. For example, if Tag1 is BAD_QUALITY then the 
expression “x=quality({{Tag1}})" will return 0 with GOOD_QUALITY. 
 
The result of an expression is the minimum quality of the evaluated tag in the expression and is 
affected only by the quality of the conditional (if, then, or else) branch that is executed.  
Consider the following sample expression: 

x= if ({{TAG_01}}>0,{{TAG_02}},{{TAG_03}}) 
This expression can be read as follows:  
"If the value of TAG_01 is greater than 0, then the expression result (x) is TAG_02. If the value of 
TAG_01 is less than or equal to 0, then the expression result (x) is TAG_03." 
Let's assume that the following values and qualities for these tags: 
TAG_01=5 with quality GOOD 
TAG_02=6 with quality UNCERTAIN 
TAG_03=7 with quality BAD 
Because the value of TAG_01 is 5 (greater than 0), the expression result is TAG_02. Thus, the 
final expression result is 6, and the final expression quality is UNCERTAIN. 
 

Type Conversion 
The tostring option on the Functions menu of the Expression Editor takes the value of 
whatever item is in parentheses and converts it into a string as follows: 
The value is +(value)+unit 
It can be used to convert from number to string, and it can be very useful for string concatenation. 
The proper syntax for the tostring option is: 

x=$"The value is "$ + tostring(value) + $" unit"$ 
 
Note: In the expression above, the word "unit" is placeholder text for a user-specified unit of 
measurement or variable (e.g. Watt, inches, meters, etc.).  
Example Expressions Type Conversion 
Expression Result 
x=$"The value is "$ + tostring({{gfwsim.ramp.float}}) + $" Watt"$ “The value is 543.2345152 Watt” 

 
Constants 
The Functions menu of the Expression Editor supports constant values, including hexadecimal, 
octal, and binary formats.  
Example Expressions Using Constants 
Expression Result 
x=0x11   17 

x=0t11   9 

x=0b11 3 

 
The Expression Editor conveniently inserts the 0x and 0t and 0b prefixes for you so do not have 
to recall them. 
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Interpreting and Translating Constants 
The examples below show how values are calculated for each type of constant. 
• Hexadecimal: 0x20A = 2 * (16^2) + 0 * (16^1) + 10 * (16^0) = 2*256 + 0*16 + 10 * 1 = 512 + 0 
+ 10 = 522 
• Octal: 0t36= 3 * (7^1) + 6 *(7^0) = 3* 7 + 6* 1= 21 + 6 = 27 
• Binary: 0b110 = 1 * (2^2) + 1 * (2^1) + 0 * (2^ 0) = 1 * 4 + 1 * 2 + 0 * 1 = 4+2+0 = 6 

Tags 
The menu options available under the Tags button of the Expression Editor are shown in the 
figure below. The Expression Editor dialog box can also be used to create and edit alarm filters. 
The Expression Editor provides a Filter Wizard and an Alarm Tag list to help you create simple 
alarm filters. If you want to customize your alarm filters, you can use the other functions in the 
Expression Editor to set up your alarm filters manually. 

 
Creating Alarm Filters Using the Expression Editor  

Filter Wizard 

The Filter Wizard, shown in the figure below, allows you to choose from the following to items 
enter in your expression. Select one or more items, and then click OK. The filter string is 
automatically inserted into the Edit Expression dialog box. 

• Alarm Types: Alarm, Ack, Unack, Tracking, and Operator 

• Subconditions: LoLo, Lo, Hi, HiHi, ROC, and Digital 

 
Filter Wizard 
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Selecting Alarm Attributes 

Selecting Advanced from the Tags menu of the Expression Editor opens the Alarm Tag list, 
shown in the figure below, which allows you to choose alarm attributes for your alarm filter. Select 
the attribute that you want to include in the filter expression and click OK.  

 
Alarm Attributes List 

There are two additional attributes available for use in filtering: Alarm Type and Current Time.  
The Alarm Type attribute allows you to filter alarms according to ALARM 1, ACK 2, UNACK 3, 
OPER 4, TRACK 5 or NORM 6.  For example, you can set up a filter with the condition: 

X = {{AlarmType}}  

 

If the Alarm Type is true, then the alarms are displayed. If they are false then, the alarms are not 
displayed.   

The Current Time attribute allows you to filter according to the current time.  Only alarms 
occurring around the current time will be displayed. 

 

Example Alarm Filters 

EXPRESSION RESULT 
X = {{Severity}} > 500.   Only alarm messages with a severity greater than 500 will be visible. 
X = Like({{Source}}, $"Tag"$,0) Only messages with the tag in the source name will be displayed. 
X = 1.   Filter displays all messages. 
X = 0.   Filter does not display any messages. 

 

All filters resolve to TRUE or FALSE. All nonzero values resolve to TRUE.  

For more information, please see the AlarmWorX Server documentation. 
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Global Aliases 
For global aliases within the expression, use the following syntax:   

<#global_alias_name#> 

Example: 

x=<#RoomTemperature#> 

Selecting Global Alias Browser opens the Global Alias Browser, as shown in the figure below. 
Select a global alias from the Global Alias Browser, which includes all global aliases in the global 
alias database. This eliminates the need to manually type in the alias name. All global aliases that 
are configured in the Global Alias Engine Configurator are conveniently available to choose from 
inside the browser. The tree control of the Global Alias Engine Configurator is mimicked in the tree 
control of the Global Alias Browser. Select a global alias by double-clicking the alias name (e.g. 
"Floor" in the figure below). The alias name appears at the top of the browser, which automatically 
adds the <# and #> delimiters to the alias name. Click the OK button. 

 
Selecting an Alias From the Global Alias Browser 
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Language Aliases 
For language aliases within the expression, use the following syntax:   

/+anguage_alias_name+/ 

Example: 

x=/+WaterSystem+/ 

Selecting Language Alias Browser from the pop-up menu opens the Language Alias Browser, as 
shown in the figure below. The browser includes all languages aliases in the language database. 
All language aliases that are configured in the Language Configurator are conveniently available to 
choose from inside the browser. The tree control of the Language Configurator is mimicked in the 
tree control of the Language Alias Browser. Select a language alias by double-clicking the alias 
name. The alias name appears at the top of the browser, which automatically adds the /+ and +/ 
delimiters to the alias name. Click the OK button. 

 
Selecting an Alias From the Language Alias Browser 
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Ranges Tab 
The Ranges tab of the AlarmWorX Indicator ActiveX Properties dialog box, shown below, 
allows you to configure colors, flash periods, and sounds for the Alarm Indicator. The Severity 
Range field enables you to set Alarm Indicator parameters based on the severity level of alarms. 
The severity values range from 0-1000. Each severity range is configured separately. For 
example, the figure below shows the default configuration for the severity range 0-99. Each 
severity range has a different configuration. Thus, the next severity range (e.g. 100-199), will have 
a different configuration. 

 
AlarmWorX Indicator ActiveX Control Properties: Ranges Tab 

Configuring Severity Ranges for the Alarm Indicator 

To configure a severity range: 

1. Under the Severity Range field of the Ranges tab, select a severity range to configure.  

2. Click the Configure button to open the Severity Range Configuration dialog box, shown 
below. The Severity field displays the lower limit for the selected severity range. 

Note: You can customize the severity ranges by changing the "low limit" value in the Severity 
field. The new range will be displayed in the Severity Range field on the Ranges tab. The default 
severity value '0' cannot be deleted. 
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Severity Range Configuration Dialog Box 

3. Choose a color that will indicate the severity level when the Alarm Indicator flashes. Click on 
the color palette to select a color. 

4. Set the value for the flash period. The Flash Period is the frequency at which the Alarm 
Indicator will flash (in milliseconds) when an alarm occurs within the specified severity range. 

5. Set the value for the sound period. The Sound Period is the frequency at which the Alarm 
Indicator will make a sound (in milliseconds) when an alarm occurs within the specified severity 
range.  

6. Select a sound that will indicate alarms that fall under the severity range. Click the ... button 
under the Sound File Name field to browse for a sound (.wav) file. To test the selected sound file, 
click the Play Sound button. 

Note: Flashing and sound will occur for unacknowledged alarms in order of priority from the 
highest to lowest severity level. 

7. Click OK to apply the changes. The new configuration settings will be shown on the Ranges 
tab. 

Repeat the steps above for each severity range you wish to configure for the Alarm Indicator. 

 

Deleting a Severity Range Configuration 

To delete a severity range configuration: 

1. Select the severity range for the configuration you wish to delete in the Ranges tab. 

2. Click the Configure button to open the Severity Range Configuration dialog box.  

3. Click the Delete button.   
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Subscription Tab 
The Subscription tab of the Alarm Indicator ActiveX Properties dialog box, shown below, 
determines what type of OPC connection will be made. It allows you to add, rename, delete, or 
edit a subscription to a particular alarm. To add a new subscription, click the Add button.  

 
Alarm Viewer ActiveX Properties: Subscription Tab 

The subscription named "New Subscription" appears. This subscription does not contain any data, 
so it is necessary to immediately edit the new subscription. To do so, click the Edit button to open 
the Event Subscription dialog box, as shown in the figure below. It is only possible to add or edit 
subscriptions that are connected to active OPC Alarm and Event servers.  

Note: It is possible for a server to have more than one subscription.  In fact, it is a very effective 
way to achieve filtering.  

 
Creating an Event Subscription  
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Server 
The Server tab of the Event Subscription dialog box, shown in the figure below, allows you to 
select an Event Server and Node for each subscription. To select the event server, click the 
Browse button.  

 
Event Subscription Dialog Box: Server Tab 

This opens the OPC Universal Tag Browser, shown in the figure below, which lists all available 
Alarm and Event OPC servers. Select the desired server, and click OK. For local servers, it is not 
necessary to fill in the Node field. 

 
Selecting an Alarm and Events Server From the OPC Universal Tag Browser 

You can also select global aliases to use in the Node field. Clicking the ... button and selecting 
Global Alias Browser from the pop-up menu opens the Global Alias Browser, as shown in the 
figure below. Select a global alias from the Global Alias Browser, which includes all global aliases 
in the global alias database. This eliminates the need to manually type in the alias name. All global 
aliases that are configured in the Global Alias Engine Configurator are conveniently available to 
choose from inside the browser. The tree control of the Global Alias Engine Configurator is 
mimicked in the tree control of the Global Alias Browser. Select a global alias by double-clicking 
the alias name (e.g. "Floor" in the figure below). The alias name appears at the top of the browser, 
which automatically adds the <# and #> delimiters to the alias name. Click the OK button. 
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Selecting an Alias From the Global Alias Browser 

Clicking the ... button and selecting Language Alias Browser from the pop-up menu opens the 
Language Alias Browser, as shown in the figure below. The browser includes all languages aliases 
in the language database. All language aliases that are configured in the Language Configurator 
are conveniently available to choose from inside the browser. The tree control of the Language 
Configurator is mimicked in the tree control of the Language Alias Browser. Select a language 
alias by double-clicking the alias name. The alias name appears at the top of the browser, which 
automatically adds the /+ and +/ delimiters to the alias name. Click the OK button. 

 
Selecting an Alias From the Language Alias Browser 
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Types 
The Types tab of the Event Subscription dialog box, shown in the figure below, allows you to 
configure which OPC-defined event types each subscription should have, as well as to set the 
ranges for severity (priority). A value of "0" represents the low severity value, and "1000" 
represents the high severity value. Please note that OPC Alarm and Event (AE) servers are 
required to scale severity values to the OPC ranges (i.e. an AE server that contained two severity 
ranges would convert these to "0" and "1000"). 

 
Event Subscription Dialog Box: Types Tab 

Simple: These messages state information but do not have alarm status, nor do they contain 
information on what initiated the message. This includes the following information: Source, Time, 
Type, EventCategory, Severity, Message, Cookie, and server-specific items.   

 Example: "FIC101, 12:0:0 1/1/99, Simple, Category1, 100, 'Shift Change', 1" 

Simple messages would be similar to an event. 

Tracking: These messages contain the additional information of the client that initiated the event. 
This includes the following information: Source, Time, Type, EventCategory, Severity, Message, 
Cookie, ActorID, and server-specific items. 

 Example: "FIC101, 12:0:1 1/1/99, Tracking, Category1, 300, 'Pump pressure Set to 10 psi', 1, 
Station 12" 

Tracking messages are similar to event messages in that the cause of the event is important. An 
example would be an operator changing a setpoint value. This type of message does not include 
acknowledge capability. 

Note: Simple and tracking messages are removed from the alarm viewer via the acknowledge 
mechanism. 

Condition: These messages contain all of the above information but also include an 
acknowledgement portion. This includes the following information: Source, Time, Type, 
EventCategory, Severity, Message, Cookie, ConditionName, SubConditionName, ChangeMask, 
NewState, ConditionQuality, AckRequired, ActiveTime, ActorID and server-specific items. 

 Example: "FIC101, 12:0:3 1/1/99, Condition, Category1, 700, 'Pump pressure to high', 1, Limit, 
HiHi, 1,Active Enabled, Good, TRUE, 12:0:2 1/1/99" 

Condition messages would be considered a "typical" alarm message with acknowledge capability. 

For further details on any of the included information, please refer to the OPC Alarm and Events 
specification. 
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Categories 
The Categories tab of the Event Subscription dialog box, shown in the figure below, allows you 
to select the categories for a subscription. Select the category from the list of available categories, 
and then click the Add -> button. The category will appear in the Subscribed list. To remove a 
category from this list, select it in the Subscribed list and click the <- Remove button. If no 
categories are listed in the Subscribed list, then all categories are selected by default. 

 
Event Subscription Dialog Box: Categories Tab 

Areas 
Use the Areas tab of the Event Subscription dialog box, shown in the figure below, to select an 
area or a group of areas for filtering in a subscription.  

 
Event Subscription Dialog Box: Areas Tab 

Clicking the Browse button opens the OPC Event Server Area / Source Browser, shown in the 
figure below, which lists all available areas for your event server. Area subscription supports 
wildcards, which subscribe to the format of the Microsoft Visual Basic 'like" command. For 
example, "Area1*" will subscribe to all alarm areas that contain strings beginning with "Area1". 
"Area1\*" will subscribe to the root area and its "child" areas. A detailed explanation of the wildcard 
support can be found in the OPC Alarm and Events documentation. It is recommended that you 
thoroughly read the wildcard documentation before attempting to use complicated expressions.  



Indicator ActiveX 
 

2.26 

It is also possible to delete an area from the Areas tab. To delete an area, select it from the list of 
areas for this particular subscription, and then click the Delete button. Not all OPC Alarm and 
Event servers support area filtering as part of the subscription. 

Note: If no areas are listed, then all areas are selected by default. 

Note: It is recommended that you have an area in the alarm server to which you subscribe; this 
ensures that the relevant multimedia alarms are received. 

 
OPC Event Server Area/Source Browser 

You can also select global aliases to use in the Area field. Clicking the ... button and selecting 
Global Alias Browser from the pop-up menu opens the Global Alias Browser, as shown in the 
figure below. Select a global alias from the Global Alias Browser, which includes all global aliases 
in the global alias database. This eliminates the need to manually type in the alias name. All global 
aliases that are configured in the Global Alias Engine Configurator are conveniently available to 
choose from inside the browser. The tree control of the Global Alias Engine Configurator is 
mimicked in the tree control of the Global Alias Browser. Select a global alias by double-clicking 
the alias name (e.g. "Floor" in the figure below). The alias name appears at the top of the browser, 
which automatically adds the <# and #> delimiters to the alias name. Click the OK button. 

 
Selecting an Alias From the Global Alias Browser 
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Clicking the ... button and selecting Language Alias Browser from the pop-up menu opens the 
Language Alias Browser, as shown in the figure below. The browser includes all languages aliases 
in the language database. All language aliases that are configured in the Language Configurator 
are conveniently available to choose from inside the browser. The tree control of the Language 
Configurator is mimicked in the tree control of the Language Alias Browser. Select a language 
alias by double-clicking the alias name. The alias name appears at the top of the browser, which 
automatically adds the /+ and +/ delimiters to the alias name. Click the OK button. 

 
Selecting an Alias From the Language Alias Browser 

 

Sources 
The Sources tab of the Event Subscription dialog box, shown in the figure below, allows you to 
filter on a source or group of sources for a particular subscription. It is also possible to delete a 
source for a particular subscription. To delete a source, select it from the list of sources for this 
particular subscription and click the Delete button. Not all OPC Alarm and Event servers support 
source filtering as part of the subscription.  

Note: If no sources are listed, then all sources are selected by default. 

 
Event Subscription Dialog Box: Sources Tab 
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To select a source, click the Browse button and select one from the OPC Event Server Area / 
Source Browser, shown in the figure below. Source subscription provides the wildcard support 
found in the area subscription.  

 
OPC Event Server Area/Source Browser 

You can also select global aliases to use in the Area field. Clicking the ... button and selecting 
Global Alias Browser from the pop-up menu opens the Global Alias Browser, as shown in the 
figure below. Select a global alias from the Global Alias Browser, which includes all global aliases 
in the global alias database. This eliminates the need to manually type in the alias name. All global 
aliases that are configured in the Global Alias Engine Configurator are conveniently available to 
choose from inside the browser. The tree control of the Global Alias Engine Configurator is 
mimicked in the tree control of the Global Alias Browser. Select a global alias by double-clicking 
the alias name (e.g. "Floor" in the figure below). The alias name appears at the top of the browser, 
which automatically adds the <# and #> delimiters to the alias name. Click the OK button. 

 
Selecting an Alias From the Global Alias Browser 

Clicking the ... button and selecting Language Alias Browser from the pop-up menu opens the 
Language Alias Browser, as shown in the figure below. The browser includes all languages aliases 
in the language database. All language aliases that are configured in the Language Configurator 
are conveniently available to choose from inside the browser. The tree control of the Language 
Configurator is mimicked in the tree control of the Language Alias Browser. Select a language 
alias by double-clicking the alias name. The alias name appears at the top of the browser, which 
automatically adds the /+ and +/ delimiters to the alias name. Click the OK button. 
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Selecting an Alias From the Language Alias Browser 

Attributes 
The Attributes tab of the Event Subscription dialog box, shown in the figure below, allows you to 
add extra attributes to a particular event category within a subscription. Select the event category 
from the corresponding drop-down list. Choose the desired items from the available attributes list, 
and click the Add button. To remove an attribute from the subscribed list, select that particular 
attribute and click Remove.  

 
Event Subscription Dialog Box: Attributes Tab 

It is important to note that the order of the subscribed attributes does matter. The order of the 
attributes determines the order they will be selected from the server, and also determines with 
which viewer attribute column they are associated. To change the order of the attributes in the 
subscribed field, simply select an attribute and click the "up" and "down" arrow buttons. Server-
specific information will be displayed in the Attributes1-n columns. The attributes columns are 
added in the Column tab of the Smar AlarmWorX Viewer Properties dialog box. 

Note: To receive extra attributes, you must request them per event category. 
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Images Tab 
The Images tab of the AlarmWorX Indicator ActiveX Properties dialog box, shown below, 
allows you to choose which image to use for the Alarm Indicator ActiveX. For your convenience, 
the Alarm Indicator provides several default large and small images to use for the ActiveX. The 
small images are particularly well-suited for placement of the Indicator in an area of your display 
where space is limited, such as the Windows taskbar.  

Alternatively, you can select your own images to use for the Alarm Indicator by clicking the 
Browse button. This opens a dialog box that allows you to select .gif, .jpg, or .bmp image files. 

Note: Although you are free to use your own images for the Alarm Indicator, it is recommended 
that you use the default images provided because the default images contain predefined flashing 
regions. If you use your own images, you will have to manually specify the flashing regions for the 
images. 

 
Smar Alarm Indicator ActiveX Control Properties: Images Tab 

Runtime Functions 
When you have finished configuring the AlarmWorX Indicator ActiveX, you are ready to enter the 
Alarm Indicator into runtime mode. During runtime mode, the Alarm Indicator notifies you of alarms 
that are occurring in your ProcessView system by flashing and making sounds based on the color, 
sound, flashing, and severity parameters that you have set in your configuration.  

To enter the ActiveX display into runtime mode from the AlarmWorX or TrendWorX container 
applications, select Runtime Mode from the Actions menu. To enter the display into runtime 
mode from GraphWorX, click Runtime on the menu bar. 

ToolTips 
When you place the mouse pointer over the Alarm Indicator ActiveX during runtime mode, you can 
view the ToolTip that you specified in the General configuration tab. In the example below, the text 
"Control Room" appears in the ToolTip during runtime mode. 

 
Viewing the ToolTip in Runtime  
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Colors, Flashing and Sounds 
When an alarm is triggered during runtime mode, the Alarm Indicator ActiveX will flash repeatedly 
to visually indicate the alarm. The normal color (no alarm) and the replacement (flashing alarm) 
color have been specified the Settings configuration tab. In the example below, the Alarm 
Indicator is flashing red to indicate that an alarm is occurring. 

 
Alarm Occurring in Runtime 

When an alarm occurs during runtime, the Alarm Indicator flashes and/or sounds according to the 
parameters that have been set in the Ranges configuration tab, in which the colors, flash period, 
and sound period have been specified for the Alarm Indicator. The sound, color, and flashing of 
the Alarm Indicator during runtime vary depending on the severity range of each alarm. The 
severity ranges have been specified in the Severity Range Configuration dialog box.  

Each severity range has a different configuration, so the Alarm Indicator may look and sound 
different for each occurring alarm. For example, the following configuration might be used. For 
each alarm that occurs in the severity range 100-199, the Alarm Indicator will beep once every two 
seconds and flash blue once every two seconds. For each alarm that occurs in the severity range 
200-299, the Alarm Indicator will sound a horn one time per second and flash red one time per 
second. 

Note: Flashing and sound will occur for unacknowledged alarms in order of priority from the 
highest severity level to the lowest severity level. 

Launching an Application During Runtime 
You can launch an application from the Alarm Indicator ActiveX during runtime mode. The type of 
application, the application file, and the method for launching the application have already been 
specified in the Settings configuration tab. Launch the application using the method you selected 
in the configuration (single-click, double-click, or right-click context menu). For example, suppose 
you have configured the Alarm Indicator to launch a document when the Alarm Indicator is right-
clicked during runtime mode. In runtime mode, right-click the Indicator ActiveX, and then select 
Launch Doc from the pop-up menu, as shown below. 

 
Launching an Application During Runtime 
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Turning off the Sound During Runtime 
If you have configured the Alarm Indicator to make a sound when an alarm is indicated, you can 
turn off the sound during runtime mode using the sound suppression feature. The sound 
suppression period is specified in the Settings configuration tab. Turn off the sound using the 
method you selected in the configuration (single-click, double-click, or right-click context menu). 
For example, suppose you have configured the Alarm Indicator to suppress the sound when the 
Alarm Indicator is right-clicked during runtime mode. In runtime mode, right-click the Indicator 
ActiveX, and then select Suppress Sound from the pop-up menu, as shown below. The sound 
will be suppressed for the duration of the sound-suppression period specified in the configuration. 
When the sound-suppression period has elapsed, the Alarm Indicator will resume making the 
sound. 

 
Turning off the Sound During Runtime 

Global Sound Suppression 

If multiple instances of the Alarm Indicator ActiveX are running concurrently and each instance is 
configured to produce a sound indicating an alarm, you can use the global sound suppression 
function to monitor the sound status of all instances. For example, suppose you have two Alarm 
Indicators open (Alarm Indicator 1 and Alarm Indicator 2). If Alarm Indicator 1 sounds an alarm, 
and global sound suppression is enabled in the Settings configuration tab, the sound of Alarm 
Indicator 2 will be temporarily suppressed until Alarm Indicator 1 stops making a sound. 

Changing Properties During Runtime 
During runtime mode, you can quickly and easily access the Alarm Indicator ActiveX Properties 
configuration dialog box by right-clicking the Alarm Indicator and selecting Properties from the 
pop-up menu, as shown below. 

 
Accessing Configuration Properties During Runtime 

Automation Interfaces 
The AlarmWorX Indicator ActiveX provides a COM interface that allows external programs to 
manipulate the indicator as it is running. The interface is available to all programming languages 
that support COM including Visual Basic (VB), Visual Basic for Applications (VBA) and Microsoft 
Visual C++. 

To access the Automation interface from VB and VBA, AlarmWorX Indicator must be made 
available by choosing Project - References from the main menu in the VB or VBA development 
environment and selecting AwxInd 1.0 Type Library in the list of available references. 
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Available Control Properties 

Members of ‘AwxIndicator’: 
 
OLE_COLOR BackColor 

Description 
This is the “replacement” color of the Alarm Indicator. It is the color that you see behind the 
flashing color when there are alarms coming in.  Property is read/write. 

Remarks 
Please note, the replacement color can only be a valid color that already exists in the bitmap, 
otherwise you will not see any change. 
OLE_COLORs can be set in more than one way.  You can use a VB color constant such as 
vbWhite, an RGB color value, or a Long integer. 
Example 
This example shows how to read and write the background color. 
Dim backColor As Long 
backColor = AwxIndicator1.BackColor 
AwxIndicator1.BackColor = 16777215 
‘Or: 
AwxIndicator1.BackColor = vbWhite 
‘Or: 
AwxIndicator1.BackColor = RGB(255, 255, 255) 
‘(All examples make the background color white) 
 
boolean CanUserConfigure 

Description 
True if configuration is enabled for the currently logged in user. Property is read-only. 

Example 
This example shows how to determine if user configuration is enabled. 
MsgBox AwxIndicator1.CanUserConfigure 
 

boolean CanUserLaunchDoc 

Description 
True if launching a document is enabled for the currently logged in user.  Property is read-only. 

Example 
This example shows how to determine if launching a document is enabled. 
MsgBox AwxIndicator1.CanUserLaunchDoc 
 
boolean CanUserSuppressSound 

Description 
True if sound suppression is enabled for the currently logged in user.  Property is read-only. 

Example 
This example shows how to determine if sound suppression is enabled. 
MsgBox AwxIndicator1.CanUserSuppressSound 
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string Caption 

Description 
This is the text that appears when you hover over the Alarm Indicator with your mouse.  Property 
is read/write. 
Example 
This example shows how to read and write the caption. 
Dim caption As String 
caption = AwxIndicator1.Caption 
AwxIndicator1.Caption = “My Caption” 
 
boolean FileEnabled 

Description 
True if a configuration file is enabled.  Property is read/write. 
Example 
This example shows how to determine if a configuration file is enabled. 
Dim bEnabled As Boolean 
bEnabled = AwxIndicator1.FileEnabled 
This example shows how to turn on/off a configuration file. 
AwxIndicator1.FileEnabled = True 
 

string FileName 

Description 
This is the name of the configuration file.  Property is read/write. 
Remarks 
Use this property to load and save configuration files.  First set the property to the correct path and 
file name, and then call either FileLoad() or FileSave(). 

 
Example 
This example shows how to read and write the configuration file name. 
Dim fileName As String 
fileName = AwxIndicator1.FileName 
AwxIndicator1.FileName = “C:\My Directory\AwxIndCfg.awi” 
 
OLE_COLOR FillColor 

Description 
This is the “normal” color of the Alarm Indicator.  It is the color that flashes when there are no 
alarms coming in.  This can be any color.  Property is read/write. 
Remarks 
OLE_COLORs can be set in more than one way.  You can use a VB color constant such as 
vbWhite, an RGB color value, or a Long integer. 
Example 
This example shows how to read and write the fill color. 
Dim fillColor As Long 
fillColor = AwxIndicator1.FillColor 
AwxIndicator1.FillColor = 16777215 
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‘Or: 
AwxIndicator1.FillColor = vbWhite 
‘Or: 
AwxIndicator1.FillColor = RGB(255, 255, 255) 
‘(All make the fill color white) 
 
boolean GlobalSoundSuppression 

Description 
True if global sound suppression is enabled.  Property is read/write. 
Example 
This example shows how to determine if global sound suppression is enabled. 
Dim bEnabled As Boolean 
bEnabled = AwxIndicator1.GlobalSoundSuppression 
 

This example shows how to turn on/off global sound suppression. 
AwxIndicator1.GlobalSoundSuppression = True 
 

string LaunchDoc 

Description 
This is the file name of the Word document to be launched from the Alarm Indicator.  Property is 
read/write. 
Example 
This example shows how to read and write the launch document file name. 

Dim launchDoc As String 
launchDoc = AwxIndicator1.LaunchDoc 
AwxIndicator1.LaunchDoc = “C:\My Directory\MyWordDoc.doc” 
 
tagINVOKE_VIA LaunchDocVia 

Description 
This property corresponds to a constant that determines which method can be used to launch a 
document.  Property is read/write. 
Remarks 
The tagINVOKE_VIA constant values are: 
SingleClick = 1 
DoubleClick = 2 
ContextMenu = 3 

Example 
This example shows how to read and write the document launching method. 
Dim n As tagINVOKE_VIA 
n = AwxIndicator1.LaunchDocVia 
AwxIndicator1.LaunchDocVia = ContextMenu 
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IPictureDisp Picture 

Description 
This is the bitmap object that is displayed on the Alarm Indicator. 
Example 
This example shows how to grab the Picture object. 
Dim pic As IPictureDisp 
Set pic = AwxIndicator1.Picture 

 

object RangeCollection 

Description 
This object returns a RangeCollection, which is a collection of Range objects that determine the 
Alarm Indicator’s color depending on the severity of the alarm.  There is only one RangeCollection 
per Alarm Indicator instance; however, there can be many Range objects in each 
RangeCollection. 
Remarks 
The RangeCollection object has 3 properties and 2 methods: 
Clone As Object 
Count As Long 
Item As Object 
AddItem(NewItem As Object) 
DeleteItem(ToDelete As Object) 

Example 
This example shows how to grab the RangeCollection object. 
Dim rc As RangeCollection 
Set rc = AwxIndicator1.RangeCollection 
 
long SuppressSoundPeriod 

Description 
This specifies the number of seconds the sound will be suppressed when you invoke the 
“Suppress Sound” action.  Property is read/write. 
Example 
This example shows how to read and write the sound suppression period. 
Dim n As Long 
n = AwxIndicator1.SuppressSoundPeriod 
AwxIndicator1. SuppressSoundPeriod = n + 1 
 
tagINVOKE_VIA SuppressSoundVia 

Description 
This property corresponds to a constant that determines which method can be used to suppress a 
sound. 
Remarks 
The tagINVOKE_VIA constant values are: 
SingleClick = 1 
DoubleClick = 2 
ContextMenu = 3 

Example 
This example shows how to read and write the sound suppression method. 
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Dim n As tagINVOKE_VIA 

n = AwxIndicator1.SuppressSoundVia 
AwxIndicator1. SuppressSoundVia = SingleClick 
 
string URLPath 

Description 
This specifies the URL path of a configuration file.  Property is read/write. 
Example 
This example shows how to read and write the URL path. 
Dim path As String 
path = AwxIndicator1.URLPath 
AwxIndicator1.URLPath = “http://www.smar.com/awxindcfg.awi” 

 

Members of ‘Range’: 
object Clone 

Description 
This is a copy of the Range object.  Property is read-only. 

Example 
This example shows how to grab a copy of the Range object. 
Dim range As Range 
range = AwxIndicator1.RangeCollection.Item(0).Clone 

 

long Color 

Description 
This is the color that will flash when alarms within this particular severity range are 
coming in.  Property is read/write. 
Remarks 
This property accepts all valid OLE_COLORs. 
Example 
This example shows how to read and write the range color. 
Dim color As Long 
color = AwxIndicator1.RangeCollection.Item(0).Color 
AwxIndicator1.RangeCollection.Item(0).Color = 16777215 
‘Or: 
AwxIndicator1.RangeCollection.Item(0).Color = vbWhite 
‘Or: 
AwxIndicator1.RangeCollection.Item(0).Color = RGB(255, 255, 255) 
‘(All make the range’s color white) 
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long FlashPeriod 

Description 
This is the duration (in milliseconds) of each flash for that particular severity range. Property is 
read/write. 
Example 
This example shows how to read and write the flash period. 
Dim n As Long 
n = AwxIndicator1.RangeCollection.Item(0).FlashPeriod 
AwxIndicator1.RangeCollection.Item(0).FlashPeriod = 200 
 
boolean IsWav 

Description 
Returns true if the current Range object has a valid file associated with it.  Returns false if it cannot 
locate the file on the system. 
Example 
This example shows how to read the IsWav property. 
Dim bEnabled As Boolean 
bEnabled = AwxIndicator1.RangeCollection.Item(0).IsWav 

 

long PlayPeriod 

Description 
This specifies the number of milliseconds between each time the .wav file is played. Property is 
read/write. 

Remarks 
If the .wav file that you are using is longer than the play period, the sound will not cut off; it will 
immediately restart once the .wav file is done playing. 
Example 
This example shows how to read and write the play period. 
Dim n As Long 
n = AwxIndicator1.RangeCollection.Item(0).PlayPeriod 
AwxIndicator1.RangeCollection.Item(0).PlayPeriod = 10000 

 

long Severity 

Description 
This is the severity level of the current range object. Property is read/write. 
Remarks 
If you change the severity level of a range to be lower than the severity level of any ranges below 
it, it will delete those ranges and your current range will encompass the entire severity level of the 
previous ranges combined.  It will never create a brand new severity level. 
Example 
This example shows how to read and write the severity level. 

Dim n As Long 
n = AwxIndicator1.RangeCollection.Item(0).Severity 
AwxIndicator1.RangeCollection.Item(0).Severity = 500 
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string WavFileName 

Description 
This is a property that you set before loading or playing a .wav file for a particular range. Property 
is read/write. 
Remarks 
Use this property to load and play .wav files.  First set the property to the correct path and file 
name, and then call either LoadWavFile() or PlayWav(). 

Example 
This example shows how to read and write the .wav file name. 
Dim wavFile As String 
wavFile = AwxIndicator1.RangeCollection.Item(0).WavFileName 
AwxIndicator1.RangeCollection.Item(0).WavFileName = “C:\wav_file.wav” 

 

Members of ‘RangeCollection’: 
 
object Clone 

Description 
This is a copy of the RangeCollection object.  Property is read-only. 
Example 
This example shows how to grab a copy of the RangeCollection object. 
Dim rc As RangeCollection 
rc = AwxIndicator1.RangeCollection.Clone 
 
long Count 

Description 
This is the number of Range objects in the RangeCollection.  (Read-only). 

Example 
This example shows how to read the count. 
Dim n As Long 
n = AwxIndicator1.RangeCollection.Count 
 
object Item 

Description 
This corresponds to each Range object within the RangeCollection.  Item is an array of objects.  
Property is read-only. 
Remarks 
The Item array corresponds to the Range objects in reverse order (or by decreasing severity).  The 
first array index is 0 and it goes up to the RangeCollection Count – 1. 

Example 
This example shows how to grab a Range object from the RangeCollection Item array. 
Dim r As Range 
Set r = AwxIndicator1.RangeCollection.Item(0) 
‘This grabs the Range object of highest severity 
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Available Control Methods 
Members of ‘AwxIndicator’: 

 
void DoContextMenu() 

Description 
Launches the context menu so that a user can then click on an option. 
Example 
This example shows how to launch the context menu. 
AwxIndicator1.DoContextMenu 
 

void DoLaunchDoc() 

Description 
Launches the document specified in the LaunchDoc property. 
Example 
This example shows how to perform the LaunchDoc action. 
AwxIndicator1.DoLaunchDoc 

 

void DoLeftMouseButton() 

Description 
Simulates a left mouse button click, thus performing whichever action (if any) is associated with 
the left mouse button. 

Example 
This example shows how to simulate a left mouse button click. 
AwxIndicator1.DoLeftMouseButton 
 
void DoLeftMouseDoubleClick() 

Description 
Simulates a left mouse button double-click, thus performing whichever action (if any) is associated 
with double-clicking the left mouse button. 

Example 
This example shows how to simulate a left mouse button double-click. 
AwxIndicator1.DoLeftMouseDoubleClick 

 

void DoSuppressSound() 

Description 
Performs the sound suppression action.  This will silence the Alarm Indicator for the number of 
seconds specified in the SoundSuppressionPeriod property. 

Example 
This example shows how to suppress the sound. 
AwxIndicator1.DoSuppressSound 
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void FileLoad() 

Description 
Loads the configuration file that is currently in the FileName property. 
Remarks 
You must set the FileName property and make sure that FileEnabled is set to “True” before calling 
this method or it will have no effect. 
Example 
This example shows how to load a configuration file. 
AwxIndicator1.FileName = “C:\My Directory\AwxIndCfg.awi” 
AwxIndicator1.FileEnabled = True 
AwxIndicator1.FileLoad 
‘Loads the file AwxIndCfg.awi 

 

void FileSave() 

Description 
Saves the configuration file that is currently in the FileName property. 
Remarks 
You must set the FileName property and make sure that FileEnabled is set to “True” before calling 
this method or it will have no effect. 
Example 
This example shows how to save a configuration file. 
AwxIndicator1.FileName = “C:\My Directory\AwxIndCfg1.awi” 
AwxIndicator1.FileEnabled = True 
AwxIndicator1.FileSave 
‘Saves the current configuration out to the file AwxIndCfg1.awi 

 

void ForceConfigMode(Force As Boolean) 

Description 
Allows the Alarm Indicator to exit runtime and enter configuration mode while the container 
remains in runtime mode. 
Example 
This example shows how to force configuration mode. 
AwxIndicator1.ForceConfigMode(True) 

 

long GetAlarmOleBlob() 
void SetAlarmOleBlob(pBlob As Long) 

Description 
These above two methods are part of AlarmOLE.   
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long ReplaceFilePath(OldSubstring As String, NewSubstring As String) 

Description 
Works over path name parameters of pick dynamics. Returns 0 on success and HRESULT when 
something fails. 
Example 
'similar to ReplaceTag 

'VBA example, works only in configure mode 

'replaces file path in whole display 

 

Dim Status As Long 

Status = ThisDisplay.ReplaceFilePath("C:\Windows\Temp", "D:\Temp") 

'if Status <> 0 then there was no replacement performed or an 
error occurs 

If Status <> 0 Then 

 MsgBox "No replacements" 

Else 

 MsgBox "Tags replaced" 

End If 

 
long ReplaceHost(OldHostName As String, NewHostName As String) 

Description 
Works over both data source tags and path name attributes and replaces node name substring 
within URL path only. Returns 0 on success and HRESULT when something fails. 
Example 
'similar to ReplaceTag 

'VBA example, works only in configure mode 

'replaces host name in whole display 

 

Dim Status As Long 

Status = ThisDisplay.ReplaceHost("Host1", "Host2") 

'if Status <> 0 then there was no replacement performed or an 
error occurs 

If Status <> 0 Then 

 MsgBox "No replacements" 

Else 

 MsgBox "Tags replaced" 

End If 

 



AlarmWorX 
 

 2.43

long ReplaceHost(OldHostNameSubstring As String, NewHostNameSubstring As String, 
MatchCase As Long, MatchWholeWord As Long) 

Description 
Works over both data source tags and path name attributes and replaces node name substring 
within URL path only, and supports case-sensitivity, wildcard strings and MatchWholeWord flag. 
Returns 0 on success and HRESULT when something fails. 

Example 
'similar to ReplaceTag 

'VBA example, works only in configure mode 

'replaces host name in whole display, regarding "case" and "whole 
words" options 
 

Dim Status As Long 

Status = ThisDisplay.ReplaceHostEx("Host1", "Host2", True, True) 

'if Status <> 0 then there was no replacement performed or an 
error occurs 

If Status <> 0 Then 

 MsgBox "No replacements" 

Else 

 MsgBox "Tags replaced" 

End If 

 
string ReplaceStringInString(StringToReplace As String, OldSubstring As String, 
NewSubstring As String) 

Description 
Replaces OldSubstring with NewSubstring inside (within) StringToReplace. Returns 0 on 
success and HRESULT when something fails. 
 
long ReplaceTag(OldSubstring As String, NewSubstring As String) 

Description 
Works over data source tags in dynamic actions of all display objects. Replaces OldSubstring 
with NewSubstring in certain situations. Returns 0 on success and HRESULT when something 
fails. 
Typical use of this method: 

Example 
'VBA example, works only in configure mode 

'replaces tag name in whole display 
 

Dim Status As Long 

Status = ThisDisplay.ReplaceTag("gfwsim.ramp.float", 
"gfwsim.sine.double") 

'if Status <> 0 then there was no replacement  

'performed or an error occurs 

If Status <> 0 Then 

 MsgBox "No replacements" 

Else 

 MsgBox "Tags replaced" 

End If 
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Members of ‘Range’: 
void LoadWavFile() 

Description 
Sets the .wav file to be played when that specific range is in alarm condition.  Uses the .wav file 
that is currently residing in the WavFileName property. 

Remarks 
You must set the WavFileName property before calling this method or it may return an error. 

Example 
This example shows how to load a .wav file. 
AwxIndicator1.RangeCollection.Item(0).WavFileName = “C:\My Directory\MyWav.wav” 
AwxIndicator1.LoadWavFile 
‘Loads the file MyWav.wav 
 

void PlayWav() 

Description 
Plays the .wav file that is currently residing in the WavFileName property. 
Remarks 
You must set the WavFileName property before calling this method or it may return an error. 

Example 
This example shows how to play a .wav file. 
AwxIndicator1.RangeCollection.Item(0).WavFileName = “C:\My Directory\MyWav.wav” 
AwxIndicator1.PlayWav 
‘Plays the file MyWav.wav 
 

Members of ‘RangeCollection’: 
void AddItem(NewItem As Object) 

Description 
Adds a new item into the RangeCollection of the Alarm Indicator. 
Remarks 
The easiest way to do this is to clone an already existing Range object and then modify its 
properties to fit your new Range needs. 
Example 
This example shows how to clone an existing Range object and add a modified version of it to the 
RangeCollection. 

Dim newRange As Range 
Set newRange = AwxIndicator1.RangeCollection.Item(0).Clone 
newRange.Color = vbBlue 
newRange.FlashPeriod = 300 
newRange.PlayPeriod = 6000 
newRange.Severity = 500 
AwxIndicator1.RangeCollection.AddItem(newRange) 
 
void DeleteItem(ToDelete As Object) 



Chapter 3 

 

3.1 

Logger Configurator 
Introduction 

The AlarmWorX Logger provides a permanent copy of alarm and event notifications produced by 
any OPC Alarm and Events server, including the AlarmWorX Server. The alarm and event data may 
be stored in an OLE-DB or ODBC database and/or sent to a printer. The logger has been tested 
with the Microsoft Access (Jet) database and with Microsoft SQL Server. 
The Logger Application (AWXLog.exe) that provides the runtime storage and printing has no user 
interface and may optionally be run as a service on Windows NT. The logger typically reads its 
configuration information from a Microsoft Access database file. 
The Alarm Logger Configurator (AWXLogCfg.exe) is used to make changes to the Microsoft Access 
Database file that the Logger uses for configuration information. 

Installation 
The following are the major files that comprise the Logger component of AlarmWorX: 

AWXLog.exe Logger application/service. 
AWXLogCfg.exe Logger Configurator. 
AWXLog.mdb Logger sample configuration database 
 

The files are installed in the Bin directory chosen during the install. Program icons are installed for 
the Configurator in the AlarmWorX program group. 
By default the Logger (AwxLog.exe) is registered as a normal application, but can be registered to 
run as a service under Windows NT. Running as a Service has the following advantages: 
• The Logger can be set to start as soon as the machine is powered (before a user has logged on). 

• The Logger will remain running even if a user Logs off of NT. 
To register the Logger as a Windows NT Service: 
1. Run the ProcessView Tray utility from the Windows Start menu by selecting Programs > 
Smar ProcessView- > Tools > ProcessView Tray. 
2. This opens ProcessView Tray and puts the ProcessView Tray icon in the taskbar system tray. 
Click the ProcessView Tray icon in the system tray and select AlarmWorX > Logger > NT 
Service, as shown in the figure below. To have the service start automatically upon system startup, 
click the ProcessView Tray icon in the system tray and select AlarmWorX > Logger > Auto Start. 

 
Running AlarmWorX Logger From ProcessView Tray 

The ProcessView Tray utility can also be used to manually start and stop the logger. 
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Note: The Alarm Logger does not use standard COM rules for activation/deactivation. If the server 
is started for any reason (via ProcessView Tray or by activation by an OPC Alarm Client), it will 
remain running until both of the following conditions are met: 
• The ProcessView Tray utility has issued the Stop command to the Server. 
• All OPC alarm clients have disconnected from the server. 
Since NT Services are not supported in Windows 95 and Windows 98, ProcessView Tray can be 
used to facilitate the starting of the Alarm Logger on startup: 
3. Place a shortcut to the ProcessView Tray utility in the startup group so ProcessView Tray will 
start automatically when Windows 95 or Windows 98 boots up. 
4. To have the Alarm Logger start automatically when ProcessView Tray starts, click the 
ProcessView Tray icon in the system tray and select AlarmWorX > Logger > Auto Start. 

 

Starting the Alarm Logger Configuration 
The AlarmWorX Logger Configurator writes configuration information to a configuration database. 
This configuration information is read by the AlarmWorX Logger during runtime to determine what 
alarms and events to log and where to log them. A single database can contain multiple named 
configurations to be run by one or more nodes on a network. A single node can also run multiple 
configurations simultaneously. 
To launch the AlarmWorX Logger Configurator from the Windows Start menu: 
1. Select Programs > Smar ProcessView- > AlarmWorX > Alarm Logger Configurator. 
2. The AwxLog.mdb Microsoft Access database file opens in the Alarm Logger Configurator, as 
shown in the figure below. The screen consists of a split window with a tree control view in the left-
hand pane and a configuration view in the right-hand pane. The Configurator provides a standard 
format for the configuration database, as well as a sample (default) configuration project. The 
Configurator also includes a toolbar and menus with many command functions. 

 
Alarm Logger Configurator Screen 
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3. To open a different database file, select Open from the File menu. This opens the Open dialog 
box, shown below, which enables you to browse for configuration files. 

 
Selecting a Configuration Database 

Creating Configuration Databases 
The Configurator provides a Configuration Database Wizard for creating new Microsoft Access and 
SQL Server configuration databases. To create a new configuration database in the Configurator: 

1. Select New from the File menu, as shown in the figure below.  

 
Creating a Configuration Database 

2. The introduction screen for the Configuration Database Wizard appears. Click the 
Next button to continue. 

3. You have two options for creating your new database, as shown in the figure below: 

• Create a new Microsoft Access configuration database: For a Microsoft Access 
database, the Configurator uses a single .mdb file 
• Create a Microsoft SQL Server database: The Configurator uses Universal Data 
Link (.udl) files to connect to a Microsoft SQL Server or MSDE database. 
 
Select the database type you want to create, and then click Next.  
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Choosing the Type of Database To Create 

Creating a Microsoft Access Configuration Database 
To create a new Microsoft Access configuration database in the Configurator: 

1. Select New from the File menu, as shown in the figure below.  

 
Creating a Configuration Database 

2. The introduction screen for the Configuration Database Wizard appears. Click the Next button 
to continue. 

3. You have two options for creating your new database, as shown in the figure below. Select 
Create new configuration in MS Access database. Click the Next button to continue.  
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Creating a New Microsoft Access Database  

4. Specify the directory path and file name for the new database, as shown in the figure below. 
Click the ... button to browse for a directory. If you want this new database to be the active 
configuration database, check Make Database Active. 

 
Naming the New Access Database 

5. Click the Finish button. The new database is created and opened in the Configurator.  
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Creating a Microsoft SQL Server Configuration Database 
To create a new Microsoft SQL Server configuration database in the Configurator: 

1. Select New from the File menu, as shown in the figure below.  

 
Creating a Configuration Database 

2. The introduction screen for the Configuration Database Wizard appears. Click the Next button 
to continue. 

3. You have two options for creating your new database, as shown in the figure below. Select 
Create new configuration in MS SQL Server database. Click the Next button to continue.  

 
Creating a New Microsoft SQL Server Database 

4. To connect to a SQL Server database, either select an existing database from the Database 
Name drop-down list, or a type a new name to create a new database, as shown in the figure below.  
If you choose to use an existing database, you have the option of adding (auto-appending) the 
configuration to the existing database. (For more information about the auto-append function, please 
see "Adding the Configuration to an Existing Database.")  

In the SQL Server Name field, select the local SQL Server on which to create the database. If 
necessary, enter a user name and password to log on to the SQL Server. (It is recommended that 
you use Windows NT integrated security.) 
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Note: Usually you have only one instance of SQL Server running on the local node. In this case, the 
drop-down list under SQL Server Name has only one option: "(local)." However, it is possible to run 
multiple SQL Server instances on the local node, in which case the SQL Server field lists all those 
SQL Server instances: "(local)" for the default instance and "node_name/instance_name" for all 
others. The drop-down list may show SQL Server instances on other nodes as well. 

 
Connecting to a SQL Server Database 

5. Specify a directory path location in which to create the database, as shown in the figure below. 
You can either use the default SQL Server database folder, or you can click the ... button and 
browse for a specific folder. 

 
Specifying the Database Location and Properties 
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Under the Database Properties section, specify an initial size for the database, which should be as 
large as possible. You can also specify a Database Growth option (in megabytes) or as a 
percentage of the total size. MSDE servers are capable of growing the database on the fly to store 
more data. However, if this operation is performed frequently, the overall system performance may 
decrease. Choosing an initially large database size and a corresponding database growth option 
can drastically improve system performance. 

Under the Log File Properties section, you can also modify the settings for the database 
transaction log file. Specify a Log File Growth option (in megabytes) or as a percentage of the total 
size. Again, a sufficient initial size setting can greatly improve performance. The default options 
should be adequate for most applications with a small to medium size load.  

Click the Next button to create the new SQL Server database. 

6. The Configurator uses Universal Data Link (.udl) files to connect to the Microsoft SQL Server 
database. These .udl files contain OLE database connection information that allows the Configurator 
to create and manage connections to OLE databases. Enter a name and directory path for the new 
.udl file in the Data Link File Name field, as shown in the figure below. You can browse for a 
directory by clicking the … button to the right of this field. Click the Next button to continue. If you 
want this new database to be the active configuration database, check Make Database Active. 

 
Creating a Universal Data Link File 

7. Click the Finish button. The new database is created and opened in the Configurator.  
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Adding a Configuration Database to an Existing SQL Server Database 
The Configuration Database Wizard also gives you the option to add the configuration database 
structure to an existing Microsoft SQL Server database: 

1. Select New from the File menu, as shown in the figure below.  

 
Creating a Configuration Database 

2. The introduction screen for the Configuration Database Wizard appears. Click the Next button 
to continue. 

3. You have two options for creating your new database, as shown in the figure below. Select 
Create new configuration in MS SQL Server database. Click the Next button to continue.  

 
Creating a Microsoft SQL Server Database 

4. To connect to a SQL Server database, select the existing database from the drop-down list, as 
shown in the figure below. Check the Auto-append configuration into existing database check 
box. In the SQL Server field, select the local SQL Server on which to create the database. Type a 
name for the database in the Database Name field. If necessary, enter a user name and password 
to log on to the SQL Server. (Note: It is recommended that you use Windows NT integrated 
security.) Click the Next button to continue. 
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Note: Usually you have only one instance of SQL Server running on the local node. In this case, the 
drop-down list under SQL Server Name has only one option: "(local)." However, it is possible to run 
multiple SQL Server instances on the local node, in which case the SQL Server field lists all those 
SQL Server instances: "(local)" for the default instance and "node_name/instance_name" for all 
others. The drop-down list may show SQL Server instances on other nodes as well. 

 
Connecting to an Existing SQL Server Database 

5. If the existing database already has configuration tables, you have the following options, as 
shown in the figure below: 

• Select a different database name (recommended): This option allows you to rename the 
database without affecting the existing database as well as create a new Data Link (.udl) file.  
• Use the existing database structure:  This option preserves the content of the existing 
database and allows you to create a new Universal Data Link (.udl) file. 
• Override all existing configuration tables: This option expunges the content of the existing 
database and allows you to create a new Universal Data Link (.udl) file. 
 
Note: Overriding the database may disable other applications that also use the database. 
 
Click the Next button to continue. 
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Adding the Configuration to an Existing SQL Server Database 

6. If you chose Select a different database name (recommended), you are directed back to the 
SQL Server Database Connection dialog box, as shown in the figure below. Enter a new name for 
the database, and then click Next. 

 
Renaming the Existing SQL Server Database 

7. Specify a directory path location in which to create the database, as shown in the figure below. 
You can either use the default SQL Server database folder, or you can click the ... button and 
browse for a specific folder. 
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Specifying the Database Location and Properties 

Under the Database Properties section, specify an initial size for the database, which should be as 
large as possible. You can also specify a Database Growth option (in megabytes) or as a 
percentage of the total size. MSDE servers are capable of growing the database on the fly to store 
more data. However, if this operation is performed frequently, the overall system performance may 
decrease. Choosing an initially large database size and a corresponding database growth option 
can drastically improve system performance.  

Under the Log File Properties section, you can also modify the settings for the database 
transaction log file. Specify a Log File Growth option (in megabytes) or as a percentage of the total 
size. Again, a sufficient initial size setting can greatly improve performance. The default options 
should be adequate for most applications with a small to medium size load.  

Click the Next button to create the new SQL Server database. 

8. The Configurator uses Universal Data Link (.udl) files to connect to the Microsoft SQL Server 
database. These .udl files contain OLE database connection information that allows the Configurator 
to create and manage connections to OLE databases. Enter a name and directory path for the new 
.udl file in the Data Link File Name field, as shown in the figure below. You can browse for a 
directory by clicking the … button to the right of this field. Click the Next button to continue. If you 
want this new database to be the active configuration database, check Make Database Active 

Note: If you chose to Use the existing database structure or to Override all existing 
configuration tables, you will still need to create a new Data Link file.   
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Creating a Universal Data Link File 

9. Click the Finish button. The new database is created and opened in the Configurator.  

Toolbars 
The Alarm Logger Configurator contains two toolbars: a Standard toolbar and a Data Manipulation 
toolbar.  

Standard Toolbar 
To show or hide the Standard toolbar, select Toolbars > Standard Buttons from the View menu. 
The Standard toolbar, shown below, contains the following command buttons. 
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New: Creates a new configuration database. 

Open: Opens an existing configuration database. 

Export Data: Exports configuration data to a text file (.txt) or a Microsoft Excel file (.csv).  

Import Data: Imports configuration data from a text file (.txt) or a Microsoft Excel file (.csv). 

Back: Moves the cursor back to the previously selected item in the tree control. 

Next: Moves the cursor to the next item in the tree control. 

Up One Level: Moves up one level in the tree control. 

Cut: Deletes current selection, sending it to the clipboard. 

Copy: Copies the current selection to the clipboard. 

Paste: Pastes the current contents of the clipboard. 

Large Icons: Displays items as large icons. 

Small Icons: Displays items as small icons. 
 

List: Displays items as a list. 

Details: Displays items as a list with details. 

Dialog View: Displays additional configuration options. 

Global Refresh: Refreshes the data for the entire Configurator screen. 

Start/Stop Logger: Toggle runtime mode for the Alarm Logger. 

About: Displays information about the application. 
 

Help: Displays context-sensitive help. 

Help Topics: Launches online Help for the application. 

 

Data Manipulation Toolbar 
To show or hide the Data Manipulation toolbar, select Toolbars > Data Manipulation Buttons 
from the View menu. The Data Manipulation toolbar, shown below, contains the following 
command buttons. 
 

New Configuration: Creates a new Logger configuration under the Configurations tree. 

New Column Definition: Creates a Column Definition for a Logger configuration. 

New Node: Creates a new node under the Nodes tree control. 

New Link to Configuration: Creates a new link to a Logger configuration. 
 

Multiply: Creates a copy of the selected item in the tree control. 
 

Delete: Deletes the selected item in the tree control. 
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Menus 
The menu bar of the Alarm Logger Configurator contains the following menus: 
File  
Edit  
View  
Go  
Action 
Tools  
Help  
Note: You can also access many of the menu commands by right-clicking items in the tree control of 
the Configurator and selecting command functions from the pop-up menus. 

File Menu 

∼ The File menu of the AlarmWorX Logger Configurator contains the following commands: 

Command Shortcut Key Function 
New CTRL+N Creates a new configuration database. 

Open CTRL+O Opens a new .mdb (Microsoft Data Access) or .udl (Microsoft Data Link) fi le. 

Save As  Saves the database under a different name.  

Connection Properties  Opens the Database Connection Properties dialog box. 

CSV Export  Exports data from a selected .csv fi le. 

CSV Import   Imports data from a selected .csv file. 

XML Export  Exports configuration data to an XML file. 

XML Export Schema  Exports configuration data to an XML Schema file. 

XML Import  Imports configuration data from an XML file. 

XML Validate  
This feature does not import an XML data file, but it will try to validate its 
structure using stored XML schema. Once it passes this validation, the XML 
file is acceptable for import by the Configurator. 

Make Active  Activates the current configuration database for use by the alarm server.  

Exit  Closes the applications and stops data logging if it started within the 
Configurator. 

 

Database Connection Properties 
Selecting Connection Properties from the File menu opens the Database Connection Properties 
dialog box, shown below, which lists the initialization properties for the current database connection. 
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Database Connection Properties Dialog Box 

Exporting Configuration Data 
Exporting Data to a Text or CSV File 
The Configurator offers the flexibility of exporting data from your configuration database to a text 
(.txt) file or a Microsoft Excel (.csv) file. To export data, select Export from the File menu. This 
opens the Export Configuration Data to File dialog box, as shown in the figure below. You can 
then specify the delimiters for exporting the data. Unless you specify delimiters in the Export 
Configuration Data to File dialog box, the file uses Commas as delimiters by default. Each group 
contains headings and columns that provide information about each item, such as descriptions and 
associated translations and expressions. It also provides the "tree" pathway for each item. Choose 
the directory to which you want to export the data from your database. In the Save As Type field, 
choose the file type (.txt or .csv) that you would like to save.  
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Exporting Configuration Data  

 
Exporting Data to an XML File 
The Configurator also allows you to export data from your configuration database to an XML file. 
The XML export/import functionality was mainly developed for Windows platforms that do not 
support databases (e.g. Windows CE and Windows Embedded). XML has the following advantages 
over the CSV import/export function:  
• XML has a standardized format, unlike the text/CSV format, which uses various delimiters (e.g. 
TAB instead of commas, strings could not accept all characters, etc.) 
• XML is language-independent, whereas CSV converts date/time, floats, and currency fields 
according to local settings in Windows. For example, using CSV, you cannot export data on German 
Windows and import it on English windows without making changes 
• Windows has an installed automation object that has the capability to work with XML. Thus, 
programmers can create/modify their configurations outside the Configurator using Visual Basic, if 
desired. 
• XML supports schemas. A schema is a special XML file that specifies the data structure of an 
XML data file. 
To export data, select XML Export from the File menu. This opens the Export XML File dialog box, 
as shown in the figure below. Give the file a name, and then choose the directory to which you want 
to export the data from your database. Click Save. 
Note: You can also export configuration data to an XML Scheme file by selecting XML Export from 
the File menu. 
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Exporting Configuration Data to an XML File 

Importing Configuration Data 
Importing Data From a Text or CSV File 
The Configurator offers the flexibility of importing data from a text (.txt) file or a Microsoft Excel (.csv) 
file to your configuration database. To import data, select Import CSV from the File menu. This 
opens the Import Configuration Data From File dialog box, shown below. You can then specify 
the delimiters and choose from the following import settings:  
• Create new items. When the import file contains items that are not yet in the configuration 
database, then it creates them. Otherwise it skips these items. 
• Update existing items. When the import file contains items that are in the configuration 
database, then it updates them using data from the import file. Otherwise it skips these items. 
 
Note: Either Create new items or Update existing items must be selected. Otherwise there is 
nothing to import. 
• Display errors. When this item is checked, the Configurator shows a dialog box if an error 
occurs, and then asks you if you want to proceed with the import. When it is not checked, it skips all 
items where an error occurred.  
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Importing Configuration Data  

When you have selected a file to import, click Open. When the import is completed, the File Import 
Results dialog box opens, as shown below. This shows the import settings, including the input file 
name. It also provides a summary of the import, including how many items were inserted, updated, 
or rejected, and shows how many errors occurred.  
Click the ... button to the right of each field to get the details view of the import results, as shown 
below. This view shows the specific items that were inserted, updated, or rejected, as well as a 
description of any errors that occurred. 

 
File Import Results Dialog Box 
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Importing Data From an XML File 
The Configurator allows you to import data from your configuration database to an XML file. The 
XML export/import functionality was mainly developed for Windows platforms that do not support 
databases (e.g. Windows CE and Windows Embedded). XML has the following advantages over the 
CSV import/export function:  
• XML has a standardized format, unlike the text/CSV format, which uses various delimiters (e.g. 
TAB instead of commas, strings could not accept all characters, etc.) 
• XML is language-independent, whereas CSV converts date/time, floats, and currency fields 
according to local settings in Windows. For example, using CSV, you cannot export data on German 
Windows and import it on English windows without making changes 
• Windows has an installed automation object that has the capability to work with XML. Thus, 
programmers can create/modify their configurations outside the Configurator using Visual Basic, if 
desired. 
• XML supports schemas. A schema is a special XML file that specifies the data structure of an 
XML data file. 
To import data, select XML Import from the File menu. This opens the Import XML File dialog box, 
as shown in the figure below. Give the file a name, and then choose the directory from which you 
want to import the data. You can then specify the delimiters and choose from the following import 
settings. Click Open. 
• Create new items. When the import file contains items that are not yet in the configuration 
database, then it creates them. Otherwise it skips these items. 
• Update existing items. When the import file contains items that are in the configuration 
database, then it updates them using data from the import file. Otherwise it skips these items. 
 
Note: Either Create new items or Update existing items must be selected. Otherwise there is 
nothing to import. 
Note: Selecting XML Validate from the File menu does not import an XML data file, but it will try to 
validate its structure using stored XML schema. Once it passes this validation, the XML file is 
acceptable for import by the Configurator. 

 
Importing Configuration Data From an XML File 
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Activating the Database 
Once your configuration is complete, you need to make sure that it is the active database. The 
database that is currently active is the one that the alarm server will use. To make the current 
database active, select Make Active from the File menu. If the Make Active selection is grayed out, 
then the current database is already the active database. 
A dialog box appears, as shown in the figure below, showing both the current active database and 
database that is currently being edited, as shown in the figure below. To set the edited database as 
the active database, click the Yes button. 

 
Activating the Database 

Edit Menu 
The Edit menu commands are listed in the table below. 

 
Edit Menu Commands  

Command Shortcut Keys Function 
New   Creates a new item depending on what is selected in the tree control.  

Rename CTRL+R Renames the selected item. 

Multiply CTRL+M Opens the Multiply Item dialog box (see below), which allows you to 
multiply an item in the tree control.  

Delete CTRL+DEL Deletes the selected object. 

Cut CTRL+X Cuts the selected object from the view and places it on the clipboard. 

Copy CTRL+C Copies the selected object to the clipboard. 

Paste CTRL+V Pastes the last object placed on the clipboard. 

Select All CTRL+A Selects all objects in a list. The selection is shown in the upper-right-
hand section of the viewer. 

Invert Selection  Unselects all selected items and selects all unselected items in a list in 
the upper-right-hand section of the viewer.  

 

Multiplying Items 
The Alarm Logger Configurator allows you to multiply items in the tree control. Multiplication 
provides a simple way of developing configurations where there are many similar items in a given 
category. To multiply an item: 

1. Select the item in the tree control that you wish to multiply.   

2. Either right-click the item and select Multiply from the pop-up menu, or select Multiply from the 
Edit menu. This opens the Multiply Item dialog box, shown below. 
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Multiply Item Dialog Box 

3. When the items are multiplied, they are all given a base name followed by a number. The 
default base text is the name of the item selected for multiplication. To modify the base text, change 
the Base Text field appropriately. 

4. In the First Number field, specify the number to appear next to the first multiplied item. 

5. In the Number of Items field, specify how many items you wish to create. 

6. In the Numeric Places field, specify the minimum length of each number to append. Values that 
take up less space than the specified amount of numeric places will have zeros before the 
number. 

7. If you want to multiply all subfolders as well, check the Including Subtree check box. 

8. Click the OK button to do the multiplication. The example configuration shown in the Multiply 
Item dialog box above creates three new OPC Data folders with the following names: 

• Core Temp001 

• Core Temp002 

• Core Temp003 
All subfolders will also be multiplied. 

View Menu 
The View menu commands are listed in the table below. 

 
View Menu Commands 

Command Shortcut Keys Function 
Toolbars  Toggles the standard and data manipulation toolbars.  

Status Bar  Toggles the status bar. 

Large Icons F7 Displays items as large icons. 

Small Icons F8  Displays items as small icons. 

List F9 Displays items as a list. 

Details F10 Displays items as a list along with detailed information about the configuration 
of each item. 

Dialog View F11 Toggles the configuration window (right-hand pane). 

Sort By  Displays a list of options for sorting the columns in the right-hand pane of the 
screen. The options listed depend on the level within the view.  

Show/Hide Columns  Displays a list of options that you can choose to show or hide in the view.  

Select Language  
Opens the Select Language dialog box (see below). Choose the language 
you wish to use for your system (Unicode version only) and click OK. For 
navigation purposes, use the buttons and check boxes in the List section.  

Global Refresh F5 Refreshes the data for the entire Configurator screen. 

Subtree Refresh CTRL+F5 Refreshes only the data contained in the currently selected subtree.  
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Selecting Languages 
The Select Language function on the View menu allows you to choose which language to use in 
your display. Choosing Select Language from the View menu opens the Select Language dialog 
box, shown in the figure below. 
Note: A language resource .dll is required for language switching. 

 
Select Language Dialog Box 

Define the parameters listed in the table below. Then click OK to return to the work area. 
 

Select Language Parameters 
Parameter Description 

List 

Lists available languages.  Depending on which item you have selected, the view 
on the left will change.  If English is checked, the languages will appear as their 
English name. If Localized is checked, the languages will appear with the native 
country in parentheses (for languages with several dialects only). When Native is 
checked, the languages are displayed the way they would be written in that 
language. 

Installed Locales Only If this is checked, local languages appear in the box. 

Available Language 
Translations Only Checking this box allows you to choose from available language translations only. 

Go Menu 
The Go menu commands are listed in the table below. 
Go Menu Commands 

Command Shortcut Keys Function 

Back CTRL+ALT+ Left 
Arrow Moves the cursor back to the previously selected item in the tree control. 

Forward CTRL+ALT+ Right 
Arrow Moves the cursor forward to the previously selected item in the tree control. 

Up One Level  Moves the cursor up one level in the tree control. 

Next Item ALT+Down Arrow Moves the cursor to the next item down in the tree control. 

Previous Item  ALT+Up Arrow Moves the cursor to the next item up in the tree view. 

Expand Item ALT+Left Arrow Expands an item that contains a submenu. 

Collapse Item ALT+Right Arrow Collapses an item that contains a submenu. 

Page Up ALT+PgUp Moves the cursor up to the first item in the tree. 

Page Down ALT+PgDown Moves the cursor down to the last visible item in the tree. 
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Command Shortcut Keys Function 
Home ALT+Home Moves the cursor up to the first item in the tree. 

End ALT+End Moves the cursor down to the last visible item in the tree. 

Next Pane F6 Moves the cursor to the next pane. 

Previous Pane SHIFT+F6 Moves the cursor to the last pane used. 

 

Action Menu 
The Action menu contains the following commands: 

Command Function 
Start Alarm Logger Starts alarm data logging for the active configuration.  

Stop Alarm Logger Stops t alarm data logging for the active configuration. 

 
Only one of the above options will be available at a time, depending on the state of the Alarm OPC 
Logger.   
 

Tools Menu 
The Tools menu commands are listed in the table below. 
Tools Menu Commands 

Command Function 
Set Working Directory Sets a working directory for all files relating to the saved configuration. 

Options Launches the Options dialog box.  

Compact/Repair MS Access Database Opens the Compact/Repair MS Access Database dialog box. 

 

Setting the Working Directory 
Selecting Set Working Directory from the Tools menu opens the Set Working Directory dialog 
box, shown below, which enables you to configure a custom directory in which all application 
configuration files will be stored and retrieved. Click Browse to select the directory. 

 
Set Working Directory Dialog Box 

Options 
To choose additional settings, select Options from the Tools menu. This opens the Options dialog 
box, shown in the figure below. The General tab of the Options dialog box, sets the startup and 
workspace parameters for the Alarm Server Configurator. 
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Options Dialog Box: General Tab 

Startup Settings 
The Startup Settings options allow you to save regional settings in the registry so that they are 
applied each time you start the Configurator. This applies to the language settings as well as time 
and date settings. Select one of the following startup settings: 
• Open the active file: Launches the currently active database upon startup. 
• Open the most recently used file: Launches the recently opened database. 
• Open a specific file: Specifies a Microsoft Access (.mdb) or Microsoft Datalink (.udl) database 
to launch upon startup. To select a database, click the ... button next to the text box and browse for 
the file. When this option is selected, the "active" database is overridden by the specified database. 
 
Workspace Settings 
The following Workspace Settings are available: 

• Auto-apply editor changes: Checking this option allows changes to the configuration database to be 
saved each time you switch dialogs without clicking on the Apply button or being shown a message 
asking if you would like to apply changes. 

• Auto-test Make Active before closing the database: When this option is checked, each time you exit a 
currently open (nonactive) database you are asked whether you want to make the database active. 

• Enable hover selection: Checking this option allows you to highlight an item by moving the mouse 
pointer over that item and keeping it there for a specified amount of time (in milliseconds). 
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Compacting and Repairing MS Access Databases 
You can compact Microsoft Access databases, which can be either configuration databases or 
historical databases, using the Compact/Repair MS Access Database dialog box, shown in the 
figure below. To open this dialog box, select Compact/Repair MS Access Database from the 
Tools menu. Microsoft Access–based databases are subject to database fragmentation over time, 
and the support for the database will compact the target database, reclaim unused space, and 
drastically improve database performance. 
Note: It is critical that no users or client applications are connected to the database at the time of 
compacting and that, if the Backup Original Database option is selected, there is plenty of 
available hard disk space. 

 
Compact/Repair MS Access Database Dialog Box 

 

Help Menu 

∼ The Help menu contains the following commands: 

Command Shortcut Key Function 
Help Topics F1 Launches the online help for the Configurator.  

What's This? SHIFT+F1 Displays context-sensitive help topics. 

About Application  
Launches the SMAR About Box, which contains information about the product 
version number, copyright, and available disk space. It also contains 
information about how to contact SMAR.  

 

Logger Configurations 
The configuration database contains one or more Logger configurations. Each configuration 
specifies a subset of alarms and events to be logged to a single database table and/or printer. 
Additionally, the configuration defines which data fields (columns) available are to be stored and/or 
printed. 

Creating a New Logger Configuration 
To create a new logger configuration: 
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1. Right-click on the Configurations tree control of the Configurator and select New > 
Configuration from the pop-up menu, as shown in the figure below.  

 
Creating a New Logger Configuration 

2. The properties dialog box for the new configuration appears in the right-hand pane of the 
Configurator, as shown in the figure below.  

 
Setting the Properties for the New Logger Configuration 

3. In the Name field, type a name for the new configuration.  

4. In the Alarm Filter field, you can click the ... button to open the Expression Editor, which 
allows you to define alarm filters. 

5. When you have finished configuring the Logger configuration properties, click the Apply button. 
The new configuration appears under the Configurations tree control, as shown in the figure below. 

 
New Logger Configuration Added to Tree Control 
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Logger Configuration Properties 
Configure the following parameters for Logger configurations, as shown in the figure below.  
Note: If Dialog View is not selected from the View menu, you will not see the configuration 
properties. 
The configuration dialog contains three main tabs: 
• Database Logging 
• Printer Logging 
• Translation 
 

 
Logger Configuration Properties 

Name: Type a name for the new configuration. The name must be unique. 
Alarm Filter: Click the ... button to open the Expression Editor, shown in the figure below, which 
allows you to define alarm filters for the logger configuration. Please refer to the Expression Editor 
Help documentation for additional information. 

 
Expression Editor 

Click on Tags button and select Filter Wizard from the pop-up menu. The Filter Wizard, shown in 
the figure below, allows you to choose from the following to items enter in your expression. Select 
one or more items, and then click OK. The filter string is automatically inserted into the Edit 
Expression dialog box. 
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• Alarm Types: Alarm, Ack, Unack, Tracking, and Operator 
• Subconditions: LoLo, Lo, Hi, HiHi, Rate of Change, and Digital 

 

 
Filter Wizard 

Apply Button: Commits changes to the database. 
Reset Button: Restores the default configuration settings.  
Add New Button: Adds a new Logger configuration to the database.  
Edit Subscription Button: Opens the Subscription Properties dialog box, shown in the figure 
below, which allows you to subscribe to one or more OPC Alarm and Events servers and select the 
desired additional attributes to be included for logging and/or printing. Select a server and click the 
Edit button. This process is identical to the AlarmWorX 

 
Subscription Properties Dialog 
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Database Logging Tab 
The Database Logging tab of the configuration properties, shown in the figure below, contains the 
following two tabs: 
• Database Connection 
• Table Management 

 
Note: In order to log alarm data to the specified database, you must check the Enable Database 
Logging check box, as shown in the figure below. 

 
Database Logging Tab 

Database Connection 
The Database Connection section of the Database Logging tab, shown in the figure below, 
contains the following two tabs, establishes a connection to an ODBC data source. 

 
Database Logging: Establishing a Database Connection 

The ODBC Data Source field specifies the database to use for logging. If this field is blank (the 
default), logging will take place to the active configuration database. It is highly recommended that 
you change the default database and log alarm data to a different database from the configuration 
database. 
User Name: Enter the user name to use (if any) when connecting to the logging database. 
Password: Enter the password that goes with the User Name. 
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Advanced Button: Clicking Advanced opens the Advanced Database Settings dialog box, 
shown in the figure below, which allows the OLE DB provider name and the Connection string to 
be edited directly. This capability is provided to allow connection to databases directly via OLE DB 
(without using ODBC). 

 
Advanced Database Settings Dialog 

Creating a New ODBC Data Source 
To set up data logging, you must first configure the underlying database and set up ODBC data 
sources. This can be done within the Logger Configurator by connecting a database group to an 
existing database or a new database. It is very critical that the PCs on which the AlarmWorX Logger 
resides have full access to the target database to create, add, delete, and update tables. Otherwise, 
data logging cannot be accomplished.  
To set up a data-logging source in the Configurator: 
1. Click the ... button in the ODBC Data Source field of the Database Connection section of the 
Database Logging tab, as shown in the figure below. 

 
Database Logging: Establishing a Database Connection 
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2. This opens the Select Data Source dialog box, shown below. Choose the Machine Data 
Source tab and an existing database.  

 
Select Data Source Dialog Box 

3. Or you can create a new database by clicking New in the Machine Data Source tab of the 
Select Data Source dialog box. This opens the Create New Data Source wizard, shown 
below, which enables you to configure a new database. 

 
Create New Data Source Wizard  

It is recommended that you configure the new database as a System Data Source so it is 
available to any user logged into the specific PC. Click Next to select the corresponding ODBC 
driver, such as Microsoft Access, Microsoft SQL Server, or Oracle.  
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We recommend configuring the new database as a System Data Source so it is available to any 
user logged on the specific PC station. Next pick the corresponding ODBC driver such as Microsoft 
Access or SQL Server. 
Note: When using a Microsoft SQL Server configuration database, the AlarmWorX Logger will not 
log any data when the ODBC Data Source is set as Not available - using configuration DB in the 
Database Logging tab, as shown in the figure above. This setting is designed to be used with a 
Microsoft Access configuration database. 

Configuring Microsoft Access Databases 

To configure a Microsoft Access database: 

1. Select Microsoft Access Driver (.mdb) in the Create New Data Source wizard, as 
shown in the figure below. 

 
Selecting a Microsoft Access ODBC Driver 

2. When you have selected the Microsoft Access driver, click Next to proceed to the final 
dialog box in the Create New Data Source wizard, shown below. 
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Creating a New Microsoft Access Database Connection  

3. Click Finish to configure your new Microsoft Access database. This opens the ODBC 
Microsoft Access Setup dialog box, shown below. Enter the Data Source Name and the 
Description.  

 
ODBC Microsoft Access Setup Dialog Box 

4. Click Select to choose an existing .mdb file. This opens the Select Database dialog box, 
shown below.  
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Selecting an Existing Microsoft Access Database File 

5. Click Create to create a new .mdb file. This opens the .mdb file directory in the New 
Database dialog box, as shown below. 

 
Creating a New Microsoft Access Database File 

6. You can choose a local hard disk or a networked hard disk as the location of your new 
.mdb file. Click OK to exit the configuration and establish the database connection. 

Note: When creating a new .mdb file, the Microsoft Access configuration dialog box provides 
the options of creating a Version 4.x or a Version 3.x compatible .mdb file. By default, Version 
4.x is selected, creating a Jet Engine 4.x compatible .mdb file, which can be opened only in 
Microsoft Access 2000. If you have Microsoft Access 97, select the Version 3.x compatibility. 
In general, Version 4.x is preferred because it offers greater functionality than the older 
versions. 
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Configuring Microsoft SQL Server and MSDE Databases 

The Alarm Logger includes native support for MSDE (Microsoft Data Engine), which is a 
Microsoft SQL Server 7.0 or 2000 compatible database engine with the following limitations: 

• The Maximum database size is 2 GB. 

• Performance can decrease if more than five connections are open at one time. 

However, MSDE is a Microsoft SQL Server compatible engine that can be directly upgraded to 
the full Microsoft SQL Server. Thus, database connections to MSDE are identical to the 
database connections to Microsoft SQL Server.  

1. To establish an ODBC connection to this database, when configuring a new 
ODBC data source for Microsoft SQL Server or MSDE, select the appropriate ODBC driver. 
To configure a Microsoft SQL Server or MSDE database, select the SQL Server driver in the 
Create New Data Source wizard, as shown in the figure below.  

 
Selecting a Microsoft SQL or MSDE Server ODBC Driver  

2. When you have selected the Microsoft SQL Server driver, click Next to proceed to the final 
dialog box in the Create New Data Source wizard, shown below. 
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Creating a Microsoft SQL Server or MSDE Database Connection 

3. Click Finish to configure your new database. This opens the Create a New Data Source 
to SQL Server dialog box, shown below. Enter the Data Source Name, the Description, and 
the name of the Server on which the Microsoft SQL Server or MSDE engine resides. 

 
Create a New Data Source to SQL Server Dialog Box 

4. If it the engine resides on the same PC node as the AlarmWorX Logger, select "local." 
Otherwise select or specify the appropriate server name. Click Next to continue with the 
Microsoft SQL Server Security configuration and Connection type. It is recommended that you 
use the Windows NT authentication mechanism, which eliminates the need for maintaining 
individual user accounts and passwords.  
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Configuring a Microsoft SQL or MSDE Database Connection 

5. Click Next to continue with the selection of the default database for the connection. Make 
sure it is not the master database, but the one created for the purpose of data logging. 

 
Setting the Default Microsoft SQL Server or MSDE Database 

Note: When connecting to an Microsoft SQL Server or MSDE database, make sure that the desired 
database for historical data logging is selected in the Change the Default Database field, as shown 
in the figure above. Otherwise, you will establish a connection to the master database, which is not 
recommended. 
6. Click Next to accept or modify the default settings, as shown in the figure below. 
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Configuring the Default Settings  

7. Complete the connection configuration by clicking Finish. It is recommended that you test 
the established connection by clicking Test Data Source, as shown in the figure below. 

 
Testing a Microsoft SQL Server or MSDE Database Connection  

Note: Regardless of the database type, all AlarmWorX modules, which interact with 
databases, will create, modify, drop, and update tables. Therefore, it is critical that the currently 
logged-in user has permission to perform these tasks. 
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Configuring Oracle Databases 

The Alarm Logger includes support for logging data as well as replaying data to and from 
Oracle databases. The support for Oracle was developed under the assumption that: 

• ODBC database connections to Oracle are established using the Oracle ODBC Driver 8.05.60, 
which is provided by Oracle and is available on the SMAR product CD under the Tools directory. 
• Oracle is running on a Microsoft Windows NT station. 

To configure an Oracle database: 

1. Select the Oracle ODBC Driver in the Create New Data Source wizard, as shown in the 
figure below. 

 
Selecting the Oracle ODBC Driver 

2. When you have selected the ODBC for Oracle driver, click Next to proceed to the final 
dialog box in the Create New Data Source wizard, shown below.  
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Creating an Oracle Database Connection 

3. Click Finish to configure your new database. This opens the Oracle ODBC Driver Setup 
dialog box, shown below. Enter the Data Source Name, the Description, the Service Name, 
and the User ID, and configure the other desired settings. 

 
Configuring an Oracle ODBC Database Connection 

Table Management 
Alarm data are logged to one master active table. If no restrictions are placed on the size of the 
active table, then logging will continue to go to the active table as long as the Alarm Logger is 
running. If, however, a restriction is placed on the size of the active table, then all logged data  
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beyond the active table size will get logged to archive tables. The archive tables also have a 
maximum size determined by a number of records or time interval.  When one archive table is full, 
archiving goes on to the next table.  When all archive tables are full, the oldest archive table is 
deleted and a new one is set up. The name of each archive table is the name of the active table 
followed by the date and time of the first alarm in the table. In this system, the Active Table will 
always have the most recent alarm data.   
The Table Management section of the Database Logging tab, shown in the figure below, 
configures the following parameters for the active table. 
 

 
Database Logging: Table Management 

 
Table Name: Enter the name of the active table to log data to. 
Active Table: Here you can specify a limit on the active table size.  The limit can be by the Maximum 
Number of Records, or by the Maximum Time Interval (select from hours, days, months, or years by 
clicking the ... button).  If both items are checked, then the table is full when the first of those two 
conditions is met. The Interval refers to the time difference between the first item logged (not the 
logging start time) and the most recent item logged.  If neither item is checked, then no archiving will 
take place. 
Archive Tables: In this section, you can enter in the quantity of archive tables and the condition(s) 
upon which each archive table is full.   
Note: If, in the Archive Table(s) section, the Max Records and Max Interval fields are both left 
unchecked, then all archiving will go to one archive table of theoretically unlimited length, as no 
restrictions have been placed on the table size.  In essence, the Max Tables field will be ignored. 
Note: During runtime, the Alarm Logger will create the active table if it does not exist and will also 
add any columns to the table if they are missing. The logger will not create any indexes. Use a 
database administration tool to add indexes to columns that are searched and/or sorted by queries. 
Note to Microsoft Access Users: If you are connected to a Microsoft Access data base and you are 
using archive tables, it is very important to note that, though the archiving deletes the oldest table to 
make room for a new one when all tables are used up, the disk space taken by the deleted table 
does not get freed up.  The end result is that over a long period of time, the log database file will 
keep growing in size even though you may have specified a finite quantity of records to archive.  
One solution to this problem is to periodically open the database in Microsoft Access and select 
Compact/Repair Access Database from the Tools menu of the Configurator. This frees up unused 
disk space.  It is very important, however, that you make sure that no other users, including the 
AlarmWorX Alarm Logger, are connected to your database when you use the 'Compact' command.  
An alternative solution is to use SQL or MSDE for your data logging instead of Microsoft Access.  
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Printer Logging Tab 
Checking the Enable Printing check box on the Printer Logging tab of the configuration 
properties, shown in the figure below, causes the Alarm Logger to type event records to the 
printer(s) specified in the following fields.  

 
Printer Logging Tab 

Printer: Select the Primary Printer from the drop-down list. The AlarmWorX Logger sends each 
event directly to the printer as soon as it is received. This works best with a dedicated ink jet or dot 
matrix printer that will print one line at a time, rather than a page-oriented printer like a laser printer. 
Laser printers will still work, but the page will not be ejected until it is full. 
All event notifications will print on the Primary Printer unless an error is detected (offline, out of 
paper, etc.), in which case the Backup Printer will be used. Switchover from Backup to Primary 
occurs automatically when the error condition is cleared on the Primary Printer. 
Backup Printer: Select the Backup Printer from the drop-down list. The Backup Printer will be 
used whenever an error is detected (offline, out of paper, etc.) on the Primary Printer. Switchover 
from Backup to Primary occurs automatically when the error condition is cleared on the Primary 
Printer. 
Height: Enter the number of lines your printer prints on a single page using its default font. The 
logger prints events "one line at a time," by sending raw text to the printer, bypassing the normal 
Windows page device context printing. Printers that accept this raw text will use an internal font to 
render the characters. The number of lines that will fit on a page using this internal font needs to be 
entered here. If you cannot find this information in the printer manual, you may need to experiment 
to find an acceptable value. A value of 58 will be safe for most printers. 
Width: Enter the number of characters the printer is capable of printing on a single line using its 
default font. 
Header and Footer Button: Click the Header and Footer button to edit the lines of text that will 
appear at the top and bottom of each printed page. The header and footer may contain more than 
one line. The following tokens will be replaced at runtime with their appropriate values: 
%d - Name of the configuration. 
%n - Computer name the logger is running on. 
%p - Page number. 
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Header and Footer Dialog 

International Language Printing 
The AlarmWorX Logger supports printing using character sets other than the standard 7-bit ASCII 
codes appropriate for English. Since the logger does not use normal “Windows” printing, the setup 
to use other character sets is more involved than for other typical Windows programs. 
Selecting the Windows Regional Options 
First select the desired locale and Language from the Windows Control Panel “Regional Settings”:  

1. From the Windows Start menu, select Settings > Control Panel. 

2. In the Control Panel, double-click on Regional Options. This opens the Regional Options 
dialog box, as shown in the figure below. On the General tab, select the desired locale and 
Language, as shown in the figure below. 

Note: You must set the desired language in the Windows Regional Settings. It is not enough to 
choose the language only within ProcessView. 
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Setting the Windows Regional Language Options 

 

Selecting the Character Set (Code Page) in the Printer 
By selecting the desired language in Windows, the Logger will convert the UNICODE characters to 
the 8-bit ASCII version using the DOS code page for the selected language. In order for the 
characters to print properly, the printer must be configured to use the correct code page. 
The code page for the printer is selected by sending the printer special non-printable ASCII 
characters called control codes. The control codes are listed in the first column (Decimal 0 - 31) of 
the ASCII chart below. 
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The configuration of the header and footer for the printed alarms understands the ASCII control 
codes so for example the character sequence ^[ will be interpreted as the ESC code (Decimal 27) 
instead of the two literal characters  ̂and [. 
The proper control code sequence to select a particular language varies by printer manufacturer and 
model. Please refer to the printer manual for your printer to obtain the correct code sequence. For 
example, the following sequence will assign the PC866 Russian code page to character table 1 and 
then make character table 1 active for International (non-US) Epson printers: 
[̂ ( t 3 0 1 14 0 [̂ t 1 

The same code sequence is shown below in the header configuration of the AlarmWorX Logger. To 
view the header configuration, click the Header and Footer button on the Printer Logging tab of 
the AlarmWorX Logger Configurator. 
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Code Sequence Displayed in Printer Header Configuration 

Translation Tab 
The Translation tab of the configuration properties, shown in the figure below, will appear only if 
you have the version of AlarmWorX with Language Switching installed (Unicode Version only). It is 
for use with the language translations as configured in the Language Configurator. 

 
Translation Tab 

Translation Mode allows you to choose how you would like Language Switching to work with the 
Alarm Logger for this particular configuration. 
Use Registry: This mode uses the registry settings to determine what language to use.  This means 
that if a user changes the language in another application, the Alarm Logger will also use the new 
language. 
No Translation: This mode does not allow for the language to be translated before getting logged. 
If you have items configured with special characters for use with Language Switching, they will 
remain with the items and be logged in this way. This is useful if you would like the next phase, such 
as reporting, to be able to determine which language translation to use. 
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Custom Translation: This mode allows you to set the language translation here so that it will 
always be the language used with the Alarm Logger for this particular configuration.  The following 
Custom Translation Settings are available for use with this mode: 
• Language: Choose the language you wish to use from the list of available languages as 
configured in the Language Configurator. 
• Language Subset: If you are using a language subset, enter it here.  It must be a language 
subset that has been defined in the Language Configurator. 
• Synchronize application LCID with selected language: If using application language 
converting also, you can synchronize with language switching by checking this check box. 
• Application LCID: Allows you to choose a language to use for application language converting.  
This option is only available for use with languages that have alternate language resources 
(dynamic link libraries) associated with them. See the document 'International ToolworX.doc' on 
your Smar CD for more information.  It can be found in the CD directory in the Tools folder under 
Translations. 

Columns 
Each configuration contains one or more columns. The columns defined for a configuration appear 
as child elements of the configuration in the tree control, and as list items in the list view (top right 
pane). 

Creating a New Column 
To create a new column: 

1. Right-click on a logger configuration in the tree control of the Configurator and select New > 
Column Definition from the pop-up menu, as shown in the figure below.  

 
Creating a New Column 

2. The properties dialog box for the new tag appears in the right-hand pane of the Configurator, as 
shown in the figure below.  

 
Setting the Properties for the New Column 

3. In the Name field, type a name for the new column. This will be the column name used in the 
logging database and the column heading when printing. 
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4. In the Type field, select a column type from the drop-down list. 

5. When you have finished configuring the column properties, click the Apply button. The new tag 
appears under the Logger Configuration tree control, as shown in the figure below. 

 
New Column Added to Tree Control 

Column Configuration Properties 
Configure the following parameters for columns, as shown in the figure below.  
Note: If Dialog View is not selected from the View menu, you will not see the configuration 
properties. 

 
Column Configuration Properties 

The following fields are specified for each column: 
Name: Enter the name of the column. This will be the column name used in the logging database 
and the column heading when printing. 
Maximum Width: Enter the number of character spaces for this column when printing. 
Line Number: When printing, each event may occupy more than one printed line. Specify the line 
on which you want the column to print. A value of zero will prevents the column from printing. 
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Start Position: Enter the number of character spaces from the left to begin printing. The first 
character space is zero. 
Enable Line Wrapping: When printing, field data that are wider than the configured column width 
will either be truncated or wrapped to the next line depending on this setting. 
Column Type: Select the OPC Alarm and Events data item you wish to log in this column from the 
drop-down list. 
The available column types are listed in the table below. 
Note: The following column type descriptions are taken directly from the OPC Alarms and Events 
Specifications. Please refer to the Specifications for complete information. 

COLUMN TYPE DESCRIPTION 
 The following items are present for all event types. 

Source The source of event notification. This Source can be used in the IOPCEventServer::TranslateToItemIDs 
method to determine any related OPC Data Access itemIDs. 

Time 
Time of the event occurrence. For conditions, time that the condition transitioned into the new state or sub-
condition.  For example, if the event notification is for acknowledgment of a condition, this would be the time 
that the condition became acknowledged.  

Active Time 

Array of active times corresponding to each Source and ConditionName pair.  This parameter uniquely 
identifies a specific transition of the condition to the active state or into a different sub-condition and is the 
same as the SubCondLastActive condition attribute. Active times are passed to the client in the ActiveTime 
member of the ONEVENTSTRUCT by the IOPCEventSink::OnEvent callback. If the condition has become 
active again or transitioned into a different sub-condition at a later time, this acknowledgment will be ignored.   

Message Event notification message describing the event. 

Subscription Subscription to a given OPC Alarm and Event server. 

Server Description Information about the currently subscribed OPC Alarm and Event server. 

Server Node Node (computer) on which the currently subscribed OPC Alarm and Event server is located. 

Event Type OPC_SIMPLE_EVENT, OPC_CONDITION_EVENT, or OPC_TRACKING_EVENT for Simple, Condition-
Related, or Tracking events, respectively. 

Event Category 

Event categories define groupings of events supported by an OPC Event server.  Examples of event 
categories might include “Process Events”, “System Events”, or “Batch Events”.  Event categories may be 
defined for all event types, i.e. Simple, Tracking, and Condition-Related.  However, a particular event category 
can include events of only one type.  A given Source may generate events for multiple event categories.  
Names of event categories must be unique within the event server.  The definition of event categories is 
server-specific.   

Severity 

Event severity (0-1000).  The severity value is an indication of the urgency of the sub-condition. This is also 
commonly called ‘priority’, especially in relation to process alarms.  Values will range from 1 to 1000, with 1 
being the lowest severity and 1000 being the highest.  Typically, a severity of 1 would indicate in event that is 
informational in nature, while a value of 1000 would indicate an event of catastrophic nature which could 
potentially result in severe financial loss or loss of life. 

Number Event Attributes The length of the specific event attribute array. 

Attributes 1-20 User-specified event attributes. 

 The following items are present only for condition-related events. 

Condition Name The name of the condition related to this event notification.  

SubCondition Name The name of the current sub-condition, for multi-state conditions.  For a single-state condition, this contains the 
condition name. 

Change Mask 

Indicates to the client which properties of the condition have changed to have caused the server to send the 
event notification.  It may have one or more of the following values: 

OPC_CHANGE_ACTIVE_STATE OPC_CHANGE_ACK_STATE OPC_CHANGE_ENABLE_STATE 
OPC_CHANGE_QUALITY OPC_CHANGE_SEVERITY OPC_CHANGE_SUBCONDITION 
OPC_CHANGE_MESSAGE OPC_CHANGE_ATTRIBUTE 

If the event notification is the result of a Refresh, these bits are to be ignored. 

For a “new event”, OPC_CHANGE_ACTIVE_STATE is the only bit that will always be set.  Other values are 
server-specific.  (A “new event” is any event resulting from the related condition leaving the Inactive and 
Acknowledged state.) 

NewState A WORD bit mask of three bits specifying the new state of the condition:  OPC_CONDITION_ACTIVE, 
OPC_CONDITION_ENABLED, OPC_CONDITION_ACKED. 
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COLUMN TYPE DESCRIPTION 

Quality Quality associated with the condition state. Values are as defined for the OPC Quality Flags in the OPC Data 
Access Server specification. 

AckRequired 

This flag indicates that the related condition requires acknowledgment of this event.  The determination of 
those events that require acknowledgment is server-specific.  For example, transition into a LimitAlarm 
condition would likely require an acknowledgment, while the event notification of the resulting acknowledgment 
would likely not require an acknowledgment. 

Active Time 
Time that the condition became active (for single-state conditions), or the time of the transition into the current 
sub-condition (for multi-state conditions).  This time is used by the client when acknowledging the condition 
(see IOPCEventServer::AckCondition method). 

Cookie Server-defined cookie associated with the event notification.  This value is used by the client when 
acknowledging the condition (see IOPCEventServer::AckCondition method).  This value is opaque to the client. 

 The following is used only for tracking events and for condition-related events that are 
acknowledgment notifications. 

ActorID 

For tracking events, this is the actor ID for the event notification. 
For condition-related events, this is the AcknowledgerID when OPC_CONDITION_ACKED is set in NewState.  
If the AcknowledgerID is a NULL string, the event was automatically acknowledged by the server. 
For other events, the value is a pointer to a NULL string. 

 

Event Type Values 
Event Type Value Description 

OPC_SIMPLE_EVENT 1 Simple event. 

OPC_TRACKING_EVENT 2 Tracking event. 

OPC_CONDITION_EVENT 4 Condition-Related event. 

 

Change Mask Values 
Change Mask Item Value Description 

OPC_CHANGE_ACTIVE_STATE 1 The condition’s active state has changed. 

OPC_CHANGE_ACK_STATE 2 The condition’s acknowledgment state has changed. 

OPC_CHANGE_ENABLE_STATE 4 The condition’s enabled state has changed. 

OPC_CHANGE_QUALITY 8 The ConditionQuality has changed. 

OPC_CHANGE_SEVERITY 16 The severity level has changed. 

OPC_CHANGE_SUBCONDITION 32 The condition has transitioned into a new sub-
condition. 

OPC_CHANGE_MESSAGE 64 The event message has changed (compared to prior 
event notifications related to this condition). 

OPC_CHANGE_ATTRIBUTE 128 
One or more event attributes have changed 
(compared to prior event notifications related to this 
condition). 

 

New State Values 
New State Value Description 

OPC_CONDITION_ENABLED 1 The condition has been enabled. 

OPC_CONDITION_ACTIVE 2 The condition has become active. 

OPC_CONDITION_ACKED 4 The condition has been acknowledged. 
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Nodes 
Each Node represents a computer on the network that is configured to run one or more of the 
named logger configurations in the active configuration database. When the logger executable is 
run, it looks for its network computer name in the list of nodes to determine which logger 
configuration(s) to run. If a logger cannot find its computer name in the list of nodes, it will run the 
default configuration. 

Adding a New Node 
To add a new node to the configuration: 

1. Right-click on the Nodes tree control of the Configurator and select New > Node from the pop-
up menu, as shown in the figure below.  

 
Creating a New Node 

2. The properties dialog box for the new node appears in the right-hand pane of the Configurator, 
as shown in the figure below.  

 
Setting the Properties for the New Node 

3. In the Name field, type a name for the new node, or click the Browse button to select a node 
from the network. 

4. When you have finished configuring the nodes, click the Apply button. The new area appears 
under the Nodes tree control. 

 

Assigning Configurations to Nodes 
Each node has one or more configurations assigned to it. The configurations assigned to a node 
appear as child elements of the node in the tree control, and as list items in the list view (top right 
pane). A configuration may be assigned to more than one node. 
To assign a configuration to a node, 

1. Right-click on the Nodes tree control of the Configurator and select New > Link to 
Configuration from the pop-up menu, as shown in the figure below.  
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Linking a Configuration to a Node 

2. From the drop-down list under Configuration Name, select an existing configuration to assign 
to this node, as shown in the figure below. 

 
Assigning a Configuration to a Node 

3. Click the Apply button.  

Running the Logger 
The Alarm Logger application (AWXLog.exe) that provides the runtime storage and printing has no 
user interface and may optionally be run as a service on Windows NT (see the installation section). 
The logger reads its configuration information from a Microsoft Access database file. The logger 
reads the configuration for the active database only. To activate a database, select Make Active 
from the File menu in the Logger Configurator.  

Possible Runtime Errors 
Any error conditions encountered by the logger will be reported via the SMAR Event Server and 
optionally to the Windows NT Event Log. 
To allow the logger to send messages to the NT Event Log, open the License Monitor by selecting 
Start > Programs > SMAR PROCESSVIEW > License Monitor. In the License Monitor, select the 
Events tab, as shown in the figure below. Check AWXLog in the list of applications. 
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NT Event Log Configuration 

 
The possible error messages are listed in the table below. 

 

SEVERITY SOURCE MESSAGE 
500 AWXLog SMAR AlarmWorX Logger Started. 

500 AWXLog SMAR AlarmWorX Logger Stopped. 

500 AWXLog Primary Printer "%1" now in service. Printing on Backup Printer "%2" 
terminated 

500 AWXLog Printing has resumed 

500 AWXLog Configuration "%1" INSERT INTO table "%2" succeeded. 

750 AWXLog Failed to Open Primary Printer "%1" 

750 AWXLog Configuration "%1" printer event queue overflow. Messages have 
been lost. Queue size is %2 events. 

750 AWXLog Primary Printer "%1" has failed. Now Printing on Backup Printer "%2" 

750 AWXLog Configuration "%1" filter is inactive due to syntax error(s). 

750 AWXLog Configuration "%1" logging event queue overflow. Messages have 
been lost. Queue size is %2 events. 
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SEVERITY SOURCE MESSAGE 

800 AWXLog 

Error opening Configuration Database: 
Provider: %1 
Connection: %2 
(Error string from database is in "Comment" Attribute) 

800 AWXLog 

Error Querying Configuration Database: 
Provider: %1 
Connection: %2 
Query: %3 
(COM error string is in "Comment" Attribute) 

800 AWXLog 

Configuration Database has no configuration for "Node" and no 
"Default". 
Provider: %1 
Connection: %2 

800 AWXLog 

Error opening Logging Database for Configuration "%1" 
Provider: %2 
Connection: %3 
(COM error string is in "Comment" Attribute) 

800 AWXLog 
Query of Column definitions failed for configuration "%1" 
Query: %2 
(COM error string is in "Comment" Attribute) 

800 AWXLog 

Error opening Configuration Database: 
Provider: %1 
Connection: %2 
(COM error string is in "Comment" Attribute) 

800 AWXLog 

Configuration Database has no configuration "%1". 
Provider: %2 
Connection: %3 
(COM error string is in "Comment" Attribute) 

800 AWXLog Configuration "%1" subscription to OPC Event Server(s) failed. 

800 AWXLog Configuration "%1" error assigning value to column "%2" 

800 AWXLog Configuration "%1" INSERT INTO table "%2" failed 
(Error string from database is in "Comment" Attribute) 

800 AWXLog Failed to register "%1" with GenRegistrar. Configuration "%2" will not 
execute. 

800 AWXLog Printing to both Primary Printer "%1" and Backup Printer "%2" has 
failed 

 
Using a technology that has been incorporated into all Smar products, TraceWorX provides online 
diagnostics and tuning of applications running in the ProcessView system. TraceWorX is designed 
expressly for systems integrators, OEMs and customers who want to have tools for doing their own 
troubleshooting and diagnostics. 
TraceWorX tracks the runtime activity for each ProcessView application and logs the runtime data to 
a log file based on user-configured trace levels. The log file provides a thorough, color-coded report 
detailing all activity for the application, including the time, the date, the severity level, and a 
description of the event or problem.  
TraceWorX also features several options for reporting issues to technical support. If you are 
experiencing problems with any applications, the log file deployment options, such as compressing 
and e-mailing log files, are ideal for tracking and archiving data and sending detailed reports to 
technical support. Developers can use these reports to identify the source of the problems. 
For information about TraceWorX, please see the TraceWorX Help documentation. 
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Introduction 
This reference describes the OLE Automation features available in the AlarmWorX Logger.  

Automation Interfaces 
The AlarmWorX logger provides a COM interface that allows external programs to manipulate the 
logger as it is running. The interface is available to all programming languages that support COM 
including Visual Basic (VB), Visual Basic for Applications (VBA) and Microsoft Visual C++. 
To access the Automation interface from VB and VBA, AlarmWorX logger must be made available 
by choosing Project - References from the main menu in the VB or VBA development environment 
and selecting AWXLog 1.0 Type Library in the list of available references. 

Available Control Properties 
boolean LoggingEnabled  
Description 
True if logging to database is enabled. Applies to all running configurations that match the current 
Filter Property. Property is read/write. 
Remarks 
Values written to this property are transient. The value written is not stored in the configuration 
database and hence is "lost" when the logger is shut down. 
Reading this property will throw an error in the following cases: 
The logger has just started and the configuration has not been read yet. 
Multiple running configurations match the filter and they have differing values (some True, some 
False). 
Example 
This example shows how to determine if logging is enabled. 
Dim bEnabled as Boolean 
bEnabled = AWXLogger.LoggingEnabled 
 

This example shows how to turn on/off logging 
AWXLogger.LoggingEnabled = True 

 
 

boolean PrintingEnabled  
Description 
True if logging to printer is enabled. Apply to all running configurations that match the current Filter 
Property. Property is read/write. 
Remarks 
Values written to this property are transient. The value written is not stored in the configuration 
database and hence is "lost" when the logger is shut down. 
Reading this property will throw an error in the following cases: 
The logger has just started and the configuration has not been read yet. 
Multiple running configurations match the filter and they have differing values (some True, some 
False). 
Example 
This example shows how to determine if printing is enabled. 
Dim bEnabled as Boolean 
bEnabled = AWXLogger.PrintingEnabled 
 

This example shows how to turn on/off printing. 
AWXLogger.PrintingEnabled = True 
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long Count  
Description 
Return the number of running configurations whose names match the current Filter Property. 
Property is read-only. 
Remarks 
Reading this property will throw an error if the logger has just started and the configuration has not 
been read yet. 
Example 
Dim n as Long 
n = AWXLogger.Count 
 
 
string Filter  
Description 
Wildcard string that a running configuration name must match in order to be affected by other 
methods and properties of this object. String property is read/write. 
Remarks 
If the name of a running configuration does not match the filter, then that configuration is ignored by 
all other methods and properties of this object. The default initial value for this Property is "*" 
meaning all running configurations will match, hence by default, all of the methods and properties 
will operate simultaneously on all running configurations. 
Example 
Dim sFilter as String 
sFilter = AWXLogger.Filter 
 
'set filter for all configurations that begin with b 
AWXLogger.Filter = "b*" 

 
 
 

string Item  
Description 
The name of a running configuration (that matches the Filter Property) for a given index value in 
the array (VB Collection). String property is read-only. 
Syntax 
Item( long n ) 
Where n is an integer from 1 to Count 
Remarks 
The AlarmWorX logger Automation object is designed as a VB Collection. Each element in the 
collection is the name of an active configuration that matches the current Filter Property. 
Example 
These three examples do the same thing -- print the name of each configuration. 
Dim AWXLogger As AWXLogAuto 
Set AWXLogger = New AWXLogAuto 
 
' method 1 
For Each ConfigName In AWXLogger 
    Print ConfigName 
Next ConfigName 
 
' method 2 
For i = 1 To AWXLogger.Count 
    Print AWXLogger(i) 
Next i 
 
' method 3 
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For i = 1 To AWXLogger.Count 
    Print AWXLogger.Item(i) 
Next i 
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 4.1 

AlarmWorX Report 
The AlarmWorX Report ActiveX allows reporting (user-configured or pre-configured) and graphing of 
alarms. The source of the Alarm data is alarms previously logged by the Alarm Logger. The Alarm 
Report is an ActiveX, allowing it to be placed in any ActiveX container application, including 
GraphWorX, Visual Basic, or a Web page. 
The AlarmWorX Report ActiveX is accessible from the ActiveX toolbar in the AlarmWorX Container, 
or from the Edit menu. Selecting Insert New Object from the Edit menu opens the Insert Object 
dialog box. Select the Smar AlarmWorX Report ActiveX item, and then click OK. The Report ActiveX 
is inserted into the display, as shown in the figure below. 

 
Alarm Container Window With the AlarmWorX Report ActiveX 

 

Configuration 
To start the configuration of the Report ActiveX, double-click the ActiveX (the yellow notebook type 
object). This opens the Alarm Report ActiveX Properties dialog box for the ActiveX. Use these 
property pages to configure how alarms will be reported (appearance, organization, etc.) and which 
report type will be used.  

General 
The General tab of the Alarm Report ActiveX Properties dialog box, shown below, allows you to 
specify the name of the report file, select the border type and connect to a data source. 
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Report ActiveX General Tab 

Configure the following General tab settings: 
• Title: Enter a title for the report. 
• About: Clicking the About button displays both technical support information and the SMAR 
About Box, which contains registration and serial number information as well as system resource 
information, such as memory and disk space available. 
• Border Type: Select one of the following border types for the report from the drop-down list: 
None, Flat, or 3-dimensional. 
• Enable Popup Toolbar: When this option is checked, the Report toolbar is available during 
runtime mode. 
• Auto Update: Specifies the frequency (in seconds) at which the alarm report updates data from 
the Alarm Logger database. 
• Configuration File: By default, information is stored as part of the container application's 
document file. You can also store information as part of a separate (.awr) file. To save the .awr file, 
click Save As to open the Save AWXReport Configuration Info dialog box. Enter a name for the 
.awr file in the File Name field, and then click Save.  
You can also open an existing configuration file by clicking the Load button on the General tab and 
browsing for the file. If Configuration File is selected, the Report ActiveX will attempt to load from the 
file listed under File name.  If URL Path is checked, the ActiveX will use the specified network URL 
path upon loading the file.   
Note:  The ActiveX cannot be saved to a URL path. To create a URL file, save a report 
configuration to a local file and copy the file to the desired network location. 
You can also select aliases to use for the configuration file. Clicking the ... button and selecting 
Insert Global Alias from the pop-up menu opens the Global Alias Browser, as shown in the figure 
below. Select a global alias from the Global Alias Browser, which includes all global aliases in the 
global alias database. This eliminates the need to manually type in the alias name. All global aliases 
that are configured in the Global Alias Engine Configurator are conveniently available to choose 
from inside the browser. The tree control of the Global Alias Engine Configurator is mimicked in the 
tree control of the Global Alias Browser. Select a global alias by double-clicking the alias name (e.g. 
"Floor" in the figure below). The alias name appears at the top of the browser, which automatically 
adds the <# and #> delimiters to the alias name. Click the OK button. 
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Selecting an Alias From the Global Alias Browser 

• Data Source: Clicking the Connection parameters button opens the Database Connection 
dialog box, where you can specify an alarm logger database. See "Connecting to a Data Source" 
below. 

• Auto Print: The Auto Print feature is available only when the Auto Update feature is enabled. 
Reports are printed automatically on the same time interval specified for the auto update. Thus, 
if the Auto Update is set for 300 seconds, then reports will be automatically printed every 300 
seconds.  

• Clicking the printer button opens the Auto Print Settings dialog box, as shown in the figure 
below. Check the Enable Auto Print feature check box. If you use the Default Printer for your 
system, you can specify the page orientation and number of copies. If you choose an alternate 
device under Selected Devices, you must click on the printer buttons to the right to configure 
the settings for each device.  

• The options available under What to Print? depend on your database connection and whether 
you have configured any Crystal Report Designs in the Reporting tab of the Alarm Report 
ActiveX Properties dialog box.  

Note: If the Crystal Report Engine is not installed on the local machine, then auto print for Crystal 
Reports will not work on that machine. 

 
Configuring Auto Print Settings 
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Connecting to a Data Source 
To connect to a data source: 

1. Click the Connection parameters button. This opens the Database Connection dialog box, as 
shown below. 

2. Under Data provider, select from Microsoft Access, Microsoft SQL Server, or ODBC (Open 
Data Base Connectivity), as shown in the figure below. 

 
Connecting to a Database 

3. Click the Build Connection String button. This opens the Microsoft Data Link Properties 
dialog box, as shown in the figure below. In the Connection tab specify the data source and then 
click OK.  

Note: All data source connections are made through the Data Link Properties dialog box. The 
Connection tab settings may vary depending on which data provider you selected. Click the OK 
button. Click the Help button at any time to view the Microsoft Data Link help documentation. 
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Specifying a Data Source 

4. The data source reference appears in the Database Connection dialog box in the OLE DB 
Connection String field, as shown below. The Base Table Name field lists the tables in the 
database. You can select a specific table from the drop-down list to use as the reference table for 
the database. 

5. Click the Connect button to connect to the database. The traffic light icon changes to green 
when the connection is successful, as shown in the figure below. 

 
Database Connection  
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Columns 
In the Columns tab of the Alarm Report ActiveX Properties dialog box, shown below, you can 
specify which columns will appear in your alarm report.  By default, the following three items are 
included in the report: EventTime, Tag, and Message, as shown in the Selected list in the figure 
below.  
Note: For more information about column types, event types and attributes, please see the 
AlarmWorX Viewer, AlarmWorX Server, and AlarmWorX Logger documentation. 

 
Report ActiveX Columns Tab 

By clicking the Add and Remove buttons in the middle of and the "up" and "down" arrows on the 
right side of this the Columns tab, you can select which columns to include in the report as well as 
indicate the order of their appearance.  To move an item from the Available list to the Selected list, 
simply highlight the item and click the Add button.  To move an item back from the Selected list to 
the Available list, highlight the item and click the Remove button.  To change the order of an item in 
the Selected list, simply select the item and click the "up" and "down" arrows located on the right-
hand side.   
You can also change the appearance of a column by either double-clicking on an item in the 
Selected list or selecting the item and clicking the Config… button. The Set Column configuration 
dialog for the item opens, as shown below.  From this dialog, you can set the font, color, width, and 
cell properties by selecting and changing the various options available. 

 
Columns Configuration Dialog 
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Grid Configuration 
The Grid Configuration tab of the Alarm Report ActiveX Properties dialog box, shown below, 
determines how the grids on your alarm report will look and act.   

 
Report ActiveX Grid Configuration Tab 

Configure the following grid settings: 
• Appearance: Choose either a 3-dimensional grid or a flat grid. 

• Row Height: Specifies the space between horizontal grid lines. 
• Colors: Specifies colors for the grid text, headers, and background. 
• Title: To show the grid title on the report, check the Display Grid Title check box. When Blink 
on Update is checked, the grid title will blink each time the report is updated with new data from the 
Alarm Logger database. You can also specify the color for both the title text and background. 
• Grid Lines: Both Horizontal and Vertical grid lines appear on the alarm report.  You can 
specify the Width, Style (e.g. Solid, Dashed, etc.), and Color of the grid lines. To change the color 
of the grid lines, simply click the Color check box and select a color from the color palette. 
Note: It is not necessary to have grid lines, but it is helpful in distinguishing between different 
records.    

Charts Configuration 
The Charts Configuration tab of the Alarm Report ActiveX Properties dialog box, shown below, 
refers to the chart that will be generated from the report data.  The settings in the Charts 
Configuration tab determine how the chart will appear in runtime mode.  To access the report 
chart, enter runtime and click the Chart Summary button. For more details on this runtime feature, 
please see the Runtime - Chart Summary section. 
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Report ActiveX Charts Configuration Tab 

Configure the following chart settings: 
• Chart Type: Select one of two types of chart: Bar or Pie. 
• Background Color: Set the background color for the chart (the color that will surround the 

chart) and the chart's title.   
• Title/Plot/Legend: You can toggle the visibility of chart title and/or legend by checking or 

unchecking Display Title or Display Legend, respectively.  
You can also set the exact positions and sizes of chart elements (title, plot, and legend). The 
positions are determined by values in the Left and Top fields, and sizes for particular chart 
elements are set in the Height and Width fields. The positions and sizes are given in the 
percentage of full width and height of chart area, assuming that the coordinate origin (0,0) is located 
in the top left corner of the chart. For example, setting Left=50, Top=50, Height=50, Width=50 for 
the chart legend will position legend in the lower right quadrant of the chart area. 
If Update Title On Series Select is checked, the chart's title text will be updated when you click on 
any data series (either bar or pie segment) of the plot object. A name of the selected data series will 
be included with the title text. This mode is particularly useful when the chart legend is hidden. 
• Advanced Chart Options: Clicking the Advanced Chart Options button opens the Advanced 
Chart Properties dialog box, as shown in the figure below. If your alarm records contain long 
strings of data, you can abbreviate the strings by checking Truncate Long strings to "X" 
characters. Then specify the maximum number of string characters to be displayed (in place of the 
"X"). 
For bar charts, checking Enable Data Series Scrolling allows you to scroll across the bars in the 
chart. The number of bars in the scrolling region is determined by the Scroll Size. When scrolling is 
enabled for bar charts, you have the option of using global scaling. 

 
Advanced Chart Properties 
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If scrolling is enabled, an Enable Scrolling button appears at the base of the bar chart summary in 
runtime mode, as shown below. Click this button to scroll left or right between bars on the chart 
using the arrows. 

 
Bar Chart Summary 

 

Fonts 
The Fonts tab of the Alarm Report ActiveX Properties dialog box, shown below, specifies the font 
size, style, and text effects (i.e. underline and strikethrough) for the alarm report.   

 
Report ActiveX Fonts Tab 
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Records Sorting 
The Records Sorting tab of the Alarm Report ActiveX Properties dialog box, shown below, has 
just one button: the Sort By button.   

 
Report ActiveX Records Sorting Tab 

Clicking the Sort By button opens the Sorting Fields dialog box, as shown in the figure below. You 
can choose whether to disable or enable sorting by leaving the Disable All Sorting check box 
checked or unchecked. If you choose to leave this box unchecked, then several sorting options are 
available. Here you will specify the priority by which the fields in the alarm report are sorted. 

 
Sorting Fields Dialog Box 

To change the priority by which the fields will be displayed, highlight a field and then click the Move 
Up/Move Down buttons. The order of the columns under Field indicates their priority level. 
To determine the order in which the data will be displayed within in each column, highlight that 
column and select one of the following sorting options: 
• Do Not Sort on This Field: Leaves the data unsorted. 

• Sort Ascending: Sorts the data in the column in ascending order (i.e. from least to greatest) 
• Sort Descending: Sorts the data in the column in ascending order (i.e. from greatest to least) 
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All elements will be sorted by the first category in the list.  In the event that two elements in the first 
category are identical, the reported alarms are sorted by the criteria configured for the next item in 
the list.  
 If you are dealing with language translations, you have the option of resorting values after 
translating them.  This option is for advanced users and is not recommended for scenarios where 
there is a large set of records after filtering.   
You can also set the Summary Field Sort Order (see Runtime - Data Grid and Chart Summary 
for more information on the summary field) by selecting Descending or Ascending.   
If the Enable sorting action on grid header double-click check box is selected, then you have the 
option of double-clicking the header of each column in the report while in runtime to toggle between 
ascending and descending sorting for the selected column.   
Note:  You can also access the Sorting Options dialog box via the Sort Alarms button on the 
AWXRep toolbar while in runtime mode. (Double-click anywhere in the ActiveX client box to show 
the AWXRep toolbar.) 

Record Filtering 
The Records Filtering tab of the Alarm Report ActiveX Properties dialog box, shown below, 
offers simple filtering options for the alarm report. You can filter by date, by tag, or by custom SQL 
statements. 

 
Reports ActiveX Record Filtering Tab 

All of the items checked in the Available Filters list box are used as criteria for determining which 
alarms/events are displayed on the grid in runtime. If the Display active filter name(s) on grid's 
title bar check box is selected, then the names of the filters that are checked will appear on the 
grid's title bar while in runtime. To configure a filter, either click the Add Filter… button to set a new 
filer or select an existing filter and click the Config Filter… button to modify the filter.  Either action 
opens the Record Filter dialog box, shown below.   
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Record Filter Dialog 

The decision of whether to use string/number values or date/time ranges for filtering depends on the 
column selected in the Column Name drop-down list. If [EventTime] is selected from this list, then 
a date/time range specified in the Included Date/Time Values field is used for the filtering criteria.  
For any other Column Name selection, the string/number values that are checked in the Available 
Values list box are used for the filtering criteria. You will notice, as you select different values for 
Column Name that the list of available values in the list box changes. 
Three types of filtering are available:  
Inclusive Filter: If an inclusive filter is used, then the alarm conditions that meet the criteria set by 
the items selected in the Available Values list box or the alarms appearing within the time range 
specified in the Included Date/Time Values field pass through the filter and are displayed in the 
alarm report grid in runtime. 
Exclusive Filter: If an exclusive filter is used, then the matching alarms do not pass through the 
filter and are not displayed in runtime.  
Custom Filter: If custom filtering is used, then you have the option of typing a SQL WHERE 
statement in the text box at the bottom of the dialog box to specify what type of values can pass 
through the filter. You can also select a global alias to use in the SQL WHERE statement. Clicking 
the # button opens the Global Alias Browser, shown below, which allows you to choose from a list 
of aliases in the Global Aliasing System Engine. 

 
Selecting Global Aliases From the Browser 
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Reporting 
The Report ActiveX Control makes use of Seagate Crystal Reports (version 8.0) for versatile, neat, 
and easy-to-manage alarm reports. From the Reporting tab of the Alarm Report ActiveX 
Properties dialog box, shown below, you can configure templates for Crystal Reports. Clicking the 
Preview button next to any configured template launches Crystal Reports and displays a sample 
report matching the criteria set in the template configuration. 

 
Alarm Report ActiveX Reporting Tab 

Clicking on any of the Config. Template… buttons opens the Template Designer dialog box, which 
contains the following tabs: 
• Report Fields 
• Title Section 
• Data Section 
• Size and Orientation 
• Records Filtering 
• Sorting 
 

Report Fields 
As the Template Designer dialog box opens, it defaults to the Report Fields tab, shown below. 
Here you can configure which alarm columns to report, the order in which they are to be reported, 
and the amount of space each category will take on the report.   
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Report Fields Tab of Template Designer Dialog Box 

To select columns to be reported, simply check the appropriate items in the list box.  To change the 
order of an item, highlight the item and click the Move Up and Move Down buttons. You will see the 
item move up and down the list as you do so. When you select an item, you can also specify a width 
as a percentage of the width of the entire report. You can rename the header title by clicking the 
Rename Header button and filling in the appropriate text, or you can simply click on the header text 
itself and wait for the cursor to appear. 
 

Title Section 
The Title Section tab of the Template Designer dialog box, shown below, allows you to configure a 
title for your report.  Simply adjust the text, colors, borders, font, shadowing, and alignment of your 
title and subtitle to match the desired appearance. 

 
Title Section Tab of Template Designer Dialog 
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Data Section 
The Data Section tab of the Template Designer dialog box, shown below, configures the 
appearance of the headers and fields of your reported data.  Adjust the font, cell padding, and text 
color of the column headers in the Field Headers frame.  You can change the style, thickness, and 
color of the header dividers by adjusting the Line Style, Pen Size and Line Color items in the 
Header Divider frame. To adjust the appearance of the reported data and dividers, make the 
appropriate modifications to the Field Data and Data Records Divider frames. 

 
Data Section Tab of Template Designer Dialog Box 

Size and Orientation 
The Size and Orientation tab of the Template Designer dialog box, shown below, adjusts the 
margins for the final report. Simply fill in the margin fields as needed.  Adjust the paper size by 
selecting an item from the Format report to paper size drop-down list.  (The default is 8.5 x 11 
inches.) You can also specify a Portrait (vertical) or Landscape (horizontal) orientation for the 
report. 

 
Size Tab of Template Designer Dialog Box 
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Records Filtering 
You can configure filters for your reports on the Records Filtering tab of the Template Designer 
dialog box, shown below.  Records can be reported either from the grid or from the alarm table.  
One level of filtering marks the difference between reporting alarms from the grid and reporting 
alarms from the table.  The alarms that make it from the table to the grid are the ones that pass 
through the filter defined in the Record Filtering tab of the Alarm Report ActiveX Properties 
dialog box. The records chosen, whether from the alarm table or from the grid, can be filtered for 
reporting in the Available Filters list. (In case you are reporting only records shown on the grid, this 
is a second level of filtering from the alarm table to the report)  The adding, deleting, and configuring 
of filters is handled the exact same way as on the Record Filtering property tab. 

 
Records Filtering Tab of Template Designer Dialog Box 

Sorting 
The Sorting tab of the Template Designer dialog box, shown below, provides three options for 
sorting alarm records in your report. You can choose not to sort at all by selecting the Do not sort 
option.  If the Use sorting order from the grid option is selected, then the report sorting defaults to 
the sorting defined on the Records Sorting tab of the Alarm Report ActiveX Properties dialog 
box. You can override the grid sorting by choosing Select a Field to set sorting options on.  Set 
your sorting parameters with the list box and options below. For detailed information on configuring 
your custom sorting, see the Records Sorting section. 
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Sorting Tab of Template Designer Dialog Box 

Summary 
The Summary tab of the Alarm Report ActiveX Properties dialog box, shown below, configures 
the content and appearance of summary information to be displayed on the alarm report grid in 
runtime mode. The Select Category drop-down list specifies the category of alarm to be displayed 
in the summary.   

 
Alarm Report ActiveX Summary Tab 

You can also select a title and click the Config… button. This opens the Set Column dialog box for 
the selected category, as shown below. Here you can adjust the font, color, and appearance of the 
selected alarm category. The title and configuration on under Summary Column are used to modify 
the appearance of the values associated with the Summary Category. 
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Setting the Summary Column/Category Characteristics 

Web Access 
The Web Access tab of the Alarm Report ActiveX Properties dialog box, shown below, allows 
you to access the currently connected Alarm Logger database over the Internet via a Remote Data 
Service (RDS). The RDS, which is hosted by an Internet Information Server (IIS), enables the 
downloading of report data from the logger database to a client over the Internet. Simply specify the 
URL name or IP address of the IIS Web server in the Internet Information Server for Remote 
Data Access field, as shown in the figure below. You can also specify a maximum number of 
database records to download from the logger database. The default maximum number of records is 
1,024. 

 
Alarm Report ActiveX Web Access Tab 

When Internet Access to the logger database is enabled, the client makes a request over the 
Internet to the IIS Remote Data Service. The RDS uses a special component, called the Data 
Factory Handler, to relay the request to the local logger database on the server, as shown in the 
figure below. The RDS retrieves the relevant information for the alarm report from the logger 
database so that the client can download the data from the server over the Internet. The client 
machine then displays the data in the Report ActiveX per the client's report configuration settings. 
In most typical scenarios, the Report ActiveX configuration is done on the server side. Those steps 
include:  
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• Connection to the database is established by clicking the Connection Parameters button on 
the General tab of the Report ActiveX Properties dialog and using the Database Connection 
dialog. 
• Internet access settings are enabled on the Web Access tab. 
• Configuration data saved as a *.awr file or a *.gdf display containing the Report ActiveX are 
published to an HTML document on a WebHMI server. 

 
Downloading Alarm Report Data From a Remote Logger Database 

Tips for Remote Data Access 
A good understanding of Remote Data Access principles is a key element to building a successful 
solution for a Web-enabled alarm reporting system. Since the volume of alarm databases can reach 
hundreds of megabytes, it is very important to keep in mind the following aspects. 
 
Maximum Number of Downloadable Database Records and Adequate Record Filtering 
The setting for the maximum number of records to download (Nmax) indicates that any database 
query operations would return no more than Nmax alarm records (lines to the grid). If more than 
Nmax records from the current table match the current filtering criteria, then only the portion of the 
record set containing top Nmax records is returned. To avoid such record set cut-off, strong 
restrictive record filters should be used all the time. Since the record filters are processed on the 
database side, the database server uses all existing records to build the record set.  
 
Proper Choice of the Back-end Database 
It should be noted that the use of Microsoft Access databases (*.mdb) is not recommended for Web 
Access. Poor memory management in Microsoft Jet Engine creates a serious scalability problem for 
any type of Web database application. The recommended back-end database for Web alarming 
is MSDE (Microsoft Desktop Engine) or Microsoft SQL Server. 
  
Table Management in Alarm Logger Configuration 
To provide further optimization for the Alarm Logger database operations, the table management 
should be enabled in the logger configuration. See the Alarm Logger Configurator documentation for 
more information. 
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Using the Remote Database Access Manager 
The AlarmWorX Remote Database Access Manager, shown in the figure below, is a separate 
utility (the AWXRepRDSSM.exe file) located in the ProcessView Bin directory. This utility configures 
the communication parameters for the Data Factory Handler (described above) so that the 
AlarmWorX Report ActiveX can connect to a remote Alarm Logger database and retrieve data from 
the database. It also enables security for remote database access via the ProcessView Security 
Server. 

 
AlarmWorX Remote Database Access Manager 

Database Connection Options 
The Database Connection Options section of the AlarmWorX Remote Database Access Manager 
sets the following connection parameters for the Data Factory Handler: 
• Connection Retry Number: Specifies the maximum number of times the Data Factory Handler 
will try to reconnect to the Alarm Logger database in case the connection fails. 
• Connection Retry Delay: Sets the amount of time (in seconds) the Data Factory Handler waits 
between subsequent connection retries to the Alarm Logger database. 
Security Management 
The AlarmWorX Remote Database Access Manager allows you to enable security for remote 
database access via the ProcessView Security Server. Check the Enable Security Management 
for Remote Database Access (via Security Server) check box. When security is enabled, each 
time a user tries to access the Alarm Logger Database, the Security Server will check to verify 
whether that user is allowed to have remote access to the database. 
Note: For information about the Security Server configuration and login, please see the Security 
Configurator and Security Login Help documentation.  
Because the database is accessed over the Internet via TCP/IP communications, GenBroker 
communications over OPC over TCP/IP must also be enabled. Thus, you must specify a 
GenBroker Configuration File (.gbc or .gbx). Clicking the … button to the right of this field allows 
you to browse for a GenBroker configuration file, as shown in the figure below. If you do not specify 
a GenBroker configuration file, or if no Security Server is specified in the GenBroker configuration, 
then the default system GenBroker configuration file will be used. 
Note: If you are using WebHMI, it is recommended that the Security Server be located on the same 
machine as the WebHMI Server. For information about how to configure GenBroker 
communications, please see the GenBroker Help documentation. 
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The GenClient Updates Timeout sets the maximum amount of time (in seconds) the Data Factory 
Handler will wait for Security Server validation of a data request from the client (i.e. the client with 
the Alarm Report ActiveX installed) before returning an "Access Denied" error. 

 
Selecting a GenBroker Configuration File 

 

Security 
To access the Smar security server, either select Security > Configuration from the Tools menu, 
or click the Security button on the toolbar. This opens the Security Server Login dialog box, as 
shown below.  

 
Security Server Login 

Enter your User Name and Password, and then click OK.  This opens the Smar Security Server 
Configurator, where it will be possible to access the Security Server. Depending on your configured 
level of security, you may or may not be able to edit components of the Security Server.   
Note: For more information about security, please see the Security Configurator help 
documentation.   
Once a user has gained access, the Smar Security Server dialog box will appear.  From the Edit 
menu, choose Application Actions. The Actions/Users Association dialog box appears as 
shown below.   
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Editing Security Actions and User Associations 

The Security Server can be set up to allow access to several different actions from this dialog.  To 
set the options for the AlarmWorX Report ActiveX, select AWXReport from the list in the right pane.  
This brings up the list in the left pane, which includes the following options: 

 Add Filter 
 Change Chart Type 
 Change Filters 
 Change Grid/Chart View 
 Change Sort 
 Change Summary/Details View 
 Delete Filter 

 Edit Filter 
 Navigate Through Tables 
 Print 
 Rearrange Columns 
 Resize Columns 
 Run Crystal Reports 
 Toggle Toolbar 

Global-Aliasing Support 
The AlarmWorX Report ActiveX supports Global Aliasing by interfacing to the Smar Global Aliasing 
System Engine Server.  
Currently the AlarmWorX Report ActiveX supports machine-level and process-level aliasing. All 
fields that support aliasing have been interfaced to the Global Alias Browser dialog, which is evoked 
by clicking on the … button in the configuration.  
In addition, the AlarmWorX Report ActiveX now has an integrated Global Alias Browser. 
When specifying a global alias in the Alarm Report ActiveX Properties dialog box, you can also 
select a global alias from the Global Alias Browser, which includes all global aliases in the Global 
Aliasing System database. This eliminates the need to manually type in the alias name. Clicking the 
... button and selecting Global Alias Browser from the pop-up menu opens the Global Alias 
Browser, as shown in the figure below. The Global Alias Browser is available for the following: 
• Title, Configuration File, and URL Path sections of the Alarm Report ActiveX Properties 
dialog box General tab 

• Records filtering  
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Opening the Global Alias Browser in the Report Properties 

All global aliases that are configured in the Global Alias Engine Configurator are conveniently 
available to choose from inside the browser. The tree control of the Global Alias Engine Configurator 
is mimicked in the tree control of the Global Alias Browser. Select a global alias by double-clicking 
the alias name (e.g. "Floor" in the figure below). The alias name appears at the top of the browser, 
which automatically adds the <# and #> delimiters to the alias name. Click the OK button. 

 
Selecting an Alias From the Global Alias Browser 

Asynchronous Downloading features 
The AlarmWorX Report ActiveX supports asynchronous downloading of configuration data when 
used inside SMAR ActiveX document servers, such as GraphWorX, to produce documents, which 
can be viewed using Microsoft Internet Explorer. 
To enable this feature, select URL Path from the General tab of the Alarm Report ActiveX 
Properties dialog box, shown below, and supply a URL path. In the case of viewing ActiveX 
documents within an intranet setup, you can supply a server name and directory specifying the 
location of the AlarmWorX Report configuration data (must be a shared directory), by using the 
convention "file:\\Server Name\Directory\File Name.awr." 
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Alarm Report ActiveX Properties: General Tab 

Runtime Mode 
To enter runtime, either click the Enter Runtime button on the toolbar or select Runtime Mode from 
the Actions menu.  Once in runtime, the following data grid appears.  

 
Runtime Mode 

Note: If runtime mode does not show any data, make sure you have established a connection with 
an Alarm Logger database. You can connect to a database by clicking Connection Parameters on 
the General tab of the Alarm Report ActiveX Properties dialog box while in configuration mode. 
Also, if you deleted one of the three default columns (EventTime, Tag, or Message), the Report 
ActiveX will be disabled in runtime mode.  
Double-clicking anywhere on the Alarm Report ActiveX during runtime mode opens the Alarm 
Report toolbar, as shown in the figure below. Using the toolbar, you can execute certain operations 
and change how the data are viewed.   

 
Alarm Report Toolbar 
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There are two different views to choose from: Data Grid or Chart Summary.  When viewing the Data 
Grid, you can further choose from a detailed report or a summary report.  These views are 
described in the sections below along with the other tool button options. 

Data Grid 
By default, the Alarm Report ActiveX runtime screen displays the Data Grid > Details view, as 
shown below.  The Data Grid displays all data for the alarms in the report.  The reported elements 
are determined by the columns selected during configuration.  Additionally, you may be able to 
change the view slightly by changing the width of the columns (if this option was enabled during 
configuration).   

 
Data Grid Details View in Runtime Mode 

To view a summary of the data, double-click the grid and then click the Alarm Summary button on 
the Alarm Report toolbar. The view changes to display only the Tag name and the Alarm Summary, 
as shown in the figure below. The data are listed, from highest to lowest, by the number of alarms.   

 
Data Grid Summary View in Runtime Mode 

Chart Summary 
To view a bar chart or pie chart summary of the Alarm Report data during runtime mode, double-
click the Alarm Report ActiveX and then click the Chart Summary buttons on the Alarm Report 
toolbar. The number of items charted depends on the options selected on the Record Filtering tab 
of the Alarm Report ActiveX Properties dialog box.  If no filters are enabled, all alarm types are 
charted.   
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Bar Charts 
A Bar Summary Chart, shown in the figure below, shows how many alarms of each type are 
present in the database that is being reported. If scrolling was enabled in the Charts Configuration 
tab of the Alarm Report ActiveX Properties dialog box, an Enable Scrolling button appears at the 
base of the bar chart summary, as shown below. Click this button to scroll left or right between bars 
on the chart using the arrows. 

 
Bar Chart Summary 

Pie Charts 
A Pie Summary Chart, shown in the figure below, shows what percentage of each alarm type 
exists in the report.   

 
Pie Chart Summary 

Printing Current Alarms 
The Print Current Alarms button on the Alarm Report toolbar opens the standard Print dialog 
box, where you can choose your printing settings. The current view will be printed with the date, 
time, description, and page number at the top of the page. 

Choosing a Crystal Report Template 
If you have configured any reporting templates on the Reporting tab in configuration mode, you will 
see one to five reports on the Alarm Report toolbar from which to choose.  Clicking on a report 
button launches a Crystal Reports viewer, showing the selected report.  From there, all of the 
features of Crystal Reports are at your disposal for printing, formatting, and saving your report.  A 
sample Crystal Report is shown below. 
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Sample Report 

Updating Alarm Data 
Clicking the Update Alarm Data button on the Alarm Report toolbar refreshes the data shown in 
the Alarm Report ActiveX during runtime with the most current alarm data from the connected Alarm 
Logger database. 

Adjusting Column Width 
During runtime mode, you can adjust each column in the Alarm Report ActiveX data grid 
independently by moving the cursor over the vertical line between each column (a double arrow will 
appear) and moving the line while holding down the mouse button. 

Sorting and Filtering Data Using the Alarm Report Toolbar 
The last two buttons before the left and right arrows on the Alarm Report toolbar are used to sort 
and filter the alarm data.  
Clicking the Sort Alarms button on the toolbar opens the Sorting Fields dialog box accessed 
through the Records Sorting tab of the Alarm Report ActiveX Properties dialog box. 
Clicking the Filter Alarms button on the toolbar opens the Records Filtering dialog box, shown 
below. For information about adding, removing, and configuring filters, please see the Record 
Filtering section. 

 
Alarm Filtering 
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OLE Automation 
Introduction 

This reference describes the OLE Automation features available in the AlarmWorX Report.  

Automation Interfaces 
The AlarmWorX Report provides a COM interface that allows automation interfaces run from within 
the ActiveX container to manipulate the Report ActiveX control as it is running. The interface is 
available to all programming languages that support COM, including Visual Basic (VB), Visual Basic 
for Applications (VBA), and Microsoft Visual C++. 
To access the Automation interface from VB and VBA, AlarmWorX Report must be made available 
by choosing Project > Components from the main menu in the VB or VBA development 
environment and selecting Smar AWXRep ActiveX in the list of available components. 

The description of every property or method in this reference is followed by the code example for 
typical use of that property or method.  The example code is written in Visual Basic for Applications 
(VBA) language, built in the AlarmWorX container application (Awx.exe). It assumes that AWXRep 
ActiveX is embedded within AlarmWorX display and its name property is set to "AWXRep1." 

Available Control Properties 
AWXRepTitle 
Type: String 
Description 
Sets/gets title string on General property page. 

Example 
Dim strNewTitle as String 

ThisDocument.AWXRep1.AWXRepTitle=strNewTitle 

 

AppearanceMode 
Type: Long 
Description  
Determine the appearance of data grid. This property can be one of the following: 
 0 - flat look 
1 - 3D look 

Example  
Sets 3D look for the grid. 
ThisDocument.AWXRep1.AppearanceMode=1        

 

BackColor 
Type: OLE_COLOR  
Description  
Sets/gets grid background color. 

Example 
Sets grid background color to cyan. 
ThisDocument.AWXRep1.BackColor=RGB(0,255,255)   
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BorderType 
Type: String 
Description  
Set/get control's border appearance. Can be one of the following: 
"0" - none 
"1" - flat border 
"2" - 3D border 

Example 
Set 3D look for the control's border. 
ThisDocument.AWXRep1.BorderType="2" 

 

ChartBackColor 
Type: OLE_COLOR  
Description 
Set/get summary chart background color. 

Example 
Set summary chart background color to white. 

ThisDocument.AWXRep1.ChartBackColor=RGB(255,255,255) 
 

ChartLegendHeight 
Type: Short 
Description 
These properties determine the dimensions of the corresponding chart element. The width and 
height of a particular chart element are given in percents of the total width or height of the chart 
area. 
 

ChartLegendLeft 
ChartLegendTop 
Type: Short 
Description 
These properties determine the location of the corresponding chart element within the chart area. 
The coordinates are given in percents of the total width or height of the chart area, assuming that 
the coordinate origin (point {0, 0}) is located at the left top corner of the chart area. 
 

ChartLegendVisible 
Type: Boolean 
Description 
These properties set/get the visibility of chart legend and/or title. Setting either property to FALSE 
will hide the corresponding chart element. 
Default value: TRUE    
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ChartLegendWidth 
Type: Short 
Description 
These properties determine the dimensions of the corresponding chart element. The width and 
height of a particular chart element are given in percents of the total width or height of the chart 
area. 
 

ChartPlotHeight 
Type: Short 
Description 
These properties determine the dimensions of the corresponding chart element. The width and 
height of a particular chart element are given in percents of the total width or height of the chart 
area. 
 

ChartPlotLeft 
ChartPlotTop 
Type: Short 
Description 
These properties determine the location of the corresponding chart element within the chart area. 
The coordinates are given in percents of the total width or height of the chart area, assuming that 
the coordinate origin (point {0, 0}) is located at the left top corner of the chart area.   
 

ChartPlotWidth 
Type: Short 
Description 
These properties determine the dimensions of the corresponding chart element. The width and 
height of a particular chart element are given in percents of the total width or height of the chart 
area. 
 

ChartTitle 
Type: String 
Description 
Set/get a string value that appears in the summary chart title area. 
Example 
ThisDocument.AWXRep1.ChartTitle="Alarm Summary By Tags" 

 

ChartTitleHeight 
Type: Short 
Description 
These properties determine the dimensions of the corresponding chart element. The width and 
height of a particular chart element are given in percents of the total width or height of the chart 
area. 
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ChartTitleLeft 
ChartTitleTop 
Type: Short 
Description 
These properties determine the location of the corresponding chart element within the chart area. 
The coordinates are given in percents of the total width or height of the chart area, assuming that 
the coordinate origin (point {0, 0}) is located at the left top corner of the chart area. 
 

ChartTitleUpdateOnDataSelect 
Type: Boolean 
Description 
Set/get the value of a flag that determines whether the chart title is updated when user clicks on a 
data series (either bar or pie segment) inside the plot. If set to TRUE (default), the name of 
selected data series is attached to the chart title. 
 
ChartTitleVisible 
Type: Boolean 
Description 
These properties set/get the visibility of chart legend and/or title. Setting either property to FALSE 
will hide the corresponding chart element. 
Default value: TRUE    
 

ChartTitleWidth 
Type: Short 
Description 
These properties determine the dimensions of the corresponding chart element. The width and 
height of a particular chart element are given in percents of the total width or height of the chart 
area. 
 

ChartType 
Type: Integer 
Description 
Set/get the type of alarm summary chart. Can be one of the following: 
0 - bar type 
1 - pie type 

Example 
Set summary chart to pie type.  
ThisDocument.AWXRep1.ChartType=1 
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Columns 
Type: String 
Description 
Sets/gets comma-separated list of database columns to be shown on grid. 

Example 
This line configures control to show only EventTime, Tag and Message columns. 
ThisDocument.AWXRep1.Columns="EventTime, Tag, Message" 

 
Remarks 
If database column name contains one or more space characters, the column name should be 
enclosed in square brackets, as in this example: 

ThisDocument.AWXRep1.Columns="[Column 1], [Column 2]" 

 
ConnectionString 
Type: String 
Description 
Sets/gets ADO connection string used by AWXReport control to access data. 

Example 
Dim strConnString as String 

strConnString="Provider=Microsoft.Jet.OLEDB.4.0; _ 

 Data Source=c:\alarms\AWXLog.mdb; _ 

 User ID=Admin; Password=SYSTEM" 

ThisDocument.AWXRep1. ConnectionString = strConnString 

 

DisplayActiveFilterName 
Type: Boolean 
Description 
Set/get Boolean value that controls whether the active filter(s) name(s) is(are) shown on the 
grid title bar. 
Example 
ThisDocument.AWXRep1. DisplayActiveFilterName = TRUE 
 

DisplayGridTitle 
Type: Boolean 
Description 
Set/get Boolean value that controls the visibility of the grid title bar. 
Example 
ThisDocument.AWXRep1. DisplayGridTitle = TRUE 

 



AlarmWorX 
 

 4.33 

EnableToolbar 
Type: Boolean 
Description 
Setting this property to FALSE prohibits the floating toolbar to pop up when user 
double-clicks inside the control.  

Default value - TRUE. 
Example 
To disable tools 
ThisDocument.AWXRep1.EnableTools=FALSE 

 

FilteringString 
Type: String 
Description 
Set/get SQL WHERE statement that determines filtering of alarm data. 

Example 
These statements configure control to show only Humidity alarms or Pressure alarms. 
Dim strFiltrStmt as String 

strFiltrStmt="WHERE  (Tag='Humidity' OR Tag='Pressure') " 

ThisDocument.AWXRep1. FilteringString = strFiltrStmt 

 

Font 
Type: StdFont 
Description 
Return a reference to the control's default font. 
Example 
To set control's default font to Arial, 14 pt., use the following statements: 
With ThisDocument.AWXRep1.Font 

.Name="Arial" 

.Size=14 

End With 

 

ForeColor 
Type: OLE_COLOR 
Description 
Set/get Forecolor property of data grid. 

Example 
ThisDocument.AWXRep1. ForeColor=RGB(0,0,0) 
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GridBackColor 
Type: OLE_COLOR 
Description 
Set/get color value used to paint the gaps between rightmost column and right edge 
of the grid, last row and bottom edge of the grid, and row headers column (the 'back 
area' of the grid). 
Example 
ThisDocument.AWXRep1. GridBackColor =RGB(0,127,0) 
 

GridBorderStyle 
Type: Long 
Description 
Set/get the style of data grid border. Can be one of the following: 
0 - no border 
1 - fixed single border style 

Example 
ThisDocument.AWXRep1.GridBorderStyle=1 

 

GridDefRowHeight 
Type: Integer 
Description 
Set/get the default row height for data grid. 

Example 
ThisDocument.AWXRep1. GridDefRowHeight=16 

 

GridHorizLinesColor and GridVertLinesColor 
Type: OLE_COLOR 
Description 
Set/get color for horizontal or vertical grid lines. 

Example 
ThisDocument.AWXRep1. GridHorizLinesColor =RGB(127,127,127) 

ThisDocument.AWXRep1. GridVertLinesColor = RGB(127,127,127) 

 

GridHorizLinesStyle and GridVertLinesStyle 
Type: Integer 
Description 
Set/get style for horizontal or vertical grid lines. Can be one of the following: 
0 - no line 
1 - solid line 
2 - dot line 
3 - dashdot line 
4 - dashdotdot line 
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Example 
ThisDocument.AWXRep1. GridHorizLinesStyle =0 

ThisDocument.AWXRep1. GridVertLinesStyle = 2 

 

GridHorizLinesWidth and GridVertLinesWidth 
Type: Integer 
Description 
Set/get the widths for the horizontal or vertical grid lines when corresponding grid line style 
(property GridHorizLinesStyle or GridVertLinesStyle) is set to 1 - solid line. For all other line 
styles, these properties must be set to 1. 

Example 
Sets both horizontal and vertical grid lines to solid line style, 2 pixels wide. 
ThisDocument.AWXRep1. GridHorizLinesStyle =1 

ThisDocument.AWXRep1. GridVertLinesStyle = 1 

ThisDocument.AWXRep1. GridHorizLinesWidth =2 

ThisDocument.AWXRep1. GridVertLinesWidth = 2 

 

GridTitleBackColor 
Type: OLE_COLOR 
Description 
Set/get the background color for the grid's title bar. 

Example 
Sets title bar background color to dark blue. 
ThisDocument.AWXRep1. GridTitleBackColor =GRB(0,0,127) 

 

GridTitleTextColor 
Type: OLE_COLOR 
Description 
Set/get the text color for the grid's title bar. 

Example 
Sets grid's title bar text color to yellow. 
ThisDocument.AWXRep1. GridTitleBackColor =GRB(255,255,0) 

 
HeaderColor 
Type: OLE_COLOR 
Description 
Set/get the background color for grid's column headers. 

Example 
Sets color of grid's column header to dark green. 
ThisDocument.AWXRep1. GridTitleBackColor =GRB(0,127,0) 
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IsConnected 
Type: Boolean 
Description 
This is read-only property, indicating that control is connected to the database. 

Example 
If  ThisDocument.AWXRep1.IsConnected Then 

 ``` do something here  ``` 

End If 
 

NoSorting 
Type: Boolean 
Description 
Set/get Boolean value that indicates whether records sorting has been enabled or not. By 
default, this property is set to TRUE (sorting disabled), providing best data retrieval 
performance. 

Example 
To enable sorting: 
ThisDocument.AWXRep1.NoSorting=FALSE 

 

QueryText 
Type: String 
Description 
Set/get the SQL statement used to populate data grid in detailed report mode. 

Example 
Dim strQry as String 

strQry=ThisDocument.AWXRep1.QueryText 

MsgBox strQry 

 

Remarks 
Though this property is read/write, it is not recommended to set 
QueryText directly. Instead, you can set the Columns, 
FilteringString, and SortingString properties, then the value of 
QueryText will be automatically updated. 
 

QueryTextSummary 
Type: String 
Description 
Set/get the SQL statement used to populate data grid in alarm summary mode. 

Example 
Dim strQrySmr as String 

strQrySmr=ThisDocument.AWXRep1.QueryTextSummary 

MsgBox strQrySmr 
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Remarks 
Though this property is read/write, it is not recommended to set QueryTextSummary directly. 
Instead, you can set the SummaryColumn, FilteringString, SortingString, or 
SummaryFieldSortDir properties. The value of QueryTextSummary will then be 
automatically updated. 
 

ReportFileAlarms 
These properties should be considered obsolete in version 6.1. They are 
supported only for backwards compatibility. 
 

RowDividerStyle 
Type: String 
Description 
Set/get the appearance of row divider on data grid (horizontal grid lines). Can be one of the 
following: 
0 - No dividers 
1 - Black line 
2 - Dark gray line 
3 - Raised 
4 - Inset 
5 - Use ForeColor 
6 - Light gray line 
This property can be used to set the appearance of both vertical and horizontal grid lines in 
one statement.  The same can be done using the GridHorizLineColor and 
GridVertLinesColor properties independently. 
Example 
To set Black row divider: 
ThisDocument.AWXRep1.RowDividerStyle=1 

 

ShowSummaryChart 
Type: Boolean 
Description 
Set/get the Boolean value that controls how alarm records are reported. Use this property to 
toggle between Chart and Grid Display modes. 
Examples 
This statement brings control into Chart Display mode: 
ThisDocument.AWXRep1. ShowSummaryChart=TRUE 

 
This statement brings control into Grid Display mode: 
ThisDocument.AWXRep1. ShowSummaryChart=FALSE 

 

ShowSummaryGrid 
Type: Boolean 
Description 
Set/get the Boolean value that controls how alarm records are reported in Grid Display mode. 
Use this property to toggle between Detailed and Summary views in Grid Display mode. 
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Remarks 
If control is in the Chart mode, setting ShowSummaryGrid property will not have immediate 
effect. Only after ShowSummaryChart  property is switched to FALSE (Grid mode), will the 
desired grid view be displayed.  
 

Examples 
These statements bring the control into Detailed Grid Display mode: 
ThisDocument.AWXRep1. ShowSummaryChart =FALSE 

ThisDocument.AWXRep1. ShowSummaryGrid =FALSE 

 
This statement brings the control into Summary Grid Display mode: 
ThisDocument.AWXRep1. ShowSummaryGrid =TRUE 

 
SortByDblClick 
Type: Boolean 
Description 
Set/get Boolean value indicating that records will be sorted by values in the particular grid's 
column when user double-clicks on that column's header. Subsequent double clicks on the 
same column header will reverse sorting direction.  
 
Remarks 
The sorting action will occur only if the NoSorting property is set to FALSE. 
 
Example 
ThisDocument.AWXRep1. NoSorting =FALSE 

ThisDocument.AWXRep1. SortByDblClick=TRUE 

 

SortingString 
Type: String 
Description 
Set/get SQL ORDER BY statement that determines sorting of alarm data. 

Example 
Configures control to sort alarm data by EventTime in ascending order. 
Dim strSortStmt as String 

strSortStmt="ORDER BY EventTime ASC " 

ThisDocument.AWXRep1. SortingString = strSortStmt 
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SummaryColumn 
Type: String 
Description 
Set/get database column name, by which the alarm records are grouped for Summary Grid 
view and Summary Chart. By default, this is "[Tag]" column. 

Example 
This statement changes the database column to summarize records by "Area": 
ThisDocument.AWXRep1.SummaryColumn="[Area]" 
 

SummaryFieldSortDir 
Type: Integer 
Description 
Set/get sort direction for the Summary field on the Summary Grid view or Summary 
Chart. Can be one of the following: 
0 - ascending 
1 - descending 
Example 
This statement changes the Summary field sort direction to descending: 
ThisDocument.AWXRep1. SummaryFieldSortDir=1 
 

TableName 
Type: String 
Description 
Set/get name of the current database table.  

Example 
ThisDocument.AWXRep1.TableName="EventLog" 
 

ToolsVisible 
Type: Boolean 
Description 
Set/get visibility of toolbar. 

Example 
To show toolbar: 
ThisDocument.AWXRep1.ToolsVisible=TRUE 

 

ToolXPos 
Type: Integer 
Description 
Set/get the X coordinate of toolbar's left top corner (in device units). 

Example 
ThisDocument.AWXRep1.ToolXPos=255 
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ToolYPos 
Type: Integer 
Description 
Set/get the Y coordinate of toolbar's left top corner (in device units). 

Example 
ThisDocument.AWXRep1.ToolYPos=100 

 

AutoUpdateInterval 
Type: Short 
Description 
Set/get the number of seconds between automatic updates. 

Example 
ThisDocument.AWXRep1.AutoUpdateInterval=60 

 
BlinkOnUpdate 
Type: Boolean 
Description 
Set/get whether or not the Report ActiveX will blink on update. 
Example 
ThisDocument.AWXRep1.BlinkOnUpdate=True 

 
ChartGlobalScaling 
Type: Boolean 
Description 
Enable/disable global scaling of the chart. 

Example 
ThisDocument.AWXRep1.ChartGlobalScaling=True 
 

ChartScrolling 
Type: Boolean 
Description 
Enable/disable chart scrolling. 
Example 
ThisDocument.AWXRep1.ChartScrolling=True 

 
ChartScrollSize 
Type: Short 
Description 
Indicates how many items you can scroll through on the chart at one time. 

Example 
ThisDocument.AWXRep1.ChartScrollSize=10 
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ChartTruncateNumber 
Type: Short 
Description 
Sets/gets the size at which long strings are truncated.  Must have ChartTruncateStrings property 
set to “True” in order for this to take effect. 

Example 
ThisDocument.AWXRep1.ChartTruncateNumber=8 
 

ChartTruncateStrings 
Type: Boolean 
Description 
Enable/disable the truncation of strings longer than the ChartTruncateNumber. 
Example 
ThisDocument.AWXRep1.ChartTruncateStrings=True 
 

EnableAutoUpdate 
Type: Boolean 
Description 
Enable/disable automatic updates. 
Example 
ThisDocument.AWXRep1.EnableAutoUpdate=True 
 

EnableWebAccess 
Type: Boolean 
Description 
Enable/disable Report ActiveX web access. 
Example 
ThisDocument.AWXRep1.EnableWebAccess=True 

 
FileName 
Type: BSTR 
Description 
Set/get the name of the Report ActiveX configuration file. 
Example 
ThisDocument.AWXRep1.FileName=”C:\AwxRepConfig.awr” 
 

MaxRecords 
Type: Long 
Description 
Set/get the maximum number of records that the Report ActiveX will fit. 

Example 
ThisDocument.AWXRep1.MaxRecords=1024 
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RemoteDataServer 
Type: BSTR 
Description 
This is the Internet Information Server for remote data access. 

Example 
ThisDocument.AWXRep1.RemoteDataServer = “http://localhost” 
 

URLPathName 
Type: BSTR 
Description 
Set/get the URL path for a configuration file over the web.  Must set URLPathUsed to “True” for 
this to take effect. 

Example 
ThisDocument.AWXRep1.URLPathName= 
”http://www.smar.com/awxrepcfg.awr” 

 
URLPathUsed 
Type: Boolean 
Description 
Enable/disable the use of a URL path. 

Example 
ThisDocument.AWXRep1.URLPathUsed=True 
 

UseLocalSettings 
Type: Boolean 
Description 
Tell a URL-enabled Report ActiveX whether or not to use local settings. 
Example 
ThisDocument.AWXRep1.UseLocalSettings=True 

 

Available Control Methods 
AboutBox 
Shows About dialog box. 

Example 
ThisDocument.AWXRep1.AboutBox 
 

Connect As Boolean 
Forces the control to establish connection to database, using the information set in 
ConnectionString and TableName.  If control is already connected, the current connection will be 
closed and a new connection will be established. This method can be used in VBA scripts 
automatically to switch the report ActiveX between different databases. 
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Return Value 
On success, returns TRUE; if for any reason connection cannot be established, returns FALSE. 

Example 
Dim strConnString as String 

strConnString="Provider=Microsoft.Jet.OLEDB.4.0; _ 

Data Source=c:\alarms\SomeOtherDatabase.mdb; _ 

User ID=Admin; Password=SYSTEM" 

ThisDocument.AWXRep1. ConnectionString = strConnString 

ThisDocument.AWXRep1.TableName="SomeOtherTable" 

ThisDocument.AWXRep1.Connect 

ThisDocument.AWXRep1.Refresh 

 

GetColumnHeaderText(iColIndex As Integer) As String 
Returns the header text for the grid column specified by iColIndex argument. The iColIndex 
argument is 1 - based index of the column, counting from the left of the grid. In Summary Grid view, 
iColIndex can be either 1 or 2; in Detailed Grid view, it can be from 1 to the maximum number of 
entries in the Columns property 

Example  
Dim strHeader1 

strHeader1=ThisDocument.AWXRep1.GetColumnHeaderText(1) 

 

GetColumnWidth(iColIndex As Integer) As Integer 
Returns the width of the column specified by iColIndex argument. The iColIndex argument is 1 - 
based index of the column, counting from the left of the grid. In Summary Grid view, iColIndex can 
be either 1 or 2; in Detailed Grid view, it can be from 1 to the maximum number of entries in the 
Columns property. The width is given in logical units, depending on the selected font. 

Example 
Retrieves the current width on the leftmost column: 
Dim cx1 As Integer 

cx1=ThisDocument.AWXRep1.GetColumnWidth(1) 

 

LaunchReport(iTemplateIndex As Integer)  As Integer 
Create Crystal Report based on the template specified by iTemplateIndex parameter. The value of 
argument iTemplateIndex can be 0 through 4 (there might be up to 5 different Crystal Report 
templates). 

Return value 
On success, returns 0; if a template for certain index does not exist or is not configured (in which 
case the Crystal Report button on the toolbar at the position corresponding to that index, counting 
from left, is grayed), return value is (-1). 

Example 
Creates Crystal Report based on the third template from the left, as seen on the Reporter's toolbar: 
If  ThisDocument.AWXRep1.LaunchReport(2)=-1 Then 

 MsgBox " It looks like the template specified is not configured"  

End If 
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Print 
Description 
Prints detailed alarm data, alarm summary, data or alarm summary chart depending on the current 
state of AWXReport control. 

Example 
ThisDocument.AWXRep1.Print 
 

Refresh 
Description 
Update alarm data by requerying the database. 

Example 
ThisDocument.AWXRep1.Refresh 
 

SetColumnHeaderText(iColIndex As Integer, strNewText As String) 
Set the header text for the grid column specified by iColIndex argument. The iColIndex argument is 
1 - based index of the column, counting from the left of the grid. In Summary Grid view, iColIndex 
can be either 1 or 2; in Detailed Grid view, it can be from 1 to the maximum number of entries in the 
Columns property. 
Example 
ThisDocument.AWXRep1.SetColumnHeaderText(1,"Column1") 
 

SetColumnWidth(iColIndex As Integer, iNewWidth As Integer) 
 
Sets the width of the column specified by iColIndex argument to iNewWidth. The iColIndex 
argument is 1 - based index of the column, counting from the left of the grid. In Summary Grid view, 
iColIndex can be either 1 or 2; in Detailed Grid view, it can be from 1 to the maximum number of 
entries in the Columns property. The width is given in logical units, depending on the selected font. 

Example 
Doubles the current width on the leftmost column: 
Dim cx1 As Integer 

cx1=ThisDocument.AWXRep1.GetColumnWidth(1) 

ThisDocument.AWXRep1.SetColumnWidth(1, 2*cx1) 
 

LoadConfigFile(BSTR newVal) as Boolean 
Load the configuration file specified in newVal. 
Example 
Dim ret As Boolean 

ret = AWXRep1.LoadConfigFile(“C:\My Configs\cfg.awr”) 
 

SaveConfigFile(BSTR newVal) as Boolean 
Saves your current Report ActiveX configuration to the file specified in newVal. 

Example 
Dim ret As Boolean 

ret = AWXRep1.SaveConfigFile(“C:\My Configs\cfg.awr”) 
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LoadConfigURL(BSTR newVal) as Boolean 
Load the configuration file specified in the URL string newVal. 

Example 
Dim ret As Boolean 

ret = AWXRep1.LoadConfigURL(“http://localhost/cfg.awr”) 
 

SetDBType(short NewDBType) 
Set the database type. 

Example 
AWXRep1.SetDBType(1) 
 

GetColumnsNumber() as Short 
Return the number of columns in your current report configuration. 
Example 
MsgBox AWXRep1.GetColumnsNumber 
 

GetFiltersNumber() as Short 
Return the number of filters currently available to your report. 

Example 
MsgBox AWXRep1.GetFiltersNumber 

 
GetSortEntriesNumber() as Short 
Return the number of columns on which your report is currently sorting. 

Example 
MsgBox AWXRep1.GetSortEntriesNumber 
 

GetColumn(short iIndex) as OGridColumnWrapper 
Get the Column object corresponding to iIndex.  Returns “Nothing” if the index is invalid.  Column 
index numbers start at 1. 

Example 
Dim col As OGridColumnWrapper 

Set col = AWXRep1.GetColumn(1) 
 

AddColumn(BSTR newCol) as OGridColumnWrapper 
Adds the specified column to your report.  Returns “Nothing” if argument is not a valid column name.  
You can then modify the column through the OGridColumnWrapper automation properties and 
methods. 

Example 
Dim col As OGridColumnWrapper 

Set col = AWXRep1.AddColumn(“Severity”) 
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SwitchColumns(short iIndex1, short iIndex2) 
Switch the display order of the two columns corresponding to the specified indices.  Returns 
“Nothing” if the column index is invalid. 

Example 
AWXRep1.SwitchColumns(1,2) 
 

DeleteColumn(short iIndex) 
Deletes the column corresponding to the specified index.  Returns “Nothing” if the column index is 
invalid. 

Example 
AWXRep1.DeleteColumn(2) 
 

GetSummaryColumn(short iIndex) as OGridSummaryColumnWrapper 
Gets the OGridSummaryColumnWrapper object corresponding to the specified column index.  The 
summary column is the header associated with each column.  Returns “Nothing” if the column index 
is invalid. 
Example 
Dim sumcol As OGridSummaryColumnWrapper 

Set sumcol = AWXRep1.GetSummaryColumn(1) 
 

UpdateColumnsInfo() 
Forces a refresh of the column information. 
Example 
AWXRep1.UpdateColumnsInfo 
 

GetFilter(short iIndex) as OFilterWrapper 
Gets the filter corresponding to the specified index. 
Example 
Dim filter As OFilterWrapper 

Set filter = AWXRep1.GetFilter(1) 
 

AddFilter(BSTR newCol) as OFilterWrapper 
Adds a filter on the specified column. You can then modify the filter through the OFilterWrapper 
automation properties and methods. 

Example 
Dim filter As OFilterWrapper 

Set filter = AWXRep1.AddFilter(“Severity”) 
 

DeleteFilter(short iIndex) 
Deletes the specified filter. 

Example 
AWXRep1.DeleteFilter(1) 
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UpdateFiltersInfo() 
Forces an update of the filter information. 

Example 
AWXRep1.UpdateFiltersInfo 

 
GetSortEntry(short iIndex) as OSortEntryWrapper 
Returns an OSortEntryWrapper object corresponding to the specified index.  Returns “Nothing” if the 
index is invalid. 
Example 
Dim sort As OSortEntryWrapper 

Set sort = AWXRep1.GetSortEntry(1) 
 

AddSortEntry(BSTR newCol) as OSortEntryWrapper 
Adds a sort for the specified column.  You can then modify the sort entry through the 
OSortEntryWrapper automation properties and methods. 

Example 
Dim sort As OSortEntryWrapper 

Set sort = AWXRep1.AddSortEntry(“Tag”) 
 

DeleteSortEntry(short iIndex) 
Deletes the sort entry corresponding to the specified index. 

Example 
AWXRep1.DeleteSortEntry(1) 
 

UpdateSortInfo() 
Forces an update of the sort entry information. 

Example 
AWXRep1.UpdateSortInfo 

 
SwitchSortEntries(short iIndex1, short iIndex2) 
 
GetCellText(integer iColumnIndex, long iRowIndex) as VARIANT 
Returns the contents of the cell specified by the grid coordinates. 
Example 
Dim cell As Variant 

cell = AWXRep.GetCellText(1,1) 

MsgBox cell 
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GetGridRowCount() as VARIANT 
Returns the number of rows in the grid.  Returns –1 if there are no records or the database is not yet 
connected. 
Example 
Msgbox AWXRep1.GetGridRowCount 
 

GetSelectedRowIndex() as VARIANT 
Returns the index of the row that is currently selected.  Returns –1 if no cell is selected. 

Example 
MsgBox AWXRep1.GetSelectedRowIndex 
 

GetSelectedColIndex() as VARIANT 
Returns the index of the column that is currently selected.  Returns –1 if no cell is selected. 
Example 
MsgBox AWXRep1.GetSelectedColIndex 
 

PrintToDefault(numOfCopies as Integer, orientation as Integer) as 
Long 
Sends the current report to the default printer.  Use 0 for portrait orientation and 1 for landscape. 
Example 
AWXRep1.PrintToDefault(1,0) 
 

PrintToDevice(BSTR strDriverName, BSTR strDeviceName,BSTR 
strPortName, numberOfCopies as Integer, orientation as Integer) as Long 
Prints to the specified device. 
 

CanNavigateNextTable() as Boolean 
Returns whether or not the report can navigate to the next table.  Returns false if there are no other 
tables. 

Example 
MsgBox AWXRep1.CanNavigateNextTable 
 

CanNavigatePrevTable() as Boolean 
Returns whether or not the report can navigate to the previous table.  Returns false if there are no 
other tables. 

Example 
MsgBox AWXRep1.CanNavigatePrevTable 
 

NavigateNextTable() 
Navigates to the next available table.  Does nothing if no other tables exist, or this is the last table 
already. 

Example 
MsgBox AWXRep1.NavigateNextTable 
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NavigatePrevTable() 
Navigates to the previous table.  Does nothing if you are already on the first table. 
Example 
MsgBox AWXRep1.NavigatePrevTable 
 

PrintReport(short iReportIndex, short nCopies, long lStartPage, long 
lEndPage) as Short 
Prints the report to the default printer from page X to page Y. 

Example 
ret = AWXRep1.PrintReport(1, 1, 1, 5) 
 

PrintReportToDevice(short iReportIndex, BSTR strDriverName, BSTR 
strDeviceName,BSTR strPortName, short nCopies, long lStartPage, 
long lEndPage) as Short 
Prints the report to the specified device from page X to page Y. 

 
GetHighlightedRange() as VARIANT 
Returns a pair of coordinates corresponding to the upper left selected grid and the lower right 
selected grid. 

Example 
Dim sel As Variant 

sel = AWXRep1.GetHighlightedRange 

For Each coordinate In sel 

 MsgBox coordinate 

Next coordinate 

 

ScrollUp() 
 

ScrollDwn() 
 

ScrollPgUp() 
 

ScrollPgDwn() 
 

ScrollLeft() 
 

ScrollRight() 
 

ScrollPgLeft() 
 

ScrollPgRight() 
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SelectGridColumn(short iIndex) 
Selects the specified column in the grid. 
Example 
AWXRep1.SelectGridColumn(2) 
 
GetSelectedGridColumns() as VARIANT 
Returns a list of the currently selected grid columns.  If no columns are selected, returns “Nothing”. 

Example 
Dim n As Variant 

n = AWXRep1.GetSelectedGridColumns 
 
GetAllColumns() as VARIANT 
Returns a list of all columns available to the report. 

Example 
Dim cols As Variant 

cols = AWXRep1.GetAllColumns 

For Each col In cols 

 MsgBox col 

Next col 
 
GetAutoPrintSupport() as IOAutoPrintSupport 
Returns an OAutoPrintSupport object to be used for configuring auto printing.  See the 
OAutoPrintSupport documentation below for its properties. 
Example 
Dim aps As OAutoPrintSupport 

Set aps = AWXRep1.GetAutoPrintSupport 
 
GetCRTemplate(short iReportIndex) as IOCRTemplate 
Returns a Crystal Reports template object.  See the OCRTemplate documentation below for more 
information on its properties and methods. 
Example 
Dim cr As OCRTemplate 

Set cr = AWXRep1.GetCRTemplate(1) 
 
ReplaceHost(BSTR OldHostName, BSTR NewHostName) as Long 
Works over both data source tags and path name attributes and replaces node name substring 
within URL path only. Returns 0 on success and HRESULT when something fails. 

Example 
'similar to ReplaceTag 

'VBA example, works only in configure mode 

'replaces host name in whole display 
 

Dim Status As Long 

Status = ThisDisplay.ReplaceHost("Host1", "Host2") 
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'if Status <> 0 then there was no replacement performed or an 
error occurs 

If Status <> 0 Then 

 MsgBox "No replacements" 

Else 

 MsgBox "Tags replaced" 

End If 
 
ReplaceFilePath(BSTR OldSubstring, BSTR NewSubstring) as Long 
Works over path name parameters of pick dynamics. Returns 0 on success and HRESULT when 
something fails. 

Example 
'similar to ReplaceTag 

'VBA example, works only in configure mode 

'replaces file path in whole display 
 

Dim Status As Long 

Status = ThisDisplay.ReplaceFilePath("C:\Windows\Temp", "D:\Temp") 

'if Status <> 0 then there was no replacement performed or an 
error occurs 

If Status <> 0 Then 

 MsgBox "No replacements" 

Else 

 MsgBox "Tags replaced" 

End If 
 
ReplaceHostEx(BSTR OldHostNameSubstring, BSTR 
NewHostNameSubstring, BOOL MatchCase, BOOL MatchWholeWord) 
as Long 
Works over both data source tags and path name attributes and replaces node name substring 
within URL path only, and supports case-sensitivity, wildcard strings and MatchWholeWord flag. 
Returns 0 on success and HRESULT when something fails. 

Example 
'similar to ReplaceTag 

'VBA example, works only in configure mode 

'replaces host name in whole display, regarding "case" and "whole 
words" options 
 

Dim Status As Long 

Status = ThisDisplay.ReplaceHostEx("Host1", "Host2", True, True) 

'if Status <> 0 then there was no replacement performed or an 
error occurs 

If Status <> 0 Then 

 MsgBox "No replacements" 

Else 

 MsgBox "Tags replaced" 

End If 
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Available Control Events 
OnUpdate() 
 

OnChartSeriesSelect(BSTR strSelectedItem) 
 

OnGridSelectionChanged(boolean IsDragging) 
 

OnGridLButtonDblClk(short iColIndex, long iRowIndex) 
 

OnGridLButtonClicked(short iColIndex, long iRowIndex) 
 

OnGridRButtonDblClk(short iColIndex, long iRowIndex) 
 

OnGridRButtonClicked(short iColIndex, long iRowIndex) 
 

OnGridMButtonDblClk(short iColIndex, long iRowIndex) 
 

OnGridMButtonClicked(short iColIndex, long iRowIndex) 
 

OnChartDblClick() 
 

OnChartMouseUp(short Button, short Shift) 
 

OnChartMouseDown(short Button, short Shift) 
 

OnChartClicked() 
 

Available Automation Objects 
OGridColumnWrapper,  
OGridSummaryColumnWrapper object properties: 
 
HeaderTitle 
Type: BSTR 
Description 
Sets/gets the value of the column header field. 
Example 
    Dim column As OGridColumnWrapper 

    Set column = ThisDisplay.AWXRep1.GetColumn(1) 

    column.HeaderTitle = "New Column Header" 

    ThisDisplay.AWXRep1.UpdateColumnsInfo 

The above example will change the header of column 1 in the Alarm Report 
ActiveX. 
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ColumnName 
Type: BSTR 
Description 
Sets/gets the value of the column name field. 
Example 
    Dim column As OGridColumnWrapper 

    Set column = ThisDisplay.AWXRep1.GetColumn(1) 

    Msgbox column.ColumnName 

The above example will display the column name for column 1. 
 

Width 
Type: Short 
Description 
Sets/gets the width of the column 

Example 
    Dim column As OGridColumnWrapper 

    Set column = ThisDisplay.AWXRep1.GetColumn(1) 

    column.Width = 100 

The above example will set the width of column 1 equal to 100. 
 

DataType 
Type: Short 
Description 
Sets/gets the data type of the column 

Example 
    Dim column As OGridColumnWrapper 

    Set column = ThisDisplay.AWXRep1.GetColumn(1) 

    Msgbox column.DataType 
The above example will display the data type of column 1. 

 
ModifyFont 
Type: Boolean 
Description 
Enables/Disables the modified cell font. 

Example 
    Dim column As OGridColumnWrapper 

    Set column = ThisDisplay.AWXRep1.GetColumn(1) 

    column.ModifyFont = False 
The above example will disable the modified font for column 1. 
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ModifyHeadFont 
Type: Boolean 
Description 
Enables/Disables the modified header font. 

Example 
    Dim column As OGridColumnWrapper 

    Set column = ThisDisplay.AWXRep1.GetColumn(1) 

    column.ModifyHeadFont = False 
The above example will disable modified the header font for column 1. 
 
ModifyTextColor 
Type: Boolean 
Description 
Enables/Disables the modified text color. 

Example 
    Dim column As OGridColumnWrapper 

    Set column = ThisDisplay.AWXRep1.GetColumn(1) 

    column.ModifyTextColor = True 

    column.TextColor = RGB(0, 255, 0) 
The above example will change the text color for column 1 to green. 
 
TextColor 
Type: OLE_COLOR 
Description 
Sets/gets the color of the column text. 

Example 
    Dim column As OGridColumnWrapper 

    Set column = ThisDisplay.AWXRep1.GetColumn(1) 

    column.ModifyTextColor = True 

    column.TextColor = RGB(0, 255, 0) 
The above example will change the text color for column 1 to green. 
 
ModifyBackColor 
Type: Boolean 
Description 
Enables/Disables the modified background color. 

Example 
    Dim column As OGridColumnWrapper 

    Set column = ThisDisplay.AWXRep1.GetColumn(1) 

    column.ModifyBackColor = True 

    column.BackColor = RGB(0, 255, 0) 

The above example will change the background color for column 1 to green. 
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BackColor 
Type: OLE_COLOR 
Description 
Sets/gets the background color of the column. 
Example 
    Dim column As OGridColumnWrapper 

    Set column = ThisDisplay.AWXRep1.GetColumn(1) 

    column.ModifyBackColor = True 

    column.BackColor = RGB(0, 255, 0) 
The above example will change the background color for column 1 to green. 
 

ModifyCell 
Type: Boolean 
Description 
Enables/Disables changes to the cell justification and wrap text settings. 

Example 
    Dim column As OGridColumnWrapper 

    Set column = ThisDisplay.AWXRep1.GetColumn(1) 

    column.ModifyCell = True 

    column.CellJustify = 0 
The above example will change the column to left justified. 
 

CellWrapText 
Type: Boolean 
Description 
Enables/Disables column text wrapping. 

Example 
    Dim column As OGridColumnWrapper 

    Set column = ThisDisplay.AWXRep1.GetColumn(1) 

    column.ModifyCell = True 

    column.CellWrap = True 
The above example will enable cell wrapping. 
 

CellJustify 
Type: Short 
Description 
Sets/Gets the column justification 

Example 
    Dim column As OGridColumnWrapper 

    Set column = ThisDisplay.AWXRep1.GetColumn(1) 

    column.ModifyCell = True 

    column.CellJustify = 0 
The above example will change the column text to left justified. 



Report ActiveX 
 

4.56 

HeadJustify 
Type: Short 
Description 
Sets/Gets the column justification 
Example 
    Dim column As OGridColumnWrapper 

    Set column = ThisDisplay.AWXRep1.GetColumn(1) 

    column.HeadJustify = 0 

The above example will change the column header to left justified. 
 
CellFont 
Type: IfontDisp* 
Description 
Set/Get the cell font 
Example 
    Dim column As OGridColumnWrapper 

    Set column = ThisDisplay.AWXRep1.GetColumn(1) 

    Dim fnt As IFontDisp 

    Set fnt = column.CellFont 

    fnt.Bold = True 

    fnt.Italic = True 

    Set column.CellFont = fnt 
The above example will turn on bold and italic for column 1. 
 

HeadFont 
Type: IfontDisp* 
Description 
Sets/Gets the header font 

Example 
    Dim column As OGridColumnWrapper 

    Set column = ThisDisplay.AWXRep1.GetColumn(1) 

    Dim fnt As IFontDisp 

    Set fnt = column.HeadFont 

    fnt.Bold = True 

    fnt.Italic = True 

    Set column.HeadFont = fnt 
The above example will turn on bold and italic for column 1. 
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OFilterWrapper properties: 
Active 
Type: Boolean 
Description 
Activates/Deactivates the indicated filter 

Example 
    Dim filter As ofilterwrapper 

    Set filter = ThisDisplay.AWXRep1.GetFilter(1) 

    filter.Active = True 

    ThisDisplay.AWXRep1.UpdateFiltersInfo 
The above example will activate filter number 1. 
 

FilterName 
Type: BSTR 
Description 
Sets/Gets the filter name 

Example 
    Dim filter As ofilterwrapper 

    Set filter = ThisDisplay.AWXRep1.GetFilter(1) 

    filter.FilterName = "New Filter" 

    ThisDisplay.AWXRep1.UpdateFiltersInfo 
The above example will rename filter number 1 to the name “New Filter”. 
 

ColumnName 
Type: BSTR 
Description 
Sets/Gets the name of the column to filter 

Example 
    Dim filter As ofilterwrapper 

    Set filter = ThisDisplay.AWXRep1.GetFilter(1) 

    filter.ColumnName = "[Tag]" 

    ThisDisplay.AWXRep1.UpdateFiltersInfo 
The above example will change the filter to filter on column “[Tag]”. 
 

DataType 
Type: Short 
Description 
Gets the data type of the column selected in the filter. 

Example 
    Dim filter As ofilterwrapper 

    Set filter = ThisDisplay.AWXRep1.GetFilter(1) 

    Msgbox filter.DataType 
The above example will display the data type of the column selected in the filter. 
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FilterType 
Type: Short 
Description 
Sets/Gets the type of the filter.  Can be one of the following: 
   0 – Inclusive Filter 
   1 – Exclusive Filter 
   2 – Custom Filter 

Example 
    Dim filter As ofilterwrapper 

    Set filter = ThisDisplay.AWXRep1.GetFilter(1) 

    filter.FilterType = 0 

    ThisDisplay.AWXRep1.UpdateFiltersInfo 
The above example will set the filter type as an Inclusive Filter. 
 

IncludedValues 
Type: VARIANT 
Description 
Sets/Gets the column values included by the filter. 

Example 
     Dim myfilter As ofilterwrapper 

     Set myfilter = ThisDisplay.AWXRep1.GetFilter(1) 

     Dim included As String 

     Dim varstring 

     Dim myvar As Variant 

     included = "" 

     myvar = myfilter.IncludedValues 

     For Each varstring In myvar 

         included = included & CStr(varstring) & "; " 

     Next varstring 

     Msgbox included 
The above example will display a list of the included values separated by semicolons. 
 

ExcludedValues 
Type: VARIANT 
Description 
Set/Get the column values excluded by the filter. 
Example 

     Dim myfilter As ofilterwrapper 

     Set myfilter = ThisDisplay.AWXRep1.GetFilter(1) 

     Dim excluded As String 

     Dim varstring 

     Dim myvar As Variant 
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     excluded = "" 

     myvar = myfilter.ExcludedValues 

     For Each varstring In myvar 

         excluded = excluded & CStr(varstring) & "; " 

     Next varstring 

     Msgbox excluded 
The above example will display a list of the included values separated by semicolons. 
 

TimeMode 
Type: Short 
Description 
Set/Get the date/time type for inclusive or exclusive filters.  Can be one of the following: 
   0 – Today 
   1 – Single Day 
   2 – Date Range 
   3 – Last 

Example 
    Dim filter As ofilterwrapper 

    Set filter = ThisDisplay.AWXRep1.GetFilter(1) 

    Filter.TimeMode = 2 

    ThisDisplay.AWXRep1.UpdateFiltersInfo 
The above example will set date/time to “single day”. 
 

Days 
Type: Short 
Description 
Sets/Gets the last x Days value for Date/Time filters 

Example 
    Dim filter As ofilterwrapper 

    Set filter = ThisDisplay.AWXRep1.GetFilter(1) 

    Filter.Days = 1 

The above example will set the filter to show the last 1 day. 
 

Hours 
Type: Short 
Description 
Sets/Gets the last x Hours value for Date/Time filters 

Example 
    Dim filter As ofilterwrapper 

    Set filter = ThisDisplay.AWXRep1.GetFilter(1) 

    Filter.Hours = 1 
The above example will set the filter to show the last 1 hour. 
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Minutes 
Type: Short 
Description 
Sets/Gets the last x Minutes value for Date/Time filters 

Example 
    Dim filter As ofilterwrapper 

    Set filter = ThisDisplay.AWXRep1.GetFilter(1) 

    Filter.Minutes = 1 
The above example will set the filter to show the last 1 minute. 
 

DateTimeFrom 
Type: Variant 
Description 
Sets/Gets the Time From setting for filters that are set for Date Range.  This setting is also used to 
determine which day is selected for Single Day filters. 

Example 
    Dim filter As ofilterwrapper 

    Set filter = ThisDisplay.AWXRep1.GetFilter(1) 

    Filter.DateTimeFrom = “7/27/2003 12:00:00 AM” 

    Filter.DateTimeTo = “7/28/2003 12:00:00 AM” 

The above example will set the filter to show any message occurring on 7/27/2003. 
 

DateTimeTo 
Type: Variant 
Description 
Sets/Gets the Time To setting for filters that are set for Date Range. 
Example 
    Dim filter As ofilterwrapper 

    Set filter = ThisDisplay.AWXRep1.GetFilter(1) 

    Filter.DateTimeFrom = “7/27/2003 12:00:00 AM” 

    Filter.DateTimeTo = “7/28/2003 12:00:00 AM” 
The above example will set the filter to show any message occurring on 7/27/2003. 
 

CustomSQL 
Type: BSTR 
Description 
Sets/Gets the custom SQL string that is used when the Filter Type is a Custom Filter. 

Example 
    Dim filter As ofilterwrapper 

    Set filter = ThisDisplay.AWXRep1.GetFilter(1) 

    Filter.CustomSQL = “[Tag] 
IN('Humidity','Pump1','Tank1')” 
The above example will set the custom SQL to select messages with where the Tag field is 
‘Humidity’, ‘Pump1’, or ‘Tank1’.
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OFilterWrapper  methods: 
 
GetSQL() as BSTR 
Type: BSTR 
Description 
Returns the custom SQL string that is used when the Filter Type is a Custom Filter. The returned 
string is enclosed in parenthesis. 

Example 
    Dim filter As ofilterwrapper 

    Set filter = ThisDisplay.AWXRep1.GetFilter(1) 

    MsgBox filter.CustomSQL 
The above example will return the Custom SQL string. 

 
IsValid() as Boolean 
Type: BSTR 
Description 
Returns whether or not the filter is valid. 
Example 
    Dim filter As ofilterwrapper 

    Set filter = ThisDisplay.AWXRep1.GetFilter(1) 

    If filter.IsValid Then 

        MsgBox “This filter is valid.” 

    Else 

        MsgBox “This filter is invalid.” 

    End If 
The above example will say let you know if the filter is valid. 

 

OSortEntryWrapper properties: 
 
ColumnName 
Type: BSTR 
Description 
Sets/Gets the column name to sort on. 

Example 
    Dim sort As OSortEntryWrapper 

    Set sort = ThisDisplay.AWXRep1.GetSortEntry(1) 

    sort.ColumnName = "[Tag]" 

    ThisDisplay.AWXRep1.UpdateSortInfo 
The above example sets the sort column as [Tag]. 
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SortDir 
Type: Short 
Description 
Sets/Gets sort direction.  Possible values are: 
   0 – Do not sort on this field 
   1 – Sort Ascending 
   2 – Sort Descending 

Example 
    Dim sort As OSortEntryWrapper 

    Set sort = ThisDisplay.AWXRep1.GetSortEntry(1) 

    Sort.sortdir = 1 

    ThisDisplay.AWXRep1.UpdateSortInfo 

The above example sets the sort direction as ascending. 
 

ResortMode 
Type: Short 
Description 
Sets/Gets the re-sort settings.  Possible values are: 
   0 – Do not re-sort after translating 
   1 – Re-sort after translating 

Example 
    Dim sort As OSortEntryWrapper 

    Set sort = ThisDisplay.AWXRep1.GetSortEntry(1) 

    Sort.ResortMode = 1 

    ThisDisplay.AWXRep1.UpdateSortInfo 
The above example sets the sort entry to re-sort after translating 

 

OAutoPrintSupport properties: 
 
EnableAutoPrint 
Type: Boolean 
Description 
Enables/Disables auto printing of Alarm Report 

Example 
    Dim autoprint As OAutoPrintSupport 

    Set autoprint = 
ThisDisplay.AWXRep1.GetAutoPrintSupport() 

    autoprint.EnableAutoPrint = True 
The above example enables auto print support. 
 

AutoPrintMode 
Type: Short 
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Description 
Gets/Sets the printing mode.  Possible values are: 
   0 – Default printer 
   1 – Selected Devices 

Example 
    Dim autoprint As OAutoPrintSupport 

    Set autoprint = 
ThisDisplay.AWXRep1.GetAutoPrintSupport() 

    autoprint.AutoPrintMode = 0 

The above example selects default printer as the printing mode. 
 

Orientation 
Type: Short 
Description 
Gets/Sets the printer orientation.  Possible values are: 
   0 – Portrait 
   1 – Landscape 

Example 
    Dim autoprint As OAutoPrintSupport 

    Set autoprint = 
ThisDisplay.AWXRep1.GetAutoPrintSupport() 

    autoprint.Orientation = 0 

The above example selects portrait as the orientation. 
 

NumberOfCopies 
Type: Short 
Description 
Gets/Sets the number of copies to be printed. 

Example 
    Dim autoprint As OAutoPrintSupport 

    Set autoprint = 
ThisDisplay.AWXRep1.GetAutoPrintSupport() 

    Autoprint.NumberofCopies = 5 
The above example sets the number of copies to 5. 
 

PrintContent 
Type: Short 
Description 
Gets/Sets content of the pages to be printed.  Possible values are: 
   0 - None 
   1 – Crystal Report – Design #5 
   2 – Crystal Report – Design #4 
   4 – Crystal Report – Design #3 
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   8 – Detailed Alarm Report 
   16 – Condensed Alarm Report 
   32 – Current Grid / Chart View 
* To include multiple choices in auto-printing just add the values together.  For example, 63 = all 
report views. 

 
Example 
    Dim autoprint As OAutoPrintSupport 

    Set autoprint = 
ThisDisplay.AWXRep1.GetAutoPrintSupport() 

    autoprint.PrintContent = 63 

The above example sets all pages to be printed. 
 

SpecialPrinter1 
Type: IOSpecialPrinter* 
Description 
Gets/Sets settings for an additional printer. 

Example 
    Dim autoprint As OAutoPrintSupport 

    Set autoprint = 
ThisDisplay.AWXRep1.GetAutoPrintSupport() 

    Dim specprint As OSpecialPrinter 

    Set specprint = autoprint.SpecialPrinter1() 

    specprint.Orientation = 0 
The above example sets the orientation of the additional printer as portrait. 
 

IOSpecialPrinter* SpecialPrinter2 
Type: IOSpecialPrinter* 
Description 
Gets/Sets settings for an additional printer. 

Example 
See Example for SpecialPrinter1 
 

IOSpecialPrinter* SpecialPrinter3 
Type: IOSpecialPrinter* 
Description 
Gets/Sets settings for an additional printer. 

Example 
See Example for SpecialPrinter1 
 

IOSpecialPrinter* SpecialPrinter4 
Type: IOSpecialPrinter* 
Description 
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Gets/Sets settings for an additional printer. 

Example 
See Example for SpecialPrinter1 
 

IOSpecialPrinter* SpecialPrinter5 
Type: IOSpecialPrinter* 
Description 
Gets/Sets settings for an additional printer. 

Example 
See Example for SpecialPrinter1 

 
OSpecialPrinter properties: 
DriverName 
Type: BSTR 
Description 
Gets/Sets the driver name for the printer. 

Example 
    Dim specprint As OSpecialPrinter 
    Msgbox specprint.DriverName 
This example displays the name of the driver. 

 
DeviceName 
Type: BSTR 
Description 
Gets/Sets the device name for the printer. 

Example 
    Dim specprint As OSpecialPrinter 
    Msgbox specprint.DeviceName 
This example displays the name of the device. 
 

PortName 
Type: BSTR 
Description 
Gets/Sets the port name. 

Example 
    Dim specprint As OSpecialPrinter 
    Msgbox Specprint.PortName 

This example displays the name of the port. 
 

NumberOfCopies 
Type: short 
Description 
Gets/Sets the number of copies to print. 
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Example 
    Dim specprint As OSpecialPrinter 
    specprint.NumberOfCopies = 5 
 

Orientation 
Type: short 
Description 
Gets/Sets the orientation for printing 

Example 
    Dim specprint As OSpecialPrinter 
    specprint.Orientation = 0 
This example sets the orientation as portrait. 
 
OCRLine properties: 
 
long Style 
 
long PenWidth 
 
OLE_COLOR Color 
 
 
OCRText properties: 
 
BSTR Text 
 
IFontDisp*  Font; 
 
short FontPointSize 
 
OLE_COLOR ForeColor 
 
OLE_COLOR BackColor 
 
OLE_COLOR BorderColor 
 
short Justify 
 
short Left 
 
short Width 
 
short Top 
 
short Height 
 
bool DropShadow 
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long LeftBorder 
 
long TopBorder 
 
long RightBorder 
 
long BottomBorder 
 
 
OCRField properties: 
 
BSTR Field 
 
BSTR HeaderText 
 
short Width 
 
 
OCRTemplate properties: 
 
OLE_COLOR DataColor 
 
IFontDisp*  HeaderFont 
 
short HeaderFontPointSize 
 
IFontDisp*  DataFont 
 
short DataFontPointSize 
 
OLE_COLOR HeaderColor 
 
IOCRText* MainTitle 
 
IOCRText* SubTitle 
 
IOCRLine* HeaderDivider 
 
IOCRLine* DataRowDivider 
 
short XtraHeaderSpace 
 
short XtraDataSpace 
 
BSTR TemplateName 
 
float BottomMargin 
 
float TopMargin 
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float LeftMargin 
 
float RightMargin 
 
short PaperType 
 
short ReportingMode 
 
boolean HasUpperLimit 
 
long UpperLimit 
 
boolean AttachCurrTableName 
 
short Orientation 
 
short SortingMode 
 
 
OCRTemplate methods: 
 
GetFieldsCount() as Short 
 
AddField(BSTR NewFieldName, BSTR NewFieldHeaderText, short 
NewFieldWidth) as IOCRField 
 
DeleteField(short FieldIndex) 
 
SwitchFields(short FieldIndex1, short FieldIndex2) 
 
GetFieldObject(short FieldIndex) as IOCRField 
 
GetFiltersNumber() as Short 
 
GetSortEntriesNumber() as Short 
 
GetFilter(short iIndex) as IOFilterWrapper 
 
AddFilter(BSTR newCol) as IOFilterWrapper 
 
DeleteFilter(short iIndex) 
 
GetSortEntry(short iIndex) as IOSortEntryWrapper 
 
AddSortEntry(BSTR newCol) as IOSortEntryWrapper 
 
DeleteSortEntry(short iIndex) 
 
SwitchSortEntries(short iIndex1, short iIndex2) 



Chapter 5 
 

1 

Server Configurator 
Introduction 

The AlarmWorX Server receives field data from any OPC-compliant Data Access server and 
performs alarm detection and reporting based on the OPC Alarm and Events Standard. The event 
notifications generated by the AlarmWorX Server are sent to any OPC Alarm and Event clients that 
subscribe. The AlarmWorX Viewer and the AlarmWorX Logger are two examples of clients that can 
receive these notifications from the server. 
The server supports the following alarm types: 
 Limit: High High, High, Low, Low Low 
 Deviation: High High, High, Low, Low Low 
 Rate of Change 
 Digital 

The Server Application (AwxSvr.exe) has no user interface and may optionally be run as a service 
on Windows NT. The server reads its configuration information from a Microsoft Access Database 
file, which by default is AwxSvr.mdb located in the same directory as the server application. During 
runtime the server will poll the configuration database for changes, so configuration may be done on 
the fly without stopping the server. 
The Server Configurator Application (AwxServerConfigurator.exe) is used to make changes to the 
Microsoft Access Database file that the server uses for configuration information. 
 

Installation 
The following are the major files that comprise the server component of AlarmWorX: 

AwxSvr.exe Server application/service 
AwxServerConfigurator.exe Server Configurator 
AwxSvr.mdb Server configuration database 

 
The files are installed in the Bin directory chosen during the installation. A program icon is installed 
for Configurator in the AlarmWorX program group. 
By default the Server (AwxSvr.exe) is registered as a normal application, but can be registered to 
run as a service under Windows NT. Running as a Service has the following advantages: 
• The Server can be set to start as soon as the machine is powered (before a user has logged 

on). 

• The Server will remain running even if a user Logs off of NT. 
To register the Server as a Windows NT Service: 

1. Run the ProcessView Tray utility from the Windows Start menu by selecting Programs > 
Smar PROCESSVIEW > Tools > the ProcessView Tray. 
2. This opens ProcessView Tray and puts the the ProcessView Tray icon in the taskbar system 
tray. Click the the ProcessView Tray icon in the system tray and select AlarmWorX > Sever > NT 
Service, as shown in the figure below. To have the service start automatically upon system startup, 
click the the ProcessView Tray icon in the system tray and select AlarmWorX > Sever > Auto 
Start. 
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Running AlarmWorX Server From ProcessView Tray 

The ProcessView Tray utility can also be used to manually start and stop the server. 
Note: The Alarm Server does not use standard COM rules for activation/deactivation. If the server is 
started for any reason (via ProcessView Tray or by activation by an OPC Alarm Client), it will remain 
running until both of the following conditions are met: 

The ProcessView Tray utility has issued the Stop command to the Server. 
All OPC alarm clients have disconnected from the server. 
Since NT Services are not supported in Windows 95 and Windows 98, ProcessView Tray can be 
used to facilitate the starting of the Alarm Server on startup: 

3. Place a shortcut to the ProcessView Tray utility in the startup group so ProcessView Tray will 
start automatically when Windows 95 or Windows 98 boots up. 

4. To have the Alarm Server start automatically when ProcViewTray starts, click the ProcessView 
Tray icon in the system tray and select AlarmWorX > Sever > Auto Start. 

Starting the Alarm Server Configuration 
AlarmWorX Server Configurator is an application used to create and maintain an alarm tag 
database for use by the AlarmWorX Server. In addition to simple tag configuration, the configurator 
is used to create and maintain a process area hierarchy and to group tags into one or more named 
"configurations" to support servers running on multiple network nodes. 
To launch the AlarmWorX Server Configurator from the Windows Start menu: 
 Select Programs > SMAR PROCESSVIEW > AlarmWorX > Alarm Server Configurator. 
 The Awx32Svr.mdb Microsoft Access database file opens in the Alarm Server Configurator, as 

shown in the figure below.    The screen consists of a split window with a tree control view in the 
left-hand pane and a configuration view in the right-hand pane. The Configurator provides a 
standard format for the configuration database, as well as a sample (default) configuration 
project. The Configurator also includes a toolbar and menus with many command functions. 
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Alarm Server Configurator Screen 

1. To open a different database file, select Open from the File menu. This opens the Open dialog 
box, shown below, which enables you to browse for configuration files. 

 
Selecting a Configuration Database 

Creating Configuration Databases 
The Configurator provides a Configuration Database Wizard for creating new Microsoft Access and 
SQL Server configuration databases. To create a new configuration database in the Configurator: 

• Select New from the File menu, as shown in the figure below.  

 
Creating a Configuration Database 
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• The introduction screen for the Configuration Database Wizard appears. Click the Next button to 
continue. 

• You have two options for creating your new database, as shown in the figure below: 

Create a new Microsoft Access configuration database: For a Microsoft Access database, the 
Configurator uses a single .mdb file 

Create a Microsoft SQL Server database: The Configurator uses Universal Data Link (.udl) files 
to connect to a Microsoft SQL Server or MSDE database. 

Select the database type you want to create, and then click Next.  

 
Choosing the Type of Database To Create 

Creating a Microsoft Access Configuration Database 
To create a new Microsoft Access configuration database in the Configurator: 

1. Select New from the File menu, as shown in the figure below.  

 
Creating a Configuration Database 

• The introduction screen for the Configuration Database Wizard appears. Click the Next button to 
continue. 

• You have two options for creating your new database, as shown in the figure below. Select 
Create new configuration in MS Access database. Click the Next button to continue.  
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Creating a New Microsoft Access Database  

• Specify the directory path and file name for the new database, as shown in the figure below. 
Click the ... button to browse for a directory. If you want this new database to be the active 
configuration database, check Make Database Active. 

 
Naming the New Access Database 

• Click the Finish button. The new database is created and opened in the Configurator.  
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Creating a Microsoft SQL Server Configuration Database 
To create a new Microsoft SQL Server configuration database in the Configurator: 

1. Select New from the File menu, as shown in the figure below.  

 
Creating a Configuration Database 

• The introduction screen for the Configuration Database Wizard appears. Click the Next button to 
continue. 

• You have two options for creating your new database, as shown in the figure below. Select 
Create new configuration in MS SQL Server database. Click the Next button to continue.  

 
Creating a New Microsoft SQL Server Database 

• To connect to a SQL Server database, either select an existing database from the Database 
Name drop-down list, or a type a new name to create a new database, as shown in the figure 
below.  If you choose to use an existing database, you have the option of adding (auto-
appending) the configuration to the existing database. (For more information about the auto-
append function, please see "Adding the Configuration to an Existing Database.")  

• In the SQL Server Name field, select the local SQL Server on which to create the database. If 
necessary, enter a user name and password to log on to the SQL Server. (It is recommended 
that you use Windows NT integrated security.) 

• Note: Usually you have only one instance of SQL Server running on the local node. In this case, 
the drop-down list under SQL Server Name has only one option: "(local)." However, it is 
possible to run multiple SQL Server instances on the local node, in which case the SQL Server 
field lists all those SQL Server instances: "(local)" for the default instance and 
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"node_name/instance_name" for all others. The drop-down list may show SQL Server instances 
on other nodes as well. 

 
Connecting to a SQL Server Database 

• Specify a directory path location in which to create the database, as shown in the figure below. 
You can either use the default SQL Server database folder, or you can click the ... button and 
browse for a specific folder. 

 
Specifying the Database Location and Properties 

• Under the Database Properties section, specify an initial size for the database, which should be 
as large as possible. You can also specify a Database Growth option (in megabytes) or as a 
percentage of the total size. MSDE servers are capable of growing the database on the fly to 
store more data. However, if this operation is performed frequently, the overall system 
performance may decrease. Choosing an initially large database size and a corresponding 
database growth option can drastically improve system performance.  

• Under the Log File Properties section, you can also modify the settings for the database 
transaction log file. Specify a Log File Growth option (in megabytes) or as a percentage of the 
total size. Again, a sufficient initial size setting can greatly improve performance. The default 
options should be adequate for most applications with a small to medium size load.  
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• Click the Next button to create the new SQL Server database. 

• The Configurator uses Universal Data Link (.udl) files to connect to the Microsoft SQL Server 
database. These .udl files contain OLE database connection information that allows the 
Configurator to create and manage connections to OLE databases. Enter a name and directory 
path for the new .udl file in the Data Link File Name field, as shown in the figure below. You can 
browse for a directory by clicking the … button to the right of this field. Click the Next button to 
continue. If you want this new database to be the active configuration database, check Make 
Database Active. 

 
Creating a Universal Data Link File 

• Click the Finish button. The new database is created and opened in the Configurator.  

Adding a Configuration Database to an Existing SQL Server Database 
The Configuration Database Wizard also gives you the option to add the configuration database 
structure to an existing Microsoft SQL Server database: 

1. Select New from the File menu, as shown in the figure below.  

 
Creating a Configuration Database 

• The introduction screen for the Configuration Database Wizard appears. Click the Next button to 
continue. 

• You have two options for creating your new database, as shown in the figure below. Select 
Create new configuration in MS SQL Server database. Click the Next button to continue.  
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Creating a Microsoft SQL Server Database 

• To connect to a SQL Server database, select the existing database from the drop-down list, as 
shown in the figure below.  Check the Auto-append configuration into existing database 
check box. In the SQL Server field, select the local SQL Server on which to create the 
database. Type a name for the database in the Database Name field. If necessary, enter a user 
name and password to log on to the SQL Server. (Note: It is recommended that you use 
Windows NT integrated security.) Click the Next button to continue. 

• Note: Usually you have only one instance of SQL Server running on the local node. In this case, 
the drop-down list under SQL Server Name has only one option: "(local)." However, it is 
possible to run multiple SQL Server instances on the local node, in which case the SQL Server 
field lists all those SQL Server instances: "(local)" for the default instance and 
"node_name/instance_name" for all others. The drop-down list may show SQL Server instances 
on other nodes as well. 

 
Connecting to an Existing SQL Server Database 

• If the existing database already has configuration tables, you have the following options, as 
shown in the figure below: 
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Select a different database name (recommended): This option allows you to rename the 
database without affecting the existing database as well as create a new Data Link (.udl) file.  

Use the existing database structure:  This option preserves the content of the existing database 
and allows you to create a new Universal Data Link (.udl) file. 

Override all existing configuration tables: This option expunges the content of the existing 
database and allows you to create a new Universal Data Link (.udl) file. 

 
Note: Overriding the database may disable other applications that also use the database. 
 
Click the Next button to continue. 

 
Adding the Configuration to an Existing SQL Server Database 

• If you chose Select a different database name (recommended), you are directed back to the 
SQL Server Database Connection dialog box, as shown in the figure below. Enter a new name 
for the database, and then click Next. 

 
Renaming the Existing SQL Server Database 
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• Specify a directory path location in which to create the database, as shown in the figure below. 
You can either use the default SQL Server database folder, or you can click the ... button and 
browse for a specific folder. 

 
Specifying the Database Location and Properties 

• Under the Database Properties section, specify an initial size for the database, which should be 
as large as possible. You can also specify a Database Growth option (in megabytes) or as a 
percentage of the total size. MSDE servers are capable of growing the database on the fly to 
store more data. However, if this operation is performed frequently, the overall system 
performance may decrease. Choosing an initially large database size and a corresponding 
database growth option can drastically improve system performance.  

• Under the Log File Properties section, you can also modify the settings for the database 
transaction log file. Specify a Log File Growth option (in megabytes) or as a percentage of the 
total size. Again, a sufficient initial size setting can greatly improve performance. The default 
options should be adequate for most applications with a small to medium size load.  

• Click the Next button to create the new SQL Server database. 
• The Configurator uses Universal Data Link (.udl) files to connect to the Microsoft SQL Server 

database. These .udl files contain OLE database connection information that allows the 
Configurator to create and manage connections to OLE databases. Enter a name and directory 
path for the new .udl file in the Data Link File Name field, as shown in the figure below. You can 
browse for a directory by clicking the … button to the right of this field. Click the Next button to 
continue. If you want this new database to be the active configuration database, check Make 
Database Active. 

 
Note: If you chose to Use the existing database structure or to Override all existing 
configuration tables, you will still need to create a new Data Link file.   
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Creating a Universal Data Link File 

• Click the Finish button. The new database is created and opened in the Configurator.  

Toolbars 
The Alarm Server Configurator contains two toolbars: a Standard toolbar and a Data Manipulation 
toolbar.  

Standard Toolbar 
To show or hide the Standard toolbar, select Toolbars > Standard Buttons from the View menu. 
The Standard toolbar, shown below, contains the following command buttons. 
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New: Creates a new configuration database. 

Open: Opens an existing configuration database. 

Export Data: Exports configuration data to a text file (.txt) or a Microsoft Excel file (.csv).  

Import Data: Imports configuration data from a text file (.txt) or a Microsoft Excel file (.csv). 

Back: Moves the cursor back to the previously selected item in the tree control. 

Next: Moves the cursor to the next item in the tree control. 

Up One Level: Moves up one level in the tree control. 
 

Cut: Deletes current selection, sending it to the clipboard. 

Copy: Copies the current selection to the clipboard. 

Paste: Pastes the current contents of the clipboard. 

Large Icons: Displays items as large icons. 

Small Icons: Displays items as small icons. 

List: Displays items as a list. 
 

Details: Displays items as a list with details. 

Dialog View: Displays additional configuration options. 

Areas: Moves the cursor to the Areas tree control. 

Configurations: Moves the cursor to the Alarm Configurations tree control. 

Nodes: Moves the cursor to the Nodes tree control. 

Global Refresh: Refreshes the data for the entire Configurator screen. 
 

Start/Stop Server: Toggles Alarm Server runtime mode. 

About: Displays information about the application. 
 

Help: Displays context-sensitive help. 

Help Topics: Launches online Help for the application. 

 

Data Manipulation Toolbar 
To show or hide the Data Manipulation toolbar, select Toolbars > Data Manipulation Buttons 
from the View menu. The Data Manipulation toolbar, shown below, contains the following 
command buttons. 
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New Area: Creates a new area under the Areas tree control. 

New Link to Tag: Creates a new link to an alarm tag. 

New Configuration: Creates a new configuration under the Alarm Configurations tree. 

New Tag: Creates a new tag for an alarm configuration. 

New Node: Creates a new node under the Nodes tree control. 

 

Menus 
The menu bar of the Alarm Server Configurator contains the following menus: 
• File  
• Edit  

• View  
• Go  
• Action 

• Tools  
• Help  
Note: You can also access many of the menu commands by right-clicking items in the tree control 
of the Configurator and selecting command functions from the pop-up menus. 

File Menu 

The File menu of the AlarmWorX Server Configurator contains the following commands: 

Command Shortcut Key Function 
New CTRL+N Creates a new configuration database. 

Open CTRL+O Opens a new .mdb (Microsoft Data Access) or .udl (Microsoft Data Link) file. 

Save As  Saves the database under a different name.  

Connection Properties  Opens the Database Connection Properties dialog box. 

CSV Export  Exports data from a selected .csv file. 

CSV Import   Imports data from a selected .csv file. 

XML Export  Exports configuration data to an XML file. 

XML Export Schema  Exports configuration data to an XML Schema file. 

XML Import  Imports configuration data from an XML file. 

XML Validate  This feature does not import an XML data file, but it will try to validate its structure 
using stored XML schema. Once it passes this validation, the XML file is acceptable for 
import by the Configurator. 

Make Active  Activates the current configuration database for use by the alarm server.  

Exit  Closes the applications and stops data logging if it started within the Configurator. 
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Database Connection Properties 
Selecting Connection Properties from the File menu opens the Database Connection Properties 
dialog box, shown below, which lists the initialization properties for the current database connection. 

 
Database Connection Properties Dialog Box 

Exporting Configuration Data 

Exporting Data to a Text or CSV File 
The Configurator offers the flexibility of exporting data from your configuration database to a text 
(.txt) file or a Microsoft Excel (.csv) file. To export data, select Export from the File menu. This 
opens the Export Configuration Data to File dialog box, as shown in the figure below. You can 
then specify the delimiters for exporting the data. Unless you specify delimiters in the Export 
Configuration Data to File dialog box, the file uses Commas as delimiters by default. Each group 
contains headings and columns that provide information about each item, such as descriptions and 
associated translations and expressions. It also provides the "tree" pathway for each item. Choose 
the directory to which you want to export the data from your database. In the Save As Type field, 
choose the file type (.txt or .csv) that you would like to save.  
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Exporting Configuration Data  

Exporting Data to an XML File 
The Configurator also allows you to export data from your configuration database to an XML file. 
The XML export/import functionality was mainly developed for Windows platforms that do not 
support databases (e.g. Windows CE and Windows Embedded). XML has the following advantages 
over the CSV import/export function:  
XML has a standardized format, unlike the text/CSV format, which uses various delimiters (e.g. TAB 

instead of commas, strings could not accept all characters, etc.) 
XML is language-independent, whereas CSV converts date/time, floats, and currency fields 

according to local settings in Windows. For example, using CSV, you cannot export data on 
German Windows and import it on English windows without making changes 

Windows has an installed automation object that has the capability to work with XML. Thus, 
programmers can create/modify their configurations outside the Configurator using Visual Basic, 
if desired. 

XML supports schemas. A schema is a special XML file that specifies the data structure of an XML 
data file. 

To export data, select XML Export from the File menu. This opens the Export XML File dialog box, 
as shown in the figure below. Give the file a name, and then choose the directory to which you want 
to export the data from your database. Click Save. 
Note: You can also export configuration data to an XML Scheme file by selecting XML Export from 
the File menu. 

 
Exporting Configuration Data to an XML File 
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Importing Configuration Data 

Importing Data From a Text or CSV File 
The Configurator offers the flexibility of importing data from a text (.txt) file or a Microsoft Excel (.csv) 
file to your configuration database. To import data, select Import CSV from the File menu. This 
opens the Import Configuration Data From File dialog box, shown below. You can then specify 
the delimiters and choose from the following import settings:  

Create new items. When the import file contains items that are not yet in the configuration 
database, then it creates them. Otherwise it skips these items. 
Update existing items. When the import file contains items that are in the configuration database, 
then it updates them using data from the import file. Otherwise it skips these items. 
Note: Either Create new items or Update existing items must be selected. Otherwise there is 
nothing to import. 
Display errors. When this item is checked, the Configurator shows a dialog box if an error occurs, 
and then asks you if you want to proceed with the import. When it is not checked, it skips all items 
where an error occurred.  

 
Importing Configuration Data  

When you have selected a file to import, click Open. When the import is completed, the File Import 
Results dialog box opens, as shown below. This shows the import settings, including the input file 
name. It also provides a summary of the import, including how many items were inserted, updated, 
or rejected, and shows how many errors occurred.  
Click the ... button to the right of each field to get the details view of the import results, as shown 
below. This view shows the specific items that were inserted, updated, or rejected, as well as a 
description of any errors that occurred. 
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File Import Results Dialog Box 

Importing Data From an XML File 
The Configurator allows you to import data from your configuration database to an XML file. The 
XML export/import functionality was mainly developed for Windows platforms that do not support 
databases (e.g. Windows CE and Windows Embedded). XML has the following advantages over the 
CSV import/export function:  

XML has a standardized format, unlike the text/CSV format, which uses various delimiters (e.g. 
TAB instead of commas, strings could not accept all characters, etc.) 
XML is language-independent, whereas CSV converts date/time, floats, and currency fields 
according to local settings in Windows. For example, using CSV, you cannot export data on 
German Windows and import it on English windows without making changes 
Windows has an installed automation object that has the capability to work with XML. Thus, 
programmers can create/modify their configurations outside the Configurator using Visual Basic, if 
desired. 
XML supports schemas. A schema is a special XML file that specifies the data structure of an 
XML data file. 
To import data, select XML Import from the File menu. This opens the Import XML File dialog box, 
as shown in the figure below. Give the file a name, and then choose the directory from which you 
want to import the data. You can then specify the delimiters and choose from the following import 
settings. Click Open. 

• Create new items. When the import file contains items that are not yet in the configuration 
database, then it creates them. Otherwise it skips these items. 

• Update existing items. When the import file contains items that are in the configuration 
database, then it updates them using data from the import file. Otherwise it skips these items. 

Note: Either Create new items or Update existing items must be selected. Otherwise there is 
nothing to import. 
Note: Selecting XML Validate from the File menu does not import an XML data file, but it will try to 
validate its structure using stored XML schema. Once it passes this validation, the XML file is 
acceptable for import by the Configurator. 
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Importing Configuration Data From an XML File 

Activating the Database 
Once your configuration is complete, you need to make sure that it is the active database. The 
database that is currently active is the one that the alarm server will use. To make the current 
database active, select Make Active from the File menu. If the Make Active selection is grayed out, 
then the current database is already the active database. 
A dialog box appears, as shown in the figure below, showing both the current active database and 
database that is currently being edited, as shown in the figure below. To set the edited database as 
the active database, click the Yes button. 

 
Activating the Database 
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Edit Menu 
The Edit menu commands are listed in the table below. 

 
Edit Menu Commands  

Command Shortcut Keys Function 
New   Creates a new item depending on what is selected in the tree control.  

Rename CTRL+R Renames the selected item. 

Multiply CTRL+M Opens the Multiply Item dialog box (see below), which allows you to multiply an 
item in the tree control.  

Delete CTRL+DEL Deletes the selected object. 

Cut CTRL+X Cuts the selected object from the view and places it on the clipboard. 

Copy CTRL+C Copies the selected object to the clipboard. 

Paste CTRL+V Pastes the last object placed on the clipboard. 

Select All CTRL+A Selects all objects in a list. The selection is shown in the upper-right-hand section of 
the viewer. 

Invert Selection  Unselects all selected items and selects all unselected items in a list in the upper-
right-hand section of the viewer.  

Multiplying Items 
The Alarm Server Configurator allows you to multiply items in the tree control. Multiplication 
provides a simple way of developing configurations where there are many similar items in a given 
category. To multiply an item: 

1. Select the item in the tree control that you wish to multiply.   

2. Either right-click the item and select Multiply from the pop-up menu, or select Multiply from the 
Edit menu. This opens the Multiply Item dialog box, shown below. 

 
Multiply Item Dialog Box 

• When the items are multiplied, they are all given a base name followed by a number. The default 
base text is the name of the item selected for multiplication. To modify the base text, change the 
Base Text field appropriately. 

• In the First Number field, specify the number to appear next to the first multiplied item. 

• In the Number of Items field, specify how many items you wish to create. 
• In the Numeric Places field, specify the minimum length of each number to append. Values that 

take up less space than the specified amount of numeric places will have zeros before the 
number. 

• If you want to multiply all subfolders as well, check the Including Subtree check box. 
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• Click the OK button to do the multiplication. The example configuration shown in the Multiply 
Item dialog box above creates three new OPC Data folders with the following names: 

Core Temp001 
Core Temp002 
Core Temp003 
 
All subfolders will also be multiplied. 

View Menu 
The View menu commands are listed in the table below. 
View Menu Commands 

Command Shortcut Keys Function 
Toolbars  Toggles the standard and data manipulation toolbars.  
Status Bar  Toggles the status bar. 
Large Icons F7 Displays items as large icons. 
Small Icons F8  Displays items as small icons. 
List F9 Displays items as a list. 

Details F10 Displays items as a list along with detailed information about the 
configuration of each item. 

Dialog View F11 Toggles the configuration window (right-hand pane). 

Sort By  Displays a list of options for sorting the columns in the right-hand pane of 
the screen. The options listed depend on the level within the view.  

Show/Hide 
Columns  Displays a list of options that you can choose to show or hide in the view.  

Select Language  
Opens the Select Language dialog box (see below). Choose the language 
you wish to use for your system (Unicode version only) and click OK. For 
navigation purposes, use the buttons and check boxes in the List section.  

Global Refresh F5 Refreshes the data for the entire Configurator screen. 
Subtree Refresh CTRL+F5 Refreshes only the data contained in the currently selected subtree.  
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Selecting Languages 
The Select Language function on the View menu allows you to choose which language to use in 
your display. Choosing Select Language from the View menu opens the Select Language dialog 
box, shown in the figure below. 
Note: A language resource .dll is required for language switching. 

 
Select Language Dialog Box 

Define the parameters listed in the table below. Then click OK to return to the work area. 
 

Select Language Parameters 
Parameter Description 

List 

Lists available languages.  Depending on which item you have selected, 
the view on the left will change.  If English is checked, the languages will 
appear as their English name. If Localized is checked, the languages will 
appear with the native country in parentheses (for languages with several 
dialects only). When Native is checked, the languages are displayed the 
way they would be written in that language. 

Installed Locales Only If this is checked, local languages appear in the box. 

Available Language 
Translations Only 

Checking this box allows you to choose from available language 
translations only. 

 

Go Menu 
The Go menu commands are listed in the table below. 
Go Menu Commands 

Command Shortcut Keys Function 

Back CTRL+ALT+ 
Left Arrow Moves the cursor back to the previously selected item in the tree control. 

Forward CTRL+ALT+ 
Right Arrow Moves the cursor forward to the previously selected item in the tree control. 

Up One Level  Moves the cursor up one level in the tree control. 

Next Item ALT+Down 
Arrow Moves the cursor to the next item down in the tree control. 

Previous Item  ALT+Up Arrow Moves the cursor to the next item up in the tree view. 
Expand Item ALT+Left Arrow Expands an item that contains a submenu. 
Collapse Item ALT+Right Collapses an item that contains a submenu. 



AlarmWorX 
 

5.23 

Command Shortcut Keys Function 
Arrow 

Page Up ALT+PgUp Moves the cursor up to the first item in the tree. 
Page Down ALT+PgDown Moves the cursor down to the last visible item in the tree. 
Home ALT+Home Moves the cursor up to the first item in the tree. 
End ALT+End Moves the cursor down to the last visible item in the tree. 
Areas F2 Moves the cursor to the Areas tree control. 
Configurations F3 Moves the cursor to the Alarm Configurations tree control. 
Nodes F4 Moves the cursor to the Nodes tree control. 
Next Pane F6 Moves the cursor to the next pane. 
Previous Pane SHIFT+F6 Moves the cursor to the last pane used. 

Action Menu 
The Action menu contains the following commands: 

Command Function 
Start Alarm Server Starts the alarm server for the active configuration.  

Stop Alarm Server Stops the alarm server for the active configuration.  

Only one of the above options will be available at a time, depending on the state of the Alarm OPC 
Server.   

Tools Menu 
The Tools menu commands are listed in the table below. 
Tools Menu Commands 

Command Function 
Set Working Directory Sets a working directory for all files relating to the saved configuration. 

Options Launches the Options dialog box.  

Compact/Repair MS 
Access Database Opens the Compact/Repair MS Access Database dialog box. 

 

Setting the Working Directory 
Selecting Set Working Directory from the Tools menu opens the Set Working Directory dialog 
box, shown below, which enables you to configure a custom directory in which all application 
configuration files will be stored and retrieved. Click Browse to select the directory. 

 
Set Working Directory Dialog Box 
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Options 
To choose additional settings, select Options from the Tools menu. This opens the Options dialog 
box, shown in the figure below. The General tab of the Options dialog box, sets the startup and 
workspace parameters for the Alarm Server Configurator. 

 
Options Dialog Box: General Tab 

Startup Settings 
The Startup Settings options allow you to save regional settings in the registry so that they are 
applied each time you start the Configurator. This applies to the language settings as well as time 
and date settings. Select one of the following startup settings: 

Open the active file: Launches the currently active database upon startup. 
Open the most recently used file: Launches the recently opened database. 
Open a specific file: Specifies a Microsoft Access (.mdb) or Microsoft Datalink (.udl) database to 
launch upon startup. To select a database, click the ... button next to the text box and browse for 
the file. When this option is selected, the "active" database is overridden by the specified 
database. 
 
Workspace Settings 
The following Workspace Settings are available: 

Auto-apply editor changes: Checking this option allows changes to the configuration database to 
be saved each time you switch dialogs without clicking on the Apply button or being shown a 
message asking if you would like to apply changes. 
Auto-test Make Active before closing the database: When this option is checked, each time 
you exit a currently open (nonactive) database you are asked whether you want to make the 
database active. 
Enable hover selection: Checking this option allows you to highlight an item by moving the mouse 
pointer over that item and keeping it there for a specified amount of time (in milliseconds). 
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Compacting and Repairing MS Access Databases 
You can compact Microsoft Access databases, which can be either configuration databases or 
historical databases, using the Compact/Repair MS Access Database dialog box, shown in the 
figure below. To open this dialog box, select Compact/Repair MS Access Database from the 
Tools menu. Microsoft Access–based databases are subject to database fragmentation over time, 
and the support for the database will compact the target database, reclaim unused space, and 
drastically improve database performance. 
Note: It is critical that no users or client applications are connected to the database at the time of 
compacting and that, if the Backup Original Database option is selected, there is plenty of 
available hard disk space. 

 

Help Menu 

Compact/Repair MS Access Database Dialog BoxHelp Menu 
The Help menu contains the following commands: 

Command Shortcut Key Function 
Help Topics F1 Launches the online help for the Configurator.  

What's This? SHIFT+F1 Displays context-sensitive help topics. 

About Application  

Launches the SMAR About Box, which contains 
information about the product version number, 
copyright, and available disk space. It also contains 
information about how to contact SMAR.  

Areas 
An area is used to group OPC alarm tags. This information can be used by clients for filtering 
purposes.  A tag can exist under multiple areas, and an area can have a multiple levels.  An area is 
defined by its name and the name of its parent branches.  For example, a branch called Area 1 
under plant Area A is different from Area 1 under plant Area B. 

Creating a New Area 
To create a new area: 

1. Right-click on the Areas tree control of the Configurator and select New > Area from the pop-up 
menu, as shown in the figure below.  
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Creating a New Area 

• The properties dialog box for the new area appears in the right-hand pane of the Configurator, 
as shown in the figure below.  

 
Setting the Properties for the New Area 

• In the Name field, type a name for the new area. You can optionally type a Description for the 
area. 

• When you have finished configuring the area properties, click the Apply button. The new area 
appears under the Areas tree control, as shown in the figure below. 

 
New Area Added to Tree Control 

Linking to Alarm Tags 
To create a new link to alarm tags from a particular area: 

1. Right-click on an area in the Areas tree control of the Configurator and select New > Insert New 
Link(s) to Tags from the pop-up menu, as shown in the figure below.  
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Creating an Alarm Tag Link 

• This opens the Alarm Tag Selector, as shown in the figure below, which lists all alarm tags for 
each alarm configuration. Select an alarm configuration from the Select Configuration drop-
down list, and then click on the tag(s) to which you want to link from the area. 

 
Alarm Tag Selector 

• The tag(s) appear under the area in the tree control, as shown in the figure below. In the right-
hand pane, all the tag properties are displayed. To change the tag configuration properties, click 
the Jump to Tag button. 
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Linked Tags Added to Tree Control 

Alarm Configurations 
An alarm configuration sets the parameters for OPC tags and defines how alarm information will 
be handled by the alarm server. Multiple configurations can be stored in a single database, but only 
one configuration can be active for a single alarm server at one time.  Only one alarm configuration 
can be active per node at one time.  Only one alarm server can run per node at one time.   

Creating a New Alarm Configuration 
To create a new alarm configuration: 

1. Right-click on the Alarm Configurations tree control of the Configurator and select New > 
Configuration from the pop-up menu, as shown in the figure below.  

 
Creating a New Alarm Configuration 

• The properties dialog box for the new configuration appears in the right-hand pane of the 
Configurator, as shown in the figure below.  
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Setting the Properties for the New Alarm Configuration 

• In the Name field, type a name for the new configuration.  

• When you have finished configuring the alarm configuration properties, click the Apply button. 
The new configuration appears under the Alarm Configurations tree control, as shown in the 
figure below. 

 
New Alarm Configuration Added to Tree Control 

Alarm Configuration Properties 
Configure the following parameters for alarm configurations, as shown in the figure below. 

 
Alarm Configuration Properties 

Name: Type a name for the alarm configuration. 
Description: Type in a description for the alarm configuration (optional). 
Default Configuration: If you have multiple alarm configurations, you can specify a default 
configuration that will be used for the active database. Check this check box to make the current 
alarm configuration the default configuration. 
Scan Period: This is the requested update rate (period in milliseconds) sent to all OPC Data 
Access servers used by this configuration. The default is one second (1000 milliseconds). 
Startup squelch: Specifies the number of minutes from when the alarm server starts to inhibit the 
reporting of alarms with BAD quality. The default is 1 minute. When the alarm server starts, it may 
cause underlying OPC Data Access Servers to start. During startup, many OPC Data Access 



Server Configurator 
 

5.30 

servers will send data values with BAD quality until an initial value is received from the device. 
Adjust this setting to eliminate erroneous alarms on startup. At the end of the defined period, any 
event notifications being suppressed for BAD quality will be reported. 
Note: This setting does not suppress all alarm processing and reporting during this period. As soon 
as an input quality is first reported as GOOD, normal alarm processing begins. In most cases, this 
happens well before the squelch period ends. 
Use OPC DA Timestamp: By default, the alarm server generates timestamps internally using the 
system clock. When this check box is checked, the timestamps provided by the OPC Data Access 
servers are used instead. If an alarm has more than one input, the latest timestamp will be used. 
 

Tags 
A tag represents a single object for OPC alarm information.  An alarm tag can contain information 
for multiple types of OPC alarms, including deviation, limit, rate of change, and digital alarms.   

Creating a New Tag 
To create a new tag: 

1. Right-click on an alarm configuration in the tree control of the Configurator and select New > 
Tag from the pop-up menu, as shown in the figure below.  

 
Creating a New Tag 

• The properties dialog box for the new tag appears in the right-hand pane of the Configurator, as 
shown in the figure below.  

 
Setting the Properties for the New Tag 
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• In the Name field, type a name for the new tag.  
• In the OPC Input 1 field, specify the base field for the calculation of alarms. You can choose 

OPC tags and expressions for the various fields by clicking on the arrow button. 
• When you have finished configuring the tag properties, click the Apply button. The new tag 

appears under the Alarm Configurations tree control, as shown in the figure below. 

 
New Tag Added to Tree Control 

Configuring Tag Properties 
Configure the following parameters for alarm tags, as shown in the figure below. 

 
Alarm Tag Properties 

Name: Type a name for the tag. The alarm's tag name uniquely identifies the alarm. 
OPC Input 1: Indicates an expression (which can contain an OPC tag) or an OPC tag itself as the 
source of data for the alarm.  You can choose OPC tags and expressions for the various fields by 
clicking on the arrow buttons. 
The tag properties contain four main sections: 
General 
Alarms 
Related Values 
Areas 
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Throughout the tag properties sections, you can choose OPC tags and expressions for the various 
fields by clicking on the arrow buttons, as shown in the figure below. 

 
Selecting OPC Tags and Expressions 

General 
The General section of the tags properties, shown in the figure below, configures the following 
general tag properties. 

 
Tags: General Properties 

Enabled: Specifies a value (expression or OPC tag) to determine if the alarm is enabled or not. 
Default Display: Choose a file to display for the selected tag by clicking on the ... button and 
browsing for a file. 
Description: Type in a description for the alarm tag (optional).  
Delay: Normally alarms are reported as soon as they are detected.  Sometimes it is desirable to 
delay reporting an alarm condition for some time after it is detected. If the alarm condition still exists 
after this delay, the alarm is reported. The delay is specified in seconds. 
Base Text: Message text that will appear with the alarm.  
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Note: The Base Text field automatically adds a single space at the beginning of the text string, so 
you should be aware of this when filtering alarms. 
Help Instructions: Type in the text that will be displayed in the Alarm Viewer screen when the 
associated tag reaches the alarming state. This helps guide operators through corrective action 
steps to solve or acknowledge a particular alarm.  You can enter information directly or paste text 
from the Clipboard. 
Clicking the ... button in the Help Instructions and Base Text fields opens the Language Alias 
Browser, as shown in the figure below. The browser includes all languages aliases in the language 
database. All language aliases that are configured in the Language Configurator are conveniently 
available to choose from inside the browser. The tree control of the Language Configurator is 
mimicked in the tree control of the Language Alias Browser. Select a language alias by double-
clicking the alias name. The alias name appears at the top of the browser, which automatically adds 
the /+ and +/ delimiters to the alias name. Click the OK button. 

 
Selecting an Alias From the Language Alias Browser 

Alarms 
The Alarms section of the tags properties contains four tabs that describe the limits of each tag and 
when an alarm will be set off: 

Limit 
Deviation 
Rate of Change  
Digital 
Note: If data are entered on either the Limit or Deviation tabs, the tag is defined as an Analog tag.  
If data are entered on either the Rate of Change or Digital tabs, the tag is defined as a Digital tag.  
A tag that contains data on at least one tab from each group is classified as an Analog/Digital tag.  
Calculation of Alarms 
It is important to note that alarm states are calculated per update of an OPC tag.  This means that 
alarm tags that have multiple OPC tags associated with a state will be calculated once for each 
OPC tag update.  For example: A limit alarm has an OPC tag for the OPC Input 1 field and for the 
LoLo field. Both tags change value and are updated to the alarm server simultaneously. The server 
will then calculate the limit value once for the OPC Input 1 field and once for the LoLo field. The 
order of fields calculated is random and determined by the order they are placed in the update 
queue. 
In normal operation this is not a concern, however this can cause posting of alarms due to "noise" 
situations. Continuing with the above example, if the LoLo value changed from 5 to 15 and the OPC 
Input value changed from 6 to 16, an alarm could be posted if the new LoLo value is calculated 
before the new OPC input value, even though these two numbers changed "simultaneously." This 
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can be especially true when using alias values, as each of the OPC data inputs will be calculated 
individually. 

Limit 
The Limit tab of the Alarms section of the tag properties, shown in the figure below, sets the 
secondary OPC input and sets the values for the four levels of alarms: LoLo, Lo, Hi, and HiHi.   

 
Alarm Types: Limit Tab 

The OPC Override Input field is used to replace the OPC Input 1 base field for the calculation of 
alarms.  This field is optional and if left blank the default field of OPC Input 1 will be used. 
Deadband indicates the deadband value to apply to the converted analog values.  The deadband 
value is required and is calculated on borderline alarming limit values to prevent repeated alarm 
cycles.   
The Value field is used to calculate the state of the input fields.  For example, a value of 10 for LoLo 
is compared with the value of OPC Input 1 or OPC Override Input to determine if the alarm is in 
LoLo state. 
In the Message Text field, enter the warning message that will appear when the alarm is sent. The 
message can be any text string, including a language alias (Unicode version only).  
In the Return to Normal field you to enter the text that will appear when the alarm is taken care of 
(e.g. has been acknowledged). The message can be any text string, including a language 
alias(Unicode version only). 
Note:  It is not necessary to enter a message text or a base text. The Server will default to the OPC 
subcondition name and the OPC condition name. For example, a LoLo alarm will post a description 
of LoLo limit. 
Clicking the ... button opens the Language Alias Browser, as shown in the figure below. The 
browser includes all languages aliases in the language database. All language aliases that are 
configured in the Language Configurator are conveniently available to choose from inside the 
browser. The tree control of the Language Configurator is mimicked in the tree control of the 
Language Alias Browser. Select a language alias by double-clicking the alias name. The alias name 
appears at the top of the browser, which automatically adds the /+ and +/ delimiters to the alias 
name. Click the OK button. 
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Selecting an Alias From the Language Alias Browser 

Severity is the OPC-defined value for alarm Priority. The valid OPC severity range is 0 (lowest) to 
1000 (highest).  
The Requires Ack field is used for OPC condition alarms to determine whether the alarm needs a 
user acknowledgement. If the Requires Ack field value is 1, then the alarm requires a user 
acknowledgement. If the value is 0, then the alarm is posted as already acknowledged. 
Note:  Changes to the alarm property fields (HiHi, LoLo, Hi, Lo, Message Text, etc.) in runtime 
through an OPC tag update will be automatically saved to the database, over-writing any values 
specified in configuration mode.  

Deviation 
The Deviation tab of the Alarms section of the tag properties,, shown in the figure below, allows the 
configuration of alarms where the limits are tested against the difference between two inputs: OPC 
Input 1 and OPC Input 2. The OPC Input 2 field is mandatory and is used to calculate the deviation 
from the OPC Input 1 base field.   

 
Alarm Types: Deviation Tab 
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Deadband indicates the deadband value to apply to the converted analog values.  The deadband 
value is required and is calculated on borderline alarming limit values to prevent repeated alarm 
cycles.   
The Value field is used to calculate the state of the input fields.  For example, a value of 10 for LoLo 
is compared with the value of OPC Input 1 or OPC Override Input to determine if the alarm is in 
LoLo state. 
In the Message Text field, enter the warning message that will appear when the alarm is sent. The 
message can be any text string, including a language alias (Unicode version only).  
In the Return to Normal field you to enter the text that will appear when the alarm is taken care of 
(e.g. has been acknowledged). The message can be any text string, including a language 
alias(Unicode version only). 
Note:  It is not necessary to enter a message text or a base text. The Server will default to the OPC 
subcondition name and the OPC condition name. For example, a LoLo alarm will post a description 
of LoLo limit. 
Clicking the ... button opens the Language Alias Browser, as shown in the figure below. The 
browser includes all languages aliases in the language database. All language aliases that are 
configured in the Language Configurator are conveniently available to choose from inside the 
browser. The tree control of the Language Configurator is mimicked in the tree control of the 
Language Alias Browser. Select a language alias by double-clicking the alias name. The alias name 
appears at the top of the browser, which automatically adds the /+ and +/ delimiters to the alias 
name. Click the OK button. 

 
Selecting an Alias From the Language Alias Browser 

Severity is the OPC-defined value for alarm Priority. The valid OPC severity range is 0 (lowest) to 
1000 (highest).  
The Requires Ack field is used for OPC condition alarms to determine whether the alarm needs a 
user acknowledgement. If the Requires Ack field value is 1, then the alarm requires a user 
acknowledgement. If the value is 0, then the alarm is posted as already acknowledged. 
Note:  Changes to the alarm property fields (HiHi, LoLo, Hi, Lo, Message Text, etc.) in runtime 
through an OPC tag update will be automatically saved to the database, over-writing any values 
specified in configuration mode.  
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Rate of Change 
The Rate of Change tab of the Alarms section of the tag properties, shown in the figure below, sets 
an alarm if an input changes at a rate higher than ROC Limit/Sec. The remaining fields on this tab 
are identical to those on the Limit tab.  

 
Alarm Types: Rate of Change Tab 

In the Message Text field, enter the warning message that will appear when the alarm is sent. The 
message can be any text string, including a language alias (Unicode version only).  
In the Return to Normal field you to enter the text that will appear when the alarm is taken care of 
(e.g. has been acknowledged). The message can be any text string, including a language 
alias(Unicode version only). 
Note:  It is not necessary to enter a message text or a base text. The Server will default to the OPC 
subcondition name and the OPC condition name. For example, a LoLo alarm will post a description 
of LoLo limit. 
Clicking the ... button opens the Language Alias Browser, as shown in the figure below. The 
browser includes all languages aliases in the language database. All language aliases that are 
configured in the Language Configurator are conveniently available to choose from inside the 
browser. The tree control of the Language Configurator is mimicked in the tree control of the 
Language Alias Browser. Select a language alias by double-clicking the alias name. The alias name 
appears at the top of the browser, which automatically adds the /+ and +/ delimiters to the alias 
name. Click the OK button. 

 
Selecting an Alias From the Language Alias Browser 
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Severity is the OPC-defined value for alarm Priority. The valid OPC severity range is 0 (lowest) to 
1000 (highest).  
The Requires Ack field is used for OPC condition alarms to determine whether the alarm needs a 
user acknowledgement. If the Requires Ack field value is 1, then the alarm requires a user 
acknowledgement. If the value is 0, then the alarm is posted as already acknowledged. 

Digital 
The Digital tab of the Alarms section of the tag properties, shown in the figure below, sets an alarm 
if the comparison between the Alarm State Value and the input state is TRUE. The remaining fields 
on this tab are identical to those on the Limit tab. 

 
Alarm Type Digital Tab 

In the Message Text field, enter the warning message that will appear when the alarm is sent. The 
message can be any text string, including a language alias (Unicode version only).  
In the Return to Normal field you to enter the text that will appear when the alarm is taken care of 
(e.g. has been acknowledged). The message can be any text string, including a language 
alias(Unicode version only). 
Note:  It is not necessary to enter a message text or a base text. The Server will default to the OPC 
subcondition name and the OPC condition name. For example, a LoLo alarm will post a description 
of LoLo limit. 
Clicking the ... button opens the Language Alias Browser, as shown in the figure below. The 
browser includes all languages aliases in the language database. All language aliases that are 
configured in the Language Configurator are conveniently available to choose from inside the 
browser. The tree control of the Language Configurator is mimicked in the tree control of the 
Language Alias Browser. Select a language alias by double-clicking the alias name. The alias name 
appears at the top of the browser, which automatically adds the /+ and +/ delimiters to the alias 
name. Click the OK button. 
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Selecting an Alias From the Language Alias Browser 

Severity is the OPC-defined value for alarm Priority. The valid OPC severity range is 0 (lowest) to 
1000 (highest).  
The Requires Ack field is used for OPC condition alarms to determine whether the alarm needs a 
user acknowledgement. If the Requires Ack field value is 1, then the alarm requires a user 
acknowledgement. If the value is 0, then the alarm is posted as already acknowledged. 

Related Values 
The related values feature allows up to 10 "snapshots" of data taken at the time of alarm to be 
permanently associated with that instance of the alarm. This is often used to associate the 
occurrence of an alarm with a particular lot or batch. A related value can be the value of an OPC 
data access item, an expression or a constant expression. 
The Related Values section of the tags properties, shown in the figure below, allows you to associate 
up to 10 OPC tags or expressions with each alarm tag as “supplemental” information to the alarm.  For 
example, you could relate a “Batch ID” to a specific alarm.  Then, when the alarm becomes active, a 
permanent record of the Batch ID is also stored along with the alarm information. You can choose OPC 
tags and expressions for the various fields by clicking on the arrow buttons. 

 
Tags: Related Values 
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Areas 
The Areas section of the tags properties, shown in the figure below, shows all areas to which the 
tag is linked. Clicking on an area takes you to the area configuration. You can assign an alarm to 
more than one area or grouping. For example, a tank limit alarm may be part of both the "Tank 1" 
area, as well as the "Water" area. 

 
Tags: Areas 

OPC Tags and Expressions 
Throughout the tag properties sections, you can choose OPC tags and expressions for the various 
fields by clicking on the arrow buttons, as shown in the figure below. 

 
Selecting OPC Tags and Expressions 
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OPC Tags 
The Tag Browser, shown in the figure below, which allows you to select from OPC Data Access 
tags. 

 
OPC Universal Tag Browser 

 
Expression Editor 

Selecting Expression Editor opens the Edit Expresion dialog, as shown in the figure below. The 
Expression Editor box has the following options:  

Arithmetic 
Relational 
Logical 
Bitwise 
Functions 
Each of these options is explained in greater detail in following sections. For complete information 
about writing and editing expressions, please see the Expression Editor Help documentation. 

 
Expression Editor 
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Arithmetic 
The symbols '+', '-', '*', '/' and '%' use the following format:  

expression :: parameter symbol parameter 
Where  

Parameter A local variable, an OPC tag, a constant, or another expression 
Symbol + or - or * or / or % 

 
Result 
The expression results in a number of any type (float, long, etc.). 

 
Examples 

Symbol Description Example Result 
+ Addition ~~var1~~ + ~~var2~~ 8+3 = 11 

- Subtraction ~~var1~~ - ~~var2~~ 8-3 = 5 

* Multiplication ~~var1~~ * ~~var2~~ 8*3 = 24 

/ Division ~~var1~~ / ~~var2~~ 8/3 = 2.66667 

% Calculates the remainder after division ~~var1~~ % ~~var2~~ 8%3 = 2 

( and ) Gives precedence to parts of the calculation ~~var1~~ / (~~var2~~ + ~~var3~~) 8/(3+2) = 1.6 

Relational 
The symbols '<', '>', '<=', '>=', '==' and '!=' use the following format:  

expression :: parameter symbol parameter 
Where  

Parameter A local variable, an OPC tag, a constant, or another expression 
Symbol < or > or <= or >= or == or != 

 
Result 
The expression results in a Boolean value (0 or 1).  

Examples 
Symbol Description Example Result 

< Less than ~~var1~~ < ~~var2~~ 8<3 = 0 

> Greater than ~~var1~~ > ~~var2~~ 8>3 = 1 

<= Less than or equal to ~~var1~~ <= ~~var2~~ 8<=3 = 0 

>= Greater than or equal to ~~var1~~ >= ~~var2~~ 8>=3 = 1 

== Equal to ~~var1~~ == ~~var2~~ 8==3 = 0 

!= Not equal to ~~var1~~ != ~~var2~~ 8!=3 = 1 

Logical 
The symbols '&&' and '||' use the following format:  

expression :: parameter symbol parameter 
 
The symbol '!' uses the following format: 

expression :: symbol parameter 
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Where  
Parameter A local variable, an OPC tag, a constant, or another expression 
Symbol && or || or ! 

 
Result 
The expression results in a Boolean value (0 or 1). 

 
Truth table 

  
 
Examples 

Symbol Description Example Result 
&& And ~~var1~~ && ~~var2~~ 8 && 3 = 1 

|| Or ~~var1~~ || ~~var2~~ 8 || 3 = 1 

! Not !~~var1~~ !8 = 0 

 

Bitwise 
The symbols '&', '|', and '^' of the bitwise group use the following format:  

expression :: parameter symbol parameter 
The symbol '~' of the logical group uses the following format:  

expression :: symbol parameter 
The symbols 'shl' and 'shr' of the bitwise group use the following format: 

expression :: symbol (value, shift by) 

Where  
Parameter A local variable, an OPC tag, a constant, or another expression 
Symbol && or || or ^ or shl or shr or ~ 

 
Result 
The expression results in a number when the parameters used contain numbers. 

Bit Table 
 Binary (Decimal) Binary (Decimal) 

~~var1~~ 0000.0000.0000.1000 - (8) 0000.0000.0110.0000 - (96) 

~~var2~~ 0000.0000.0000.1010 - (10) 0000.0000.0000.1000 - (8) 

~~var1~~ & ~~var2~~ 0000.0000.0000.1000 - (8) 0000.0000.0000.0000 - (0) 

~~var1~~ | ~~var2~~ 0000.0000.0000.1010 - (10) 0000.0000.0110.1000 - (104) 

~~var1~~ ^ ~~var2~~ 0000.0000.0000.0010 - (2) 0000.0000.0110.1000 - (104) 

shl (~~var1~~,3) 0000.0000.0100.0000 - (64) 0000.0011.0000.0000 - (768) 

shr (~~var1~~,3) 0000.0000.0000.0001 - (1) 0000.0000.0000.1100 - (12) 

~(~~var1~~) 1111.1111.1111.0111 - (-9) 1111.1100.1111.1111 - (-97) 

bittest(~~var1~~,3) 0000.0000.0000.0001 - (1) 0000.0000.0000.0000 - (0) 

 



Server Configurator 
 

5.44 

Examples 
Symbol Description Example Result 

& Bit And ~~var1~~ & ~~var2~~ 8 && 3 = 0 

| Bit Or ~~var1~~ | ~~var2~~ 8 || 3 = 11 

^ Bit eXclusive Or ~~var1~~ ^ ~~var2~~ 8^3=11 

shl Bit shift left shl(~~var1~~,3) 8<<3=64 

shr Bit shift right shr(~~var1~~,3) 8>>3=1 

~ Not (two's complement) ~(~~var1~~) !8 = -9 

bittest Bit Test bittest ( 5 , 0 ) 1 

 
Note: The bittest function requires you to specify the position of the bit to be tested. You must 
indicate that it starts from 0. In other words, a bit position of "0" indicates the "less significant" bit. 

Functions 
The symbols 'sin', 'asin', 'cos', 'acos', 'tan', 'atan', 'log', 'ln', 'exp', 'sqrt', 'abs', 'ceil', and 'floor' use the 
following format: 

expression :: symbol (parameter) 
 
The symbols 'pow', 'min', and 'max' use the following format: 

expression :: symbol (parameter,parameter) 
 
The symbol 'if' uses the following format: 

expression :: symbol (parameter,parameter,parameter) 

Where  
Parameter A local variable, an OPC tag, a constant, or another expression 
Symbol sin, asin, cos, acos, tan, atan, log, ln, exp, sqrt, abs, ceil, floor, min, max, pow, or if 

 
Result 
The expression results in a number. 
Examples 

Symbol Description Example Result 
sin sine of an angle in radians sin(~~var1~~) sin(0.785)=0.71 

cos cosine of an angle in radians cos(~~var1~~) cos(0.785)=0.71 

tan tangent of an angle in radians tan(~~var1~~) tan(0.785)=1.0 

asin arc sine returns an angle in radians asin(~~var1~~) asin(0.5)=0.52 

acos arc cosine returns an angle in radians acos(~~var1~~) acos(0.5)=1.05 

atan arc tangent returns an angle in radians atan(~~var1~~) atan(1)=0.785 

sqrt Returns the square root sqrt(~~var1~~) sqrt(100)=10 

pow Returns value 1 raised to the power value 2 pow(~~var1~~,~~var2~~) pow(100,1.5)=1000 

log 10 based logarithm log(~~var1~~) log(100)=2 

ln e based logarithm ln(~~var1~~) ln(7.389)=2 

exp Exponential  exp(~~var1~~) exp(2)=7.389 

abs Absolute value abs(~~var1~~) abs(-1)=1 

ceil Integer ceiling ceil(~~var1~~) ceil(7.39)=8 

floor Integer floor floor(~~var1~~) floor(7.39)=7 

min Lowest value of two min(~~var1~~,~~var2~~) min(10,5)=5 

max Highest value of two max(~~var1~~,~~var2~~) min(10,5)=10 
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Symbol Description Example Result 

if Conditional statement if(~~var1~~<~~var2~~, 
~~var1~~,~~var2~~) if(5<8,5,8)=5 

like Wildcard string compare Like(string, pattern, 
casesensitive')  

quality Quality of tag or expression See below. See below. 

tostring Type conversion See below. See below. 

0x Hexadecimal constant x=0x11   17 

0t Octal constant x=0t11   9 

0b Binary constant x=0b11 3 

Note: For the like operator: "string" equals the string to search in; "pattern" equals the string to 
search for (can include wildcards); nonzero for case-sensitive search; zero for case-insensitive 
search. String syntax is $"string"$. 
You can use these special characters in pattern matches in string:  
• ? Any single character.  
• Zero or more characters.  

• # Any single digit (0-9).  
• [charlist] Any single character in charlist.  
• [!charlist] Any single character not in charlist. 

 
Quality 
The quality option on the Functions menu of the Expression Editor is used to evaluate the quality 
of an OPC tag or an expression.  
 
The following general syntax is used for quality expressions: 

x=quality(expression) 
Note: The "(expression)" can also be a simple expression composed of a single tag. 
The quality function returns the OPC quality of the string between parentheses as one of the 
following results: 

192: quality is GOOD 
64: quality UNCERTAIN 
0: quality BAD 
 
Note: The OPC Foundation establishes the value ranges for quality. There are actually varying 
degrees of quality:  

GOOD: 192-252 
UNCERTAIN: 64-191 
BAD: 0-63 
 
For more information, refer to the OPC Data Access Custom Interface Standard available for 
download at the OPC Foundation's Web site, www.opcfoundation.org/. 
 
Example Quality Expression 

Expression Result 
x=quality({{SMAR.Simulator.1\SimulatePLC.PumpStatus}}) 192 (Quality GOOD) 
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The quality of an expression is determined through the evaluation of each single tag in the 
expression. Thus, if you have multiple tags in an expression (and each tag has a different quality), 
the result of the expression (i.e. 192 [GOOD], 64 [BAD], or 0 [UNCERTAIN]) corresponds to the 
quality of the tag with the lowest quality. If an expression contains a conditional statement (e.g. if, 
then, or else), then the result of the expression is affected only by the quality of the branch being 
executed. 
 
Consider the following sample expression: 

x= if ( quality({{Tag1}}) == 192, {{Tag1}}, {{Tag2}}) 
This expression can be read as follows:  
"If the quality of Tag1 is GOOD (i.e. 192), then the expression result (x) is the value of Tag1. In all 
other cases (i.e. the quality of Tag1 is UNCERTAIN or BAD), the expression result (x) is the value of 
Tag2." 
We can calculate the results for this expression using different qualities for Tag1 and Tag2, as 
shown in the figure below. 

 

Case Tag1 quality Tag2 quality Result Result quality 
1 GOOD GOOD Tag1 192 (GOOD) 

2 GOOD UNCERTAIN Tag1 192 (GOOD) 

3 GOOD BAD Tag1 192 (GOOD) 

4 UNCERTAIN GOOD Tag2 192 (GOOD) 

5 UNCERTAIN UNCERTAIN Tag2 64 (UNCERTAIN) 

6 UNCERTAIN BAD Tag2 0 (BAD) 

7 BAD GOOD Tag2 192 (GOOD) 

8 BAD UNCERTAIN Tag2 64 (UNCERTAIN) 

9 BAD BAD Tag2 0 (BAD) 

 

In cases 1-3 above, the quality of Tag1 is GOOD, and therefore the result of the expression is 
GOOD. Thus, the result of the expression is not affected by the quality of Tag2 (the “else” branch of 
the expression), which is ignored.  
In cases 4-6, the quality of Tag1 is UNCERTAIN, and therefore the result of the expression is the 
quality of Tag2.  
In cases 7-9, the quality of Tag1 is BAD, and therefore the result of the expression is the quality of 
Tag2. 
Note: The “quality()” function returns a value that represents the quality of the expression within the 
parentheses but is always GOOD_QUALITY. For example, if Tag1 is BAD_QUALITY then the 
expression “x=quality({{Tag1}})" will return 0 with GOOD_QUALITY. 
The result of an expression is the minimum quality of the evaluated tag in the expression and is 
affected only by the quality of the conditional (if, then, or else) branch that is executed.  
Consider the following sample expression: 

x= if ({{TAG_01}}>0,{{TAG_02}},{{TAG_03}}) 
This expression can be read as follows:  
"If the value of TAG_01 is greater than 0, then the expression result (x) is TAG_02. If the value of 
TAG_01 is less than or equal to 0, then the expression result (x) is TAG_03." 
Let's assume that the following values and qualities for these tags: 
TAG_01=5 with quality GOOD 
TAG_02=6 with quality UNCERTAIN 
TAG_03=7 with quality BAD 
Because the value of TAG_01 is 5 (greater than 0), the expression result is TAG_02. Thus, the final 
expression result is 6, and the final expression quality is UNCERTAIN. 
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Type Conversion 
The tostring option on the Functions menu of the Expression Editor takes the value of whatever 
item is in parentheses and converts it into a string as follows: 
The value is +(value)+unit 
It can be used to convert from number to string, and it can be very useful for string concatenation. 
The proper syntax for the tostring option is: 
x=$"The value is "$ + tostring(value) + $" unit"$ 
Note: In the expression above, the word "unit" is placeholder text for a user-specified unit of 
measurement or variable (e.g. Watt, inches, meters, etc.).  

 
Example Expressions Type Conversion 

Expression Result 
x=$"The value is "$ + tostring({{gfwsim.ramp.float}}) + $" Watt"$ “The value is 543.2345152 Watt” 

 
Constants 
The Functions menu of the Expression Editor supports constant values, including hexadecimal, 
octal, and binary formats.  

Example Expressions Using Constants 
Expression Result 
x=0x11   17 

x=0t11   9 

x=0b11 3 

 
The Expression Editor conveniently inserts the 0x and 0t and 0b prefixes for you so do not have to 
recall them. 
 

Interpreting and Translating Constants 
The examples below show how values are calculated for each type of constant. 

Hexadecimal: 0x20A = 2 * (16^2) + 0 * (16^1) + 10 * (16^0) = 2*256 + 0*16 + 10 * 1 = 512 + 0 + 
10 = 522 

Octal: 0t36= 3 * (7^1) + 6 *(7^0) = 3* 7 + 6* 1= 21 + 6 = 27 
Binary: 0b110 = 1 * (2^2) + 1 * (2^1) + 0 * (2^ 0) = 1 * 4 + 1 * 2 + 0 * 1 = 4+2+0 = 6 

Nodes 
A Node is the PC network name associated with a particular configuration.  When the alarm server 
starts, it checks the database for its node name.  If the server does not find an alarm configuration 
associated with its node name, it will run the default alarm configuration. A configuration can be run 
on multiple nodes; however only one configuration can be run on a node (PC) at one time. 
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Adding a New Node 
To add a new node to the configuration: 

1. Right-click on the Nodes tree control of the Configurator and select New > Node from the pop-
up menu, as shown in the figure below.  

 
Creating a New Node 

• The properties dialog box for the new node appears in the right-hand pane of the Configurator, 
as shown in the figure below.  

 
Setting the Properties for the New Node 

• In the Name field, type a name for the new node. You can optionally type a Description for the 
node. 

• Under Configuration Name, select an alarm configuration from the drop-down list. If the alarm 
server does not find an alarm configuration associated with its node name, it will run the default 
alarm configuration. To view the configuration properties, click Jump to Configuration. 

• When you have finished configuring the node, click the Apply button. The new area appears 
under the Nodes tree control. 

 

Running the Alarm Server 

Starting the Alarm Server 
The AlarmWorX Server may be launched in one of four ways: 

Automatically on boot if it is installed as an NT Service. 
By selecting Start Alarm Server from Action menu of the Alarm Server Configurator. 
When an OPC Alarm and Events client creates a connection to the alarm server. 
Through ProcViewTray. 
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Of these four methods, the third item is the least useful since the server should normally be running 
and processing alarms even if no alarm clients are active. 
When launched, the alarm server will open the active configuration database and query for a 
configuration that is set to run on that node. If a configuration with a matching node name is not 
found, the default alarm configuration will be run. 
While running, the server will continue to poll the configuration database (every 30 seconds) in order 
to respond to any changes made by the Configurator. 
The alarm server supports online configuration changes to allow minor changes in alarm 
configuration to be performed without shutting down the server.  Minor things would be adding or 
removing a tag, changing an alarm limit, and adding (but not removing) an area. Making even these 
minor changes online can have side effects, like duplicate events sent to clients and client 
messages that can no longer be acknowledged.  In a live functioning plant it is possible that these 
minor side effects would not outweigh the alternative of shutting down and restarting the alarm 
server. 
Whenever practical, it is desirable to toggle the server off and on to be sure only the latest 
configuration is being used. For major database changes within the active database or changing the 
active database, the server must be shutdown and restarted. 

 

OPC Alarm and Events Interface 
The AlarmWorX Server supports all of the mandatory and most of the optional interfaces and 
methods of the OPC Alarm & Events specification. 
The following optional methods are not currently supported: 

IOPCEventServer::TranslateToItemIDs 
IOPCEventServer::EnableConditionByArea 
IOPCEventServer::EnableConditionBySource 
IOPCEventServer::DisableConditionByArea 
IOPCEventServer::DisableConditionBySource 

Event Types and Categories 
All events generated are of the OPC defined Event Type Condition. The Server defines the 
following Event Categories and uses the identical names for the Condition Names: 

Deviation 
Digital 
Limit 
Rate of Change 
The Limit and Deviation conditions have the following Sub-conditions: 

HiHi 
Hi 
Lo 
LoLo 
Note: The following categories are not used in the alarm server: 

OPC Server Error 
System Configuration 
System Message 
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Event Attributes 
The following event attributes are made available to subscribing clients: 

Attribute Deviation Digital Limit Rate of 
Change Type Comment 

ACK COMMENT a a a a VT_BSTR Comment entered when alarm was last 
acknowledged. 

ALARM COUNT a a a a VT_I4 Number of alarm transitions before 
acknowledge. 

AREA a a a a 
VT_ARRAY | 
VT_BSTR Array of areas 

CV a a a a 
VT_R8 
VT_BOOL Current Value (OPC Input 1 or 2). 

DEADBAND a  a a VT_R8 Alarm detection Deadband. 

DEFAULT DISPLAY a a a a VT_BSTR 
A text string, usually a file name, that 
when launched provides related 
information. 

HELP TEXT a a a a VT_BSTR Help information 

LIMIT VALUE EXCEEDED a  a a VT_R8 The Current Value at the time the limit 
was exceeded. 

LOOP DESC a a a a VT_BSTR A description of the Source (tag). 

NEXT_LIM a  a  VT_R8 The value of the next limit. 

NORMAL STATE  a   VT_BOOL Value of the normal state (TRUE or 
FALSE). 

PREV LIM a  a  VT_R8 Value of the previous limit reached. 

RELATED VALUE 01-10 a a a a  
Associates up to 10 OPC tags or 
expressions with each alarm tag as 
“supplemental” information to the alarm. 

SP a    VT_SP Setpoint (OPC Input 2) 

 

 

OPC Data Access Interface 
The AlarmWorX Server exposes much of its real-time and configuration data via the OPC Data 
Access specification. This allows OPC Data Access client applications, such as GraphWorX, to 
make use of alarm-related data without using the OPC Alarm & Events interface. Some typical uses 
would include: 

• Changing the color of a graphic symbol to correspond to alarm state. 
• Displaying alarm limits. 
• Allowing alarm limits to be changed by the operator. 
The following table lists the OPC item names that are available from the server. The values in the 
table indicated as Read/Write (R/W) can be changed via the OPC Data Access Interface. Any 
changes made to the server this way are transient, and not stored to the database. If the server is 
shut down, these values will be lost. 
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OPC Data Access Items 
ITEM NAME TYPE R/W COMMENT 
Active VT_BOOL R Tag's Global Alarm Active Bit. 

Name VT_BSTR R Tag Name (Source). 

Input1 VT_BSTR R  

BaseText VT_BSTR R  

Enabled VT_BOOL R Enabled state of the Source (tag). 

HelpText VT_BSTR R  

LIM_RTNText VT_BSTR R  

LIM_Input2 VT_R8 R  

LIM_Deadband VT_R8 R  

LIM_Active VT_BOOL R  

LIM_Acked VT_BOOL R/W  

LIM_HIHI_Active VT_BOOL R  

LIM_HIHI_Enabled VT_BOOL R/W  

LIM_HIHI_RequiresAck VT_BOOL R/W  

LIM_HIHI_Severity VT_R8 R/W  

LIM_HIHI_Limit VT_R8 R/W  

LIM_HIHI_MsgText VT_BSTR R/W  

LIM_HI_Active VT_BOOL R  

LIM_HI_Enabled VT_BOOL R/W  

LIM_HI_RequiresAck VT_BOOL R/W  

LIM_HI_Severity VT_R8 R/W  

LIM_HI_Limit VT_R8 R/W  

LIM_HI_MsgText VT_BSTR R/W  

LIM_LOLO_Active VT_BOOL R  

LIM_LOLO_Enabled VT_BOOL R/W  

LIM_LOLO_RequiresAck VT_BOOL R/W  

LIM_LOLO_Severity VT_R8 R/W  

LIM_LOLO_Limit VT_R8 R/W  

LIM_LOLO_MsgText VT_BSTR R/W  

LIM_LO_Active VT_BOOL R  

LIM_LO_Enabled VT_BOOL R/W  

LIM_LO_RequiresAck VT_BOOL R/W  

LIM_LO_Severity VT_R8 R/W  

LIM_LO_Limit VT_R8 R/W  

LIM_LO_MsgText VT_BSTR R/W  

DEV_RTNText VT_BSTR R  

DEV_Input2 VT_R8 R  

DEV_Deadband VT_R8 R  

DEV_Active VT_BOOL R  

DEV_Acked VT_BOOL R/W  

DEV_HIHI_Enabled VT_BOOL R/W  

DEV_HIHI_RequiresAck VT_BOOL R/W  

DEV_HIHI_Severity VT_R8 R/W  

DEV_HIHI_Limit VT_R8 R/W  

DEV_HIHI_MsgText VT_BSTR R/W  
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ITEM NAME TYPE R/W COMMENT 
DEV_HI_Enabled VT_BOOL R/W  

DEV_HI_RequiresAck VT_BOOL R/W  

DEV_HI_Severity VT_R8 R/W  

DEV_HI_Limit VT_R8 R/W  

DEV_HI_MsgText VT_BSTR R/W  

DEV_LOLO_Enabled VT_BOOL R/W  

DEV_LOLO_RequiresAck VT_BOOL R/W  

DEV_LOLO_Severity VT_R8 R/W  

DEV_LOLO_Limit VT_R8 R/W  

DEV_LOLO_MsgText VT_BSTR R/W  

DEV_LO_Enabled VT_BOOL R/W  

DEV_LO_RequiresAck VT_BOOL R/W  

DEV_LO_Severity VT_R8 R/W  

DEV_LO_Limit VT_R8 R/W  

DEV_LO_MsgText VT_BSTR R/W  

DIG_RTNText VT_R8 R  

DIG_Input2 VT_R8 R  

DIG_Active VT_BOOL R  

DIG_Acked VT_BOOL R/W  

DIG_Enabled VT_BOOL R/W  

DIG_RequiresAck VT_BOOL R/W  

DIG_Severity VT_R8 R/W  

DIG_Limit VT_R8 R/W  

DIG_MsgText VT_BSTR R/W  

ROC_RTNText VT_BSTR R  

ROC_Input2 VT_R8 R  

ROC_Active VT_BOOL R  

ROC_Acked VT_BOOL R/W  

ROC_Enabled VT_BOOL R/W  

ROC_RequiresAck VT_BOOL R/W  

ROC_Severity VT_R8 R/W  

ROC_Limit VT_R8 R/W  

ROC_MsgText VT_BSTR R/W  

LIM_HIHI_Active VT_BOOL R  

LIM_HI_Active VT_BOOL R  

LIM_LOLO_Active VT_BOOL R  

LIM_LO_Active VT_BOOL R  

DEV_HIHI_Active VT_BOOL R  

DEV_HI_Active VT_BOOL R  

DEV_LOLO_Active VT_BOOL R  

DEV_LO_Active VT_BOOL R  
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Error Reporting 
Internal errors encountered by the AlarmWorX Sever are reported via the SMAR Event Server, 
another OPC Alarm & Events compliant server. The SMAR Event Server can optionally write 
selected events to the NT Event Log. The following simple events may be generated by the 
AlarmWorX Server: For the SMAR Event Server, severity values of 600 and below are considered 
"normal," and severity values of 601 to 1000 are considered errors. 

Server Errors 
Severity Message 

500 "%1 %2 Started." 

500 "%1 %2 Stopped." 

700 "Alarm Tag: %1, Condition: %2, Input Item: %3, Error: Unknown" 

700 "Alarm Tag: %1, Condition: %2, Input Item: %3, Error: Tag does not exist." 

700 "Alarm Tag: %1, Condition: %2, Input Item: %3, Error: Rejected by Security Server." 

700 "Alarm Tag: %1, Condition: %2, Input Item: %3, Error: Licensed I/O Point Count Exceeded. " 

700 "Alarm Tag: %1, Condition: %2, Input Item: %3, Error: Demo mode has timed out." 

700 "Alarm Tag: %1, Condition: %2, Input Item: %3, Error: Local I/O not allowed on Browser node." 

700 "Alarm Tag: %1, Condition: %2, Input Item: %3, Error: COM error registering with GenRegistrar." 

800 "%1 %2 Failed to Register with GenRegistrar. Reason: %3" 

800 "No configuration found for node and no ""Default"" configuration in Database Provider: %1 
Connection:  %2" 

800 "Database Error - Provider: %1 Connection: %2" 

 
Using a technology that has been incorporated into all Smar products, TraceWorX provides online 
diagnostics and tuning of applications running in the ProcessView system. TraceWorX is designed 
expressly for systems integrators, OEMs and customers who want to have tools for doing their own 
troubleshooting and diagnostics. 
TraceWorX tracks the runtime activity for each ProcessView application and logs the runtime data to 
a log file based on user-configured trace levels. The log file provides a thorough, color-coded report 
detailing all activity for the application, including the time, the date, the severity level, and a 
description of the event or problem.  
TraceWorX32 also features several options for reporting issues to technical support. If you are 
experiencing problems with any applications, the log file deployment options, such as compressing 
and e-mailing log files, are ideal for tracking and archiving data and sending detailed reports to 
technical support. Developers can use these reports to identify the source of the problems. 

 
For information about TraceWorX, please see the TraceWorX Help documentation. 
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Chapter 6 
 

 

Viewer ActiveX 
Introduction 

The AlarmWorX Current Events Viewer is an OPC ActiveX client application that provides real-time 
alarm information within the ProcessView product family. It communicates to OPC Alarm and Events 
servers to provide excellent alarming features. It is important to note that this is a Current Events 
Viewer, which means that it only displays active alarms and current operator messages. 
The structure of the AlarmWorX Current Events Viewer is built on a three-level system, consisting of 
Default settings (color, font, justification, wrapping method and size), Row types (color and font) and 
Column values (color, font, justification, wrapping method and size). Each system starts with certain 
default settings, which can be overwritten by row settings, which in turn can be overwritten by 
column settings.   

Using the AlarmWorX Viewer ActiveX 
The AlarmWorX Viewer ActiveX integrates easily within Microsoft Visual C++ or Microsoft Visual 
Basic (VB) container applications. The Smar ProcessView containers, such as GraphWorX, provide 
toolbar support for inserting the AlarmWorX Viewer ActiveX. Once inserted into a document or a 
form, the component can be resized and configured.  
Within the Smar ProcessView containers and in Visual Basic forms, the component is initially placed 
in Configuration mode, where its user interface is disabled and you can configure the AlarmWorX 
Viewer ActiveX through the Properties dialog box.  Once the application is committed to Runtime 
mode, the viewer will automatically connect to alarm and event OPC servers, query for a complete 
update of all requested alarms and display current alarm messages. The AlarmWorX Viewer 
ActiveX has the option of saving file information as part of the container or in its own file format.   
You must give a valid filename, if saving to a file, before the data are serialized and saved. The 
AlarmWorX Viewer uses the concept of a Working Directory, defined in the Smar ProcessView 
containers. This represents the working directory where project files and configuration files will be 
stored. The AlarmWorX Viewer will utilize this directory as a starting point for saving and loading its 
configuration files.   

Connections 
The AlarmWorX Viewer can display data from any OPC Alarm and Event server.  Alarm subscription 
filters are made through the Subscription tab of the Properties dialog box. 
Once a subscription is set up, the viewer requests a refresh of all current alarms upon animation.  
Alarms are sent by the OPC Alarm and Event server on an alarm-by-alarm basis.  This decreases 
the number of alarms sent to each viewer and allows for server-side filtering.   

Security 
To access the Smar Security Server from the AlarmWorX Container, either select Security > 
Configuration from the Tools menu or click the Security button on the toolbar. This opens the 
Security Server Administrator Login dialog box, as shown in the figure below. 
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Security Server Login 

Enter your User Name and Password, and then click OK.  This opens the SMAR Security Server, 
where you can access the AWXView Security Server. Depending on your configured level of 
security, you may or may not be able to edit components of the AWXView Security Server. Choose 
Application Actions from the Edit menu. The Actions/Users Association dialog box appears, as 
shown in the figure below.   
Note: For more information about security, please see the Security Configurator help 
documentation.   

 
AlarmWorX Viewer ActiveX Actions Protected by Security 

The Security Server can be set up to allow access to several different actions from this dialog. To 
set the options for the AlarmWorX Viewer, select AWXView32 from the list, as shown in the figure 
above. This opens the list in the left pane, which includes the following options: 
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• Acknowledge Area 
• Acknowledge Event 

• Acknowledge Events 
• Acknowledge Filtered 
• Acknowledge Global 
• Acknowledge Point 

• Acknowledge Visible 
• Change Filter 
• Change Language 

• Change Sort 
• Change ToolTips 

• Edit Filter 
• Configure Property Pages 
• Launch Applications 
• Launch Displays 

• Show - Hide Columns 
• Trigger VB Event 
• View Details 

 

Language-Aliasing Support 
The AlarmWorX Viewer ActiveX component has all of its strings saved in the resource file, which 
can be modified to provide custom versions. In addition, it provides real-time support for loading a 
resource-only .dll to support an international language. This .dll file is compiled as a standard Win32 
.dll, and it is made up of all the resources and the .odl file of the AlarmWorX Viewer module. Any 
time the SMAR applications settings are switched to a different language, AlarmWorX Viewer will 
load the corresponding resource .dll. 
The resource-only .dll file name uses the AlarmWorX Viewer component, followed by the three 
characters used in Microsoft Windows NT as the abbreviation for a language name (e.g., the 
abbreviation "deu" stands for German, and the .dll should be named "AWXView_deu.dll"). In 
addition, using the OLE Automation property language ID, you can control this functionality through 
OLE Automation. 
The Unicode version of the AlarmWorX Viewer ActiveX also supports language aliasing with 
automatic range and value scaling, as well as unit conversions, formatting, and font selection. For 
more information about configuring Unicode version language-aliasing support, refer to the 
ProcessView Language Configurator documentation. 
Note: The AlarmWorX Viewer requires the following additional language-aliasing configuration work. 
If any expression is to be used for range, alarm limits, and or unit scaling, you need to define both a 
"Read Expression" and a "Write Expression" in the Language Configurator. By doing so, the Viewer 
will be able to function properly between language switches. 
Note: To enhance language-aliasing performance, select the Microsoft Arial Unicode font, which 
contains all Unicode characters. The Arial Unicode MS font must be selected separately within the 
Properties dialog boxes of each ActiveX component. 

Sample Language Configuration 
The Unicode Installation of ProcessView provides a sample Language Server configuration under 
the "Languages" folder of the ProcessView product installation "tree." In addition, a sample display 
"languagesDemo.gdf," which includes a sample Viewer configuration, is provided under the 
ProcViewDEMO folder. The figure below shows this sample during runtime mode. Notice that you 
can switch between languages in this display by simply clicking the buttons in the Change Language 
field. 
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Language-Aliasing Demo in Runtime Mode 

The figure below shows this same language-aliasing demo in configuration mode. This display 
incorporates ActiveX objects from GraphWorX, TrendWorX, and AlarmWorX. 

 
Language-Aliasing Demo in Configuration Mode 

For example, if you click on the Alarm Viewer ActiveX in the language-aliasing configuration shown 
above, you can view the properties of the Alarm Viewer Active X, as shown in the figure below. The 
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Column tab of the Alarm Viewer ActiveX Properties dialog box, shown below, displays the 
language-aliasing configuration of the headers in the Alarm Viewer.  

 
Alarm Viewer ActiveX Properties: Column Tab 

For the example above, the Alarm Viewer configuration appears as shown in the figure below. Note 
that the strings within a "/+" and "+/" delimiter pair define a language-aliased string. As you can see, 
each header in the Alarm Viewer configuration is a language-aliased string that contains these 
delimiters.  

 
Language-Aliased Alarm Viewer Display in Configuration Mode 
During animation (runtime) mode, the Viewer ActiveX will interface to the Language Server, and it 
will try to resolve the language-aliased strings. If successful, it will display the translated strings in 
the Alarm Viewer display, as shown below. In addition, if the Units language alias string has an 
equation defined in the Language Configurator, it will autoscale the values based on the scaling 
equation supplied by the Language Server. 

 
Language-Aliased Alarm Viewer Display in Runtime Mode 

Note: The Unicode version language aliasing is independent of the resource .dll selection, which 
relates mostly to the text in the dialog boxes and other user interface elements.  

Language Alias Browser 
When specifying a language alias in the Alarm Viewer ActiveX Properties dialog box, you can 
also select a language alias from the Language Alias Browser, which includes all language aliases 
in the language database. This eliminates the need to manually type in the alias name. Clicking the 
... button and selecting Language Alias Browser from the pop-up menu opens the Language Alias 
Browser, as shown in the figure below. The Language Alias Browser is available for the following: 
• Configuration file and URL Path sections of the Alarm Viewer ActiveX Properties dialog box 
General tab 
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• Alarm filtering via the Expression Editor 
• Event Subscriptions dialog box: Server, Areas, and Sources 

 
Opening the Language Alias Browser in the Viewer Properties 

The browser, shown in the figure below, includes all languages aliases in the language database. All 
language aliases that are configured in the Language Configurator are conveniently available to 
choose from inside the browser. The tree control of the Language Configurator is mimicked in the 
tree control of the Language Alias Browser. Select a language alias by double-clicking the alias 
name. The alias name appears at the top of the browser, which automatically adds the /+ and +/ 
delimiters to the alias name. Click the OK button. 

 
Selecting an Alias From the Language Alias Browser 

Global-Aliasing Support 
The AlarmWorX Viewer ActiveX supports Global Aliasing by interfacing to the SMAR Global Aliasing 
System (GAS) Engine Server.  
Currently the AlarmWorX Viewer supports machine-level and process-level aliasing. All fields that 
support aliasing have been interfaced to the Global Alias Browser dialog, which is evoked by 
clicking on the … button in the configuration.  
In addition, the AlarmWorX Viewer now has an integrated Global Alias Browser. 
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When specifying a global alias in the Alarm Viewer ActiveX Properties dialog box, you can also 
select a global alias from the Global Alias Browser, which includes all global aliases in the Global 
Aliasing System database. This eliminates the need to manually type in the alias name. Clicking the 
... button and selecting Global Alias Browser from the pop-up menu opens the Global Alias 
Browser, as shown in the figure below. The Global Alias Browser is available for the following: 
• Title, Configuration file and URL Path sections of the Alarm Viewer ActiveX Properties 

dialog box General tab 

• Alarm filtering via the Expression Editor 
• Event Subscriptions dialog box: Server, Areas, and Sources 

 
Opening the Global Alias Browser in the Viewer Properties 

All global aliases that are configured in the Global Alias Engine Configurator are conveniently 
available to choose from inside the browser. The tree control of the Global Alias Engine Configurator 
is mimicked in the tree control of the Global Alias Browser. Select a global alias by double-clicking 
the alias name (e.g. "Floor" in the figure below). The alias name appears at the top of the browser, 
which automatically adds the <# and #> delimiters to the alias name. Click the OK button. 

 
Selecting an Alias From the Global Alias Browser 
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Asynchronous Downloading features 
The AlarmWorX Viewer supports asynchronous downloading of configuration data when used inside 
SMAR ActiveX document servers, such as GraphWorX, to produce documents, which can be 
viewed using Microsoft Internet Explorer. 
To enable this feature, select URL Path from the General tab of the Alarm Viewer ActiveX 
Properties dialog box, shown below, and supply a URL path. In the case of viewing ActiveX 
documents within an Intranet setup, you can supply a server name and directory specifying the 
location of the AlarmWorX Viewer configuration data (must be a shared directory), by using the 
convention "file:\\Server Name\Directory\File Name.awv." 

 
Alarm Viewer ActiveX Properties: General Tab 

 

User Interface 
This section describes the user interface for the AlarmWorX Viewer ActiveX.   

Properties Dialog 
The Alarm Viewer ActiveX Properties dialog box, shown below, is the user configuration interface 
for the ActiveX. When embedded in an ActiveX container, double-clicking anywhere in the ActiveX 
client opens the Properties dialog box. 
Note: Right-clicking on the Viewer ActiveX and selecting Properties also opens the Alarm Viewer 
ActiveX Properties dialog box. 
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Alarm Viewer ActiveX Properties Dialog Box 

General 
The General tab of the Alarm Viewer ActiveX Properties dialog box, shown below, allows you to 
specify the name of the viewer file. By default, information is stored as part of the container 
application's document file. 

 
Alarm Viewer ActiveX Properties: General Tab 

Configure the following General tab settings: 
• Title: Enter a title for the viewer. 
• About: Clicking the About button displays both technical support information and the SMAR 

About Box, which contains registration and serial number information as well as system resource 
information, such as memory and disk space available. 

• Configuration File: By default, information is stored as part of the container application's 
document file. You can also store information as part of a separate (.awv) file. To save the .awv 
file, click Save As to open the Save AWXView32 File dialog box. Enter a name for the .awv file 
in the File Name field, and then click Save.  

You can also open an existing configuration file by clicking the Load button on the General tab and 
browsing for the file. If Configuration File is selected, the Viewer ActiveX will attempt to load from 
the file listed under File name.  If URL Path is checked, the ActiveX will use the specified network 
URL path upon loading the file.   
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Note:  The ActiveX cannot be saved to a URL path. To create a URL file, save a report 
configuration to a local file and copy the file to the desired network location. 
You can also select aliases to use for the configuration file. Clicking the ... button and selecting 
Global Alias Browser from the pop-up menu opens the Global Alias Browser, as shown in the 
figure below. Select a global alias from the Global Alias Browser, which includes all global aliases in 
the global alias database. This eliminates the need to manually type in the alias name. All global 
aliases that are configured in the Global Alias Engine Configurator are conveniently available to 
choose from inside the browser. The tree control of the Global Alias Engine Configurator is 
mimicked in the tree control of the Global Alias Browser. Select a global alias by double-clicking the 
alias name (e.g. "Floor" in the figure below). The alias name appears at the top of the browser, 
which automatically adds the <# and #> delimiters to the alias name. Click the OK button. 

 

 
Selecting an Alias From the Global Alias Browser 

Clicking the ... button and selecting Language Alias Browser from the pop-up menu opens the 
Language Alias Browser, as shown in the figure below. The browser includes all languages aliases 
in the language database. All language aliases that are configured in the Language Configurator are 
conveniently available to choose from inside the browser. The tree control of the Language 
Configurator is mimicked in the tree control of the Language Alias Browser. Select a language alias 
by double-clicking the alias name. The alias name appears at the top of the browser, which 
automatically adds the /+ and +/ delimiters to the alias name. Click the OK button. 

 
Selecting an Alias From the Language Alias Browser 
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Default 
The Default tab of the Alarm Viewer ActiveX Properties dialog box, shown below, configures the 
appearance of the AlarmWorX Viewer ActiveX. 

 
Alarm Viewer ActiveX Properties: Default Tab 

Color, Font and Style 
The colors section allows you to choose colors for the background of the display, the background 
color of the text, the background color of the header and the base foreground text color.  Under the 
Base field, select a Grid Back Color, Text Color, Text Back Color, and Header Color by clicking 
the color palette. A Color box appears, allowing you to choose a preconfigured color or to create 
your own color using the Define Custom Colors button. 
Click the Font button to specify the font size, style, and text effects (i.e. underline and strikethrough) 
for the alarm viewer.   

 
Selecting a Font Style for the Viewer 
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Cell  
The Cell section sets the default options to apply to the cells of the viewer.  Checking Show Row 
Header causes a row header to be displayed in the viewer. Checking Show Row Header also 
enables the Number Row option, but it is not necessary to have both of these options checked.  
Checking Number Row causes the row header to number each row line. If the Number Row option 
is not checked, then the row headers will be blank.  The Row Height field sets the height of the 
rows in the viewer.  
Note: The Row Height must be a positive integer between 1 and 10.  
Checking Wrap Text box makes the text wrap when it hits the end of the particular cell.  When this 
option is not applied, text will continue in one line although only part of the text will be visible, 
depending on the size of the cell.   Please note that the Wrap Text feature is available only with 
multi-line rows. The Justify field determines the justification (left, center or right) of the text within 
each cell. 
There are three options for determining the size of each cell:  
• Manual-Size Cells: Checking this box allows you to manually set the width of each column. 

Manual sizing of columns can only be done during runtime. 
• Auto-Size Cells: When this box is checked, the viewer automatically sets the width of each 

column.  The viewer automatically sets each column to the width nearest to the size of the 
ActiveX divided by the number of visible columns. 

• Maximum Length for Each Cell:  Currently this is a range from 1 to 1000, and it applies the 
maximum cell length to all cells. 

Row 
The Row tab of the Alarm Viewer ActiveX Properties dialog box, shown below, sets the color of 
the text and background for different event types. 

 
Alarm Viewer ActiveX Properties: Row Tab 

Use the Event Type drop-down list to select the event type you wish to configure.  It is possible to 
have several different configurations for one event type.  To configure an event type, simply click the 
Configure button or click either the Text Color or Background Color box. This opens the Set Row 
dialog box, as shown in the figure below.  
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Setting Row Properties for the Alarm/Condition 

The Severity field sets the lower bound for this particular configuration. This lower bound represents 
the point at which the viewer will begin to override the current values for text color, background 
color, and font with the values set in this dialog.   
Note: The new height will be resized based on the size of the font selected.   
Through this method, it is possible to set up ranges.  For example, configuring a severity of 300 with 
a text color of purple and another severity of 600 with a text color of green would result in a purple 
range from 300 to 599.   
This dialog can also be used to delete a configuration.  To delete a configuration, select the lower 
bound severity of the configuration you wish to delete and click the Delete button.   
Note: The default severity value '0' cannot be deleted. 
Once you have made all desired edits for a particular configuration click, OK to save the edits and 
exit the dialog, or click Cancel to exit the dialog without saving any changes.  All available 
configurations can be accessed through the Severity drop-down list.   

Flash/Beep 
Selecting the Flash and/or Beep check boxes applies the flash or beep to the particular severity.  
Once the box has been checked, you can set a frequency for the occurrence of the flash or beep 
(slow, medium, or fast).  This frequency will be displayed in the Actions section on the Row tab.   
The Flash/Beep functionality can be activated on the Row - Configure dialog.   
It is possible to change the default beep to a *.wav file by accessing Settings > Control Panel > 
Sounds > Default Sound.  Please note that if you choose a large file as your default sound, your 
system may experience difficulty when trying to load it.   
The Flash option simply inverts the text and background color to indicate the flashing. 

Column 
The Column tab of the Alarm Viewer ActiveX Properties dialog box, shown below, allows you to 
select which columns you want to appear in the viewer. 
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Alarm Viewer ActiveX Properties: Column Tab 

By clicking the Add and Remove buttons in the middle of and the "up" and "down" arrows on the 
right side of this the Column tab, you can select which columns to include in the report as well as 
indicate the order of their appearance. To move an item from the Available list to the Selected list, 
simply highlight the item and click the Add button.  To move an item back from the Selected list to 
the Available list, highlight the item and click the Remove button. To change the order of an item in 
the Selected list, simply select the item and click the "up" and "down" arrows located on the right-
hand side.   

Column Types 
The available column types are listed in the table below. 
Note: The following column type descriptions are taken directly from the OPC Alarms and Events 
Specifications. Please refer to the Specifications for complete information. 
 

COLUMN TYPE DESCRIPTION 
 The following items are present for all event types. 

Source The source of event notification. This Source can be used in the IOPCEventServer::TranslateToItemIDs 
method to determine any related OPC Data Access itemIDs. 

Time 
Time of the event occurrence. For conditions, time that the condition transitioned into the new state or sub-
condition.  For example, if the event notification is for acknowledgment of a condition, this would be the 
time that the condition became acknowledged.  

Active Time 

Array of active times corresponding to each Source and ConditionName pair.  This parameter uniquely 
identifies a specific transition of the condition to the active state or into a different sub-condition and is the 
same as the SubCondLastActive condition attribute. Active times are passed to the client in the 
ActiveTime member of the ONEVENTSTRUCT by the IOPCEventSink::OnEvent callback. If the condition 
has become active again or transitioned into a different sub-condition at a later time, this acknowledgment 
will be ignored.   

Message Event notification message describing the event. 

Subscription Subscription to a given OPC Alarm and Event server. 

Server Description Information about the currently subscribed OPC Alarm and Event server. 

Server Node Node (computer) on which the currently subscribed OPC Alarm and Event server is located. 

Event Type OPC_SIMPLE_EVENT, OPC_CONDITION_EVENT, or OPC_TRACKING_EVENT for Simple, Condition-
Related, or Tracking events, respectively. 

Event Category 

Event categories define groupings of events supported by an OPC Event server.  Examples of event 
categories might include “Process Events”, “System Events”, or “Batch Events”.  Event categories may be 
defined for all event types, i.e. Simple, Tracking, and Condition-Related.  However, a particular event 
category can include events of only one type.  A given Source may generate events for multiple event 
categories.  Names of event categories must be unique within the event server.  The definition of event 



6.15 

AlarmWorX 
 

 

COLUMN TYPE DESCRIPTION 
 The following items are present for all event types. 

categories is server-specific.   

Severity 

Event severity (0-1000).  The severity value is an indication of the urgency of the sub-condition. This is 
also commonly called ‘priority’, especially in relation to process alarms.  Values will range from 1 to 1000, 
with 1 being the lowest severity and 1000 being the highest.  Typically, a severity of 1 would indicate in 
event that is informational in nature, while a value of 1000 would indicate an event of catastrophic nature 
which could potentially result in severe financial loss or loss of life. 

Number Event Attributes The length of the specific event attribute array. 

Attributes 1-20 User-specified event attributes. 

 The following items are present only for condition-related events. 

Condition Name The name of the condition related to this event notification.  

SubCondition Name The name of the current sub-condition, for multi-state conditions.  For a single-state condition, this 
contains the condition name. 

Change Mask 

Indicates to the client which properties of the condition have changed to have caused the server to send 
the event notification.  It may have one or more of the following values: 
OPC_CHANGE_ACTIVE_STATE OPC_CHANGE_ACK_STATE OPC_CHANGE_ENABLE_STATE 
OPC_CHANGE_QUALITY OPC_CHANGE_SEVERITY OPC_CHANGE_SUBCONDITION 
OPC_CHANGE_MESSAGE OPC_CHANGE_ATTRIBUTE 
If the event notification is the result of a Refresh, these bits are to be ignored. 
For a “new event”, OPC_CHANGE_ACTIVE_STATE is the only bit that will always be set.  Other values 
are server-specific.  (A “new event” is any event resulting from the related condition leaving the Inactive 
and Acknowledged state.) 

NewState A WORD bit mask of three bits specifying the new state of the condition:  OPC_CONDITION_ACTIVE, 
OPC_CONDITION_ENABLED, OPC_CONDITION_ACKED. 

Quality Quality associated with the condition state. Values are as defined for the OPC Quality Flags in the OPC 
Data Access Server specification. 

AckRequired 

This flag indicates that the related condition requires acknowledgment of this event.  The determination of 
those events that require acknowledgment is server-specific.  For example, transition into a LimitAlarm 
condition would likely require an acknowledgment, while the event notification of the resulting 
acknowledgment would likely not require an acknowledgment. 

Active Time 
Time that the condition became active (for single-state conditions), or the time of the transition into the 
current sub-condition (for multi-state conditions).  This time is used by the client when acknowledging the 
condition (see IOPCEventServer::AckCondition method). 

Cookie 
Server-defined cookie associated with the event notification.  This value is used by the client when 
acknowledging the condition (see IOPCEventServer::AckCondition method).  This value is opaque to the 
client. 

Time in Alarm 
On a periodic basis, this field is updated with the amount of time a specific alarm has been in an active 
alarm state.  The field is reset each time the message goes into alarm, and is only available for condition 
messages. 

 The following is used only for tracking events and for condition-related events that are 
acknowledgment notifications. 

ActorID 

For tracking events, this is the actor ID for the event notification. 
For condition-related events, this is the AcknowledgerID when OPC_CONDITION_ACKED is set in 
NewState.  If the AcknowledgerID is a NULL string, the event was automatically acknowledged by the 
server. 
For other events, the value is a pointer to a NULL string. 

 

Event Type Values 
EVENT TYPE VALUE DESCRIPTION 
OPC_SIMPLE_EVENT 1 Simple event. 

OPC_TRACKING_EVENT 2 Tracking event. 

OPC_CONDITION_EVENT 4 Condition-Related event. 
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Change Mask Values 
CHANGE MASK ITEM VALUE DESCRIPTION 

OPC_CHANGE_ACTIVE_STATE 1 The condition’s active state has changed. 

OPC_CHANGE_ACK_STATE 2 The condition’s acknowledgment state has changed. 

OPC_CHANGE_ENABLE_STATE 4 The condition’s enabled state has changed. 

OPC_CHANGE_QUALITY 8 The ConditionQuality has changed. 

OPC_CHANGE_SEVERITY 16 The severity level has changed. 

OPC_CHANGE_SUBCONDITION 32 The condition has transitioned into a new sub-condition. 

OPC_CHANGE_MESSAGE 64 The event message has changed (compared to prior 
event notifications related to this condition). 

OPC_CHANGE_ATTRIBUTE 128 One or more event attributes have changed (compared 
to prior event notifications related to this condition). 

 

New State Values 
NEW STATE VALUE DESCRIPTION 
OPC_CONDITION_ENABLED 1 The condition has been enabled. 

OPC_CONDITION_ACTIVE 2 The condition has become active. 

OPC_CONDITION_ACKED 4 The condition has been acknowledged. 

 
Note: Alarm Type cannot be deleted from the Selected Headers list. 
Note: If you remove a header from the selected list that was used in the sort list, you will get the 
following warning message. 

 
Click OK and open the Display tab to see how the Sort list has been changed. 
Note: If you remove a header from the selected list that was used in the help or comment ToolTip 
configuration, you will get the following warning message: 

 
Click OK and open the ToolTips tab to see how the ToolTip configuration has been changed. 
You can also change the appearance of a column by either double-clicking on an item in the 
Selected list or selecting the item and clicking the Config button. The Set Column configuration 
dialog for the item opens, as shown below. From this dialog, you can set the font, color, width, and 
cell properties by selecting and changing the various options available. 



6.17 

AlarmWorX 
 

 

 
Setting the Column Properties 

To change the configuration for Font, Text Color or Cell, the appropriate box must be checked.  To 
change the font size and style, click the Font.  Once you have made the desired changes, the new 
size and style will appear in the corresponding boxes.   
Note: It is not possible to change the size and style without using the Font dialog.  
To change the column color, click the Background Color box and use the Color dialog to make 
your changes.  
To change the text column color, click the Text Color box and use the Color dialog to make your 
changes 
The Cell section configures how the text appears within each cell and how the size of each cell is 
determined. Checking Wrap Text box makes the text wrap when it hits the end of the particular cell.  
When this option is not applied, text will continue in one line although only part of the text will be 
visible, depending on the size of the cell.   Please note that the Wrap Text feature is available only 
with multiline rows. The Justify field determines the justification (left, center or right) of the text 
within each cell. 
There are three options for determining the size of each cell:  
• Manual-Size Cells: Checking this box allows you to manually set the width of each column. 
Manual sizing of columns can only be done during runtime. 
• Auto-Size Cells: When this box is checked, the viewer automatically sets the width of each 
column.  The viewer automatically sets each column to the width nearest to the size of the ActiveX 
divided by the number of visible columns. 
• Maximum Length for Each Cell:  Currently this is a range from 1 to 1000, and it applies the 
maximum cell length to all cells. 

Display 
The Display tab of the Alarm Viewer ActiveX Properties dialog box, shown below, configures 
options for sorting or client-side filtering. 

 
Alarm Viewer ActiveX Properties: Display Tab 



Viewer ActiveX 
 

6.18 

To configure the sorting feature, click the Sort button. This opens the Sort dialog, as shown in the 
figure below.  
The Sort Alarms by section indicates the first criteria the Alarm Viewer should use when sorting all 
current alarms.  The following Then by sections indicate how the viewer should sort alarms that 
have the same value for the criteria selected in the first section.   
Note: It is not necessary to have any values listed in the Then by sections.    
The Sort dialog allows you to configure which criteria to sort the alarms by.  It also allows for 
multilevel sorting up to five levels with ascending/descending specific to each level.  The Alarm 
Viewer will always sort. The default sort for a new viewer is Time/Date. 
Sort Ascending sorts the data in the column in ascending order (i.e. from least to greatest). 
Sort Descending sorts the data in the column in ascending order (i.e. from greatest to least). 
Note: The Sort dialog, including any configuration, is also available in runtime.  

 
Sorting Alarms 

Connecting to a Data Source 
To connect to a data source: 

1. Click the Connection button. This opens the Database Connection dialog box, as shown 
below. 

2. Under Data provider, select from Microsoft Access, Microsoft SQL Server, or ODBC (Open 
Data Base Connectivity), as shown in the figure below. 
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Connecting to a Database 

3. Click the Build Connection String button. This opens the Microsoft Data Link Properties 
dialog box, as shown in the figure below. In the Connection tab specify the data source and 
then click OK.  

Note: All data source connections are made through the Data Link Properties dialog box. The 
Connection tab settings may vary depending on which data provider you selected. Click the OK 
button. Click the Help button at any time to view the Microsoft Data Link help documentation. 
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Specifying a Data Source 

4. The data source reference appears in the Database Connection dialog box in the OLE DB 
Connection String field, as shown below. The Base Table Name field lists the tables in the 
database. You can select a specific table from the drop-down list to use as the reference table 
for the database. 

Note: The Base Table list varies according to the active Alarm Logger configuration database. 

5. Click the Connect button to connect to the database. The traffic light icon changes to green 
when the connection is successful, as shown in the figure below. 
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Database Connection  

Web Access and Support for Operator Comments 
The Display tab of the Alarm Viewer ActiveX Properties dialog box, shown below, also allows you 
to connect to an operator comments database. 

 
Alarm Viewer ActiveX Properties: Display Tab 
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Connecting to the Operator Comments Database  
In most situations, you will use the AWXLog.mdb Microsoft Access database (located in the 
ProcessView Bin directory) as your operator comments database. This is the standard Alarm Logger 
database. To connect to the operator comments database: 

1. Click the Connection button on the Display tab. This opens the Database Connection dialog 
box, as shown below. 

2. Under Data provider, select Microsoft Access, as shown in the figure below. 

 
Connecting to a Database 

3. Click the Build Connection String button. This opens the Microsoft Data Link Properties 
dialog box, as shown in the figure below.  

Note: All data source connections are made through the Data Link Properties dialog box. The 
Connection tab settings may vary depending on which data provider you selected. Click the OK 
button. Click the Help button at any time to view the Microsoft Data Link help documentation. 
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Specifying a Data Source 

4. Click the … button and select the AWXLog.mdb file from the bin directory. Click the Open 
button.   

 
Selecting the Operator Comments Database 
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5. The data source reference appears in the Database Connection dialog box in the OLE DB 
Connection String field, as shown below. In the Base Table Name field, select EventLog from 
the drop-down list. 

Note: The Base Table list varies according to the active Alarm Logger configuration database. 

6. Click the Connect button to connect to the database. The traffic light icon changes to green 
when the connection is successful, as shown in the figure below. 

 
Database Connection  

7. Now you must specify which column in the database table you will use to for logging and storing 
comments. In the Comment box, select a column from the drop-down list. For most cases, only 
the Comment box should be configured.  The exception is the case where the system is logging 
from two different alarm servers, using the same tag names in both alarm server configurations.  
This is the only case where the Node, Server, Op Condition, Op Node, and Op Server 
selections should be used. 

Enabling Remote Web Access to Operator Comments 
The Alarm Viewer enables you to gain access to operator comments from the currently connected 
Alarm Logger database over the Internet. To enable Web access to operator comments, check the 
Access currently connected database over the Internet via RDS check box at the bottom of the 
Database Connection dialog box. A Remote Data Service (RDS), which is hosted by an Internet 
Information Server (IIS), enables the downloading of operator comments data from the logger 
database to a client over the Internet.  
Once you have connected to the operator comments database. Simply specify the URL name or IP 
address of the IIS Web server in the Internet Information Server for Remote Data Access field in 
the Database Connection dialog box. You can also specify a maximum number of database 
records to download from the logger database.  
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When Internet Access to the logger database is enabled, the client makes a request over the 
Internet to the IIS Remote Data Service. The RDS uses a special component, called the Data 
Factory Handler, to relay the request to the local logger database on the server, as shown in the 
figure below. The RDS retrieves the relevant information for the alarm report from the logger 
database so that the client can download the data from the server over the Internet. The client 
machine then displays the data in the Viewer ActiveX per the client's configuration settings. 
In most typical scenarios, the Viewer ActiveX configuration is done on the server side. Configuration 
data saved as a *.awv file or a *.gdf display containing the Viewer ActiveX are published to an HTML 
document on a WebHMI server. 

 
Downloading Operator Comments From a Remote Logger Database 

Tips for Remote Data Access 
A good understanding of Remote Data Access principles is a key element to building a successful 
solution for a Web-enabled alarm reporting system. Since the volume of alarm databases can reach 
hundreds of megabytes, it is very important to keep in mind the following aspects. 
 
 
Maximum Number of Downloadable Database Records and Adequate Record Filtering 
The setting for the maximum number of records to download (Nmax) indicates that any database 
query operations would return no more than Nmax alarm records (lines to the grid). If more than 
Nmax records from the current table match the current filtering criteria, then only the portion of the 
record set containing top Nmax records is returned. To avoid such record set cut-off, strong 
restrictive record filters should be used all the time. Since the record filters are processed on the 
database side, the database server uses all existing records to build the record set.  
 
Proper Choice of the Back-end Database 
It should be noted that the use of Microsoft Access databases (*.mdb) is not recommended for Web 
Access. Poor memory management in Microsoft Jet Engine creates a serious scalability problem for 
any type of Web database application. The recommended back-end database for Web alarming 
is MSDE (Microsoft Desktop Engine) or Microsoft SQL Server. 
 
Table Management in Alarm Logger Configuration 
To provide further optimization for the Alarm Logger database operations, the table management 
should be enabled in the logger configuration. See the Alarm Logger Configurator documentation for 
more information. 
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Using the Remote Database Access Manager 
The AlarmWorX Remote Database Access Manager, shown in the figure below, is a separate 
utility (the AWXRepRDSSM.exe file) located in the ProcessView Bin directory. This utility configures 
the communication parameters for the Data Factory Handler (described above) so that the 
AlarmWorX Viewer ActiveX can connect to a remote Alarm Logger database and retrieve data from 
the database. It also enables security for remote database access via the ProcessView Security 
Server. 

 
AlarmWorX Remote Database Access Manager 

Database Connection Options 
The Database Connection Options section of the AlarmWorX Remote Database Access Manager 
sets the following connection parameters for the Data Factory Handler: 
• Connection Retry Number: Specifies the maximum number of times the Data Factory Handler 
will try to reconnect to the Alarm Logger database in case the connection fails. 
• Connection Retry Delay: Sets the amount of time (in seconds) the Data Factory Handler waits 
between subsequent connection retries to the Alarm Logger database. 
Security Management 
The AlarmWorX Remote Database Access Manager allows you to enable security for remote 
database access via the ProcessView Security Server. Check the Enable Security Management 
for Remote Database Access (via Security Server) check box. When security is enabled, each 
time a user tries to access the Alarm Logger Database, the Security Server will check to verify 
whether that user is allowed to have remote access to the database. 
Note: For information about the Security Server configuration and login, please see the Security 
Configurator and Security Login Help documentation.  
Because the database is accessed over the Internet via TCP/IP communications, GenBroker 
communications over OPC over TCP/IP must also be enabled. Thus, you must specify a 
GenBroker Configuration File (.gbc or .gbx). Clicking the … button to the right of this field allows 
you to browse for a GenBroker configuration file, as shown in the figure below. If you do not specify 
a GenBroker configuration file, or if no Security Server is specified in the GenBroker configuration, 
then the default system GenBroker configuration file will be used. 
Note: If you are using WebHMI, it is recommended that the Security Server be located on the same 
machine as the WebHMI Server. For information about how to configure GenBroker 
communications, please see the GenBroker Help documentation. 
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The ProcViewClient Updates Timeout sets the maximum amount of time (in seconds) the Data 
Factory Handler will wait for Security Server validation of a data request from the client (i.e. the 
client with the Alarm Viewer ActiveX installed) before returning an "Access Denied" error. 

 
Selecting a GenBroker Configuration File 

 

Subscription 
The Subscription tab of the Alarm Viewer ActiveX Properties dialog box, shown below, 
determines what type of OPC connection will be made. It allows you to add, rename, delete, or edit 
a subscription to a particular alarm. To add a new subscription, click the Add button.  

 
Alarm Viewer ActiveX Properties: Subscription Tab 

The subscription named "New Subscription" appears. This subscription does not contain any data, 
so it is necessary to immediately edit the new subscription. To do so, click the Edit button to open 
the Event Subscription dialog box, as shown in the figure below. It is only possible to add or edit 
subscriptions that are connected to active OPC Alarm and Event servers.  
Note: It is possible for a server to have more than one subscription.  In fact, it is a very effective way 
to achieve filtering.  
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Creating an Event Subscription  

Server 
The Server tab of the Event Subscription dialog box, shown in the figure below, allows you to 

select an Alarm and Event Server and Node for each subscription. To select the event server, 
click the Browse button.  

 
Event Subscription Dialog Box: Server Tab 

This opens the OPC Universal Tag Browser, shown in the figure below, which lists all available 
Alarm and Event OPC servers. Select the desired server, and click OK. For local servers, it is not 
necessary to fill in the Node field. 
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Selecting an Alarm and Events Server From the OPC Universal Tag Browser 

You can also select global aliases to use in the Node field. Clicking the ... button and selecting 
Global Alias Browser from the pop-up menu opens the Global Alias Browser, as shown in the 
figure below. Select a global alias from the Global Alias Browser, which includes all global aliases in 
the global alias database. This eliminates the need to manually type in the alias name. All global 
aliases that are configured in the Global Alias Engine Configurator are conveniently available to 
choose from inside the browser. The tree control of the Global Alias Engine Configurator is 
mimicked in the tree control of the Global Alias Browser. Select a global alias by double-clicking the 
alias name (e.g. "Floor" in the figure below). The alias name appears at the top of the browser, 
which automatically adds the <# and #> delimiters to the alias name. Click the OK button. 
 

 
Selecting an Alias From the Global Alias Browser 
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Types 
The Types tab of the Event Subscription dialog box, shown in the figure below, allows you to 
configure which OPC-defined event types each subscription should have, as well as to set the 
ranges for severity (priority). A value of "0" represents the low severity value, and "1000" represents 
the high severity value. Please note that OPC Alarm and Event (AE) servers are required to scale 
severity values to the OPC ranges (i.e. an AE server that contained two severity ranges would 
convert these to "0" and "1000"). 

 
Event Subscription Dialog Box: Types Tab 

Simple: These messages state information but do not have alarm status, nor do they contain 
information on what initiated the message. This includes the following information: Source, Time, 
Type, EventCategory, Severity, Message, Cookie, and server-specific items.   
Example: "FIC101, 12:0:0 1/1/99, Simple, Category1, 100, 'Shift Change', 1" 
Simple messages would be similar to an event. 
Tracking: These messages contain the additional information about the client that initiated the 
event. This includes the following information: Source, Time, Type, EventCategory, Severity, 
Message, Cookie, ActorID, and server-specific items. 
Example: "FIC101, 12:0:1 1/1/99, Tracking, Category1, 300, 'Pump pressure Set to 10 psi', 1, 
Station 12" 
Tracking messages are similar to event messages in that the cause of the event is important. An 
example would be an operator changing a setpoint value. This type of message does not include 
acknowledge capability. 
Note: Simple and tracking messages are removed from the alarm viewer via the acknowledge 
mechanism. 
Condition: These messages contain all of the above information but also include an 
acknowledgement portion. This includes the following information: Source, Time, Type, 
EventCategory, Severity, Message, Cookie, ConditionName, SubConditionName, ChangeMask, 
NewState, ConditionQuality, AckRequired, ActiveTime, ActorID and server-specific items. 
Example: "FIC101, 12:0:3 1/1/99, Condition, Category1, 700, 'Pump pressure to high', 1, Limit, HiHi, 
1,Active Enabled, Good, TRUE, 12:0:2 1/1/99" 
Condition messages would be considered a "typical" alarm message with acknowledge capability. 
For further details on any of the included information, please refer to the OPC Alarm and Events 
specification. 
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Categories 
The Categories tab of the Event Subscription dialog box, shown in the figure below, allows you to 
select the categories for a subscription. Select the category from the list of available categories, and 
then click the Add -> button. The category will appear in the Subscribed list. To remove a category 
from this list, select it in the Subscribed list and click the <- Remove button. If no categories are 
listed in the Subscribed list, then all categories are selected by default. 

Event Types and Categories 
All events generated are of the OPC defined Event Type Condition. The AlarmWorX Server defines 
the following Event Categories and uses the identical names for the Condition Names: 
• Deviation 
• Digital 
• Limit 
• Rate of Change 
The Limit and Deviation conditions have the following Sub-conditions: 
• HiHi 
• Hi 
• Lo 
• LoLo 
Note: The following categories are not used in the SMAR Alarm Server: 
• OPC Server Error 
• System Configuration 
• System Message 

 
Event Subscription Dialog Box: Categories Tab 

Areas 
Use the Areas tab of the Event Subscription dialog box, shown in the figure below, to select an 
area or a group of areas for filtering in a subscription. An area is used to group OPC alarm tags. 
This information can be used by clients for filtering purposes.  A tag can exist under multiple areas, 
and an area can have a multiple levels.  An area is defined by its name and the name of its parent 
branches.  For example, a branch called Area 1 under plant Area A is different from Area 1 under 
plant Area B. Areas can be configured in the AlarmWorX Server Configurator. 
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Event Subscription Dialog Box: Areas Tab 

Clicking the Browse button opens the OPC Event Server Area / Source Browser, shown in the 
figure below, which lists all available areas for your event server. Area subscription supports 
wildcards, which subscribe to the format of the Microsoft Visual Basic 'like" command. For example, 
"Area1*" will subscribe to all alarm areas that contain strings beginning with "Area1". "Area1\*" will 
subscribe to the root area and its "child" areas. A detailed explanation of the wildcard support can 
be found in the OPC Alarm and Events documentation. It is recommended that you thoroughly read 
the wildcard documentation before attempting to use complicated expressions.  
Note: For the like operator: "string" equals the string to search in; "pattern" equals the string to 
search for (can include wildcards); nonzero for case-sensitive search; zero for case-insensitive 
search. String syntax is $"string"$. 
You can use these special characters in pattern matches in string:  
• ? Any single character.  
• Zero or more characters.  
• # Any single digit (0-9).  

• [charlist] Any single character in charlist.  
• [!charlist] Any single character not in charlist. 
It is also possible to delete an area from the Areas tab. To delete an area, select it from the list of 
areas for this particular subscription, and then click the Delete button. Not all OPC Alarm and Event 
servers support area filtering as part of the subscription. 
Note: If no areas are listed, then all areas are selected by default. 
Note: It is recommended that you have an area in the alarm server to which you subscribe; this 
ensures that the relevant alarms are received. Any available areas listed in the active Alarm Server 
configuration database are available to choose from in the Area/Source Browser, as shown in the 
figure below. 
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OPC Event Server Area/Source Browser 

You can also select global aliases to use in the Area field. Clicking the ... button and selecting 
Global Alias Browser from the pop-up menu opens the Global Alias Browser, as shown in the 
figure below. Select a global alias from the Global Alias Browser, which includes all global aliases in 
the global alias database. This eliminates the need to manually type in the alias name. All global 
aliases that are configured in the Global Alias Engine Configurator are conveniently available to 
choose from inside the browser. The tree control of the Global Alias Engine Configurator is 
mimicked in the tree control of the Global Alias Browser. Select a global alias by double-clicking the 
alias name (e.g. "Floor" in the figure below). The alias name appears at the top of the browser, 
which automatically adds the <# and #> delimiters to the alias name. Click the OK button. 

 
Selecting an Alias From the Global Alias Browser 

Clicking the ... button and selecting Language Alias Browser from the pop-up menu opens the 
Language Alias Browser, as shown in the figure below. The browser includes all languages aliases 
in the language database. All language aliases that are configured in the Language Configurator are 
conveniently available to choose from inside the browser. The tree control of the Language 
Configurator is mimicked in the tree control of the Language Alias Browser. Select a language alias 
by double-clicking the alias name. The alias name appears at the top of the browser, which 
automatically adds the /+ and +/ delimiters to the alias name. Click the OK button. 
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Selecting an Alias From the Language Alias Browser 

Sources 
The Sources tab of the Event Subscription dialog box, shown in the figure below, allows you to 
filter on a source or group of sources for a particular subscription. A source is an OPC alarm tag in 
an alarm configuration. In the AlarmWorX Server Configurator, a source can be associated with a 
particular area (group of alarm tags). It is also possible to delete a source for a particular 
subscription. To delete a source, select it from the list of sources for this particular subscription and 
click the Delete button. Not all OPC Alarm and Event servers support source filtering as part of the 
subscription.  
Note: If no sources are listed, then all sources are selected by default. Any available sources listed 
in the active Alarm Server configuration database are available to choose from in the Area/Source 
Browser, as shown in the figure below. 

 
Event Subscription Dialog Box: Sources Tab 

To select a source, click the Browse button and select one from the OPC Event Server Area / 
Source Browser, shown in the figure below. Source subscription provides the wildcard support 
found in the area subscription.  
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OPC Event Server Area/Source Browser 

You can also select global aliases to use in the Area field. Clicking the ... button and selecting 
Global Alias Browser from the pop-up menu opens the Global Alias Browser, as shown in the 
figure below. Select a global alias from the Global Alias Browser, which includes all global aliases in 
the global alias database. This eliminates the need to manually type in the alias name. All global 
aliases that are configured in the Global Alias Engine Configurator are conveniently available to 
choose from inside the browser. The tree control of the Global Alias Engine Configurator is 
mimicked in the tree control of the Global Alias Browser. Select a global alias by double-clicking the 
alias name (e.g. "Floor" in the figure below). The alias name appears at the top of the browser, 
which automatically adds the <# and #> delimiters to the alias name. Click the OK button. 

 
Selecting an Alias From the Global Alias Browser 

Clicking the ... button and selecting Language Alias Browser from the pop-up menu opens the 
Language Alias Browser, as shown in the figure below. The browser includes all languages aliases 
in the language database. All language aliases that are configured in the Language Configurator are 
conveniently available to choose from inside the browser. The tree control of the Language 
Configurator is mimicked in the tree control of the Language Alias Browser. Select a language alias 
by double-clicking the alias name. The alias name appears at the top of the browser, which 
automatically adds the /+ and +/ delimiters to the alias name. Click the OK button. 
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Selecting an Alias From the Language Alias Browser 

Attributes 
The Attributes tab of the Event Subscription dialog box, shown in the figure below, allows you to 
add extra attributes to a particular event category within a subscription. Select the event category 
from the corresponding drop-down list. Choose the desired items from the available attributes list, 
and click the Add button. To remove an attribute from the subscribed list, select that particular 
attribute and click Remove.  
Note: The following categories are not used in the SMAR Alarm Server: 
• OPC Server Error 
• System Configuration 
• System Message 

 
Event Subscription Dialog Box: Attributes Tab 

It is important to note that the order of the subscribed attributes does matter. The order of the 
attributes determines the order they will be selected from the alarm server, and also determines with 
which viewer attribute column they are associated. To change the order of the attributes in the 
subscribed field, simply select an attribute and click the "up" and "down" arrow buttons. Server-
specific information will be displayed in the Attributes1-n columns. The attributes columns are added 
in the Column tab of the Alarm Viewer ActiveX Properties dialog box. 
Note: To receive extra attributes, you must request them per event category. 
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Event Attributes 
The following event attributes are made available to subscribing clients: 

Attribute Deviation Digital Limit Rate of 
Change Type Comment 

ACK COMMENT a a a a VT_BSTR Comment entered when alarm was last 
acknowledged. 

ALARM COUNT a a a a VT_I4 Number of alarm transitions before 
acknowledge. 

AREA a a a a 
VT_ARRAY | 
VT_BSTR Array of areas 

CV a a a a 
VT_R8 
VT_BOOL Current Value (OPC Input 1 or 2). 

DEADBAND a  a a VT_R8 Alarm detection Deadband. 

DEFAULT DISPLAY a a a a VT_BSTR A text string, usually a file name, that when 
launched provides related information. 

HELP TEXT a a a a VT_BSTR Help information 

LIMIT VALUE EXCEEDED a  a a VT_R8 The Current Value at the time the limit was 
exceeded. 

LOOP DESC a a a a VT_BSTR A description of the Source (tag). 

NEXT_LIM a  a  VT_R8 The value of the next limit. 

NORMAL STATE  a   VT_BOOL Value of the normal state (TRUE or FALSE). 

PREV LIM a  a  VT_R8 Value of the previous limit reached. 

RELATED VALUE 01-10 a a a a  
Associates up to 10 OPC tags or expressions 
with each alarm tag as “supplemental” 
information to the alarm. 

SP a    VT_SP Setpoint (OPC Input 2) 

 

Client Side Filtering 
There are two ways to achieve filtering using the Alarm Viewer: on the server side and on the client 
side. Server-side filtering takes place through the use of subscriptions, while client-side filtering 
takes place through the use of the Filter option on the Display tab of the Alarm Viewer ActiveX 
Properties dialog box, as shown in the figure below. 
Note: When possible, server-side filtering should be the primary filtering method.  

 
Alarm Viewer ActiveX Properties: Display Tab 
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Clicking the Filter button opens the Client Filters dialog box, as shown in the figure below.  
Note: You can also open this dialog box by right-clicking the viewer during runtime and selecting 
Filter from the pop-up menu. 

 
Creating Client-Side Filters 

Adding and Editing Filters 
To add a filter, click the Add button. A new filter will appear in the list box. To enter the criteria for 
the filter, select the filter and click the Edit button.  This opens the Expression Editor, as shown in 
the figure below. The Expression Editor box has the following options: Arithmetic, Relational, 
Logical, Bitwise, Functions, and Tags.  Each of these options is explained in greater detail in 
following sections. 

 
Filter Expression Configuration 

Deleting Filters 
To delete a filter all together, select the filter in the Client Filters dialog box and click the Delete 
button. Your system will ask if you really want to delete the filter; click Yes and the filter will be 
deleted. 

Renaming Filters 
To rename a filter, select the filter in the Client Filters dialog box and click the Rename button.  
You must change the filter name if you are going to add more than one filter.  Try to give the filter a 
name that describes what it does or the values it considers when filtering.  
Note: Depending on the security level of the user, filters may or may not be able to be created or 
activated during runtime. 
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Arithmetic 
The symbols '+', '-', '*', '/' and '%' use the following format:  

expression :: parameter symbol parameter 
Where  

Parameter A local variable, an OPC tag, a constant, or another expression 
Symbol + or - or * or / or % 

 
Result 
The expression results in a number of any type (float, long, etc.). 

 
Examples 

Symbol Description Example Result 
+ Addition ~~var1~~ + ~~var2~~ 8+3 = 11 

- Subtraction ~~var1~~ - ~~var2~~ 8-3 = 5 

* Multiplication ~~var1~~ * ~~var2~~ 8*3 = 24 

/ Division ~~var1~~ / ~~var2~~ 8/3 = 2.66667 

% Calculates the remainder after division ~~var1~~ % ~~var2~~ 8%3 = 2 

( and ) Gives precedence to parts of the 
calculation 

~~var1~~ / 
(~~var2~~ + ~~var3~~) 

8/(3+2) = 1.6 

 

Relational 
The symbols '<', '>', '<=', '>=', '==' and '!=' use the following format:  

expression :: parameter symbol parameter 
 
Where  

Parameter A local variable, an OPC tag, a constant, or another expression 
Symbol < or > or <= or >= or == or != 

 
Result 
The expression results in a Boolean value (0 or 1). 

Examples 
Symbol Description Example Result 
< Less than ~~var1~~ < ~~var2~~ 8<3 = 0 

> Greater than ~~var1~~ > ~~var2~~ 8>3 = 1 

<= Less than or equal to ~~var1~~ <= ~~var2~~ 8<=3 = 0 

>= Greater than or equal to ~~var1~~ >= ~~var2~~ 8>=3 = 1 

== Equal to ~~var1~~ == ~~var2~~ 8==3 = 0 

!= Not equal to ~~var1~~ != ~~var2~~ 8!=3 = 1 

Logical 
The symbols '&&' and '||' use the following format:  

expression :: parameter symbol parameter 
 
The symbol '!' uses the following format: 

expression :: symbol parameter 
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Where  
Parameter A local variable, an OPC tag, a constant, or another expression 
Symbol && or || or ! 

 

Result 
The expression results in a Boolean value (0 or 1). 
 
Truth table 

  
 

Examples 
Symbol Description Example Result 

&& And ~~var1~~ && ~~var2~~ 8 && 3 = 1 

|| Or ~~var1~~ || ~~var2~~ 8 || 3 = 1 

! Not !~~var1~~ !8 = 0 

 

Bitwise 
The symbols '&', '|', and '^' of the bitwise group use the following format:  

expression :: parameter symbol parameter 
 
The symbol '~' of the logical group uses the following format:  

expression :: symbol parameter 
The symbols 'shl' and 'shr' of the bitwise group use the following format: 

expression :: symbol (value, shift by) 

Where  
Parameter A local variable, an OPC tag, a constant, or another expression 
Symbol && or || or ^ or shl or shr or ~ 

 

Result 
The expression results in a number when the parameters used contain numbers. 

Bit Table 
 Binary (Decimal) Binary (Decimal) 

~~var1~~ 0000.0000.0000.1000 - (8) 0000.0000.0110.0000 - (96) 

~~var2~~ 0000.0000.0000.1010 - (10) 0000.0000.0000.1000 - (8) 

~~var1~~ & ~~var2~~ 0000.0000.0000.1000 - (8) 0000.0000.0000.0000 - (0) 

~~var1~~ | ~~var2~~ 0000.0000.0000.1010 - (10) 0000.0000.0110.1000 - (104) 

~~var1~~ ^ ~~var2~~ 0000.0000.0000.0010 - (2) 0000.0000.0110.1000 - (104) 

shl (~~var1~~,3) 0000.0000.0100.0000 - (64) 0000.0011.0000.0000 - (768) 

shr (~~var1~~,3) 0000.0000.0000.0001 - (1) 0000.0000.0000.1100 - (12) 

~(~~var1~~) 1111.1111.1111.0111 - (-9) 1111.1100.1111.1111 - (-97) 

bittest(~~var1~~,3) 0000.0000.0000.0001 - (1) 0000.0000.0000.0000 - (0) 
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Examples 
Symbol Description Example Result 

& Bit And ~~var1~~ & ~~var2~~ 8 && 3 = 0 

| Bit Or ~~var1~~ | ~~var2~~ 8 || 3 = 11 

^ Bit eXclusive Or ~~var1~~ ^ ~~var2~~ 8^3=11 

shl Bit shift left shl(~~var1~~,3) 8<<3=64 

shr Bit shift right shr(~~var1~~,3) 8>>3=1 

~ Not (two's complement) ~(~~var1~~) !8 = -9 

bittest Bit Test bittest ( 5 , 0 ) 1 

 
Note: The bittest function requires you to specify the position of the bit to be tested. You must 
indicate that it starts from 0. In other words, a bit position of "0" indicates the "less significant" bit. 

Functions 
The symbols 'sin', 'asin', 'cos', 'acos', 'tan', 'atan', 'log', 'ln', 'exp', 'sqrt', 'abs', 'ceil', and 'floor' use the 
following format: 

expression :: symbol (parameter) 
 
The symbols 'pow', 'min', and 'max' use the following format: 

expression :: symbol (parameter,parameter) 
 
The symbol 'if' uses the following format: 

expression :: symbol (parameter,parameter,parameter) 
 

Where  
Parameter A local variable, an OPC tag, a constant, or another expression 
Symbol sin, asin, cos, acos, tan, atan, log, ln, exp, sqrt, abs, ceil, floor, min, max, pow, or if 

Result 
The expression results in a number. 
Examples 

Symbol Description Example Result 
sin sine of an angle in radians sin(~~var1~~) sin(0.785)=0.71 

cos cosine of an angle in radians cos(~~var1~~) cos(0.785)=0.71 

tan tangent of an angle in radians tan(~~var1~~) tan(0.785)=1.0 

asin arc sine returns an angle in radians asin(~~var1~~) asin(0.5)=0.52 

acos arc cosine returns an angle in radians acos(~~var1~~) acos(0.5)=1.05 

atan arc tangent returns an angle in radians atan(~~var1~~) atan(1)=0.785 

sqrt Returns the square root sqrt(~~var1~~) sqrt(100)=10 

pow 
Returns value 1 raised to the power 
value 2 pow(~~var1~~,~~var2~~) pow(100,1.5)=1000 

log 10 based logarithm log(~~var1~~) log(100)=2 

ln e based logarithm ln(~~var1~~) ln(7.389)=2 

exp Exponential  exp(~~var1~~) exp(2)=7.389 

abs Absolute value abs(~~var1~~) abs(-1)=1 

ceil Integer ceiling ceil(~~var1~~) ceil(7.39)=8 

floor Integer floor floor(~~var1~~) floor(7.39)=7 

min Lowest value of two min(~~var1~~,~~var2~~) min(10,5)=5 

max Highest value of two max(~~var1~~,~~var2~~) min(10,5)=10 
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Symbol Description Example Result 

if Conditional statement if(~~var1~~<~~var2~~, 
~~var1~~,~~var2~~) if(5<8,5,8)=5 

like Wildcard string compare Like(string, pattern, 
casesensitive')  

quality Quality of tag or expression See below. See below. 

tostring Type conversion See below. See below. 

0x Hexadecimal constant x=0x11   17 

0t Octal constant x=0t11   9 

0b Binary constant x=0b11 3 

 

Note: For the like operator: "string" equals the string to search in; "pattern" equals the string to 
search for (can include wildcards); nonzero for case-sensitive search; zero for case-insensitive 
search. String syntax is $"string"$. 
You can use these special characters in pattern matches in string:  
• ? Any single character.  
• Zero or more characters.  
• # Any single digit (0-9).  

• [charlist] Any single character in charlist.  
• [!charlist] Any single character not in charlist. 

 
Quality 
The quality option on the Functions menu of the Expression Editor is used to evaluate the quality 
of an OPC tag or an expression.  
The following general syntax is used for quality expressions: 
x=quality(expression) 
Note: The "(expression)" can also be a simple expression composed of a single tag. 
The quality function returns the OPC quality of the string between parentheses as one of the 
following results: 

• 192: quality is GOOD 
• 64: quality UNCERTAIN 
• 0: quality BAD 
 
Note: The OPC Foundation establishes the value ranges for quality. There are actually varying 
degrees of quality:  

• GOOD: 192-252 
• UNCERTAIN: 64-191 

• BAD: 0-63 
 
For more information, refer to the OPC Data Access Custom Interface Standard available for 
download at the OPC Foundation's Web site, www.opcfoundation.org/. 
 
Example Quality Expression 

Expression Result 
x=quality({{SMAR.Simulator.1\SimulatePLC.PumpStatus}}) 192 (Quality GOOD) 

 
The quality of an expression is determined through the evaluation of each single tag in the 
expression. Thus, if you have multiple tags in an expression (and each tag has a different quality), 
the result of the expression (i.e. 192 [GOOD], 64 [BAD], or 0 [UNCERTAIN]) corresponds to the 
quality of the tag with the lowest quality. If an expression contains a conditional statement (e.g. if, 
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then, or else), then the result of the expression is affected only by the quality of the branch being 
executed. 
Consider the following sample expression: 
x= if ( quality({{Tag1}}) == 192, {{Tag1}}, {{Tag2}}) 
This expression can be read as follows:  
"If the quality of Tag1 is GOOD (i.e. 192), then the expression result (x) is the value of Tag1. In all 
other cases (i.e. the quality of Tag1 is UNCERTAIN or BAD), the expression result (x) is the value of 
Tag2." 
We can calculate the results for this expression using different qualities for Tag1 and Tag2, as 
shown in the table below. 
 

Case Tag1 quality Tag2 quality Result Result quality 
1 GOOD GOOD Tag1 192 (GOOD) 

2 GOOD UNCERTAIN Tag1 192 (GOOD) 

3 GOOD BAD Tag1 192 (GOOD) 

4 UNCERTAIN GOOD Tag2 192 (GOOD) 

5 UNCERTAIN UNCERTAIN Tag2 64 (UNCERTAIN) 

6 UNCERTAIN BAD Tag2 0 (BAD) 

7 BAD GOOD Tag2 192 (GOOD) 

8 BAD UNCERTAIN Tag2 64 (UNCERTAIN) 

9 BAD BAD Tag2 0 (BAD) 

 
In cases 1-3 above, the quality of Tag1 is GOOD, and therefore the result of the expression is 
GOOD. Thus, the result of the expression is not affected by the quality of Tag2 (the “else” branch of 
the expression), which is ignored.  
In cases 4-6, the quality of Tag1 is UNCERTAIN, and therefore the result of the expression is the 
quality of Tag2.  
In cases 7-9, the quality of Tag1 is BAD, and therefore the result of the expression is the quality of 
Tag2. 
Note: The “quality()” function returns a value that represents the quality of the expression within the 
parentheses but is always GOOD_QUALITY. For example, if Tag1 is BAD_QUALITY then the 
expression “x=quality({{Tag1}})" will return 0 with GOOD_QUALITY. 
The result of an expression is the minimum quality of the evaluated tag in the expression and is 
affected only by the quality of the conditional (if, then, or else) branch that is executed.  
Consider the following sample expression: 
x= if ({{TAG_01}}>0,{{TAG_02}},{{TAG_03}}) 
This expression can be read as follows:  
"If the value of TAG_01 is greater than 0, then the expression result (x) is TAG_02. If the value of 
TAG_01 is less than or equal to 0, then the expression result (x) is TAG_03." 
Let's assume that the following values and qualities for these tags: 
TAG_01=5 with quality GOOD 
TAG_02=6 with quality UNCERTAIN 
TAG_03=7 with quality BAD 
Because the value of TAG_01 is 5 (greater than 0), the expression result is TAG_02. Thus, the final 
expression result is 6, and the final expression quality is UNCERTAIN. 
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Type Conversion 
The tostring option on the Functions menu of the Expression Editor takes the value of whatever 
item is in parentheses and converts it into a string as follows: 
The value is +(value)+unit 
It can be used to convert from number to string, and it can be very useful for string concatenation. 
The proper syntax for the tostring option is: 
x=$"The value is "$ + tostring(value) + $" unit"$ 
 
Note: In the expression above, the word "unit" is placeholder text for a user-specified unit of 
measurement or variable (e.g. Watt, inches, meters, etc.).  
 
Example Expressions Type Conversion 

Expression Result 
x=$"The value is "$ + tostring({{gfwsim.ramp.float}}) + $" Watt"$ “The value is 543.2345152 Watt” 

 
Constants 
The Functions menu of the Expression Editor supports constant values, including hexadecimal, 
octal, and binary formats.  
Example Expressions Using Constants 

EXPRESSION RESULT 
x=0x11 17 
x=0t11 9 
x=0b11 3 

 
The Expression Editor conveniently inserts the 0x and 0t and 0b prefixes for you so do not have to 
recall them. 
 
Interpreting and Translating Constants 
The examples below show how values are calculated for each type of constant. 
• Hexadecimal:  0x20A = 2 * (16^2) + 0 * (16^1) + 10 * (16^0) = 2*256 + 0*16 + 10 * 1 = 512 + 0 

+ 10 = 522 
• Octal: 0t36= 3 * (7^1) + 6 *(7^0) = 3* 7 + 6* 1= 21 + 6 = 27 

• Binary: 0b110 = 1 * (2^2) + 1 * (2^1) + 0 * (2^ 0) = 1 * 4 + 1 * 2 + 0 * 1 = 4+2+0 = 6 

Tags 
The menu options available under the Tags button of the Expression Editor are shown in the figure 
below. The Expression Editor dialog box can also be used to create and edit alarm filters. The 
Expression Editor provides a Filter Wizard and an Alarm Tag list to help you create simple alarm 
filters. If you want to customize your alarm filters, you can use the other functions in the Expression 
Editor to set up your alarm filters manually. 
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Creating Alarm Filters Using the Expression Editor  

Filter Wizard 
The Filter Wizard, shown in the figure below, allows you to choose from the following to items enter 
in your expression. Select one or more items, and then click OK. The filter string is automatically 
inserted into the Edit Expression dialog box. 

• Alarm Types: Alarm, Acknowledgement, Unacknowledgement, Tracking, and Operator 
• Subconditions: LoLo, Lo, Hi, HiHi, Rate of Change, and Digital 

 
Filter Wizard 

Selecting Alarm Attributes 
Selecting Advanced from the Tags menu of the Expression Editor opens the Alarm Tag list, shown 
in the figure below, which allows you to choose alarm attributes for your alarm filter. Select the 
attribute that you want to include in the filter expression and click OK.  
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Alarm Attributes List 

There are two additional attributes available for use in filtering: Alarm Type and Current Time.  The 
Alarm Type attribute allows you to filter alarms according to ALARM 1, ACK 2, UNACK 3, OPER 4, 
TRACK 5 or NORM 6.  For example, you can set up a filter with the condition: 
X = {{AlarmType}}  
If the Alarm Type is true, then the alarms are displayed. If they are false then, the alarms are not 
displayed.   
The Current Time attribute allows you to filter according to the current time.  Only alarms occurring 
around the current time will be displayed. 
 
Example Alarm Filters 

Expression Result 
X = {{Severity}} > 500.   Only alarm messages with a severity greater than 500 will be visible. 
X = Like({{Source}}, $"Tag"$,0)   Only messages with the tag in the source name will be displayed. 
X = 1.   Filter displays all messages. 
X = 0.   Filter does not display any messages. 

 

All filters resolve to TRUE or FALSE. All nonzero values resolve to TRUE.  
 
Global Aliases 
For global aliases within the expression, use the following syntax:   
<#global_alias_name#> 

 

Example: 
x=<#RoomTemperature#> 
 

Selecting Global Alias Browser opens the Global Alias Browser, as shown in the figure below. 
Select a global alias from the Global Alias Browser, which includes all global aliases in the global 
alias database. This eliminates the need to manually type in the alias name. All global aliases that 
are configured in the Global Alias Engine Configurator are conveniently available to choose from 
inside the browser. The tree control of the Global Alias Engine Configurator is mimicked in the tree 
control of the Global Alias Browser. Select a global alias by double-clicking the alias name (e.g. 
"Floor" in the figure below). The alias name appears at the top of the browser, which automatically 
adds the <# and #> delimiters to the alias name. Click the OK button. 
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Selecting an Alias From the Global Alias Browser 

 
Language Aliases 
For language aliases within the expression, use the following syntax:   
/+language_alias_name+/ 
 
Example: 
x=/+WaterSystem+/ 
 
Selecting Language Alias Browser from the pop-up menu opens the Language Alias Browser, as 
shown in the figure below. The browser includes all languages aliases in the language database. All 
language aliases that are configured in the Language Configurator are conveniently available to 
choose from inside the browser. The tree control of the Language Configurator is mimicked in the 
tree control of the Language Alias Browser. Select a language alias by double-clicking the alias 
name. The alias name appears at the top of the browser, which automatically adds the /+ and +/ 
delimiters to the alias name. Click the OK button. 

 
Selecting an Alias From the Language Alias Browser 
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Grids 
The Grids tab of the Alarm Viewer ActiveX Properties dialog box, shown below, configures the 
appearance of the grid lines that appear on the Alarm Viewer. 

 
Alarm Viewer ActiveX Properties: Grids Tab 

Configure the following grid settings: 
• Colors: Specifies colors for the grid text, headers, and background. 
• Grid Lines: Both Horizontal and Vertical grid lines appear on the alarm report.  You can 
specify the Width, Style (e.g. Solid, Dashed, etc.), and Color of the grid lines.  To change the color 
of the grid lines, simply click the Color check box and select a color from the color palette. 
Note: It is not necessary to have grid lines, but it is helpful in distinguishing between different 
records.    

ToolTips 
The ToolTips tab of the Alarm Viewer ActiveX Properties dialog box, shown below, allows you to 
determine which ToolTip options will be available during runtime by selecting the corresponding 
check boxes.   

 
Alarm Viewer ActiveX Properties: ToolTips Tab 
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The Width field determines the width of the ToolTip when it is shown in the display.     
The Default field allows you to select the following ToolTips that will be the default in runtime: 

• None: No ToolTips. 
• Context: Context information ToolTips. 
• Help: Displays the information associated with the column configured for help.  This is set in the 
Settings tab of the Alarm Viewer ActiveX Properties dialog box. 
• Comment: Displays the information associated with the column configured for comment. This is 
set in the Settings tab of the Alarm Viewer ActiveX Properties dialog box. 

• Alarm Line: Displays the entire alarm line. 
Both the Help and Comment fields have corresponding drop-down list boxes that determine which 
columns will be displayed for these selections. 

Settings 
The Settings tab of the Alarm Viewer ActiveX Properties dialog box, shown below, configures 
how runtime will be started and which functions will be enabled once it has.  It also contains settings 
for alarm interactions. 

 
Alarm Viewer ActiveX Properties: Settings Tab  

Checking the Auto-Start check box triggers the server to start runtime when the container is 
activated.  Checking the Event check box enables the automation event trigger (VB event) during 
runtime. The 'Always Use Ack Dialog' forces the user to acknowledge all alarms through the 
Acknowledge Alarm dialog.   
Runtime Interaction 
Checking the Auto-Start check box triggers the server to start runtime when the container is 
activated.   
Checking the Event check box enables the automation event trigger (VB event) during runtime.  
Checking the Move Columns check box enables you to change the order of the columns in runtime. 
Selecting a column header and moving it to the new location achieves this in runtime.  Additionally, 
you can decide if columns and rows can be resized while in runtime mode by checking Resize 
Columns or Resize Rows.   
 
Alarm Interaction 
When Enable Milliseconds is checked, milliseconds will be displayed after time in the Time/Date 
column of the viewer during runtime mode. 
When Enable Double Click is checked, double-clicking an alarm during runtime acknowledges only 
the row double-clicked if the CTRL key is not pressed down. 
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When Disable Popup Menu is checked, the right-click menu acknowledgement options will not be 
available during runtime mode. 
When Always Use Ack Dialog is checked, the user is forced to acknowledge all alarms through the 
Acknowledge Alarm dialog. When Force Comment is checked and an alarm is acknowledged, the 
alarm cannot be acknowledged until a comment is entered in the Comments field of the 
Acknowledge Alarm dialog. The Force Comment function applies to alarms with a severity level 
that is greater than or equal to the Severity setting. 

Runtime Operations 
During runtime mode, the AlarmWorX Viewer ActiveX provides support for the following functions:   
• Alarm acknowledgement 
• Operator comments 
• Sorting 
• ToolTips 
• VB event 
• Application 
• Display 

 
As you can see in the figure below, these functions become available when you right-click on an 
alarm line during runtime mode. The selected alarm has a 3-D look so you can distinguish it from 
the other alarm lines, as shown in the figure below. 
Note: You can also left mouse click and drag the cursor to select and acknowledge multiple alarm 
lines. 
 

 
Runtime Operations 

 
Note: When the scroll bar is moved from the top position, the Alarm Viewer enters a "freeze" mode. 
This mode will enable a user to scroll without having the alarm sorting interfere with reading the 
alarm viewer. All alarms that existed before the user entered freeze mode are displayed. This 
includes any change of state for those alarms. If one of these alarms enters a normal state while the 
viewer is in freeze mode, a placeholder line will be used to maintain visual placement. All alarms 
that did not exist before freeze mode are processed for beep, header flash, and automation support, 
but are not displayed visually. In freeze mode, the header of the alarm viewer will flash if any alarm 
is not visible. 
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Alarm Acknowledgement 
When an alarm is sent from the server to the viewer, it will remain there until it is acknowledged in 
some way. The process of acknowledgement involves communication between the Alarm Viewer 
ActiveX and the subscribed Alarm OPC Server from which the alarm signals are coming.  The initial 
communication results in the alarm signal, which appears in the Current Alarms Viewer. Once you 
acknowledge an alarm, an ack message is sent to the appropriate server. The server then posts the 
new state of the alarm (i.e. "acknowledged") to the viewer.  The alarm line is then updated with the 
new information. Events are removed during the acknowledgement process if included in the list of 
items to be acknowledged. The Alarm and Event servers do not receive communication for event 
removal. There are several ways in which an alarm or event can be acknowledged.   
Note: The alarm header will flash whenever there is an unacknowledged alarm that is not visible in 
the window. 

Point Acknowledgement 
Point acknowledgement will acknowledge all alarms currently selected. To select and 
acknowledge more than one alarm, hold the control key down and left mouse click on all rows of 
interest, right mouse click, select point, and then click OK.  A left double mouse click will also 
acknowledge all selected points if the control key is held down. 
Note: The row that is under the mouse on a right-click is selected if no other rows are currently 
selected. 
Double-clicking an alarm during runtime (if this option is selected in the Settings tab of the Alarm 
Viewer Properties dialog box) acknowledges only the row double-clicked on if the CTRL key is not 
pressed down.  
Right-clicking and selecting Ack during runtime opens the Alarm Ack dialog box, as shown in the 
figure below. 
Note: You can also left mouse click and drag the cursor to select and acknowledge multiple alarm 
lines. 

 
Acknowledging Alarms 

The Alarm Type field allows you to see which type of alarm you are acknowledging.  Clicking the 
OK button acknowledges a particular alarm.   
Note: The Global, Visible, Filtered, and Area acknowledgements are described below.  
If a different user acknowledges the alarm, the alarm will appear to automatically acknowledge.  
Clicking the Keyboard button opens the keypad, which allows operators to key in information 
directly on the screen. 

Global Acknowledgement 
When you choose Global from the Alarm Ack dialog, you are acknowledging all alarms received up 
to that point. An advantage of using this option is that it quickly clears all alarms from the current 
view.   
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Visible Acknowledgement 
The Visible option allows the user to acknowledge all visible alarms. Thus, if the size of the viewer 
allows for five alarms to be seen and a total of eight alarms are coming in, only the five visible 
alarms will be acknowledged. If there are more alarms than the visible ones, a scroll bar will appear 
on the right-hand side of the viewer.   

Filtered Acknowledgement 
The Filtered option allows the user to acknowledge all filtered alarms. This differs from global 
acknowledgement in the fact that filtered acknowledgement does not acknowledge locally filtered 
alarms. 
Note: Filtered acknowledgement is only available in version 6.0 and later. In earlier versions, this 
option behaves the same as global acknowledgement. 

Area Acknowledgement  
The Area option allows the user to acknowledge all alarms that have the same area as the alarm 
that was selected.   

Event Removal 
Selecting Events on the Alarm Acknowledgement dialog box removes all event messages from the 
viewer. 

Double Acknowledging an Alarm 
It is not possible to acknowledge an alarm more than once, but since the alarm does not 
immediately disappear from the viewer once it is acknowledged, it is possible for a user to try to 
acknowledge an alarm twice.  When this occurs, the user will see the results dialog box shown 
below. 

 
Alarm Acknowledgement Results 

Total Acknowledged Alarms: Provides information about the number of alarms acknowledged.   
Alarm Already Acked: Counts the number of alarms attempted to be acknowledged but were 
already acknowledged.  This can occur if the alarm is acknowledged by another client before the 
acknowledge message is received by the client.   
Time Does Not Match Last Active Time: The number of alarms that were attempted to be 
acknowledged but did not contain the most recent alarm timestamp.  This can occur if the alarm 
being acknowledged is not the most recent state of the alarm. This will occur if the acknowledge 
message is sent before an update of the current alarm state is received by the client. 
Does Not Need Acknowledgement: The number of messages that did not require 
acknowledgement. This can occur if an acknowledgement is attempted on a non-condition 
message. 
Other: The number of messages that produced a non-OPC alarm acknowledgement COM error. 
Persistent occurrences of this problem could be due to a bad network connection or erroneous 
alarm message.   
The Alarm Viewer will detect the current state of an alarm and will not attempt to acknowledge an 
alarm that is already marked as acknowledged.  No dialog will be posted for this occurrence. 
To clear the message, simply click the OK button.   
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Operator Comments 
Selecting Comments from the Runtime menu opens the Operator Comments dialog box, as 
shown in the figure below. This dialog describes the alarm line the user selected, and it provides a 
method for entering one or multiple operator comments in a text field. It also indicates whether the 
user is currently connected to the operator comments database. Clicking the Add button logs these 
comments to a database using the Event Logger. The dialog displays all past operator comments 
for the alarm selected under the Time, Comment, and Operator columns. The Event Logger is 
mandatory for operator comments. 

 
Entering Operator Comments 

Sorting 
Selecting Sorting from the Runtime menu opens the Sort dialog box, as shown in the figure below.  

 
Sorting Alarms 
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The Sort Alarms by section indicates the first criteria the Alarm Viewer should use when sorting all 
current alarms.  The following Then by sections indicate how the viewer should sort alarms that 
have the same value for the criteria selected in the first section.   
Note: It is not necessary to have any values listed in the Then by sections.    
The Sort dialog allows you to configure which criteria to sort the alarms by.  It also allows for 
multilevel sorting up to five levels with ascending/descending specific to each level.  The Alarm 
Viewer will always sort. The default sort for a new viewer is Time/Date. 
Sort Ascending sorts the data in the column in ascending order (i.e. from least to greatest). 
Sort Descending sorts the data in the column in ascending order (i.e. from greatest to least). 
Note: The Sort dialog, including any configuration, is also available in runtime.  

ToolTips 
The Default of the ToolTips tab of the Alarm Viewer ActiveX Properties dialog box determines which 
of the following ToolTips that will be the default in runtime: 
• None: No ToolTips. 
• Context: Context information ToolTips. 
• Help: Displays the information associated with the column configured for help.  This is set in the 

Settings tab of the Alarm Viewer ActiveX Properties dialog box. 
• Comment: Displays the information associated with the column configured for comment. This is 

set in the Settings tab of the Alarm Viewer ActiveX Properties dialog box. 

• Alarm Line: Displays the entire alarm line. 

VB Event 
This option allows a user to trigger an automation event during runtime mode.  Using this event 
requires VBA programming tied to the user event. 

Display Option 
This option only appears if the Alarm Viewer creates the display list by checking the extra attributes 
field for the registered file types. This attribute is server-specific (for example, when using the SMAR 
Alarm OPC Server, select Default Display). All displays configured for a particular alarm will be 
displayed.  Selecting one, by clicking on the attribute cell, launches the display. 

Application 
This option only appears if the user selects the extra attribute associated with it. This attribute is 
server-specific (for example, when using the SMAR Alarm OPC Server, select Default Display).  
This allows the user to launch applications (i.e. *.exe, *.com or *.bat files) by clicking on the 
corresponding attribute cell.  
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OLE Automation 
Introduction 

This reference describes the OLE Automation features available in the AlarmWorX Viewer ActiveX.  

Automation Interfaces 
The AlarmWorX Viewer ActiveX provides a COM interface that allows automation interfaces run 
from within the ActiveX container to manipulate the Viewer as it is running. The interface is available 
to all programming languages that support COM including Microsoft Visual Basic (VB), Visual Basic 
for Applications (VBA) and Microsoft Visual C++. 
To access the automation interface from VB and VBA, the AlarmWorX Viewer must be made 
available by choosing Project - Components from the main menu in the VB or VBA development 
environment and selecting AWXVIEW ActiveX in the list of available components. 

Available Control Properties 
boolean Check 
Description 
Enable/Disable URL file support. 
Remarks 
If check is True URL file support is enabled.  FileEnabled must also be True.  URL file support is 
only available for loading. 
Example 
AWXVIEW32OCX1.Check = True   

 
boolean FileEnabled  
Description 
Enable/Disable file storage 
Remarks 
If FileEnabled is True, file support is enabled. File support conisists of loading and saving 
configuration information to a file other than the container document.   It is recommended that the 
LoadSaveFile Method be used instead. 
Example 
AWXVIEW32OCX1.FileEnabled = True   

 
BSTR Caption 
Description 
String used for Title 
Remarks 
This property has no function at this time. 
 
BSTR Filename  
Description 
Name of the file to load/save 
Remarks 
If FileEnabled is True, file support is enabled. The Filename is the name of the file and the path of 
the file to load and save configuration information to.   File names must have an .awv extension.  It 
is recommended that the LoadSaveFile Method be used instead. 
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Example 
Sets the file name 
AWXVIEW32OCX1.Filename = "C:\test.awv" 

 

Gets the file name 
Dim Name as String 

Name = AWXVIEW32OCX1.Filename  

 
BSTR UrlPath 
Description 
Name of the URL path and file to load from 
Remarks 
The UrlPath is the name of the file and the path of the file to load configuration information from. File 
names must have an .awv extension. Please note that configuration information cannot be saved to 
a URL file. 
Example 
Sets the URL file name 
AWXVIEW32OCX1.UrlPath = "http:\12.13.150.2\test.awv" 

 

Gets the URL file name 
Dim Name as String 

Name = AWXVIEW32OCX1.UrlPath  

 
boolean AutoSize  
Description 
Enable/Disable AutoSize as default sizing method. 
Remarks 
AutoSize determines the base size of a column based on the size of the header text of that column. 
Example 
AWXVIEW32OCX1.AutoSize = True 

 
boolean DispRow  
Description 
Enable/Disable displaying row header 
Remarks 
Displaying the row header enables an operator to change the row width size during runtime.  This 
property can be used to with the NumRowCheck property to provide a numerical value for each row. 
Example 
AWXVIEW32OCX1.DispRow = True 

 
boolean ManSize 
Description 
Enable/Disable Manual Size as default size 
Remarks 
Enabling this property will prevent the viewer from altering the sizes of any columns except for the 
last column.  Use this property if you wish to manually set base column sizes. 
Example 
AWXVIEW32OCX1.AutoSize = False 
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boolean NumRowCheck 
Description 
Enable/Disable numbering row header.  Only enabled when DispRow is Enabled. 
Remarks 
Use this property in conjunction with the DispRow property to display a number for each alarm line. 
Example 
Example displays the number of each alarm line 
AWXVIEW32OCX1.DispRow = True 

AWXVIEW32OCX1.NumRowCheck = True 

 
boolean Scale 
Description 
N/A 
Remarks 
This property has no function at this time. 
 
boolean Title 
Description 
N/A 
Remarks 
This property has no function at this time. 
 

 
boolean WrapText 
Description 
Enable/Disable text wrapping. Only visible when row size is greater than 1. 
Remarks 
Enabling this property causes the all column text to wrap to the next line.  The wrap effect is 
contained within each individual column cell.  Please note that this effect is only visible if the 
RowSize property is greater than 1 and the text information is larger than one column length. 
Example 
This example sets the Column height to 2 and enables text wrapping. 
AWXVIEW32OCX1.WrapText = True 

AWXVIEW32OCX1.RowSize = 2 

 
long MaxLength 
Description 
Sets default cell length. 
Remarks 
This property will set all columns in the viewer to the sizes specified (excluding the last column).  
Use this property if you wish to set all base column sizes to the same size. 
Example 
AWXVIEW32OCX1.MaxLength = 10 

 
JUSTIFY BaseJustify 
Description 
Sets default justification. 
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Remarks 
This property sets the base justification for each column.  It makes use of the enumerated values 
JustifyCenter, JustifyLeft, JustifyRight.  The second half of the enumerated value name denotes 
they type of justification. For example JustifyCenter would center the text for each column. 
Example 
AWXVIEW32OCX1.BaseJustify = JustifyCenter 
 
long RowSize 
Description 
Sets base Row height. 
Remarks 
This property directly effect how much of the screen space is taken up for each row. 
Example 
This example sets the Column height to 2. 
AWXVIEW32OCX1.RowSize = 2 

 
OLE_COLOR BackColor 
Description 
Sets the default background color 
Remarks 
This color is used for the base background color of each row (excluding row and column headers). 
RGB defines colors in the order of red, green, blue.  A good trick to use when picking colors is to 
open a graphics package and use the color palate to determine the RGB numbers.  This will allow a 
visual representation of the color and provide the exact corresponding RGB values. 
Example 
AWXVIEW32OCX1.BackColor = RGB(255, 255, 255) 

 
OLE_COLOR HeaderColor 
Description 
Sets the default Header color 
Remarks 
RGB defines colors in the order of red, green, blue.  A good trick to use when picking colors is to 
open a graphics package and use the color palate to determine the RGB numbers.  This will allow a 
visual representation of the color and provide the exact corresponding RGB values. 
Example 
AWXVIEW32OCX1.HeaderColor = RGB(255, 255, 255) 

 
OLE_COLOR TextColor 
Description 
Sets the default text color 
Remarks 
RGB defines colors in the order of red, green, blue.  A good trick to use when picking colors is to 
open a graphics package and use the color palate to determine the RGB numbers.  This will allow a 
visual representation of the color and provide the exact corresponding RGB values. 
Example 
AWXVIEW32OCX1.TextColor = RGB(255, 255, 255) 
 

OLE_COLOR GridColor 
Description 
Sets the default background color 
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Remarks 
This color is used for all grid space not covered by a row. 
RGB defines colors in the order of red, green, blue. A good trick to use when picking colors is to 
open a graphics package and use the color palate to determine the RGB numbers. This will allow a 
visual representation of the color and provide the exact corresponding RGB values. 
Example 
AWXVIEW32OCX1.BackColor = RGB(255, 255, 255) 
 

GRIDLINE HStyle 
Description 
Sets horizontal grid style 
Remarks 
Grid styles other than solid can not have widths greater than 1. Also some grid styles, other than 
solid, have trouble printing on some printers.   
GRIDLINE is an enumerated list containing the following values: GridLineDash, GridLineDashdot, 
GridLineDashdotdot, GridLineDot, GridLineSolid. 
Example 
Example of a valid grid style and width settings 
AWXVIEW32OCX1.HStyle = GridLineSolid  

AWXVIEW32OCX1.HWidth = 2 
 
AWXVIEW32OCX1.HStyle = GridLineDot  

AWXVIEW32OCX1.HWidth = 1 
 

GRIDLINE VStyle 
Description 
Sets vertical grid style 
Remarks 
Grid styles other than solid can not have widths greater than 1. Also some grid styles, other than 
solid, have trouble printing on some printers.   
GRIDLINE is an enumerated list containing the following values: GridLineDash, GridLineDashdot, 
GridLineDashdotdot, GridLineDot, GridLineSolid. 
Example 
Example of a valid grid style and width settings 
AWXVIEW32OCX1.VStyle = GridLineSolid  

AWXVIEW32OCX1.VWidth = 2 
 
AWXVIEW32OCX1.VStyle = GridLineDot  

AWXVIEW32OCX1.VWidth = 1 

 
boolean HCheck 
Description 
Enable/Disable horizontal grid lines 
Example 
AWXVIEW32OCX1.HCheck = True 

 
boolean VCheck 
Description 
Enable/Disable vertical grid lines 
Example 
AWXVIEW32OCX1.VCheck = True 
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long HWidth 
Description 
Sets horizontal grid line width 
Remarks 
Grid styles other than solid cannot have widths greater than 1.  Also some grid styles, other than 
solid, have trouble printing on some printers. 
Example 
Example of a valid grid style and width settings 
AWXVIEW32OCX1.HStyle = GridLineSolid  

AWXVIEW32OCX1.HWidth = 2 

 
AWXVIEW32OCX1.HStyle = GridLineDot  

AWXVIEW32OCX1.HWidth = 1 

 
long VWidth 
Description 
Sets vertical grid line width 
Remarks 
Grid styles other than solid can not have widths greater than 1.  Also some grid styles, other than 
solid, have trouble printing on some printers. 
Example 
Example of a valid grid style and width settings 
AWXVIEW32OCX1.VStyle = GridLineSolid  

AWXVIEW32OCX1.VWidth = 2 

 
AWXVIEW32OCX1.VStyle = GridLineDot  

AWXVIEW32OCX1.VWidth = 1 

 
OLE_COLOR HorColor 
Description 
Sets horizontal grid line color 
Remarks 
RGB defines colors in the order of red, green, blue. A good trick to use when picking colors is to 
open a graphics package and use the color palate to determine the RGB numbers. This will allow a 
visual representation of the color and provide the exact corresponding RGB values. 
Example 
AWXVIEW32OCX1.HorColor = RGB(255, 255, 255) 
 

OLE_COLOR VerColor 
Description 
Sets vertical grid line color 
Remarks 
RGB defines colors in the order of red, green, blue. A good trick to use when picking colors is to 
open a graphics package and use the color palate to determine the RGB numbers. This will allow a 
visual representation of the color and provide the exact corresponding RGB values. 
Example 
AWXVIEW32OCX1.VerColor = RGB(255, 255, 255) 
 

boolean AutoStart  
Description 
Enable/Disable AutoStart feature 
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Remarks 
AutoStart allows the viewer to enter a runtime state when the container has AmbientUserMode set 
to True. 
Example 
AWXVIEW32OCX1.AutoStart = True 
 

boolean NoToolTips  
Description 
Enable/Disable NoToolTips as runtime option 
Remarks 
Setting this property to False will gray out the NoToolTips option on the right click runtime pop-up  
menu. 
Example 
AWXVIEW32OCX1.NoToolTips = False 
 

boolean Help  
Description 
Enable/Disable Help ToolTips as runtime option 
Remarks 
Setting this property to False will gray out the Help option on the right click runtime pop-up menu. 
Example 
AWXVIEW32OCX1.Help = False 

 
boolean Event  
Description 
Enable/Disable Event ToolTips as runtime option 
Remarks 
Setting this property to False will gray out the Event option on the right click runtime pop-up menu. 
Example 
AWXVIEW32OCX1.Event = False 
 

boolean Context  
Description 
Enable/Disable Context ToolTips as runtime option 
Remarks 
Setting this property to False will gray out the Context option on the right click runtime pop-up menu. 
Example 
AWXVIEW32OCX1.Context = False 
 

boolean Comment  
Description 
Enable/Disable Comment ToolTips as runtime option 
Remarks 
Setting this property to False will gray out the Comment option on the right click runtime pop-up 
menu. 
Example 
AWXVIEW32OCX1.Comment = False 
 

boolean AlarmLine  
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Description 
Enable/Disable entire alarm line popup ToolTips as runtime option 
Remarks 
Setting this property to False will gray out the AlarmLine option on the right click runtime pop-up  
menu. 
Example 
AWXVIEW32OCX1.AlarmLine = False 
 

TOOLTIP DefaultTooltip 
Description 
Set default ToolTip setting for runtime. 
Remarks 
This property sets ToolTip to use on startup.  Valid ToolTip values are as follows:   
• PopupAlarmLine 
• PopupComment 

• PopupContext 
• PopupHelp 
• PopupNone   
Example 
AWXVIEW32OCX1.Comment = False 
 

short TooltipWidth 
Description 
Set tooltip width. 
Remarks 
Longer ToolTip widths will cause the ToolTip to have fewer rows. 
Example 
AWXVIEW32OCX1.TooltipWidth = 15 
 

long CommentHeader  
Description 
Defines a header to associate with the Comment pop-up ToolTips 
Remarks 
This call should be used in conjunction with the position of the desired header. This causes the 
comment option to display the information in the associated column. 
Example 
Dim Val1 As Integer 

Val1 = AWXVIEW32OCX1.ColumnNametoPosition("Column1") 

AWXVIEW32OCX1.CommentHeader = Val1 
 

long HelpHeader  
Description 
Defines a header to associate with the Help pop-up ToolTips 
Remarks 
This call should be used in conjunction with the position of the desired header. This causes the help 
option to display the information in the associated column. 
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Example 
Dim Val1 As Integer 

Val1 = AWXVIEW32OCX1.ColumnNametoPosition("Column1") 

AWXVIEW32OCX1.HelpHeader = Val1 
 

boolean AlarmDouble  
Description 
Enable/Disable left mouse double click to acknowledge alarms 
Example 
AWXVIEW32OCX1.AlarmDouble = False 
 

boolean AckDialog 
Description 
Enable/Disable the forcing of alarm acknowledgement through ack dialog. 
Remarks 
Enabling this property forces all acknowledgements through the ack dialog.  This differs from the 
AlarmDouble property in the fact that a double click with AckDailog set to true will bring up the 
acknowledge dialog. 
Example 
AWXVIEW32OCX1.AckDialog = False 
 

boolean EnableMoveCol  
Description 
Enable/Disable the changing of column order during runtime 
Example 
AWXVIEW32OCX1.EnableMoveCol = True 

 
boolean EnableResizeCol  
Description 
Enable/Disable the resizing of columns during runtime 
Remarks 
This feature should only be used for design and testing due to the fact that it would allow the user to 
completely hide a column of information. 
Example 
AWXVIEW32OCX1.EnableResizeCol = True 

 
boolean EnableResizeRow  
Description 
Enable/Disable the resizing of rows during runtime 
Remarks 
This feature should only be used for design and testing due to the fact that it would allow the user to 
completely hide alarm lines. 
Example 
AWXVIEW32OCX1.EnableResizeRow = True 

 
BSTR SelectedSource 
Description 
Returns the selected source string.  Source name is chosen based on messages selected, alarm 
state, severity, and time 
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Remarks 
This property will return the source string (tag name) that best fits the following criteria:  
1) Highlighted alarm line.  
2) Highest alarm state.  
3) Highest severity.  
4) Most recent time stamp.   
Alarm state priority is defined as follows: 
1) In Alarm and unacknowledged 
2) In Alarm but acknowledged 
3) Passed out of Alarm but unacknowledged 
4) Tracking message 
5) Operator message 
Example 
Dim SourceName As String 
SourceName = AWXVIEW32OCX1.SelectedSource 
MsgBox (SourceName) 

 
BSTR PrioritySource 
Description 
Return the priority source string.  Source name is chosen based on messages in alarm, severity, 
and time. 
Remarks 
This property returns a source name (tag name) that best fits the following criteria: 
1) In alarm.  
2) Highest severity.  
3) Most recent time stamp.   
If no alarm messages are in alarm and unacknowledged this property will return an empty string. 
Example 
Dim SourceName As String 

SourceName = AWXVIEW32OCX1.PrioritySource 

MsgBox (SourceName) 

 

Available Control Methods 
boolean ShowColumn(COLIMNID ColumnId, boolean bShow)  
Description 
This method will hide and show columns.  If bShow is True it will attempt to show the column. 
Return a True on success. 
Example 
This example shows the column alarm type 
Dim bVal as Boolean 

bVal = AWXVIEW32OCX1.ShowColumn(ALARMTYPE,True) 

 
boolean SetToolTip(TOOLTIP Id)  
Description 
This method will set the current Tooltip mode to the type associated with TOOLTIP id. 
Remarks 
See the DefaultTooltip property for TOOLTIP id list. 
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Example 
Dim bVal as Boolean 

bVal = AWXVIEW32OCX1.SetToolTip(PopupAlarmline) 

 
boolean SortOn(short Count, COLIMNID Sort1, boolean Direction1, COLIMNID Sort2, boolean 
Direction2, COLIMNID Sort3, boolean Direction3, COLIMNID Sort4, boolean Direction4, 
COLIMNID Sort5, boolean Directon5)  
Description 
Sorts grid. Pass in columnID and direction combinations to set up sort. Count is the number of items 
to sort on.  Pass zero for all unused parameters. The first pair can not be zero. Returns true on 
success.  A direction of True causes accending order. 
Remarks 
The count parameter is used to determin how many columnID and direction pairs to use for sorting.  
Example 
This example causes the grid to be sorted first by alarm type and then by time. The effect is to have 
the earliest most recent alarms on top and the oldest operator messages on the bottom. 
Dim bVal as Boolean 

bVal = AWXVIEW32OCX1.SortOn(2, ALARMTYPE, True, AEACTIVETIME,False , 0, 
0, 0, 0, 0, 0) 

 
boolean SetColumnName(BSTR Name, short Pos) 
Description 
This method sets the name of the column located at the position passed in. 
Remarks 
Column position can change due to runtime user interaction or script. Please be aware that column 
position counts hidden columns when doing calculations. 
Example 
Dim bVal As Boolean 

bVal = AWXVIEW32OCX1.SetColumnName("NewCol1",3) 

 
short ColumnNametoPosition(BSTR Name) 
Description 
Pass in string name (Case sensitive) returns column position.  A return of zero is a failure. 
Remarks 
Column position can change due to runtime user interaction or script. Please be aware that column 
position counts hidden columns when doing calculations. 
Example 
Dim ColPos as Integer 

ColPos = AWXVIEW32OCX1.ColumnNametoPosition("Column1") 

 
short ColumnNametoId(BSTR Name)  
Description 
Pass in string name (Case sensitive) returns column id.  A Value of zero is a failure. 
Remarks 
The column id value corresponds to the following list: 
AECHANGEMASK = 0, 
AENEWSTATE = 1, 
AESOURCE = 2, 
AETIME = 3, 
AEMESSAGE = 4, 
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AEEVENTTYPE = 5, 
AEEVENTCATEGORY = 6, 
AESEVERITY = 7, 
AECONDITIONNAME = 8, 
AESUBCONDITIONNAME = 9, 
AEQUALITY = 10, 
AEACKREQUIRED = 11, 
AEACTIVETIME = 12, 
AECOOKIE = 13, 
AENUMEVENTATTRS = 14, 
AEACTORID = 15, 
ATTRIB1 = 16,  
ATTRIB2 = 17, 
ATTRIB3 = 18, 
ATTRIB4 = 19, 
ATTRIB5 = 20, 
ATTRIB6 = 21,  
ATTRIB7 = 22, 
ATTRIB8 = 23, 
ATTRIB9 = 24, 
ATTRIB10 = 25, 
ATTRIB11 = 26,  
ATTRIB12 = 27, 
ATTRIB13 = 28, 
ATTRIB14 = 29, 
ATTRIB15 = 30, 
ATTRIB16 = 31,  
ATTRIB17 = 32, 
ATTRIB18 = 33, 
ATTRIB19 = 34, 
ATTRIB20 = 35, 
ALARMTYPE = 36, 
Example 
Dim ColId as Integer 

ColId = AWXVIEW32OCX1. ColumnNametoId("Column1") 

 
BSTR IdtoColumnName(COLIMNID Id)  
Description 
Pass in columnID.  Returns string name. 
Remarks 
See ColumnNametoId function for Id list. 
Example 
Dim ColName as String 

ColName = AWXVIEW32OCX1.IdtoColumnName(AEACTIVETIME) 

 
BSTR PositiontoColumnName(short Position)  
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Description 
Pass in position.  Returns string name. 
Remarks 
Column position can change due to runtime user interaction or script. Please be aware that column 
position counts hidden columns when doing calculations. 
Example 
Dim ColName as String 

ColName = AWXVIEW32OCX1.PositiontoColumnName(2) 

 
long GetNumberofAlarms()  
Description 
Returns current number of items in alarm. 
Example 
Dim Val1 As Integer 

Val1 = AWXVIEW32OCX1.GetNumberofAlarms() 

 
long GetNumberofAcked()  
Description 
Returns current number of items in acknowledged state. 
Example 
Dim Val1 As Integer 

Val1 = AWXVIEW32OCX1.GetNumberofAcked() 

 
long GetNumberofUnacked() 
Description 
Returns current number of items in unacknowledged state. 
Example 
Dim Val1 As Integer 

Val1 = AWXVIEW32OCX1.GetNumberofUnacked() 

 

long GetNumberofTracking()  
Description 
Returns current number of tracking items. 
Example 
Dim Val1 As Integer 

Val1 = AWXVIEW32OCX1.GetNumberofTracking() 

 
long GetNumberofOperator() 
Description 
Returns current number of operator items. 
Example 
Dim Val1 As Integer 

Val1 = AWXVIEW32OCX1.GetNumberofOperator() 

 

long GetTotalNumberofMessages() 
Description 
Returns total number of current messages. 
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Example 
Dim Val1 As Integer 

Val1 = AWXVIEW32OCX1.GetNumberofMessages() 

 
long GetNumberofFilterAlarms()  
Description 
Returns current number of items in alarm that pass through the client filter. 
Example 
Dim Val1 As Integer 

Val1 = AWXVIEW32OCX1.GetNumberofFilterAlarms() 

 
long GetNumberofFilterAcked()  
Description 
Returns current number of items in acknowledged state that pass through the client filter. 
Example 
Dim Val1 As Integer 

Val1 = AWXVIEW32OCX1.GetNumberofFilterAcked() 

 
long GetNumberofFilterUnacked() 
Description 
Returns current number of items in unacknowledged state that pass through the client filter. 
Example 
Dim Val1 As Integer 

Val1 = AWXVIEW32OCX1.GetNumberofFilterUnacked() 

 
long GetNumberofFilterTracking()  
Description 
Returns current number of tracking items that pass through the client filter. 
Example 
Dim Val1 As Integer 

Val1 = AWXVIEW32OCX1.GetNumberofFilterTracking() 

 
long GetNumberofFilterOperator() 
Description 
Returns current number of operator items that pass through the client filter. 
Example 
Dim Val1 As Integer 

Val1 = AWXVIEW32OCX1.GetNumberofFilterOperator() 

 

long GetTotalNumberofFilterMessages() 
Description 
Returns total number of current messages that pass through the client filter. 
Example 
Dim Val1 As Integer 

Val1 = AWXVIEW32OCX1.GetNumberofFilterMessages() 

 
short PositiontoId(short Pos)  
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Description 
Pass in position returns column ID. 
Remarks 
Column position can change due to runtime user interaction or script. Please be aware that column 
position counts hidden columns when doing calculations. 
Example 
Dim Val1 As Integer 

Val1 = AWXVIEW32OCX1.PositiontoId(2) 

 
 
short IdtoPosition(COLIMNID Id); 
Description 
Pass in column ID return position. 
Remarks 
Column position can change due to runtime user interaction or script. Please be aware that column 
position counts hidden columns when doing calculations. 
Example 
Dim Val1 As Integer 

Val1 = AWXVIEW32OCX1.IdtoPosition(AEACTIVETIME) 

 
boolean SizeColAtPosition(short Pos, long Size); 
Description 
Pass in position and new size, changes size of column at that position.  Return of true means 
success.  Size must be larger than minimum width as seen in property pages.  (equal to or larger 
than 1) 
Remarks 
Column position can change due to runtime user interaction or script. Please be aware that column 
position counts hidden columns when doing calculations.  Width values are based on an internal 
algorithm composed of font size and type 
Example 
Changes column in position 2 to a width of 15  
Dim bVal As Boolean 

bVal = AWXVIEW32OCX1.SizeColAtPosition(2,15) 

 
boolean SizeColWithId(COLIMNID Id, long Size) 
Description 
Pass in column ID and new size, changes size of column at that position.  Return of true means 
success.  Size must be larger than minimum width as seen in property pages.  (equal to or larger 
than 1) 
Remarks 
Width values are based on an internal algorithm composed of font size and type 
Example 
Changes the time column to a width of 15  
Dim bVal As Boolean 

bVal = AWXVIEW32OCX1.SizeColWithId(AEACTIVETIME,15) 

 
boolean MovCol(short FromStartPos, short FromEndPos, short ToPos) 
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Description 
Move columns.  FromStartPos is first column selected. FromEndPos is last column selected.  Moves 
group of columns to ToPos. Cannot move past last column.  Return of True means success. 
Remarks 
Please be aware that column position counts hidden columns when doing calculations. 
Example 
This Example will move columns 3, 4, and 5 in front of column 2. 
Dim bVal As Boolean 

bVal = AWXVIEW32OCX1.MovCol(3,5,2) 

 

boolean EnableColTextColorOverride(COLIMNID Id, boolean Enable)  
Description 
Change text color for specified column. Enable = true enables override. Return true on success. 
Example 
This Example enables the text color of the time column to be overwritten and then changes the text 
color. 
Dim bVal As Boolean 

bVal = AWXVIEW32OCX1.EnableColTextColorOverride(AEACTIVETIME,  True) 

Call AWXVIEW32OCX1.SetColTextColor(AEACTIVETIME,RGB(255,255,255)) 

 
boolean EnableColBackColorOverride(COLIMNID Id, boolean Enable) 
Description 
Changes background color for specified column.  Enable = true enables override.  Returns true on 
success. 
Example 
This Example enables the background color of the time column to be overwritten and then changes 
the background color. 
Dim bVal As Boolean 

bVal = AWXVIEW32OCX1.EnableColBackColorOverride(AEACTIVETIME,  True) 

Call AWXVIEW32OCX1.SetColBackColor(AEACTIVETIME,RGB(255,255,255)) 

 

void SetColTextColor(COLIMNID Id, OLE_COLOR Color)  
Description 
Sets text color of specified column.  Automatically enables text color override. 
Remarks 
This function will enable the text color to be overwritten.  
Example 
Dim bVal As Boolean 

Call AWXVIEW32OCX1.SetColTextColor(AEACTIVETIME,RGB(255,255,255)) 

 
void SetColBackColor(COLIMNID Id, OLE_COLOR Color)  
Description 
Sets background color of specified column.  Automatically enables background color override. 
Remarks 
This function will enable the background color to be overwritten. 
Example 
Dim bVal As Boolean 

Call = AWXVIEW32OCX1.SetColBackColor(AEACTIVETIME,RGB(255,255,255)) 
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OLE_COLOR GetColBackColor(COLIMNID Id)  
Description 
Returns text color of specified column. - Note: this is the override color. 
Remarks 
This returns the column background color not the base default background color. 
Example 
Dim rcolor As OLE_COLOR 

rcolor = AWXVIEW32OCX1.GetColBackColor(AEACTIVETIME) 

 
OLE_COLOR GetColTextColor(COLIMNID Id)  
Description 
Returns background color of specified column. - Note: this is the override color. 
Remarks 
This returns the column text color not the base default text color. 
Example 
Dim rcolor As OLE_COLOR 

rcolor = AWXVIEW32OCX1.GetColTextColor(AEACTIVETIME) 

 
boolean EnableRowTextColor(MESSAGETYPE wType, long LowSeverity, boolean Enable)  
Description 
Enables/Disables text color override for associated message type and rowID.  Enable = True 
enables override.  Returns true on success. 
Remarks 
The messagetype values are as follows: 

• Alarm = 1 
• Acknowledge = 2 
• Unacknowledge = 3 
• Operator  = 4 

• Tracking = 5 
• Normal  = 6 
Example 
This Example will disable the setting of the row text color for all alarm lines in alarm for severity 
values starting at 400 to the next configured severity or 1000.  Which ever is less. 
Dim bVal As Boolean 
bVal = AWXVIEW32OCX1.EnableRowTextColor(Alarm,400,False) 

 
boolean EnableRowBackColor(MESSAGETYPE wType, long LowSeverity, boolean Enable)  
Description 
Enables/Disables background color override for associated message type and rowID.  Enable = 
True enables override.  Returns true on success. 
Remarks 
See EnableRowTextColor method for available messagetype values. 
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Example 
This Example will disable the setting of the row background color for all alarm lines in alarm for 
severity values starting at 400 to the next configured severity or 1000.  Which ever is less. 
Dim bVal As Boolean 
bVal = AWXVIEW32OCX1.EnableRowBackColor(Alarm,400,False) 

 
void SetRowTextColor(MESSAGETYPE wType, long LowSeverity, OLE_COLOR Color)  
Description 
Sets text color associated with message type and rowID.  Automatically enables text color override. 
Remarks 
See EnableRowTextColor method for available messagetype values. 
Example 
This Example will change the row text color for all alarm lines in alarm for severity values starting at 
400 to the next configured severity or 1000.  Which ever is less. 
Call  AWXVIEW32OCX1.SetRowTextColor(Alarm,400,RGB(255,255,255)) 

 
void SetRowBackColor(MESSAGETYPE wType, long LowSeverity, OLE_COLOR Color) 
Description 
Sets background color associated with message type and rowID.  Automatically enables 
background color override. 
Remarks 
See EnableRowTextColor method for available messagetype values. 
Example 
This Example will change the row background color for all alarm lines in alarm for severity values 
starting at 400 to the next configured severity or 1000.  Which ever is less. 
Call AWXVIEW32OCX1.SetRowBackColor(Alarm,400,RGB(255,255,255)) 

 
OLE_COLOR GetRowTextColor(MESSAGETYPE wType, long LowSeverity)  
Description 
Returns the row text color of the associated message type rowID combination.  Note - this is the 
override color. 
Remarks 
See EnableRowTextColor method for available messagetype values. 
Example 
This example will get the row text color value for severity values starting at 400 to the next 
configured severity or 1000.  Which ever is less. 
Dim rcolor As OLE_COLOR 

rcolor = AWXVIEW32OCX1.GetRowTextColor(Alarm,400) 

 

OLE_COLOR GetRowBackColor(MESSAGETYPE wType, long LowSeverity)  
Description 
Returns the row background color of the associated message type rowID combination.  Note - this 
is the override color. 
Remarks 
See EnableRowTextColor method for available message type values. 
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Example 
This example will get the row background color value for severity values starting at 400 to the next 
configured severity or 1000.  Which ever is less. 
Dim rcolor As OLE_COLOR 

rcolor = AWXVIEW32OCX1.GetRowBackColor(Alarm,400) 

 

GlobalAck(BSTR comment) 
Description 
Acknowledges all received alarms. 
Remarks 
The comment is passed to the server. 
Example 
Call AWXVIEW32OCX1.GlobalAck("down for maintenance") 

 
AckSelectedRows(BSTR comment)  
Description 
Acknowledges rows selected by the operator. 
Remarks 
The comment is passed to the server. 
Example 
Call AWXVIEW32OCX1.AckSelectedRows("down for maintenance") 

 
void AckDisplayed(BSTR comment)  
Description 
Acknowledges all displayed alarms 
Remarks 
This function will acknowledge all alarm messages visible on the screen. The comment is passed to 
the server. 
Example 
Call AWXVIEW32OCX1.AckDisplayed("down for maintenance") 

 
void AckFiltered(BSTR comment) 
Description 
Acknowledges all alarms that pass through the client filter.  This differs from the global acknowledge 
by the fact that the global acknowledge will also acknowledge requested alarms that the client filter 
has filtered out. 
Remarks 
The comment is passed to the server. 
Example 
Call AWXVIEW32OCX1.AckFiltered("down for maintenance") 

 
void SetActorID(BSTR Operator, BSTR Station) 
Description 
Creates string of defining user who acknowledged an alarm.  Syntax is as follows  user: Operator  
Node: Station 
Remarks 
Once ActorID is called the ocx will not get the ActorID from the security system unless resetActorId 
is called. 
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Example 
Call AWXVIEW32OCX1.SetActorID("NewOperator","NewStation") 

 
void SetSecurity(long Security)  
Description 
Allows the AlarmWorX viewer security to be set through an automation interface. 
Remarks 
Once enabled, Smar security server will not be used for the life of the ocx.  The security map is as 
follows: 
 
m_bSecAckPoint   0x0001 
m_bSecGlobalAck   0x0002 
m_bSecPageAck   0x0004 
m_bSecScreenAck   0x0008 
m_bSecAreaAck   0x0010 
 
m_bSecVBEvent   0x0020 
m_bSecSort    0x0040 
m_bSecFilter   0x0080 
m_bSecDetails   0x0100 
m_bSecProperty   0x0200 
m_bSecApplication   0x0400 
m_bSecDisplay   0x0800 
m_bSecTooltip   0x1000 
m_bSecColumn   0x2000 
m_bSecLanguage   0x4000 
m_bSecChFilter   0x8000 
  

A 1 enables the feature and a 0 disables the feature.  By default all items are disabled.   
 

A registry setting of Security 0 must be added to 
HKEY_LOCAL_MACHINE\software\Smar\awxview32 for this automation method to be enabled.  
This registry setting disables the use of the security server for the Alarm viewer. 
 

Example 
This Example enables all options except AckPoint (point acknowledge) 
Dim Security As Integer 

Security = 65534 '65534  = 0xfffe  

Call AWXVIEW32OCX1.SetSecurity(Security) 
 

void ResetActorID()  
Description 
Sets the Actor ID back to the internal actor id string. 
Example 
Call AWXVIEW32OCX1.ResetActorID() 
void FilterOff()  
Description 
Turns off all client filters. 
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Example 
Call AWXVIEW32OCX1.ResetActorID() 

 

BSTR GetActiveFilter()  
Description 
Returns the active client fitler name. 
Remarks 
This is the name of the filter not the filter expression  
Example 
Dim FilterName As String 

FilterName = AWXVIEW32OCX1.GetActiveFilter() 

 
BSTR GetFilter(LPCTSTR Filter) 
Description 
Returns the filter expression. 
Remarks 
Given the name of an existing filter this method will return the filter expression string.  An empty 
string is returned if the filter does not exist. 
Example 
Dim FilterName As String 

Dim FilterExpression As String 

FilterExpression = AWXVIEW32OCX1.GetFilter(FilterName) 

 

boolean SetFilter(LPCTSTR Filter, BSTR Expression) 
Description 
Creates Filter if Filter does not  already exist.  Sets Expression as the expression string associated 
with Filter.  Returns a true on success. 
Remarks 
The best way to ensure accurate expression syntax is to create the string using the client filter 
dialog and then copy the string expression.  This method only adds the filter and filter name to the 
list of possible client filters.  It does not activate the filter. 
Example 
This example creates a filter named filter1 with an expression that only passes alarms with a  source 
name beginning with Tag. 
Dim FilterName As String 

Dim FilterExpression As String 

 

FilterName = "Filter1" 

'actual expression  x=  like({{Source}},$"Tag*"$,0) 

FilterExpression = "like({{Source}},$"Tag*"$,0)"    

FilterExpression = AWXVIEW32OCX1.SetFilter(FilterName,FilterExpression) 

 

boolean EnableFilter(LPCTSTR Filter, boolean State)  
Description 
Turns Filter on if state is True or off if state is False.  Returns true on success. 
Remarks 
This method will turn filters on and off.  When a filter is turned on, the previous filter will be turned 
off.  It is only possible to have one filter running at any given time. 
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Example 
This example turns the filter named filter1 on.   
Dim FilterName As String 

Dim bVal as Boolean 

FilterName = "Filter1" 

bVal = AWXVIEW32OCX1.EnableFilter(FilterName,True) 
 

boolean AlarmFilter(BSTR Filter, long StartSeverity, long EndSeverity, long AlarmType, 
BSTR AttributeField1, BSTR Attribute1, BSTR AttributeField2, BSTR Attribute2)  
Description 
 

Sets Filter with the following syntax:   
( {{Severity}} >= StartSeverity )&& 
( {{Severity}} <= EndSeverity )&& 
( {{AlarmType}} == AlarmType )&& 
( like({{Attribute1}},$"AttributeField1"$,0) )&& 
( like({{Attribute2}},$"AttributeField2"$,0) ) 
 

Remarks 
AlarmType decodes as follows: 
• ALARM  1 

• ACK       2 
• UNACK  3 
• OPER    4 
• TRACK  5 

• NORM   6 
 

An AlarmType of 7 or greater removes alarm type from the filter. 
 

The attribute field compare the string AttributeField with the string found in the column of the 
associated attribute.  Comparison is done using the like function.  The like function behaves 
identically to the VB like operator. 
  

Attibute1 is removed from the filter if AttributeField1 is the string * 
Attibute2 is removed from the filter if AttributeField2 is the string * 
It is recommended that the SetFilter and EnableFilter methods are used instead of this method. 
Example 
Dim bVal as Boolean 

bVal = AWXVIEW32OCX1.AlarmFilter("Filter1",0,1000, Alarm, 
"*","extracol1","*","extracol2") 
 

void EnterAnimate() 
Description 
Causes the ActiveX to enter runtime mode. 
Example 
This example causes the viewer to exit runtime, load file test.awv, and enter runtime. 
Dim FileName As String 

Dim bVal as Boolean 
 

FileName = "c:\test\test.awv" 

Call AWXVIEW32OCX1.ExitAnimate() 

BVal = AWXVIEW32OCX1.LoadSaveFile(FileName,1) 

Call AWXVIEW32OCX1.EnterAnimate() 
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void ExitAnimate() 
Description 
Causes the ActiveX to exit runtime mode and enter design mode. 
Example 
This example causes the viewer to exit runtime, load file test.awv, and enter runtime. 
Dim FileName As String 

Dim bVal as Boolean 
 

FileName = "c:\test\test.awv" 

Call AWXVIEW32OCX1.ExitAnimate() 

BVal = AWXVIEW32OCX1.LoadSaveFile(FileName,1) 

Call AWXVIEW32OCX1.EnterAnimate() 
 

boolean LoadSaveFile(BSTR FileName, short Load) 
Description 
Will cause the ActiveX to load or save an *.awv file.   If Load is 1 then the file will be loaded.  Load 0 
will cause the file to be saved. 
Remarks 
This method will only load or save a file when the ActiveX is in design mode.  The ActiveX 
properties Check must be False and FileEnabled must be True.  This should be done through the 
property pages and saved as part of configuration.  To set the property pages to load and save from 
a file, select Configuration File in the general properties tab and disable URL Path option.  FileName 
should be the full path and filename including extension. 
Example 
This example causes the viewer to exit runtime, load file test.awv, and enter runtime. 
Dim FileName As String 

Dim bVal as Boolean 
 

FileName = "c:\test\test.awv" 

Call AWXVIEW32OCX1.ExitAnimate() 

BVal = AWXVIEW32OCX1.LoadSaveFile(FileName,1) 

Call AWXVIEW32OCX1.EnterAnimate() 
 
long ControlSize(long cx, long cy)  

Description 
Sets the size of the ocx.  Returns a 0 on success. 
Remarks 
Cx and cy are in windows pixel units. 
Example 
Dim size As Integer 

size = AWXVIEW32OCX1.ControlSize(200,300) 
 

boolean ChangeNode(BSTR OldNode, BSTR NewNode)  
Description 
This method changes the node name associated with the alarm subscription.  This method will 
cause the alarm subscription to switch the network nodes it is using for data collection. 
Remarks 
There are possible performance hits when using this function.   
Example 
Dim bVal As Boolean 

bVal = AWXVIEW32OCX1.ChangeNode("PC12","PC13") 
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void UpdateDisplay()  
Description 
This method causes a redraw of the internal grid information.   
Remarks 
This should be used at the end of a script to force the update of automation color changes. 
Example 
Dim bVal As Boolean 

Call AWXVIEW32OCX1.SetColBackColor(AEACTIVETIME,RGB(255,255,255)) 

Call AWXVIEW32OCX1.SetColTextColor(AEACTIVETIME,RGB(255,255,255)) 

Call AWXVIEW32OCX1.UpdateDisplay() 
 

BSTR SelectedColRowInfo(COLIMNID Id) 
Description 
This method returns a string containing the text in the column corresponding to 'Id' for the row 
selected in the Alarm Viewer ActiveX. 
Example 
Dim TimeInfo as string 

'Get the time of the selected row 

TimeInfo = AWXVIEW32OCX1.SelectColRowInfo(AETIME) 
 

BSTR ColRowInfo(long Row, COLIMNID Id)  
Description 
This method takes the row number and column ID as input parameters.  It returns the row and 
column information in the form of a string. 
Example 
Dim s As String 

s = AWXVIEW32OCX1.ColRowInfo(1, AESOURCE) 

MsgBox (s) 

This example will pop up a message box with the source of the alarm message. 
 
void ScrollUp(); 
Description 
Scroll up the value of one arrow click 
Example 
AWXVIEW32OCX1.ScrollUp 
 

void ScrollDwn(); 
Description 
Scroll down the value of one arrow click 
Example 
AWXVIEW32OCX1.ScrollUp 
 

void ScrollPgUp(); 
Description 
Scroll up the value of one scroll bar click 
Example 
AWXVIEW32OCX1.ScrollPgUp 
 

void ScrollPgDwn(); 
Description 
Scroll down the value of one scroll bar click 
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Example 
AWXVIEW32OCX1.ScrollPgDwn 
 

void ScrollLeft(); 
Description 
Scroll left the value of one arrow click 
Example 
AWXVIEW32OCX1.ScrollLeft 
 

void ScrollRight(); 
Description 
Scroll right the value of one arrow click 
Example 
AWXVIEW32OCX1.ScrollRight 
 

void ScrollPgLeft(); 
Description 
Scroll left the value of one scroll bar click 
Example 
AWXVIEW32OCX1.ScrollPgLeft 
 

void ScrollPgRight(); 
Description 
Scroll right the value of one scroll bar click 
Example 
AWXVIEW32OCX1.ScrollPgRight 
 

long GetNumberofCol(); 
Description 
Returns the number of columns 
Example 
Dim col As Long 

col = AWXVIEW32OCX1.GetNumberofCol() 

MsgBox (col) 

This example will pop up a message box with the number of columns. 
 

void ComputerName(); 
Description 
Returns the local node name 
Example 
Dim s As String 

s = AWXVIEW32OCX1.ComputerName() 

MsgBox (s) 

This example will pop up a message box with the computer name. 
 

long GetColSizeAtPosition(short Pos); 
Description 
Pass in the column position.  Returns the size of the column. 
Example 
Dim size As Long 

size = AWXVIEW32OCX1.GetColSizeAtPosition(1) 
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msgbox (size) 

This example will pop up a message box with the size of the first column. 
 

long GetColSizeWithId(short Id); 
Description 
Pass in the column Id.  Returns the size of the column. 
Example 
Dim size As Long 

size = AWXVIEW32OCX1.GetColSizeWithId(AESOURCE) 

MsgBox (size) 

This example will pop up a message box with the size of the AESOURCE column. 
 

boolean IsEnableRowTextColor(short wType, long LowSeverity); 
Description 
Pass in the message type and severity.  Returns true if the row text color setting is true.  Returns 
false otherwise. 
Remarks 
See EnableRowTextColor method for available messagetype values. 
Example 
This example will get the EnableRowTextColor value for severity values starting at 400 to the next 
configured severity or 1000.  Which ever is less. 
Dim b As Boolean 

b = AWXVIEW32OCX1.IsEnableRowTextColor(Alarm,400) 
 

boolean IsEnableRowBackColor(short wType, long LowSeverity); 
Description 
Pass in the message type and severity.  Returns true if the row background color setting is true.  
Returns false otherwise. 
Remarks 
See EnableRowTextColor method for available messagetype values. 
Example 
This example will get the EnableRowBackColor value for severity values starting at 400 to the next 
configured severity or 1000.  Which ever is less. 
Dim b as Boolean 

b = AWXVIEW32OCX1.IsEnableRowBackColor(Alarm,400) 
 

boolean IsEnableColTextColorOverride(short Id); 
Description 
Pass in the column Id.  Returns true if the column text color setting is true.  Returns false otherwise. 
Example 
Dim b as Boolean 

b = AWXVIEW32OCX1.IsEnableColTextColorOverride (AESOURCE) 
 

boolean IsEnableColBackColorOverride(short Id); 
Description 
Pass in the column Id.  Returns true if the column background color setting is true.  Returns false 
otherwise. 
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Example 
Dim b as Boolean 

b = AWXVIEW32OCX1.IsEnableColBackColorOverride (AESOURCE) 
 

long GetNumberofSelectedRows(); 
Description 
Returns the number of selected rows. 
Example 
Dim l As Long 

l = AWXVIEW32OCX1.GetNumberofSelectRows() 

MsgBox (l) 

This example will pop up a message box with the number of selected rows. 
 

void SetGasParentCookie(long newCookie); 
Description 
For Global Aliasing System (GAS) support only 
Remarks 
This function is hidden and should not be used through custom scripts 
Example 
None 
 

boolean SetGASThemes(BSTR strThemes); 
Description 
For Global Aliasing System (GAS) support only 
Remarks 
This function is hidden and should not be used through custom scripts 
Example 
None 

Available Control Events 
OnRightMouseClick()  
Description 
Event posted on user right mouse click 
Example 
Private Sub AWXVIEW32OCX1_OnRightMouseClick() 

'Your code here 
End Sub 
 

OnLeftMouseClick()  
Description 
Event posted on user left mouse click 
Example 
Private Sub AWXVIEW32OCX1_OnLeftMouseClick() 

'Your code here 
End Sub 
 

OnRightMouseDBLClick()  
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Description 
Event posted on user right double mouse click 
Example 
Private Sub AWXVIEW32OCX1_OnRightMouseDblClick() 

'Your code here 
End Sub 
 

OnLeftMouseDBLClick()  
Description 
Event posted on user left double mouse click 
Example 
Private Sub AWXVIEW32OCX1_OnLeftMouseDblClick() 

'Your code here 
End Sub 
 

OnNewAlarm()  
Description 
Event posted when any new message enters the viewer. 
Remarks 
Please Note:  This event occurs when any new OPC alarm and events message is passed into the 
viewer.  This includes client filtered messages, operator messages, tracking messages, alarm 
messages, and acknowledge messages.   No information provided to the event that denotes 
message type. 
Example 
Private Sub AWXVIEW32OCX1_OnNewAlarm() 

'Your code here 
End Sub 
 

OnPopupEvent()  
Description 
Event posted when the user selects the VB event menu item from the right click pop-up menu. 
Example 
Private Sub AWXVIEW32OCX1_OnPopupEvent() 

'Your code here 
End Sub 
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Visual Basic Examples 
Introduction 

This example describes how to integrate the Alarm Logger when programming in Microsoft Visual 
Basic (VB). The example shows how to build a form to enable logging and printing.  

Getting Started 
1. Open a new Standard EXE project in Visual Basic. This opens a new blank Visual Basic form.   

2. Before adding anything to this form, you must add the AlarmWorX Viewer ActiveX component 
to your toolbox. To do this, right-click anywhere in the toolbox and select Component from the 
pop-up menu.  This opens the Components dialog box, as shown in the figure below. Select 
AWXVIEW ActiveX and click OK. 

3. You are now ready to begin configuring the interface for the new Visual Basic form. 

 
Components Dialog 
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Visual Basic Form Configuration 
 

 
Click the Label button in the toolbox and draw two rectangles on the blank VB form 
that you created earlier.  Your form should now look like the figure below.  

 
VB Form With Two Labels 

These labels will be referenced in later code so that, while the program is running, the date will be 
displayed on the field Label1, and the time will be displayed on the field Label2. 
You must now insert a timer object over the Label2 field. 

 
Click the Timer button in the toolbox and draw a square over the Label2 field. The 
timer will appear in the form.   

 
Next add a shape where the action buttons will be located. 

 

Click the Shape button in the toolbox and insert the shape on the form so that your 
form looks like the one in the figure below. 

 

 
VB Form With Shape and Timer 

To configure the shape, select it and then enter the following data in the Properties window. 
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(Name): Shape1 
BackColor: Clicking the down opens a palette. Select a light color for the back color. 
BackStyle: 1 - Opaque 
BorderColor: Choose something dark that will contrast with the Back Color you picked. 
BorderStyle: 6 - Inside Solid 
BorderWidth: 1 
DrawMode: 13 - Copy Pen 
FillColor: Choose the same color as the Back Color 
FillStyle: 1 - Transparent 
Shape: 4 - Rounded Rectangle 

 
Now you will add the action buttons and text fields on top of the shape. 

 

Click the CommandButton button in the toolbox and insert two buttons over the 
shape that you have just configured. Your form should look like the one in the figure 
below. 

 

 
VB Form With Command Buttons 

To configure each button, select it and then enter the following data in the Properties window. 
 

(Name) CmdEnableAlarms CmdEnablePrinting 
Appearance: 1 - 3D 1 - 3D 

Caption: &Enable Logging E&nable Printing 

 
Note: To successfully enable printing, it is necessary to configure a printer in the AlarmWorX 
Logger. 

 

 
Click the TextBox button in the toolbox and insert two textboxes (one after each 
button).  These text boxes will indicate whether logging and printing are enabled. 
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To configure each textbox, insert the following data in the properties window: 
(Name): TxtEnableLog TxtPrinting 
Alignment: 0 - Left Justify 0 - Left Justify 
Appearance: 1 - 3D 1 - 3D 
BorderStyle: 1 - Fixed Solid 1 - Fixed Solid 
Font: MS Sans Serif - 12pt  MS Sans Serif - 12pt 
Text: OFF OFF 

Your form should look like the one in the figure below. 

 
VB Form With Text Boxes 

The final button you will add is the Exit button, which will effectively exit the user out of this form.   

 
Click the CommandButton button in the toolbox and insert a button underneath the 
previously inserted shape.   

 
To configure the button, enter the following data in the properties window: 
 

(Name): ComExit 
Appearance: 1 - 3D 
Caption: E&xit 

 
For the purposes of appearance and grouping, we will add a label component that will enclose all 
of the components that were just added. 

 
Click the Label button in the toolbox and insert the label so your form looks like the 
one in the figure below. 
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VB Form With Exit Button 

 
To configure the label, select it and then enter the following data in the Properties window.  
 

 Label3 
Alignment 0 - Left Justify 
Appearance 1 - 3D 
Back Style 1 - Opaque 
BorderStyle 1 - Fixed Single 

 
Now it is time to enter the code behind the components! 
 

Entering the VB Code 
To enter the code behind a component, double-click on the component. This opens the Project - 
Form (Code) window.  Before you enter code for any of the components, enter the following 
definitions by double-clicking on the form itself: 
 Dim b_LoggingEnabled As Boolean 
 Dim b_PrintingEnabled As Boolean 
 Dim Logger As New AWXLogAuto 
 
It is important to enter these definitions because they are referenced in later code. 
1. The first component for which you will enter the code is the Enable Logging button. When 

selected, this button will turn on or off alarm logging. Double-click the Enable Logging button 
and enter the following code: 

Private Sub CmdEnabelAlarms_Click() 
'will Enablel/Disable AlarmLogger. 
On Error GoTo INIT_ERR 
 
If b_LoggingEnabled = False Then 'if its off then swich it on 

b_LoggingEnabled = True 
TxtEnableLog.Text = "ON" 
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Logger.LoggingEnabled = b_LoggingEnabled 
Else                             'or, its on then swich it off 

TxtEnableLog.Text = "OFF" 
b_LoggingEnabled = False 
Logger.LoggingEnabled = b_LoggingEnabled 

End If 
 
Exit Sub 
' 
INIT_ERR: 
If Err = -2147467259 Then   ' AlarmLogger is not Loaded yet then just waite 

WaitToLoadAlarmLogger 
CmdEnabelAlarms_Click 

End If 
End Sub 
 
Private Sub WaitToLoadAlarmLogger() 
'this function will pause the time for The PauseTime in seconds. 

Dim Start ', count 
PauseTime = 5 
'count = 0 
Start = Timer   ' Set start time. 

 
Do While Timer < Start + PauseTime 

DoEvents    ' Yield to other processes. 
'count = Timer - Start 

Loop 
End Sub 

 
2. The next component for which you will enter code is the Enable Printing button. When 

selected, this button will enable or disable printing. Double-click the Enable Printing button 
and enter the following code: 

Private Sub CmdEnablePrinting_Click() 
'will Enable/Disable printing the Alarms. 
On Error GoTo INIT_ERR 
 
If b_PrintingEnabled = False Then  'if its off then swich it on 

b_PrintingEnabled = True 
TxtPrinting.Text = "ON" 
Logger.PrintingEnabled = b_PrintingEnabled 

Else 
TxtPrinting.Text = "OFF"    'or, its on then swich it off 
b_PrintingEnabled = False 
Logger.PrintingEnabled = b_PrintingEnabled 

End If 
Exit Sub 

' 
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INIT_ERR: 
If Err = -2147467259 Then   ' AlarmLogger is not Loaded yet then just wait 

WaitToLoadAlarmLogger 
CmdEnablePrinting_Click 

End If 
End Sub 
 
3. Next you will enter the code for the Exit button. When selected, this button will exit the user 

out of the form. Double-click the Exit button and enter the following code: 

Private Sub ComExit_Click() 
Unload Me 

End Sub 
 
4. Next you will enter the code for the entire form. Double-click the form and enter the following 

code: 

Private Sub Form_Initialize() 
 

b_PrintingEnabled = False 'set the Alarm Printing to OFF. 
End Sub 
 
Private Sub Form_Load() 
Dim MyDate, MyTime 
Dim ob As Object 
 

Timer1.Interval = 1000  ' Set Timer interval for every second. 
MyDate = Format(Date, "dddd, mmm d yyyy") 'set the DATE format. 
Label1.Caption = MyDate  ' load the current date. 

 
Screen.MousePointer = vbHourglass 
On Error GoTo INIT_ERR 
If Logger.LoggingEnabled = False Then 'if its off then show it OFF in the TxtEnableLog 

TxtEnableLog.Text = "OFF" 
Else                             'or, its ON then show it OFF in the TxtEnableLog 

TxtEnableLog.Text = "ON" 
 

End If 
Screen.MousePointer = VBDEFULT 

Exit Sub 
 
' 
INIT_ERR: 
If Err = -2147467259 Then   ' AlarmLogger is not Loaded yet then just waite 

WaitToLoadAlarmLogger 
Form_Load 

End If 
 
End Sub 



Visual Basic Examples 
 

7.8 

Private Sub Form_Unload(Cancel As Integer) 
Set Logger = Nothing  ' kill the Object Logger. 

End Sub 
 
5. Now you will enter the code for the Timer function. Double-click the Timer button and enter 

the following code: 

Private Sub Timer1_Timer() 
'just to update the Clock at every second. 

Label2.Caption = Time 'Load the current time. 
End Sub 
 
6. Once you have entered all of the above code, you must save and compile your project.  

Select Save As from the File menu and save the project as VBAlarmTest.exe. To compile 
the project, select Make VBAlarmTest.exe from the File menu.  
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AlarmWorX Multimedia 
Introduction 

AlarmWorX+ Multimedia has long been one of Smar’ core products. The success of AlarmWorX+ 
Multimedia has brought smar numerous customer requests to develop such new features as 
Video, SMS Support, 2-Way Paging, and Marquees. The result: Smar' creation of its third 
generation of AlarmWorX Multimedia! This, the most powerful multimedia product available to 
address market conditions, employs the latest technologies to bring you unsurpassed capabilities.  
 
AlarmWorX Multimedia's key features include: 
 

• MAPI-based paging 
• TAPI-based telephony support 
• Email with 2-way acknowledgment 
• URLs and pop-up capabilities to shell out to other apps 

• Message-scrolling marquees 
• Instant-messenger support 
• Prerecorded auditable alarms 
• Text-to-speech alarms 

• TAP and GSM / SMS support 
• Advanced scheduling and personal escalation 
 
To aid the shift of our current AlarmWorX+ customers to the new generation of multimedia 
products, Smar has created an easy-to-use Conversion Utility. This document describes the 
necessary procedure for conversion to AlarmWorX+ applications. 
 
The AlarmWorX+ Conversion Utility allows you to translate efficiently older AlarmWorX+ 
configurations into new distributed enterprise-wide alarm-and-events management using 
AlarmWorX Multimedia configuration.  In this way, you will be able to enjoy the simplicity and 
power of SMAR' new generation of products. 
 
Note: The AlarmWorX+ Conversion Utility must be installed separately. It is located in the 
tools directory of the Smar ProcessView V 6.1 or Product CD, as shown below: 
 

 
Tools Directory 
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AlarmWorX+ Overview 
AlarmWorX+ provides OPC-compliant multimedia technology for remote alarm notification. 
Connect pagers, PA systems, Voice, E-mail, Fax, and Telephony systems to industry-standard 
OPC servers. 
 
Voice alarming delivers specific messages quickly and effectively by actually announcing them 
using speech and sound. It eliminates the confusion of having a single siren or bell represent 
multiple alarms. AlarmWorX+ is ideal for unattended applications requiring remote alarm 
notification. 
 
Easily integrate with popular HMI/SCADA or any custom applications using industry-standard OPC 
Data Access and via OPC automation. Connect to PLCs, DCS Systems, I/O Devices, and open 
communications bus standards such as Profibus, Interbus, CAN, Devicenet, and many more. 
 
Features include:  
• Designed for Windows NT, 95/98/Me, and 2000 
• 32-bit multimedia OPC alarming client 
• Real-time alarm summary display 
• Easy configuration and set-up 

• Voice annunciation of alarms 
• Support for popular international pagers 
• Supports MAPI-based E-mail systems 
• Telephone voice systems 
• Personnel scheduler 

• Historical alarm analysis 
• Alarm troubleshooting system 
• Supports industry standards interfaces 

 
AlarmWorX+ is an OPC Data compliant multimedia alarming package that is capable of notifying 
the operator of an alarm through every possible medium. The product is base upon the 16-bit 
AlarmWorX+ product and reuses much of the same code.  However, all of the third-party controls 
and the code supporting these controls are different. 
 
One of the main features of the new AlarmWorX+ product is the addition of OLE for Process 
Control (OPC). This functionality allows users to browse points from any OPC-compliant server. 
Since OPC is an industry standard, it allows greater flexibility for customers who are no longer 
bound by company specific drivers. 
 

AlarmWorX+ Conversion Utility Compatibility 
AlarmWorX+ Conversion Utility is compatible with all AlarmWorX+ versions starting from version 
5.0. These versions include: 
• AlarmWorX+ 5.0 
• AlarmWorX+ 5.1 
• AlarmWorX+ 5.3 
• AlarmWorX+ 6.0 
• AlarmWorX+ 6.1 
 
Note: All versions previous to 5.0 are not compatible with AlarmWorX+ Conversion Utility. 
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Step-by-Step Conversion Procedure 
The figure below provides you with a general view of SMAR AlarmWorX+ to AlarmWorX Conversion 
Utility (hereafter called "Converter").  The Converter's two main parts are shown below. The first part 
has been designed to point to place where AlarmWorX+ information is stored.  The second part is 
for configuring the multimedia information extraction process. 
 

 
Conversion Process Diagram 
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AlarmWorX Multimedia Architecture 

 
Step 1: A General Description of the Converter  
 
Step 2: Configuration Fields  
 
Step 3: Importing Into the AlarmWorX Server Configurator  
 
Step 4: Importing .csv Files Into the AlarmWorX Multimedia Server Configurator  
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Step 1: A General Description of the Converter 
You can extract one or more categories from the following list (in case of AlarmWorX+ Multimedia 
notification information): 
 
1. Scheduling information 
2. Telephony agent information 
3. Paging agent information 
4. Fax agent information 
5. Sound agent information 
6. E-mail agent information   
 
To perform an extraction of AlarmWorX+ Tags and Multimedia Notification data to .csv files, you 
must select the Almworx.mdb file, then point the Converter to the places where you wish to store 
the extracted .csv files (for the AlarmWorX Server Configurator and AlarmWorX Multimedia Server 
Configurator, respectively). 

 

 
General View of Converter 
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Step 2: Configuration Fields 
AlarmWorX+ Export Database: The location of the AlarmWorX+ Configuration .mdb file. 
 
AlarmWorX Server Configurator: The destination of the .csv file for AlarmWorX Server 
Configurator. 
 
AlarmWorX Multimedia Server Configurator: The destination of the .csv file for the AlarmWorX 
Multimedia Server Configurator. 
 
The Export Database, Server Configurator, and Multimedia Server Configurator fields on the 
AlarmWorX+ Conversion Utility dialog box make it easy for you to select the source and 
destination of database files. 

 

 
Configuring the Destination of Extracted Files 

 
 
Multimedia Server Configurator Export Options 
 
• Scheduling Information: Check this option to export AlarmWorX+ scheduling information. 
• Telephony Agent: Check this option to export the AlarmWorX+ Telephony configuration. 
• Paging Agent: Check this option to export the AlarmWorX+ Paging configuration. 
• Fax Agent: Check this option to export the AlarmWorX+ Faxing configuration. 

• Sound Agent: Check this option to export the AlarmWorX+ sound file configuration. 
• E-mail Agent: The E-mail Agent allows you to send an e-mail giving alarm information. 

 
The Multimedia Server Configurator Export Options section of the AlarmWorX+ Conversion 
Utility dialog box appears below: 

 

 
Multimedia Server Configurator Export Options 
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Step 3: Importing Into the AlarmWorX Server Configurator 
To open the AlarmWorX Server Configurator, follow the path Start > Programs > Smar 
ProcessView > AlarmWorX > Alarm Server Configurator, as shown below: 

 
Opening the Alarm Server Configurator 

 

The AlarmWorX Server Configurator screen will open, as shown below: 

 
AlarmWorX Server Configurator Screen 

 
To import specially created .csv files into the AlarmWorX Server Configurator, go to File/ Import 
CSV / Tags and choose the correct file, as shown below: 

 

 
Choosing the File 
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The List of Available Configurations for Import dialog box will appear, as shown below: 

 
List of Available Configurations for Import Dialog Box 

 
Click on the OK button.  
 
The Open dialog box will appear, as shown below: 
 

 
Selecting Your Server .csv File 

 
In the directory, click on the file that you wish to import, as shown in the figure above.  The 
AlarmWorX Server Configurator will then try automatically to read and incorporate data from the 
designated .csv file. Immediately after the import process has been completed, the AlarmWorX 
Server Configurator will display a notification message box with statistical info about the inserted 
tags, as shown in the figure below: 
 

 
Tags Successful Import Notification Message Box 
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Step 4: Importing .csv Files Into the AlarmWorX Multimedia Server 
Configurator 

To open the AlarmWorX Server Configurator, follow the path Start > Programs > Smar 
ProcessView > AlarmWorX > Multimedia Configurator, as shown below: 

 

 
Opening Multimedia Configurator 

 
The AlarmWorX Multimedia Configurator screen will open, as shown below: 

 

 
AlarmWorX Multimedia Configurator Dialog Box 

 
To import specially created .csv files into the AlarmWorX Multimedia Server Configurator, go to 
select Import CSV from the File menu and choose the right file as shown below: 
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Accessing the .csv Files 

. 

 
Importing Configuration Data From File 

 
In the directory, click on the file that you wish to import, as shown in the figure above.   
 
During the import process, an error can occur.  In the figure below, the error message box 
represents a particular pager type of record error. 

 
Error Message Related to Paging Service 

 
After clicking on the OK button on the error message box, a Confirm CSV Import Proceeding 
confirmation message box will appear, as shown below:   
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Confirm CSV Import Proceeding Message Box 

 
This message box can even be used to stop the import process. 
 
The File Import Results dialog box will appear, as shown below: 

 

 
File Import Results Dialog Box 

 
In the figure above, the File Import Results dialog box of the AlarmWorX Multimedia Server 
Configurator displays statistical data about the import process. To see details of files that you have 
successfully imported, click on the ... button, as shown below: 
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Ellipse Button for Successfully Imported Files 

 

The Detail View dialog box will appear, as shown below: 
 

 
Details of Successfully Imported Tools 

 
The successfully imported files are listed, as shown in the figure, above. Click on the OK button to 
return to the File Import Results dialog box. 
 
To view details of the files that were not successfully imported, click on the ... button, as shown 
below: 
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Ellipse Button for Rejected Files  

 
The Detail View dialog box will appear, as shown below: 
 

 
Detail View of Files Not Successfully Imported 

 

The files not successfully imported are listed, as shown in the figure above. Click on the OK button 
to return to the File Import Results dialog box. Click on the OK button to return to the Multimedia 
Configurator screen, as shown below: 
 



AlarmWorX Multimedia 
 

8.14 

 
Multimedia Configurator Dialog Box: Template View 

 
As shown in the figure above, click on Alarm Configurations, then Media Templates, and a list 
of templates will pop down. Click on one of the templates; it will appear in the right pane. 
 

 
Multimedia Configurator Dialog Box: Schedule View 
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As shown in the figure above, click on Schedules, then Exported from AWX+, then on, for 
example, 2nd Shift Supervisor. The supervisor's schedule will appear in the right pane.  
 

 
Multimedia Configurator Screen: Telephone Media Name View 

 
In the figure above, click on Alarm Configurations, Multimedia Agents, Phone, and Security Guard Desk 1 on phone.  The 
imported telephone agent configuration appears in the right pane. 

 

 
Detailed View of Telephone Media Name Record 



AlarmWorX Multimedia 
 

8.16 

 
 
 
 
 

 



Chapter1  
 

1.1 

Introduction 
1.1 Introduction to AlarmWorX Multimedia 

 

Welcome to Smar AlarmWorX Multimedia, a new generation of modular automation for advanced OPC-based 
HMI and Visualization by Smar. The AlarmWorX Multimedia Configurator is a standalone product that allows you 
to configure alarms using several different media to notify anyone, anywhere, of an occurring alarm. 

AlarmWorX Multimedia is an option of AlarmWorX that provides OPC-compliant multimedia technology for 
remote alarm notification. Various multimedia "agents" are provided, including: 

• Paging (including SMS/TAP support) 
• Two-way paging 
• Phone with call-in and call-out support 
• E-mail  
• Fax 
• Voice annunciation of alarms via text-to-speech 
• Voice annunciation of alarms via recorded .wav files 
• Video 
• Pop-up windows 
• Computer screen marquee 
• Instant messaging 
• PA 

 

For examples of multimedia alarming agents, open the "MMXDemo.gdf" file in the 
"Smar/ProcessView/Examples/Multimedia Demo" directory. You must have SMAR GraphWorX™ installed to run 
this demonstration. 

1.1.1 AlarmWorX Multimedia Overview 
Figure 1.1 provides an overview of how AlarmWorX Multimedia enables you to send and receive alarms using 
various multimedia agents. The Smar AlarmWorX Multimedia Configurator is a database with a user interface that 
allows you to configure alarms, alarm action sets, multimedia agents, and alarm acknowledgement codes. You 
can also use the Multimedia Configurator to create subscriptions to OPC Alarm and Event (AE) servers. In 
addition, you can configure schedules and destinations for alarm notification messages.  

When your database configuration is completed and you start the Multimedia Server, the following occurs: 

1. When the Multimedia Server enters runtime mode, it reads all the alarm configurations in the multimedia 
configuration database.  

2. The Multimedia Server then subscribes to OPC AE servers based on the subscriptions that you created in the 
configuration database.  
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Figure 1.1. Overview of AlarmWorX Multimedia 

3. In turn, the OPC AE servers generate alarms back to the Multimedia Server. 

4. When the Multimedia Server receives alarms, it responds to those alarms according to the settings and alarm 
action sets that you configured in your database. 

5. Based on these action sets, the notification messages are then sent to a recipient (an operator or a group) via 
the configured multimedia agent, such as a telephone call or a fax. 

6. The recipient of the alarm message can then acknowledge the alarms using the configured multimedia 
device, such as a telephone or fax machine keypad. 

Note: Redundant (backup) Multimedia Servers are currently not available. 

1.2 Installing AlarmWorX Multimedia 
This section describes the steps for installing Smar AlarmWorX Multimedia. Be sure to close any other 
applications before installing AlarmWorX Multimedia. For general guidelines and requirements for ProcessView 
installation, please refer to the Smar Getting Started user's guide.  

1.2.1 System Requirements 
To use this software, you must have the following minimum system requirements: 

• 8X speed CD-ROM. 

• 125 MB of disk space. (Note: This is the recommended amount of disk space for the Multimedia 
installation only. This does not include hardware drivers. Also, as the size of the databases increases 
over time, additional space may be needed.)  

• VGA video card; 256 or more colors for best results. 

• Sound card. 

• Microsoft® Internet Explorer 5.5 or above. 

• Microsoft Windows 98 SE, Windows 2000 with Service Pack 3, Windows Millennium (ME), or Windows 
XP with Service Pack 1, or Windows NT® 4.0 with Service Pack 6a. 

• Note: Windows 98 SE is supported only by the non-Unicode version of ProcessView. 

• Microsoft® SQL Server® 2000 or MSDE 2000 (with the latest service packs) or higher. To download and 
install the latest service packs, go to www.microsoft.com. 
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IMPORTANT NOTE: You must have a telephony card installed on the computer on which you are running the 
Telephony Agents (both Call-in and Call-out) and the PA Agent. AlarmWorX Multimedia supports Intel® Dialogic® 
boards. Dialogic boards do not work for Windows 98, so neither the Call-in Agent nor the Call-out Agent 
will work on Windows 98. You also need to have an analog phone line connected to the board. (Note: Digital 
lines are not supported.) Only Dialogic boards are supported for the current version of AlarmWorX Multimedia. 
Please see Appendix B for information about installing and configuring Intel Dialogic boards. For more 
information about purchasing and installing Intel Dialogic boards, please visit the Intel Web site at 
www.intel.com/network/csp/products/index_vp.htm. 

 

CPU and RAM 
Minimum computer CPU and RAM requirements depend on the application and operating system, as shown 
below: 

Application Size Processor RAM 
Small 
Windows 98 SE/NT Client/ME,  
2000, XP 

 
233 MHz 
400 MHz 

 
64 MB 
128 MB 

Medium 
Windows 98 SE/NT/ME, 
 2000, XP  

 
400 MHz 
650 MHz 

 
128 MB 
256 MB 

Large 
All Operating Systems 

 
1.8 GHz 

 
512 MB - 1GB 

 

The actual amount of RAM and/or processor speed will vary depending upon the I/O counts, networking, logging 
and alarming requirements, etc.  To determine which type of computer best fits your application, set up a test 
application station. 

Note: The processor and memory requirements of your existing project may be greater in this version of 
ProcessView than in previous versions due to additional and enhanced features in the product. 

1.2.2 Installation Procedure 
To install Smar AlarmWorX Multimedia use the following procedure: 

Note: If your operating system (e.g., Windows NT) requires a login name, you must log in with administrator 
capability before installing the software. 

1. Before installing Smar software be sure that all other applications, such as Microsoft Office or any antivirus 
software, are closed and/or disabled. 

2. Insert the ProcessView product CD into your CD-ROM drive.  If "Autorun" is enabled on your system, the CD 
introduction starts automatically.  Otherwise, browse to your CD-ROM drive and run the "RunMe.bat" file.  

3. You will see the CD introduction and the main menu. From here you can click on a link to the Smar Web site, 
go to the Documentation Center, view CD-based Web pages containing miscellaneous Information, and 
install software.  

4. Click Multimedia on the software installation menu. The Setup screen briefly appears, followed by the 
Welcome Message screen, as shown in Figure 1.2. Click the Next button to continue. 
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Figure 1.2. Welcome Screen 

5. The Multimedia installation wizard will then check to see if Microsoft Data Access Components (MDAC) is 
installed on your system. If MDAC is installed, the setup will proceed to the next step. If it is not installed, you 
will be prompted to install MDAC. If the system prompts you to install MDAC, follow the instructions on the 
subsequent dialog boxes. 

6. The Software License Agreement dialog box appears, as shown in Figure 1.3. Read the License 
Agreement. Click Yes if you accept the terms of the agreement. 

 
Figure 1.3. Smar License Agreement 

7. The User Information dialog box appears, as shown in Figure 1.4. Type your (the user's) name in the Name 
field; your company's name in the Company field; and your product serial number in the Serial field.  Click 
the Next button to continue. 
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Figure 1.4. User Information Dialog Box 

8. The Choose Installation Destination dialog box appears, as shown in Figure 1.5. The default location is 
"C:\Program Files\Smar\ProcessView."  If you wish to specify a different directory for installation, click the 
Browse button and choose the appropriate installation folder. After you have chosen a location, click the 
Next button to continue the installation. 

 
Figure 1.5. Choosing Your Installation Location 
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9. The Select Components dialog box appears, as shown in Figure 1.6. As you can see, AlarmWorX 
Multimedia contains many multimedia "agents" for alarm notification, such as video, paging, and e-mail. Here 
you can customize your installation by selecting which agents to install. This is helpful if you have limited 
space on your hard drive or if you do not expect to use one or more multimedia agents. Click on the 
appropriate boxes to select the agents that you wish to install. The space required on your installation 
directory (as well as the space available on the directory) is displayed at the bottom of the dialog box. Once 
you have made your selections, click the Next button to continue. 

 
Figure 1.6 Select Components Dialog Box 

10. The Microsoft Agent License Agreement appears, as shown in Figure 1.7. Read the agreement carefully. 
If you agree with the terms and conditions, click the Yes button to continue.   

 
Figure 1.7. Microsoft Agent License Agreement 

11. The Microsoft Text-to-Speech Engine License Agreement appears (if you chose to install the Text-to-
Speech agent), as shown in Figure 1.8. Read the agreement carefully. If you agree with the terms and 
conditions, click the Yes button to continue.   
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Figure 1.8. Microsoft Text-to-Speech Engine License Agreement 

12. The Setup Status window appears. While the system files are being automatically copied, the percentage of 
the files already copied appears in the window's progress bar, as shown in Figure 1.9. 

 
Figure 1.9. Setup Status Window 

13. The Fonts window, shown in Figure 1.10, is open during the process of installation, but it will not stop the 
installation. The installation opens this window to configure Marquee Agent dotted fonts. You can ignore this 
window and close it at any time. 
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Figure 1.10. Fonts Window 

14. The Multimedia installation includes a Pager Agent that connects to a wide variety of pager services and 
supports the most popular paging protocols: 

• Tele Alphanumeric Protocol (TAP) 

• Simple Messaging Service (SMS) 

During the installation of Multimedia, after checking the box for including the Pager Agent, you can select 
which paging services to include with the installation. There are two separate lists: one for the Modem/ISDN 
(TAP) pagers, as shown in Figure 1.11, and one for GSM/PCS (SMS) pagers, as shown in Figure 1.12. It is 
recommended that you select all carriers in each list so that they will be available in the Multimedia 
configuration. Click OK. 

Note: Please see Appendix A for information about SMS and TAP pager services configuration. 

 
Figure 1.11. Modem/ISDN Carrier Setup 
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Figure 1.12. GSM/PCS Carrier Setup 

15. The Setup Complete dialog box appears, as shown in Figure 1.13. Click the Finish button to complete the 
installation. When you have finished installing Multimedia, restart your computer. 

Note: Depending on the multimedia agents you have chosen to install, you may encounter additional dialog boxes 
containing additional installation steps. Follow the instructions provided in these dialog boxes. For information 
about multimedia agent configuration, please see Chapter 4. 

 
Figure 1.13. Setup Complete Dialog Box 

1.3 Creating a New Configuration Database 
The Multimedia Configurator is the user interface that allows you to configure alarms and multimedia agents for 
the Multimedia Server. Before you can configure your multimedia settings, you must first create a database in 
which your configuration can be stored: 

IMPORTANT NOTE: You must have Microsoft SQL Server installed on your computer in order to create a new 
configuration database. Installation of Microsoft SQL Server Data Engine (MSDE) occurs during the AlarmWorX 
Multimedia installation. If you are using Microsoft Windows NT, Windows 2000, Windows XP, or .NET Server, you 
must log in with administrator capability in order to run the Configuration Database Wizard. 

1. Launch the Multimedia Configurator from the Windows Start menu by selecting Programs > Smar > 
ProcessView > AlarmWorX > Multimedia Configurator. You can also run the Multimedia Demo from this 
menu. 
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2. The first time you open the Configurator, the Configuration Database Wizard helps you create a new 
configuration database, as shown in Figure 1.14. Click the Next button to continue. 

 
Figure 1.14. Introduction to Multimedia Configuration Database Wizard  

3. You have two options for creating your new database, as shown in Figure 1.15. You can either create a 
new Microsoft SQL Server database, or you can add the configuration database structure to an existing 
Microsoft SQL Server database. Here we will assume that you will choose the first option (to create a new 
database). Select I want to create a new Microsoft SQL Server database on local node, and then click 
the Next button to continue. 
Note: For information about how you can add the configuration database structure to an existing Microsoft 
SQL Server database, see the "Adding the Multimedia Configuration to an Existing Database" section 
below. 

 
Figure 1.15. Creating a New Microsoft SQL Server Database 
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4. Choose the settings for the SQL Server database parameters, as shown in Figure 1.16. In the SQL Server 
field, select the local SQL Server on which to create a new database. Type a name for the database in the 
Database Name field. In the Database Path field, choose a directory path for the new database. You can 
browse for a directory by clicking the … button to the right of this field.  

Note: Usually you have only one instance of SQL Server running on the local node (in this case the SQL 
Server field has only one option: "(local)". However, it is possible to run multiple SQL Server instances on 
the local node, in which case the SQL Server field lists all those SQL Server instances: "(local)" for the 
default instance and "node_name/instance_name" for all others. Again, all those are local SQL Servers. 

Under the Database Properties section, specify an initial size for the database, which should be 
as large as possible. You can also specify a Database Growth option (in megabytes) or as a 
percentage of the total size. MSDE servers are capable of growing the database on the fly to 
store more data. However, if this operation is performed frequently, the overall system 
performance may decrease. Choosing an initially large database size and a corresponding 
database growth option can drastically improve system performance. To shrink the size of the 
new database, check the Auto Shrink check box.  

Under the Log File Properties section, you can also modify the settings for the database transaction log 
file. Specify a Log File Growth option (in megabytes) or as a percentage of the total size. Again, a 
sufficient initial size setting can greatly improve performance. The default options should be adequate for 
most applications with a small to medium size load.  

Click the Next button to create the new SQL Server database. 

 
Figure 1.16 Specifying the Database Location and Properties 

5. The Wizard creates the new SQL Server database, as shown in Figure 1.17.   Click the Next button to 
continue, when it becomes available. 
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Figure 1.17. Creating Database Structure 

6. The Configurator uses Universal Data Link (.udl) files to connect to the Microsoft SQL Server database. 
These .udl files contain OLE database connection information that allows the Configurator to create and 
manage connections to OLE databases. Enter a name and directory path for the new .udl file in the Data 
Link File Name field, as shown in Figure 1.18.  You can browse for a directory by clicking the … button to 
the right of this field. Click the Next button to continue. 

 
Figure 1.18. Creating a Universal Data Link File 

7. Once the Universal Data Link has been created, a summary appears, as shown in Figure 1.19. the Finish 
button to complete the database creation. 
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Figure 1.19. Database Creation Complete 

1.4 Adding the Multimedia Configuration to an Existing Database 
As mentioned above, the Configuration Database Wizard also gives you the option to add the Multimedia 
configuration database structure to an existing Microsoft SQL Server database. 

1. If you decide to use this option, select I want to append the Multimedia Configuration Database structure 
to existing SQL Server database, as shown in Figure 1.20.  Click the Next button to continue. 

 
Figure 1.20. Adding the Configuration to an Existing Database 

2. You are now prompted to connect to the existing SQL Server database. Click the Log On SQL Server 
button, as shown in Figure 1.21. 
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Figure 1.21. Connecting to an Existing SQL Server Database 

3. You are now prompted to connect to the existing SQL Server database. Click the Log On SQL Server 
button, as shown in Figure 1.22. 

 
Figure 1.22. Logging on to the SQL Server Database from the Data Link Properties 

4. Click the Test Connection button. If the test is successful, a message box appears, as shown in Figure 1.23. 
Click OK. Then click the OK button on the Data Link Properties dialog box. 
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Figure 1.23. Successful SQL Server Test Connection 

5. When a connection to the SQL Server database is established, the traffic light icon turns green, and the Next 
button becomes enabled, as shown in Figure 1.24.  Click the Next button to continue. 

 
Figure 1.24. Connection to SQL Server Database Established 

6. The Wizard inserts Multimedia tables into the selected SQL Server database, as shown in Figure 1.25. Click 
the Next button to continue. 

 
Figure 1.25. Creating Database Structure 
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7. Enter a name and directory path for the new .udl file in the Data Link File Name field, as shown in Figure 
1.26. You can browse for a directory by clicking the … button to the right of this field. Click the Next button to 
save OLE DB connection information in the .udl file. 

 
Figure 1.26. Selecting a Directory and File Name for Universal Data Link (.udl) File 

8. Once the Universal Data Link has been created, a summary appears, as shown in Figure 1.27. Click the 
Finish button to complete the database creation. 

 
Figure 1.27. Database Creation Complete 
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1.5 Upgrading Microsoft Access Databases 
If you have existing AlarmWorX Multimedia Version 6.1 configuration databases that were created using Microsoft 
Access, you can still use those databases in Version 7.0, but you must first upgrade those databases to Microsoft 
SQL Server by doing the following: 

1. In the Multimedia Configurator, select Open from the File menu, as shown in Figure 1.28. 

 
Figure 1.28. Opening the Existing Microsoft Access Database 

2. Selecting a Microsoft Access database and then click Open, as shown in Figure 1.29. 

 
Figure 1.29. Selecting a Microsoft Access Database 

3. Click Yes to continue, as shown in Figure 1.30. 

 
Figure 1.30. Upgrade Notice 

4. This opens the Configuration Database Wizard (refer to the section above). Run the Wizard to create a new 
SQL Server database. Select I want to create a new Microsoft SQL Server database on local node, as 
shown in Figure 1.31, and then click the Next button to continue. 
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Figure 1.31. Creating a New Microsoft SQL Server Database 

5. When you have finished creating the new SQL Server database, the Database Upgrade Summary appears, 
as shown in Figure 1.32, and the database opens the in the AlarmWorX Multimedia Configurator. 

 
Figure 1.32. Database Upgrade Summary 
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1.6 Starting the Multimedia Configurator  
Once you have finished creating a new configuration database using the Configuration Database Wizard, the 
Multimedia Configurator screen opens, as shown in Figure 1.33. The screen consists of a split window with a tree 
control view in the left-hand pane and a configuration view in the right-hand pane. The name of the .udl file that 
you created appears in the title bar of the window.  The Configurator provides a standard format for the 
configuration database, as well as a sample (default) configuration project. The Configurator also includes a 
toolbar and menus with many command functions. For a description of the toolbar and menu functions, please see 
the sections below. 

 
Figure 1.33. AlarmWorX Multimedia Configurator Screen 
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1.7 Toolbar 
The Multimedia Configurator toolbar, shown below, contains the following command buttons. To show or hide the 
toolbar, select Toolbars > Standard Buttons from the View menu. For more information on menu functions, 
please refer to the "Menus" section below. 

 
 

  

New: Creates a new database. 

Open: Opens an existing database. 

Up One Level: Moves up one level in the tree view. 

Navigate Back: Jumps to the last screen viewed.  

Navigate Forward: Jumps to the next screen viewed.  

Cut: Deletes current selection, sending it to the clipboard. 

Copy: Copies the current selection to the clipboard. 

Paste: Pastes the current contents of the clipboard. 

Large Icons: View items as large icons. 

Small Icons: View items as small icons. 

List: View items as a list. 

Details: View items as a list with details. 

Dialog View: View additional configuration options. 

Insert New Subscription: Configure a new subscription to an OPC server. 

Insert New Filter: Configure a new alarm filter. 

Insert New Configuration: Set up a new alarm configuration. 

Multimedia Assistant: Starts/stops the Icon-Nick Multimedia Assistant. 

Multimedia Configuration Wizard: Launches the Multimedia Configuration Wizard. 

Start/Stop Multimedia Server: Starts/stops the Multimedia Server. 

Monitor View: Adds a window to show alarms. 

Update Server Data: Updates the Multimedia Server of any changes while running. 

Clear Queues: Cancels all multimedia agent queues to the Multimedia Server. 

Security Administration: Configures Security Server settings for the Call-in Agent. 

About: Displays information about the application. 

Help: Displays context-sensitive help. 

Help Topics: Launches online help for the application. 
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1.8 Menus 
The menu bar of the AlarmWorX Multimedia Configurator contains the following menus: 

• File  

• Edit  

• View  

• Go  

• Action  

• Tools  

• Help  

1.8.1 File Menu 
The File menu commands are listed in Table 1.1. 

 

Table 1.1. File Menu Commands 

Command Shortcut Keys Function 

New CTRL+N Creates a new Microsoft Data Link (.udl) file through the Configuration 
Database Wizard. 

Open CTRL+O 
Opens a Microsoft Data Access (.mdb) or Microsoft Data Link (.udl) file, 
which allows you to connect to any OLE database source, such as a 
SQL database.  

Save As  Saves the current database. 

Make Active  Makes the current database active. If this command is not available, 
then the current database is already the active database. 

Export CSV  Exports configuration data from your database to a text file. You can 
specify the delimiters and what to export.  

Import CSV  Imports data into your database from a text file. You can then specify 
the delimiters and choose from the following import settings:  

Exit  Closes the application. 

 

Exporting Configuration Data 
The Configurator offers the flexibility of exporting data from your configuration database to a text (.txt) file or a 
Microsoft Excel (.csv) file. To export data, select Export CSV from the File menu. This opens the Export 
Configuration Data to File dialog box, as shown in Figure 1.34. You can then specify the delimiters for exporting 
the data. Unless you specify delimiters in the Export Configuration Data to File dialog box, the file will use 
Commas as delimiters by default. Each group contains headings and columns that provide information about 
each item, such as descriptions and associated translations and expressions. It also provides the "tree" pathway 
for each item. Choose the directory to which you want to export the data from your database. In the Save As 
Type field, choose the file type (.txt or .csv) that you would like to save.  
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Figure 1.34. Exporting Configuration Data  

Importing Configuration Data 
The Configurator offers the flexibility of importing data from a text (.txt) file or a Microsoft Excel (.csv) file to your 
configuration database. To import data, select Import CSV from the File menu. This opens the Import 
Configuration Data From File dialog box, as shown in Figure 1.35. You can then specify the delimiters and 
choose from the following import settings:  

• Create new items. When the import file contains items that are not yet in the configuration database, then 
it will create them. Otherwise it will skip these items. 

• Update existing items. When the import file contains items that are in the configuration database, then it 
will update them using data from the import file. Otherwise it will skip these items. 

•  
• Note: Either Create new items or Update existing items must be selected. Otherwise there is nothing to 

import. 
•  
• Display errors. When this item is checked, the Configurator will show a dialog box if an error occurs, and 

then will ask you if you want to proceed with the import. When it is not checked, it will skip all items where 
an error occurred.  
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Figure 1.35. Importing Configuration Data 

 
When you have selected a file to import, click Open. When the import is completed, the File Import Results 
dialog box will open, as shown in Figure 1.36. This shows the import settings, including the input file name. It also 
provides a summary of the import, including how many items were inserted, updated, or rejected, and shows how 
many errors occurred.  

Click the ... button to the right of each field to get the details view of the import results, as shown below. This view 
shows the specific items that were inserted, updated, or rejected, as well as a description of any errors that 
occurred. 

 
Figure 1.36. File Import Results Dialog Box 
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1.8.2 Edit Menu 
The Edit menu commands are listed in Table 1.2. 

 

Table 1.2. Edit Menu Commands  

Command Shortcut Keys Function 
New   Creates a new item depending on what is selected in the tree view.  
Rename CTRL+R Renames the selected object. 
Multiply CTRL+M Multiplies the selected object or item. 
Delete CTRL+DEL Deletes the selected object. 
Cut CTRL+X Cuts the selected object from the view and places it on the clipboard. 
Copy CTRL+C Copies the selected object to the clipboard. 
Paste CTRL+V Pastes the last object placed on the clipboard. 

Select All CTRL+A Selects all objects in a list. The selection is shown in the upper-right-
hand section of the viewer. 

Invert Selection  Unselects all selected items and selects all unselected items in a list 
in the upper-right-hand section of the viewer.  

1.8.3 View Menu 
The View menu commands are listed in Table 1.3. 

 

Table 1.3. View Menu Commands 

Command Shortcut Keys Function 
Toolbar   Displays the toolbar.  
Status Bar  Toggles the status bar. 
Large Icons F7 Displays the items in the list as small icons. 
Small Icons F8  Displays the items in the list as small icons. 
List F9 Displays the items in a list.  

Details F10 Displays the items along with detailed information about the 
configuration of each item. 

Dialog View F11 Toggles the configuration window (right-hand pane). 
Monitor View F12 Shows/hides the Multimedia Server runtime monitor. (See Chapter 8.) 

Sort By  
Displays a list of options for sorting the columns in the right-hand 
pane of the screen. The options listed depend on the level within the 
view.  

Show/Hide 
Columns  Displays a list of options that you can choose to show or hide in the 

view.  

Select 
Language  

Allows you to select the language to be used in the Configurator from 
the Select Language dialog box. Select the language you wish to use 
for your system and click OK. For navigation purposes, use the 
buttons and check boxes in the List section.  

Global Refresh F5 Refreshes the data for the entire Configurator screen. 
Subtree Refresh CTRL+F5 Refreshes only the data contained in the currently selected subtree.  
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Selecting Languages 
The Select Language function on the View menu allows you to choose which language to use in your display. 
Choosing Select Language from the View menu opens the Select Language dialog box, shown in Figure 1.37. 

Note: A language resource .dll must be installed for language switching to work. 

 
Figure 1.37. Select Language Dialog Box 

Define the parameters listed in the table below. Then click OK to return to the work area. 
Select Language Parameters 
Parameter Description 

List 

Lists available languages.  Depending on which item you have selected, the view on 
the left will change.  If English is checked, the languages will appear as their 
English name. If Localized is checked, the languages will appear with the native 
country in parentheses (for languages with several dialects only). When Native is 
checked, the languages are displayed the way they would be written in that 
language. 

Installed Locales Only If this is checked, local languages appear in the box. 
Available Language 
Translations Only Checking this box allows you to choose from available language translations only. 

1.8.4 Go Menu 
The Go menu commands are listed in Table 1.4. 

Table 1.4. Go Menu Commands 

Command Shortcut Keys Function 
Up One Level  Moves the cursor up one level. 
Item Above ALT+Up Arrow Moves the cursor to the next item up in the tree view. 
Item Below ALT+Down Arrow Moves the cursor to the next item down in the tree view. 
Previous Item  Moves the cursor back to the last item selected. 
Next Item  Opens the next item in the tree view. 
Expand Item ALT+Left Arrow Expands an item that contains a submenu. 
Collapse Item ALT+Right Arrow Collapses an item that contains a submenu. 
Page Up ALT+PgUp Moves the cursor up to the first item in the tree. 
Page Down ALT+PgDown Moves the cursor down to the last visible item in the tree. 
Home ALT+Home Moves the cursor up to the first item in the tree. 
End ALT+End Moves the cursor down to the last visible item in the tree. 
Next Pane F6 Moves the cursor to the next pane. 
Previous Pane SHIFT+F6 Moves the cursor to the last pane used. 
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1.8.5 Action Menu 
The Action menu commands are listed in Table 1.5. 

Table 1.5. Action Menu Commands 

Command Function 

Start Multimedia Server Enters the Multimedia Server into runtime mode. For information on runtime 
operations, please see Chapter 8.  

Stop Multimedia Server Stops the Multimedia Server and exits runtime mode. 
 

1.8.6 Tools Menu 
The Tools menu commands are listed in Table 1.6. 

Table 1.6. Tools Menu Commands 

Command Function 

Options Launches the Options dialog box. For more information about the Options dialog 
box, please see Chapter 7. 

Multimedia 
Configuration Wizard 

Launches the Alarm Configuration Wizard, which guides you through the steps 
for alarm configuration. (See Chapter 3 for details.) 

1.8.7 Help Menu 
The Help menu commands are listed in Table 1.7. 

Table 1.7. Help Menu Commands 

Command Shortcut Keys Function 
Help Topics F1 Launches the online Help for the Smar Multimedia Configurator.  

What’s This? SHIFT+F1 Displays context-sensitive help. 

Multimedia 
Assistant  Starts the Icon-Nick Multimedia Assistant, which provides interactive, 

text-to-speech help. 

About 
Application  

Launches the About Box, which contains information about the 
product version number, copyright, and available disk space. It also 
contains information about how to contact Smar.  

1.9 Adding, Reinstalling, and Uninstalling Components 
The following procedure explains how you can update your AlarmWorX Multimedia installation at any time.  

1. Select Settings > Control Panel from the Windows Start menu.  

2. In the Control Panel, select Add/Remove Programs. 

3. This opens the Windows Add/Remove Programs dialog box, as shown in Figure 1.38. To make changes 
to the Multimedia installation, select Multimedia Alarming and click the Change/Remove button.  
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Figure 1.38. Windows Add/Remove Programs Dialog Box 

4. This opens a Setup dialog box that allows you to select whether to modify, repair, or remove AlarmWorX 
Multimedia, as shown in Figure 1.39. 

 
Figure 1.39. Multimedia Setup Options 

5. To add or remove specific program components, select Modify and then click the Next button. This opens 
the Select Components dialog box, where you can select which agents to add to or remove from the 
installation. 



Introduction to AlarmWorX Multimedia 
 

1.28 

6. To repair a corrupted installation, select Repair from the Setup dialog box. Then click Next to reinstall all 
program components. 

7. To uninstall all program components, select Remove from the Setup dialog box. Then click the Next button. 
A dialog box then asks you if you wish to uninstall AlarmWorX Multimedia. Click OK to uninstall the 
application. 

8. When you have finished modifying, repairing, or uninstalling components, the Maintenance Complete 
dialog box appears. 

1.10 Multimedia Demo 
Examples of multimedia alarming agents are provided in the Multimedia Demo. You must have Smar 
GraphWorX installed to run this demonstration. To view these examples, open the "MMXDemo.gdf" file in the 
"Smar/ ProcessView/Examples/Multimedia Demo" directory. You can also open the Multimedia Demo from the 
Windows Programs menu by selecting Smar > ProcessView > AlarmWorX > Multimedia Demo.  
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Creating Alarm Configurations 
2.1 Basic Steps for Creating an Alarm Configuration 

This chapter provides a quick walk-through of how to create a basic alarm configuration. The following are 
suggested procedures for quickly and easily using the alarm Configurator's power and flexibility to develop a new 
alarm configuration. This chapter covers the following steps. More advanced options, such as templates and roles 
with scheduling, are discussed in later chapters. 

Step 1. Create a subscription to an OPC Alarm and Event server.  
Step 2. Create an alarm filter.  
Step 3. Create a multimedia agent.  
Step 4. Create an alarm configuration.  
Step 5. Create an action set.  
Step 6. Make the database active.  
Step 7: Start the Multimedia Server. 

For additional help on any of these steps, select Multimedia Assistant from the Help menu. Follow the 
instructions provided by the Multimedia Assistant. 

As an alternative, the Multimedia Configuration Wizard provides a simple walk-through that guides you through 
the steps above in a condensed, user-friendly fashion. Using the Multimedia Configuration Wizard simplifies the 
above process down to two steps:  

Step 1. Use the Multimedia Configuration Wizard to create an alarm configuration. (See Chapter 3.)  
Step 2. Make the database active. 
Step 3: Start the Multimedia Server. 

Note: In order to allow intranet/Internet-based alarm subscriptions or alarm notification, you will need to configure 
either DCOM or TCP/IP communications. For more information, please refer to the GenBroker or WebHMI help 
documentation. 

2.2 Creating a Subscription 
The first step in creating an alarm configuration is to create a subscription, which defines a connection to an alarm 
server. A subscription specifically describes alarms in which the Multimedia component is interested. To create a 
subscription to one or several OPC Alarm and Event servers, do the following: 

1. Click the Insert New Subscription button on the Configurator toolbar, or right-click the OPC Subscriptions 
folder (found under the Alarm Inputs folder on the tree control) and select New > OPC Subscription from 
the pop-up menu, as shown in Figure 2.1. 

 

Figure 2.1. Creating a New Subscription 

2. Type in the new subscription name, as shown in Figure 2.2. 

3. Click the Subscribe/Edit button to open the Subscription Properties dialog box. 

4. When you have finished configuring the subscription properties, click OK. 

5. Click Apply. 
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Figure 2.2. Naming the New Subscription 

2.2.1 Subscription Properties 
Clicking the Subscribe/Edit button in the subscription field opens the Subscription Properties dialog box, shown 
in Figure 2.3. The Subscription tab determines what type of OPC connection will be made. It allows you to add, 
rename, delete, or edit a subscription to a particular OPC Alarm and Event Server. To add a new subscription, 
click the Add button.  

The subscription named "New Subscription" appears, as shown in Figure 2.3. This subscription does not contain 
any data, so it is necessary to immediately edit the new subscription. To do so, click the Edit button to open the 
Event Subscription dialog box, shown in Figure 2.3. It is only possible to add or edit subscriptions that are 
connected to active OPC Alarm and Event servers.  

Note: It is possible for a server to have more than one subscription.  In fact, it is a very effective way to achieve 
filtering. 

 

Figure 2.3. Subscription Properties Dialog Box 
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Server Tab 
The Server tab of the Event Subscription dialog box, shown in Figure 2.4, allows you to select an Event Server 
and Node for each subscription. To select the event server, click the Browse button.  

 

Figure 2.4. Event Subscription Dialog Box: Server Tab 

This opens the OPC Universal Tag Browser, shown in Figure 2.5, which lists all available Alarm and Event OPC 
servers. Select the desired server, and click OK. For local servers, it is not necessary to fill in the Node field. 

 

Figure 2.5. Selecting an Alarm and Events Server From the Tag Browser 

You can also select global aliases to use in the Node field. Clicking the ... button and selecting Global Alias 
Browser from the pop-up menu opens the Global Alias Browser, as shown in Figure 2.6. Select a global alias 
from the Global Alias Browser, which includes all global aliases in the global alias database. This eliminates the 
need to manually type in the alias name. All global aliases that are configured in the Global Alias Engine 
Configurator are conveniently available to choose from inside the browser. The tree control of the Global Alias 
Engine Configurator is mimicked in the tree control of the Global Alias Browser. Select a global alias by double-
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clicking the alias name (e.g. "Floor" in the figure below). The alias name appears at the top of the browser, which 
automatically adds the <# and #> delimiters to the alias name. Click the OK button. 

 

Figure 2.6. Selecting an Alias From the Global Alias Browser 

 

Types Tab 
The Types tab of the Event Subscription dialog box, shown in Figure 2.7, allows you to configure which OPC-
defined event types each subscription should have, as well as to set the ranges for severity (priority). A value of 
"0" represents the low severity value, and "1000" represents the high severity value. Please note that OPC Alarm 
and Event (AE) servers are required to scale severity values to the OPC ranges (i.e. an AE server that contained 
two severity ranges would convert these to "0" and "1000"). 

 

Figure 2.7. Event Subscription Dialog Box: Types Tab 

Simple: These messages state information but do not have alarm status, nor do they contain information on what 
initiated the message. This includes the following information: Source, Time, Type, EventCategory, Severity, 
Message, Cookie, and server-specific items.   

Example: "FIC101, 12:0:0 1/1/99, Simple, Category1, 100, 'Shift Change', 1" 

Simple messages would be similar to an event. 
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Tracking: These messages contain the additional information of the client that initiated the event. This includes 
the following information: Source, Time, Type, EventCategory, Severity, Message, Cookie, ActorID, and server-
specific items. 

Example: "FIC101, 12:0:1 1/1/99, Tracking, Category1, 300, 'Pump pressure Set to 10 psi', 1, Station 12" 

Tracking messages are similar to event messages in that the cause of the event is important. An example would 
be an operator changing a setpoint value. This type of message does not include acknowledge capability. 

Note: Simple and tracking messages are removed from the alarm viewer via the acknowledge mechanism. 

Condition: These messages contain all of the above information but also include an acknowledgement portion. 
This includes the following information: Source, Time, Type, EventCategory, Severity, Message, Cookie, 
ConditionName, SubConditionName, ChangeMask, NewState, ConditionQuality, AckRequired, ActiveTime, 
ActorID and server-specific items. 

Example: "FIC101, 12:0:3 1/1/99, Condition, Category1, 700, 'Pump pressure to high', 1, Limit, HiHi, 1,Active 
Enabled, Good, TRUE, 12:0:2 1/1/99" 

Condition messages would be considered a "typical" alarm message with acknowledge capability. 

For further details on any of the included information, please refer to the OPC Alarm and Events specification. 

 

Categories Tab 
The Categories tab of the Event Subscription dialog, shown in Figure 2.8, allows you to select the categories 
for a subscription. Select the category from the list of available categories, and then click the Add -> button. The 
category will appear in the Subscribed list. To remove a category from this list, select it in the Subscribed list 
and click the <- Remove button. If no categories are listed in the Subscribed list, then all categories are selected 
by default. However, adding "Digital" and "Rate of Change," for example, to the list tells the OPC Alarm and 
Events Server to deliver only those alarm messages to the Multimedia Server. This is a “first-pass” filter on the 
server side. 

 

Figure 2.8. Event Subscription Dialog Box: Categories Tab 

Event Types and Categories 
All events generated are of the OPC defined Event Type Condition. The AlarmWorX Server defines the following 
Event Categories and uses the identical names for the Condition Names: 

• Deviation 
• Digital 
• Limit 
• Rate of Change 
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The Limit and Deviation conditions have the following Sub-conditions: 

• HiHi 
• Hi 
• Lo 
• LoLo 
 

Note: The following categories are not used in the SMAR Alarm Server: 

• OPC Server Error 
• System Configuration 
• System Message 

 
Areas Tab 
Use the Areas tab of the Event Subscription dialog box, shown in Figure 2.9, to select an area or a group of 
areas for filtering in a subscription. An area is used to group OPC alarm tags. This information can be used by 
clients for filtering purposes.  A tag can exist under multiple areas, and an area can have a multiple levels.  An 
area is defined by its name and the name of its parent branches.  For example, a branch called Area 1 under plant 
Area A is different from Area 1 under plant Area B. Areas can be configured in the AlarmWorX Server 
Configurator.  

 

Figure 2.9. Event Subscription Dialog Box: Areas Tab 

Clicking the Browse button opens the OPC Event Server Area / Source Browser, shown in Figure 2.10, which 
lists all available areas for your event server. Area subscription supports wildcards, which subscribe to the format 
of the Microsoft Visual Basic 'like" command. For example, "Area1*" will subscribe to all alarm areas that contain 
strings beginning with "Area1". "Area1\*" will subscribe to the root area and its "child" areas. A detailed 
explanation of the wildcard support can be found in the OPC Alarm and Events documentation. It is recommended 
that you thoroughly read the wildcard documentation before attempting to use complicated expressions. 

Note: For the like operator: "string" equals the string to search in; "pattern" equals the string to search for (can 
include wildcards); nonzero for case-sensitive search; zero for case-insensitive search. String syntax is $"string"$. 

You can use these special characters in pattern matches in string:  

• ? Any single character.  

• Zero or more characters.  

• # Any single digit (0-9).  

• [charlist] Any single character in charlist.  

• [!charlist] Any single character not in charlist. 
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It is also possible to delete an area from the Areas tab. To delete an area, select it from the list of areas for this 
particular subscription, and then click the Delete button. Not all OPC Alarm and Event servers support area 
filtering as part of the subscription. 

Note: If no areas are listed, then all areas are selected by default. 

Note: It is recommended that you have an area in the alarm server to which you subscribe; this ensures that the 
relevant multimedia alarms are received. Any available areas listed in the active Alarm Server configuration 
database are available to choose from in the Area/Source Browser. 

 

Figure 2.10. OPC Event Server Area/Source Browser 

You can also select global aliases to use in the Area field. Clicking the ... button and selecting Global Alias 
Browser from the pop-up menu opens the Global Alias Browser, as shown in Figure 2.11. Select a global alias 
from the Global Alias Browser, which includes all global aliases in the global alias database. This eliminates the 
need to manually type in the alias name. All global aliases that are configured in the Global Alias Engine 
Configurator are conveniently available to choose from inside the browser. The tree control of the Global Alias 
Engine Configurator is mimicked in the tree control of the Global Alias Browser. Select a global alias by double-
clicking the alias name (e.g. "Floor" in the figure below). The alias name appears at the top of the browser, which 
automatically adds the <# and #> delimiters to the alias name. Click the OK button. 

 

Figure 2.11. Selecting an Alias From the Global Alias Browser 
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Clicking the ... button and selecting Language Alias Browser from the pop-up menu opens the Language Alias 
Browser, as shown in Figure 2.12. The browser includes all languages aliases in the language database. All 
language aliases that are configured in the Language Configurator are conveniently available to choose from 
inside the browser. The tree control of the Language Configurator is mimicked in the tree control of the Language 
Alias Browser. Select a language alias by double-clicking the alias name. The alias name appears at the top of the 
browser, which automatically adds the /+ and +/ delimiters to the alias name. Click the OK button. 

 

Figure 2.12. Selecting an Alias From the Language Alias Browser 

 

Sources Tab 
The Sources tab of the Event Subscription dialog box, shown in Figure 2.13, allows you to filter on a source or 
group of sources for a particular subscription. A source is an OPC alarm tag in an alarm configuration. In the 
AlarmWorX Server Configurator, a source can be associated with a particular area (group of alarm tags). It is also 
possible to delete a source for a particular subscription. To delete a source, select it from the list of sources for 
this particular subscription and click the Delete button. Not all OPC Alarm and Event servers support source 
filtering as part of the subscription.  

Note: If no sources are listed, then all sources are selected by default. Any available sources listed in the active 
Alarm Server configuration database are available to choose from in the Area/Source Browser, as shown in the 
figure below. 

 

Figure 2.13. Event Subscription Dialog Box: Sources Tab 

To select a source, click the Browse button and select one from the OPC Event Server Area / Source Browser, 
shown in Figure 2.14. Source subscription provides the wildcard support found in the area subscription.  
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Figure 2.14. OPC Event Server Area/Source Browser 

Attributes Tab 
The Attributes tab of the Event Subscription dialog box, shown in Figure 2.15, allows you to add extra 
attributes to a particular event category within a subscription. Select the event category from the corresponding 
drop-down list. Choose the desired items from the available attributes list, and click the Add button. To remove an 
attribute from the subscribed list, select that particular attribute and click Remove.  

Note: The following categories are not used in the SMAR Alarm Server: 

• OPC Server Error 
• System Configuration 
• System Message 
 

 

Figure 2.15. Event Subscription Dialog Box: Attributes Tab 

It is important to note that the order of the subscribed attributes does matter. The order of the attributes 
determines the order they will be selected from the alarm server, and also determines with which viewer attribute 
column they are associated. To change the order of the attributes in the subscribed field, simply select an attribute 
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and click the "up" and "down" arrow buttons. Server-specific information will be displayed in the Attributes1-n 
columns. The attributes columns are added in the Column tab of the Alarm Viewer ActiveX Properties dialog 
box. 

Note: To receive extra attributes, you must request them per event category. 

 

Event Attributes 
The following event attributes are made available to subscribing clients: 

Attribute Deviation Digital Limit Rate of 
Change Type Comment 

ACK COMMENT a a a a VT_BSTR Comment entered when alarm was last 
acknowledged. 

ALARM COUNT a a a a VT_I4 Number of alarm transitions before acknowledge. 

AREA a a a a 
VT_ARRAY | 
VT_BSTR Array of areas 

CV a a a a 
VT_R8 
VT_BOOL Current Value (OPC Input 1 or 2). 

DEADBAND a  a a VT_R8 Alarm detection Deadband. 

DEFAULT DISPLAY a a a a VT_BSTR A text string, usually a fi le name, that when 
launched provides related information. 

HELP TEXT a a a a VT_BSTR Help information 

LIMIT VALUE 
EXCEEDED a  a a VT_R8 The Current Value at the time the limit was 

exceeded. 

LOOP DESC a a a a VT_BSTR A description of the Source (tag). 

NEXT_LIM a  a  VT_R8 The value of the next limit. 

NORMAL STATE  a   VT_BOOL Value of the normal state (TRUE or FALSE). 

PREV LIM a  a  VT_R8 Value of the previous limit reached. 

RELATED VALUE 
01-10 a a a a  Associates up to 10 OPC tags or expressions with each 

alarm tag as “supplemental” information to the alarm. 

SP a    VT_SP Setpoint (OPC Input 2) 

2.3 Creating an Alarm Filter 
Once you have configured your subscriptions, the Multimedia Server will receive all alarms subscribed to in the 
configuration database. Alarm filters allow you to filter an alarm subset. You can make filters that only filter a 
specific alarm tag or filters that filter a group of alarms. The Multimedia Server uses alarm filters to specify which 
subset of alarms will be used to initiate a multimedia action.  

The default configuration database provided in the installation contains many configured alarm filters. To view 
these filters, expand the Alarm Inputs folder in the tree control, and then expand the Alarm Filters folder. This 
shows all of the filters already defined in your system.   

To set up an alarm filter: 

1. Click the Insert New Filter button on the Configurator toolbar, or right-click on the Alarm Filters folder (found 
under the Alarm Inputs folder on the tree control) and select New > Alarm Filter from the pop-up menu, as 
shown in Figure 2.16. 

 

Figure 2.16. Creating a New Alarm Filter 
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2. Type in the new filter name, as shown in Figure 2.17. 

 

Figure 2.17. Naming the New Alarm Filter 

3. Click the Edit button to open the Edit Expression dialog box (described in the section below). This is where 
you will configure your filter. 

4. Click Apply. 

 
Deleting a Filter 
To delete an alarm filter, right-click the filter in the tree control and select Delete from the pop-up menu. Your 
system will ask if you really want to delete the filter. Click Yes to delete the filter. 

Renaming a Filter  
To rename a filter, right-click the filter in the tree view and select Rename from the pop-up menu. It is necessary 
to change the filter name if you are going to add more than one filter. Try to give the filter a name that describes 
what it does or the values it considers when filtering.  

Note: Depending on the security level of the user, the user may or may not be able to create or activate filters 
during runtime mode. 

2.3.1 Expression Editor 
You can use the Edit Expression dialog box, shown in Figure 2.18, to set up your alarm filtering. The following 
options are available: 

• Arithmetic  

• Relational  

• Logical  

• Bitwise  

• Functions  
• Tags  
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Figure 2.18. Edit Expression Dialog Box 

Arithmetic 
The symbols '+', '-', '*', '/' and '%' use the following format:  

expression :: parameter symbol parameter 

Where  

Parameter A local variable, an OPC tag, a constant, or another expression 
Symbol + or - or * or / or % 

 

Result 
The expression results in a number of any type (float, long, etc.). 

 

Examples 

Symbol Description Example Result 
+ Addition ~~var1~~ + ~~var2~~ 8+3 = 11 

- Subtraction ~~var1~~ - ~~var2~~ 8-3 = 5 

* Multiplication ~~var1~~ * ~~var2~~ 8*3 = 24 

/ Division ~~var1~~ / ~~var2~~ 8/3 = 2.66667 

% Calculates the remainder after division ~~var1~~ % ~~var2~~ 8%3 = 2 

( and ) Gives precedence to parts of the 
calculation 

~~var1~~ / (~~var2~~ + ~~var3~~) 8/(3+2) = 1.6 

 

Relational 
The symbols '<', '>', '<=', '>=', '==' and '!=' use the following format:  

expression :: parameter symbol parameter 

 

Where  

Parameter A local variable, an OPC tag, a constant, or another expression 
Symbol < or > or <= or >= or == or != 
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Result 
The expression results in a Boolean value (0 or 1). 

Examples 

Symbol Description Example Result 
< Less than ~~var1~~ < ~~var2~~ 8<3 = 0 

> Greater than ~~var1~~ > ~~var2~~ 8>3 = 1 

<= Less than or equal to ~~var1~~ <= ~~var2~~ 8<=3 = 0 

>= Greater than or equal to ~~var1~~ >= ~~var2~~ 8>=3 = 1 

== Equal to ~~var1~~ == ~~var2~~ 8==3 = 0 

!= Not equal to ~~var1~~ != ~~var2~~ 8!=3 = 1 

 
Logical 
The symbols '&&' and '|| ' use the following format:  

expression :: parameter symbol parameter 
 

The symbol '!' uses the following format: 

expression :: symbol parameter 

 
Where  

Parameter A local variable, an OPC tag, a constant, or another expression 
Symbol && or || or ! 

 
Result 
The expression results in a Boolean value (0 or 1). 

 
Truth table 

  
Examples 

Symbol Description Example Result 
&& And ~~var1~~ && ~~var2~~ 8 && 3 = 1 

|| Or ~~var1~~ || ~~var2~~ 8 || 3 = 1 

! Not !~~var1~~ !8 = 0 

 
Bitwise 
The symbols '&', '| ', and '^' of the bitwise group use the following format:  

expression :: parameter symbol parameter 

 
The symbol '~' of the logical group uses the following format:  

expression :: symbol parameter 
 

The symbols 'shl' and 'shr' of the bitwise group use the following format: 

expression :: symbol (value, shift by) 
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Where  

Parameter A local variable, an OPC tag, a constant, or another expression 
Symbol && or || or ^ or shl or shr or ~ 

 
Result 

The expression results in a number when the parameters used contain numbers. 

Bit Table 

 Binary (Decimal) Binary (Decimal) 

~~var1~~ 0000.0000.0000.1000 - (8) 0000.0000.0110.0000 - (96) 

~~var2~~ 0000.0000.0000.1010 - (10) 0000.0000.0000.1000 - (8) 

~~var1~~ & ~~var2~~ 0000.0000.0000.1000 - (8) 0000.0000.0000.0000 - (0) 

~~var1~~ | ~~var2~~ 0000.0000.0000.1010 - (10) 0000.0000.0110.1000 - (104) 

~~var1~~ ^ ~~var2~~ 0000.0000.0000.0010 - (2) 0000.0000.0110.1000 - (104) 

shl (~~var1~~,3) 0000.0000.0100.0000 - (64) 0000.0011.0000.0000 - (768) 

shr (~~var1~~,3) 0000.0000.0000.0001 - (1) 0000.0000.0000.1100 - (12) 

~(~~var1~~) 1111.1111.1111.0111 - (-9) 1111.1100.1111.1111 - (-97) 

bittest(~~var1~~,3) 0000.0000.0000.0001 - (1) 0000.0000.0000.0000 - (0) 

 

Examples 

Symbol Description Example Result 
& Bit And ~~var1~~ & ~~var2~~ 8 && 3 = 0 

| Bit Or ~~var1~~ | ~~var2~~ 8 || 3 = 11 

^ Bit eXclusive Or ~~var1~~ ^ ~~var2~~ 8^3=11 

shl Bit shift left shl(~~var1~~,3) 8<<3=64 

shr Bit shift right shr(~~var1~~,3) 8>>3=1 

~ Not (two's complement) ~(~~var1~~) !8 = -9 

bittest Bit Test bittest ( 5 , 0 ) 1 

 
Note: The bittest function requires you to specify the position of the bit to be tested. You must indicate that it starts 
from 0. In other words, a bit position of "0" indicates the "less significant" bit. 

 
Functions 
The symbols 'sin', 'asin', 'cos', 'acos', 'tan', 'atan', 'log', 'ln', 'exp', 'sqrt', 'abs', 'ceil', and 'floor' use the following 
format: 

expression :: symbol (parameter) 

 

The symbols 'pow', 'min', and 'max' use the following format: 

expression :: symbol (parameter,parameter) 

 

The symbol 'if' uses the following format: 

expression :: symbol (parameter,parameter,parameter) 
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Where  

Parameter A local variable, an OPC tag, a constant, or another expression 
Symbol sin, asin, cos, acos, tan, atan, log, ln, exp, sqrt, abs, ceil, floor, min, max, pow, or if 

 

Result 
The expression results in a number. 
 
Examples 

Symbol Description Example Result 
sin sine of an angle in radians sin(~~var1~~) sin(0.785)=0.71 

cos cosine of an angle in radians cos(~~var1~~) cos(0.785)=0.71 

tan tangent of an angle in radians tan(~~var1~~) tan(0.785)=1.0 

asin arc sine returns an angle in radians asin(~~var1~~) asin(0.5)=0.52 

acos arc cosine returns an angle in radians acos(~~var1~~) acos(0.5)=1.05 

atan arc tangent returns an angle in radians atan(~~var1~~) atan(1)=0.785 

sqrt Returns the square root sqrt(~~var1~~) sqrt(100)=10 

pow Returns value 1 raised to the power value 2 pow(~~var1~~,~~var2~~) pow(100,1.5)=1000 

log 10 based logarithm log(~~var1~~) log(100)=2 

ln e based logarithm ln(~~var1~~) ln(7.389)=2 

exp Exponential  exp(~~var1~~) exp(2)=7.389 

abs Absolute value abs(~~var1~~) abs(-1)=1 

ceil Integer ceiling ceil(~~var1~~) ceil(7.39)=8 

floor Integer floor floor(~~var1~~) floor(7.39)=7 

min Lowest value of two min(~~var1~~,~~var2~~) min(10,5)=5 

max Highest value of two max(~~var1~~,~~var2~~) min(10,5)=10 

if Conditional statement if(~~var1~~<~~var2~~, 
~~var1~~,~~var2~~) if(5<8,5,8)=5 

like Wildcard string compare Like(string, pattern, 
casesensitive')  

quality Quality of tag or expression See below. See below. 

tostring Type conversion See below. See below. 

0x Hexadecimal constant x=0x11   17 

0t Octal constant x=0t11   9 

0b Binary constant x=0b11 3 

 

Note: For the like operator: "string" equals the string to search in; "pattern" equals the string to search for (can 
include wildcards); nonzero for case-sensitive search; zero for case-insensitive search. String syntax is $"string"$. 

You can use these special characters in pattern matches in string:  

• ? Any single character.  

• Zero or more characters.  

• # Any single digit (0-9).  

• [charlist] Any single character in charlist.  

• [!charlist] Any single character not in charlist. 
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Quality 
The quality option on the Functions menu of the Expression Editor is used to evaluate the quality of an OPC 
tag or an expression.  
 
The following general syntax is used for quality expressions: 

x=quality(expression) 

Note: The "(expression)" can also be a simple expression composed of a single tag. 

The quality function returns the OPC quality of the string between parentheses as one of the following results: 

• 192: quality is GOOD 

• 64: quality UNCERTAIN 

• 0: quality BAD 

 
Note: The OPC Foundation establishes the value ranges for quality. There are actually varying degrees of quality:  

• GOOD: 192-252 

• UNCERTAIN: 64-191 

• BAD: 0-63 

 
For more information, refer to the OPC Data Access Custom Interface Standard available for download at the 
OPC Foundation's Web site, www.opcfoundation.org/. 

 
Example Quality Expression 

Expression Result 
x=quality({{SMAR.Simulator.1\SimulatePLC.PumpStatus}}) 192 (Quality GOOD) 

 
The quality of an expression is determined through the evaluation of each single tag in the expression. Thus, if 
you have multiple tags in an expression (and each tag has a different quality), the result of the expression (i.e. 192 
[GOOD], 64 [BAD], or 0 [UNCERTAIN]) corresponds to the quality of the tag with the lowest quality. If an 
expression contains a conditional statement (e.g. if, then, or else), then the result of the expression is affected 
only by the quality of the branch being executed. 
 
Consider the following sample expression: 

x= if ( quality({{Tag1}}) == 192, {{Tag1}}, {{Tag2}}) 

This expression can be read as follows:  

"If the quality of Tag1 is GOOD (i.e. 192), then the expression result (x) is the value of Tag1. In all other cases (i.e. 
the quality of Tag1 is UNCERTAIN or BAD), the expression result (x) is the value of Tag2." 

We can calculate the results for this expression using different qualities for Tag1 and Tag2, as shown in the table 
below. 
 

Case Tag1 quality Tag2 quality Result Result quality 
1 GOOD GOOD Tag1 192 (GOOD) 

2 GOOD UNCERTAIN Tag1 192 (GOOD) 

3 GOOD BAD Tag1 192 (GOOD) 

4 UNCERTAIN GOOD Tag2 192 (GOOD) 
5 UNCERTAIN UNCERTAIN Tag2 64 (UNCERTAIN) 

6 UNCERTAIN BAD Tag2 0 (BAD) 

7 BAD GOOD Tag2 192 (GOOD) 
8 BAD UNCERTAIN Tag2 64 (UNCERTAIN) 

9 BAD BAD Tag2 0 (BAD) 
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In cases 1-3 above, the quality of Tag1 is GOOD, and therefore the result of the expression is GOOD. Thus, the 
result of the expression is not affected by the quality of Tag2 (the “else” branch of the expression), which is 
ignored.  

In cases 4-6, the quality of Tag1 is UNCERTAIN, and therefore the result of the expression is the quality of Tag2.  

In cases 7-9, the quality of Tag1 is BAD, and therefore the result of the expression is the quality of Tag2. 

Note: The “quality()” function returns a value that represents the quality of the expression within the parentheses 
but is always GOOD_QUALITY. For example, if Tag1 is BAD_QUALITY then the expression “x=quality({{Tag1}})" 
will return 0 with GOOD_QUALITY. 

The result of an expression is the minimum quality of the evaluated tag in the expression and is affected only by 
the quality of the conditional (if, then, or else) branch that is executed.  

Consider the following sample expression: 

x= if ({{TAG_01}}>0,{{TAG_02}},{{TAG_03}}) 

This expression can be read as follows:  

"If the value of TAG_01 is greater than 0, then the expression result (x) is TAG_02. If the value of TAG_01 is less 
than or equal to 0, then the expression result (x) is TAG_03." 

Let's assume that the following values and qualities for these tags: 

TAG_01=5 with quality GOOD 

TAG_02=6 with quality UNCERTAIN 

TAG_03=7 with quality BAD 

Because the value of TAG_01 is 5 (greater than 0), the expression result is TAG_02. Thus, the final expression 
result is 6, and the final expression quality is UNCERTAIN. 

 

Type Conversion 
The tostring option on the Functions menu of the Expression Editor takes the value of whatever item is in 
parentheses and converts it into a string as follows: 

The value is +(value)+unit 

It can be used to convert from number to string, and it can be very useful for string concatenation. 

The proper syntax for the tostring option is: 

x=$"The value is "$ + tostring(value) + $" unit"$ 

 
Note: In the expression above, the word "unit" is placeholder text for a user-specified unit of measurement or 
variable (e.g. Watt, inches, meters, etc.).  
 
Example Expressions Type Conversion 

Expression Result 
x=$"The value is "$ + tostring({{gfwsim.ramp.float}}) + $" Watt"$ “The value is 543.2345152 Watt” 

 

Constants 
The Functions menu of the Expression Editor supports constant values, including hexadecimal, octal, and 
binary formats.  

Example Expressions Using Constants 

Expression Result 
x=0x11   17 

x=0t11   9 
x=0b11 3 

 
The Expression Editor conveniently inserts the 0x and 0t and 0b prefixes for you so do not have to recall them. 
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Interpreting and Translating Constants 
The examples below show how values are calculated for each type of constant. 

• Hexadecimal: 0x20A = 2 * (16^2) + 0 * (16^1) + 10 * (16^0) = 2*256 + 0*16 + 10 * 1 = 512 + 0 + 10 = 
522 

• Octal: 0t36= 3 * (7^1) + 6 *(7^0) = 3* 7 + 6* 1= 21 + 6 = 27 

• Binary: 0b110 = 1 * (2^2) + 1 * (2^1) + 0 * (2  ̂0) = 1 * 4 + 1 * 2 + 0 * 1 = 4+2+0 = 6 

 

Tags 
The menu options available under the Tags button of the Expression Editor are shown in Figure 2.19. The 
Expression Editor dialog box can also be used to create and edit alarm filters. The Expression Editor provides a 
Filter Wizard and an Alarm Tag list to help you create simple alarm filters. If you want to customize your alarm 
filters, you can use the other functions in the Expression Editor to set up your alarm filters manually. 

 

Figure 2.19. Creating Alarm Filters Using the Expression Editor  
 

Filter Wizard 
The Filter Wizard, shown in Figure 2.20, allows you to choose from the following to items enter in your 
expression. Select one or more items, and then click OK. The filter string is automatically inserted into the Edit 
Expression dialog box. 

• Alarm Types: Alarm, Acknowledgement, Unacknowledgement, Tracking, and Operator 

• Sub Conditions: LoLo, Lo, Hi, HiHi, Rate of Change, and Digital 

 
Figure 2.20. Filter Wizard 
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Selecting Alarm Attributes 
Clicking Advanced (see Figure 2.19) opens the Alarm Tag list, shown in Figure 2.21, which allows you to choose 
alarm attributes for your alarm filter. Select the attribute that you want to include in the filter expression and click 
OK. 

 

Figure 2.21. Alarm Tag List 

There are two additional attributes available for use in filtering: Alarm Type and Current Time.  The Alarm Type 
attribute allows you to filter alarms according to ALARM 1, ACK 2, UNACK 3, OPER 4, TRACK 5 or NORM 6.  For 
example, you can set up a filter with the condition: 

X = {{AlarmType}}  
 

If the Alarm Type is true, then the alarms are displayed. If it is false, then they are not displayed.  
The Current Time attribute allows you to filter according to the current time. Only alarms occurring around the 
current time will be displayed.  
 
Example Alarm Filters 

Expression Result 
X = {{Severity}} > 500.   Only alarm messages with a severity greater than 500 will be visible. 
X = Like({{Source}}, $"Tag"$,0)   Only messages with the tag in the source name will be displayed. 
X = 1.   Filter displays all messages. 
X = 0.   Filter does not display any messages. 

 
All filters resolve to TRUE or FALSE. All nonzero values resolve to TRUE.  

 
Global Aliases 
For global aliases within the expression, use the following syntax:   
<#global_alias_name#> 
 

Example: 
x=<#RoomTemperature#> 
 
Selecting Global Alias Browser opens the Global Alias Browser, as shown in Figure 2.22. Select a global alias 
from the Global Alias Browser, which includes all global aliases in the global alias database. This eliminates the 
need to manually type in the alias name. All global aliases that are configured in the Global Alias Engine 
Configurator are conveniently available to choose from inside the browser. The tree control of the Global Alias 
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Engine Configurator is mimicked in the tree control of the Global Alias Browser. Select a global alias by double-
clicking the alias name (e.g. "Floor" in the figure below). The alias name appears at the top of the browser, which 
automatically adds the <# and #> delimiters to the alias name. Click the OK button. 

 
Figure 2.22. Selecting an Alias From the Global Alias Browser 

 

Language Aliases 
For language aliases within the expression, use the following syntax:   
/+language_alias_name+/ 
 
Example: 
x=/+WaterSystem+/ 
 
Selecting Language Alias Browser from the pop-up menu opens the Language Alias Browser, as shown in 
Figure 2.23. The browser includes all languages aliases in the language database. All language aliases that are 
configured in the Language Configurator are conveniently available to choose from inside the browser. The tree 
control of the Language Configurator is mimicked in the tree control of the Language Alias Browser. Select a 
language alias by double-clicking the alias name. The alias name appears at the top of the browser, which 
automatically adds the /+ and +/ delimiters to the alias name. Click the OK button. 

 
Figure 2.23. Selecting an Alias From the Language Alias Browser 
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2.4 Configuring a Multimedia Agent 
You can configure any of the following multimedia agents to react when a predefined condition occurs within any 
alarm or events server: 

• E-mail: Sends an e-mail message. 

• Sound / Text-to-Speech: Plays prerecorded sounds and/or speech from text locally or remotely over a 
network. 

• Marquee: Creates a marquee window displaying a message locally or remotely over a network. 
• Pager (SMS/GSM/TAP): Sends a message to a pager. 

• Telephony: The Call-out Agent calls a defined number and gives a message with options to respond. 
The Call-in Agent enables callers to dial in by phone to get alarm information and issue commands. 

• Fax: Sends a message to a fax machine.  

• Instant Messaging: Sends a message to any computer using Instant Messaging. 

• Popup: Opens a program or Web site giving alarm messages.  

• Video: Plays a video; can be a prerecorded video or a video captured at the moment of the alarm. 
To configure a multimedia agent, do the following: 
1. Right-click on the type of agent you wish to configure. Then select New and then the type of agent you wish 

to configure. The agent folders can be found in the Multimedia Agents folder, which is in the Alarm 
Configurations folder on the tree control, as shown in Figure 2.24. 

 
Figure 2.24. Multimedia Agents Tree Control 

2. Depending on which type of agent you choose to configure, an appropriate dialog box will appear with all 
available options displayed. To see a description of each configuration field for a particular agent, click on that 
agent from the list above.  

3. After entering all appropriate information, click Apply to save the agent information. 
Note: For details on multimedia agent configuration, please see Chapter 4. 
Note: You must enter an Acknowledge Code in the appropriate field if you wish for your user to be able to 
acknowledge or confirm receipt of an alarm. This is important if you will be using an escalating list of alarm actions 
and want the list to discontinue once someone has recognized an alarm has occurred. Note that the Sound / Text-
to-Speech, Fax, Popup, and Video agents are used only for displaying messages and do not have an 
acknowledge option associated with them. 
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2.5 Creating an Alarm Configuration  
The alarm configuration is where you specify which OPC subscription to be used and where you create action 
sets to be followed. Each new database you create will have a default alarm configuration. This is the alarm 
configuration you should plan to use if you are just creating one alarm configuration for your computer to follow. If 
you create a new alarm configuration with a name other than "Default," you will also need to create a new node 
configuration and link it to your alarm configuration. 

To add the OPC subscription to be used in your configuration, do the following: 

1. Right-click the Alarm Configurations folder and select New > Alarm Configuration, as shown in Figure 
2.25. 

 

Figure 2.25. Adding a New Alarm Configuration 

2. Select the OPC subscription you wish to use from the drop-down list, as shown in Figure 2.26. 

 

Figure 2.26. Choosing an OPC Subscription 

3. Click Apply. 
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2.6 Creating an Alarm Action Set 
An Alarm Action Set is a set of actions that the Multimedia Server will take whenever an alarm from that 
subscription occurs. For example, one action set could not only page the security guard, but it could also send an 
e-mail message to the technician on duty, announce the message over a phone, and fax the alarm to a remote 
center.  You can create more than one action set under each alarm configuration. Each action set you create is 
based on a filter. Within each action set, you can define more than one procedure for that action set to follow.  

To create an action set: 

1. Right-click on Default and select New > Alarm Action Set from the pop-up menu, as shown in Figure 2.27. 
The Default alarm configuration object can be found in the Alarm Configurations folder on the tree control. 

 

Figure 2.27. Creating a New Alarm Action Set 

2. Enter a name for this action set, as shown in Figure 2.28. 

 

Figure 2.28. Setting the Properties for the New Alarm Action Set 
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3. Select a filter from the Filter to Use drop-down list. 

4. In the Alarm Actions field, select what you want to occur from the list under Action Destination. Clicking the 
… button in each Action Destination row opens the Select Action Destination dialog box, as shown in 
Figure 2.29. Action destinations can be configured multimedia agents (e.g. Marquee Window) or roles (e.g. 
General Manager). Select an action destination from the tree control on the left and then click the Set 
selected item as Action Destination button, as shown in Figure 2.29. 
In the Action Destination field, you can also select <NO ACTION> by clicking the Set as 'No Action' button, 
as shown in Figure 2.29. When this option is selected, the Multimedia Server will wait a specified amount of 
time (the delay time) before executing the next action. 

 

Figure 2.29. Selecting an Action Destination 

5. Select from the Media Template list only if you wish to override the previously defined template under the 
multimedia agent. 

6. If you are listing more than one Alarm Action to follow, you have the option of having them all occur at once 
or delaying the next action to take place. If you want the next action to take place at the same time as the 
previous one, leave the Delay set to 0 minutes. If you want the next action to take place after a certain 
number of minutes (if the Stop Action Condition has not yet been met) enter the number of minutes under 
Delay, min. 

7. Check the Ignore Schedule box only if you wish to override any predefined schedules. (See Chapter 6 for 
information about schedules.) 

8. To set the Action Attributes, click the … button in each row. Select when to initiate each action: in the state 
of an Alarm, a Return to Normal, or an Acknowledgement, as shown in Figure 2.30. 

 

Figure 2.30. Selecting an Alarm Action Attribute 

Note: The action attribute for the first alarm action in the action set should be set to "Alarm."  Use of Return 
to Normal or Acknowledgement action attribute settings requires an associated Alarm action attribute.  The 
Alarm action attribute must be listed in the action set before Return to Normal or Acknowledgement.  Only 
action destinations that receive the alarm message will receive the return to normal or acknowledgement 
messages. An example of this is shown in Figure 2.31. 
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Figure 2.31. Alarm Action Attribute Listed in Action Set 

9. The Stop Actions Condition field is where you define what will stop the list of Alarm Actions from 
escalating to the next action. If you do not check any of the options, the complete list of actions will occur 
regardless of whether any alarms were acknowledged or returned to normal.  

• If you check Acknowledgement Received, the list of actions will continue until one of the actions is 
acknowledged. The acknowledgement can be verified by either a multimedia agent or the alarm viewer.  

• If you check Values Returned To Normal, the list of actions will continue until the values return to 
normal. 

• If you check Return to Normal AND Acknowledgement, the list of actions will continue until one of the 
actions is acknowledged and the values return to normal. 

• Checking Receipt Confirmation tells the Multimedia Server that, yes, the alarm has been responded to, 
but does not mark the alarm as acknowledged. Therefore, the alarm will not be shown as acknowledged 
in the alarm viewer. 

• If more than one stop actions condition is checked, the complete list of actions will occur until all 
conditions have been met. For example, if both Values Returned to Normal and Receipt Confirmation 
are checked, the actions will occur until both the values have returned to normal and a confirmation has 
been sent through the multimedia agent. 

Note: The use of stop actions conditions is not required. However, if you do not select a stop actions 
condition, the infinite actions loop is disabled. 

10. Use the Actions Loop field if you wish to return to the first action destination and repeat all alarm actions 
until the specified stop actions condition has been met. If you want the loop to be repeated continuously, 
select Infinite Loop. If you want the loop to be repeated only a certain number of times, select Repeat and 
then enter the number of times you want the actions loop to be repeated. Alternatively, if you do not want an 
actions loop, select Don't Loop at All. 

Note: Be careful when enabling action looping.  The Actions Loop is performed after the delay of the last 
action in the action set.  It is possible for agents to queue hundreds of action requests.  This occurs if the 
agent takes more time to process action requests than it takes to repeat the action loop. 

11. Check Enable This Action Set for your alarm actions to take effect, and then click Apply. 

To delete an alarm action entry, click on the gray cell to the left of that entry to select the entire row and press the 
Delete key. 

Note: The Stop Actions Condition options apply to the escalating list of actions to be taken and not to one 
individual alarm action. However, if you only have one action and would like it to continue happening until it is 
acknowledged or until the values return to normal, check Enable Alarm Actions Loop and choose the Stop 
Actions Condition you wish to use to stop the action. 

Note: You can also assign a role as an action destination. For information about configuring roles, please see 
Chapter 6. 



Creating Alarm Configurations 
 

2.26 

2.7 Activating the Database 
Once your alarm configuration is complete, you need to make sure that it is the active database. The database 
that is currently active is the one that the OPC server will use. To make the current database active, select Make 
Active… from the File menu of the Configurator, as shown in Figure 2.32. If the Make Active… selection is 
grayed out, then the current database is already the active database. 

A dialog box will appear showing both the current active database and database that is currently being edited. To 
set the edited database as the active database, click the Yes button. 

If you make changes to the database while the server is running, you can update the server with your changes 
while it is running. To do this, click the Update Server Data button on the toolbar.  

 

Figure 2.32. Activating the Database 

2.8 Starting the Multimedia Server 
In order for the Multimedia Server to use the information in the configuration database, the server must be placed 
into “runtime” mode. To start/stop the server, click the stoplight button on the toolbar, or select Start Multimedia 
Server from the Action menu, as shown in Figure 2.33. 

If you make changes to the database while the server is running, you can update the server with your changes 
while it is running. To do this, click the Update Server Data button on the toolbar. 

Note: You can also start/stop the Multimedia using the ProcViewTray tool tray. For more information, please see 
the ProcViewTray Help documentation. 

 

Figure 2.33. Starting the Multimedia Server 
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Multimedia Configuration Wizard 
3.1 Using the Multimedia Configuration Wizard 

The Multimedia Configuration Wizard is a key feature of AlarmWorX Multimedia that helps you create and 
configure alarms. The Multimedia Configuration Wizard provides a simple, user-friendly walk-through that guides 
you through the creation and configuration of alarms. Using the Multimedia Configuration Wizard simplifies the 
alarm configuration process down to the following steps:  

Step 1. Use the Multimedia Configuration Wizard to configure an alarm.  
Step 2. Make the database active. 
Step 3: Start the Multimedia Server. 

Multimedia Assistant 
For additional help on configuring alarms, you can consult the Multimedia Assistant, shown in Figure 3.1, at any 
time. To launch the Multimedia Assistant, select Multimedia Assistant from the Help menu. Follow the 
instructions provided by the Multimedia Assistant. 

 
Figure 3.1. Multimedia Assistant 

3.1.1 Starting the Multimedia Configuration Wizard 
The Multimedia Configuration Wizard consists of a series of dialog boxes that guide you through alarm 
configuration. To start the Multimedia Configuration Wizard, click the Multimedia Configuration Wizard button 
on the Configurator toolbar, or select Multimedia Configuration Wizard from the Tools menu. Follow the 
instructions in the dialog boxes. 

1. The first step in the Multimedia Configuration Wizard is to enter a name for your alarm configuration, as 
shown in Figure 3.2. You can also select an existing configuration from the drop-down list. Click Next to 
continue to Step 2.  

 
Figure 3.2. Step 1: Entering a Name for the Configuration 
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2. In Step 2, you must select an OPC subscription to use with the configuration. You have the option of creating 
a new OPC subscription or selecting an existing one. An OPC subscription is a connection to a local or 
remote alarm OPC server. Create New OPC Subscription is selected by default, as shown in Figure 3.3. 
Click Next to continue to Step 3.  

 

Note: If you wish to use an existing OPC subscription, select Use Existing OPC Subscription and click 
Next. The Multimedia Configuration Wizard will skip to Step 4. 

 
Figure 3.3. Step 2: Selecting an OPC Subscription 

3. Enter a name for your new OPC subscription, and click the Subscribe Now! button, shown in Figure 3.4. 
Clicking this button will launch the Subscription Properties dialog box, which allows you to add and 
configure one or more OPC Alarm and Event server connections. If you have successfully connected, the 
traffic light icon on the dialog box will turn green. Once you have a green light, click Next to continue to Step 
4. 

 

Note: Please refer to Chapter 2 for more information on alarm subscription properties. 

 
Figure 3.4. Step 3: Creating a New OPC Subscription 
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4. You are now ready to configure an alarm action set. An Action Set is a collection of tasks to be delegated to 
various multimedia agents (marquee, sound, e-mail, etc.). Give the action set a name and supply information 
on when the action set is to stop, as shown in Figure 3.5. If you choose to enable the alarm actions loop, 
then the multimedia actions will return to the first action destination and repeat all alarm actions until the 
specified stop actions condition has been met. 

 
Note: For more information on creating an alarm action set and choosing stop actions conditions, please refer 
to Chapter 2. 

 
Figure 3.5. Step 4: Configuring an Alarm Action Set 

5. The next step is to create or specify a filter for your action set, as shown in Figure 3.6. If you wish to use an 
existing filter, simply select the appropriate option button and pick from the list of existing filters provided. To 
create a new filter, select the first option and click Next. If you have chosen an existing filter, or if you have 
chosen not to use a filter at all, the Wizard will skip to Step 7. 

 
Figure 3.6. Step 5: Adding a Filter to an Alarm Action Set 
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6. If you chose in Step 5 to create a new filter, you will be asked in Step 6 to enter a name and an expression for 
your filter, as shown in Figure 3.7. Click the Edit Filter Expression… button to launch the Expression Editor, 
which enables you to set up your alarm filters. 

 
Note: For help on writing expressions, please refer to Chapter 2. 

 
Figure 3.7. Step 6: Configuring the New Alarm Filter 

7. In Step 7, you have the option of selecting a multimedia agent to respond to your action set, as shown in 
Figure 3.8. The corresponding multimedia agent will be configured for the action that you selected.  

 
Note: The Sending Alarm Over the Phone Line option in Figure 3.8 applies only to the Call-out Agent. The 
Configuration Wizard does not support the Call-in Agent. 

 
Figure 3.8. Step 7: Adding a Multimedia Agent to the Alarm Action Set 

8. Once you have specified a multimedia agent, you will be prompted to create a new configuration or specify an 
existing configuration for that agent, as shown in Figure 3.9. To create a new agent configuration, select the 
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appropriate option and click Next. If you choose to specify an existing agent configuration, select it from the 
provided drop-down list, and then click Next.  

 
Note: If you choose to use an existing agent configuration, the wizard will skip to Step 10. 

 
Figure 3.9. Step 8: Configuring a Multimedia Agent 

9. In Step 9, enter a name for the multimedia agent configuration, as shown in Figure 3.10. Also choose a node 
on which to run the agent. You can browse for the node by clicking the ... button to the right of the node name 
field. If you leave the node name field blank, the local node name will be assumed. The remaining items to be 
filled in vary from one agent to the next. The example in Figure 3.10 shows a sample configuration for the 
Marquee Agent. This configuration asks the marquee to repeat the alarm message once—play it twice (a 
repeat of zero means play once)—and accept any acknowledgement where a user entered "12345" as an 
acknowledgement code. If this were the configuration for the E-mail Agent, for example, there would be 
places to fill in the 'To:', 'CC:' and 'Subject' fields. Different agents call for different configurations. 

 
Figure 3.10. Step 9: Configuring the Settings for the Multimedia Agent 
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10. The next step is to create or specify a media template for the multimedia agent, as shown in Figure 3.11. A 
media template is simply a way of specifying exactly what information is to be sent to the agent. To create a 
new template, select the appropriate option and click Next. To use an existing template, select an existing 
template from the provided drop-down list.  

 
Note: If you use an existing template, the Wizard will skip to Step 12. 

 
Figure 3.11. Step 10: Selecting a Media Template for the Multimedia Agent 

11. In Step 11, enter a name for the template and select the alarm components to be delivered to the multimedia 
agent, as shown in Figure 3.12. For some agents, additional options will be available to you. 

 
Figure 3.12. Step 11: Creating a New Media Template 

12. Once the media template is configured, you have the option of selecting more multimedia actions for your 
action set, as shown in Figure 3.13. If you choose to add another multimedia action, specify a waiting time 
between the action you just configured and the action to be added. The Wizard will go back to Step 7, where 
the next multimedia agent can be selected. If you choose not to add another action set, the Wizard will 
proceed to Step 13. 
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Figure 3.13. Step 12: Selecting Additional Actions for the Action Set 

13. The last step of the Wizard gives you the option of adding more action sets to be connected to your alarm 
OPC server, as shown in Figure 3.14. If you choose to add another action set, the Wizard will take you back 
to Step 4. Otherwise, the Wizard will notify you that it has been completed successfully. 

 
Figure 3.14. Step 13: Adding More Action Sets to the Configuration 

14. Click the Finish button to complete your alarm configuration. Your new alarm configuration will appear under 
the Alarm Configurations tree control of the Configurator. 
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3.2 Making the Database Active 
Once your alarm configuration is complete, you need to make sure that it is the active database. The database 
that is currently active is the one that the OPC server will use. To make the current database active, select Make 
Active… from the File menu of the Configurator, as shown in Figure 3.15. If the Make Active… selection is 
grayed out, then the current database is already the active database. 

A dialog box will appear showing both the current active database and database that is currently being edited. To 
set the edited database as the active database, click the Yes button. 

If you make changes to the database while the server is running, you can update the server with your changes 
while it is running. To do this, click the Update Server Data button on the toolbar.  

 
Figure 3.15. Activating the Database 

Note: For information about advanced database settings and upsizing databases to MSDE and SQL, please see 
Appendix D. 

3.3 Starting the Multimedia Server 
In order for the Multimedia Server to use the information in the configuration database, the server must be placed 
into “runtime” mode. To start/stop the server, click the stoplight button on the toolbar, or select Start Multimedia 
Server from the Action menu, as shown in Figure 3.16. 

If you make changes to the database while the server is running, you can update the server with your changes 
while it is running. To do this, click the Update Server Data button on the toolbar. 

Note: You can also start the Multimedia using the ProcViewTray tool tray. For more information, please see the 
ProcViewTray Help documentation. 

 
Figure 3.16. Starting the Multimedia Server  
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Multimedia Agents 
4.1 Introduction to Multimedia Agents 

The Multimedia Configurator contains the following multimedia agents for configuring alarms: 

• E-mail Agent: Sends an e-mail message. (See Section 4.2.) 
• Sound / Text-to-Speech Agent: Plays prerecorded sounds and/or speech from text locally or remotely 

over a network. (See Section 4.3.) 
• Marquee Agent: Creates a marquee window displaying a message locally or remotely over a network. 

(See Section 4.4.) 
• Pager Agent: Sends a message to a pager. (See Section 4.5 and Appendix A.) 
• Telephony Agents: The Call-out Agent calls a defined number and gives a message with options to 

respond. The Call-in Agent enables callers to dial in by phone to get alarm information and browse for 
OPC Data Access tags. (See Section 4.6, Chapter 9, and Appendix B.) 

• Fax Agent: Sends a message to a fax machine. (See Section 4.7.) 
• Instant Messaging Agent: Sends a message to any computer using instant messaging. (See Section 

4.8 and Appendix E.) 
• Popup Agent: Opens an application of your choice (e.g. Internet Explorer) to provide alarm messages. 

(See Section 4.9.) 
• Video Agent: Plays a video, which can be a prerecorded video or a video captured at the moment of the 

alarm. (See Section 4.10.) 
• PA Agent: Uses a public address (PA) system device to announce alarms and events over a 

loudspeaker. (See Section 4.11.) 
Note: Be sure to test your multimedia agent configurations by using the TEST button in the configuration field for 
each agent. 

 

Multimedia Agents Tree Control 
The Multimedia Agents tree control of the Configurator is shown in Figure 4.1. In the right-hand pane, you can 
view the agents By Type or By Node.  

 
Figure 4.1. Multimedia Agents Tree Control 

Clicking the Replace Node button opens the Node Replace dialog box, shown in Figure 4.2, which allows you to 
reassign multiple multimedia agents to run on a different node. In the Replace field, select the node you wish to 
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replace. In the With field, click the … button to select a new node. If the With field is empty, the local node is used 
by default. 

 
Figure 4.2. Replacing a Node 

Clearing Agent Queue 
Each multimedia agent configuration contains an Empty Agent’s Input Queue button, as shown in Figure 4.3. 
Clicking this button cancels all requests made by the Multimedia Server to that agent, clearing all pending 
messages for the nodes on which the agent is configured. 

Note: You can cancel queues to all agents by clicking the Stop button on the Configurator toolbar. 

 
Figure 4.3. Emptying Agent Queue 

4.2 E-mail Agent 
The E-mail Agent, shown in Figure 4.4, allows you to receive and acknowledge alarms using an e-mail message. 
For information about acknowledging alarms and creating templates for the E-mail Agent, see Appendix E. 

E-mail Configuration Fields 
The following configuration fields are available for the E-mail Agent: 

• E-mail Name: Enter a name for the e-mail contact. 
• Node Name: Enter the node name for the computer from which you wish to send the e-mails. If left 

blank, the e-mails will be sent from the computer running the Multimedia Server. Click the Browse button 
to search for a node. 

• Scheduling: If you are using scheduling, you can choose from the configured schedules on the drop-
down list. 

• Send To: Enter the e-mail address of the recipient to whom you wish to send the e-mail message. 
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Figure 4.4. E-Mail Agent 

• Cc:  Sends a carbon copy of the e-mail to another recipient. 

• BCc: Sends a "blind" carbon copy of the e-mail message to another recipient. 

• Acknowledge Code: Enter the string you wish to use as the acknowledge code. (For information about 
acknowledging alarms using e-mail, see Appendix E.) 

• Use Template: You must choose a template to be used with the E-mail Agent. The template determines 
the actual message that gets sent to e-mail recipients. The Configurator includes a template, called 
Default Email, created for sending e-mail messages. For more information about templates, please see 
Chapter 5. 

• Priority: This is used with roles. If more than one person is on schedule (or one person has more than 
one agent configured using his schedule), then the agent with the highest priority will be the one that is 
carried out. 

• Description: Allows you to add comments to the agent configuration. 

• Delivery Specific: Uses the E-mail Agent to send an optimized message to a pager. You can still use 
the E-mail Agent to send a message to a pager without checking this. However, checking this decreases 
the character count of the identifier variables, thus reducing the cost in pagers that charge according to 
number of characters.  
Note: Using this option will limit you to 99,999 unique messages before resetting the numbering back to 
one. 

• TEST button: Sends an e-mail message to test your configuration. 

• Apply button: Saves all changes to the configuration database. 
• Reset button: Clears all recently added information. 
• Add New E-mail Media Item: Adds a new agent to be configured. You can also add a new E-

mail Agent by right-clicking the E-mail folder on the tree control and selecting New - E-Mail 
Contact from the pop-up menu.  

 
To operate the E-mail Agent, a MAPI-compliant third-party e-mail program must be on the computer from which e-
mails are sent. Microsoft® Outlook is an example of a MAPI-compliant third party e-mail program. Microsoft 
Outlook Express can also be used and can be downloaded for free from Microsoft. However, unlike Outlook, 
Outlook Express will only work with POP3 e-mail servers. It is not necessary to have the e-mail program actively 
running on a Windows NT or Windows 2000 operating system. It is, however, necessary to have the e-mail 
program actively running on a Windows 98 operating system. Outlook 2002 and Outlook Express version 6 
require additional security settings in order for the E-mail Agent to work properly. For more information, go to 
http://www.microsoft.com/office/ork/xp/appndx/appa11.htm. 
The E-mail Agent will only operate on e-mail messages in the e-mail programs default folder. For example, a reply 
with an acknowledge code will only be seen if sent to the default e-mail programs folder (Inbox for Microsoft 
Outlook). If you set up your e-mail program to reroute your mail to other various folders, the multimedia agent 
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might not read the incoming e-mail. For more information about acknowledging alarms using the E-mail Agent, 
see Appendix E. 
 

Using the E-mail Agent to Page 
For high-volume applications, it is often better to use the E-mail Agent for pager support.  This is due to the fact 
that a majority of pager services support e-mail to page.  Set the SentTo field to "Pager number @Pager service."  
(e.g. 5551234@service.com).  This causes the pager service’s e-mail system to process the e-mail and send the 
information to the pager.  This method avoids the delay associated with modem dial-up.  The downside is that 
through put is limited by the Internet connection rather than the telephone connection.   

4.3 Sound / Text-to-Speech Agent 
The Sound / Text-to Speech Agent, shown in Figure 4.5, allows you to send alarm information using a sound 
message. 

Note: The sound message is specified in the sound template, where you can select a sound (.wav) file from the 
Sound Library or enter a text message to be converted to speech. You can also add your own sound files to the 
Sound Library. For information about selecting sound files, please see Section B.2 of Appendix B. For 
information about templates, please see Chapter 5. 

 
Figure 4.5. Sound / Text-to-Speech Agent 

Sound Configuration Fields 
The following configuration fields are available for the Sound / Text-to-Speech Agent: 

• Sound Media Name: Enter a name for the configuration. 

• Scheduling: If you are using scheduling, choose from the configured schedules on the drop-down list. 

• Node To Play Sound On: Enter the node name for the computer on which you wish to play the sound. If 
this field is left blank, the sounds will be played on the computer running the Multimedia Server. Click the 
Browse button to search for a node. 

• Template Name: You must choose a template to be used with the agent. The Agent plays a sound that 
is specified in the sound template, where you can select a sound (.wav) file from the Sound Library or 
enter a text message to be converted to speech. The Configurator already includes templates, called 
Default Sound Wav and Default Sound Speech, created for sending sound messages. 

• Description: Allows you to add comments to the agent configuration. 

• Priority: This is used with roles. If more than one person is on schedule (or one person has more than 
one agent configured using his schedule), then the agent with the highest priority will be the one that is 
carried out. 
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• Play: Plays the sound message a specified number of times. 

• Maximum Play Time: Sets a maximum play time (in minutes).  

• TEST button: Plays a sound message to test your configuration. 

• Apply button: Saves all changes to the configuration database. 

• Reset button: Clears all recently added information. 

• Add New Sound Media Item: Adds a new agent to be configured. Note that you can also add a new 
Sound / Text-to-Speech Agent by right-clicking the Sound / Text To Speech folder on the tree control 
and selecting New - Sound / Text To Speech from the pop-up menu. 

General Settings 
To change the voice type, click on the General Settings button while in the main Sound / Text To Speech folder, 
as shown in Figure 4.6. If you do not see the General Settings button, make sure that Dialog View is checked 
on the View menu. 

 
Figure 4.6. Sound / Text-to-Speech Agent: General Settings 

Clicking the General Settings button opens the  Voice Configuration dialog box, shown in Figure 4.7, which 
allows you to change the voice type. 

 
Figure 4.7.  Voice Configuration Dialog Box 

4.4 Marquee Agent 
The Marquee Agent, shown in Figure 4.8, allows you to send alarm information using a message to a computer 
or a marquee device box. To acknowledge an alarm, right-click in the marquee window and select Acknowledge. 

Marquee Configuration Fields 
The following configuration fields are available for the Marquee Agent: 

• Marquee Media Name: Enter a name for the Marquee Agent configuration. 

• Scheduling: If you are using scheduling, choose from the configured schedules on the drop-down list. 

• Node To Use Marquee On: Enter the node name for the computer on which you wish run the Marquee 
Agent. If left blank, the Marquee Agent will be run on the computer that is running the Multimedia Server. 
If you wish to display the message on a separate marquee device, this is configured under General 
Settings in the main Marquee folder. (See the "General Settings" section below.) Click the Browse 
button to search for a node. 
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Figure 4.8. Marquee Agent 

• Use Template: You must choose a template to be used with the agent. The template determines what 
information is displayed in the marquee message. The Configurator includes a template, called Default 
Marquee, created for sending marquee messages. For more information about templates, please see 
Chapter 5. 

• Description: Allows you to add comments to the agent configuration. 

• Acknowledge Code: Enter the string you wish to use as the acknowledge code. 

• Priority: This is used with roles. If more than one person is on schedule (or one person has more than 
one agent configured using his schedule), then the agent with the highest priority will be the one that is 
carried out. 

• Play: Specifies the number of times the marquee message will be displayed. 

• Maximum Play Time: Sets a maximum play time (in minutes).  

• TEST button: Displays a test marquee message. 

• Apply button: Saves all changes to the configuration database. 

• Reset button: Clears all recently added information. 

• Add New Marquee Media Item: Adds a new Marquee Agent to be configured. Note that you can also 
add a new Marquee agent by right-clicking the Marquee folder on the tree control and selecting New - 
Marquee Item from the pop-up menu. 

General Settings 
The following options are set for all marquee items within the Marquee folder on the tree control. To change any 
of these options, click on the General Settings button while in the main Marquee folder, as shown in Figure 4.9. 
If you do not see the General Settings button, make sure that Dialog View is checked on the View menu. 

 
Figure 4.9. Marquee Agent: General Settings 
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Clicking the General Settings button opens the Marquee Properties dialog box, shown in Figure 4.10, which 
contains the following settings. 

 
Figure 4.10. Marquee Properties Dialog Box 

Output Destination 
The Output Destination field allows you to choose whether to have the marquee displayed across a window on a 
computer monitor or across a separate hardware device. 

Device Attributes 
The Device Attributes field allows you to choose the type of device (serial or Ethernet) and to configure 
advanced settings for that device. Clicking the Settings button opens the Serial Device Settings dialog box, 
shown in Figure 4.11, which allows you to set the Port, Baud, Data Bits, Parity, Stop Bits, and Maximum 
Characters. 
The Stock Ticker setting is a scrolling screen mode that allows the hardware device to scroll letters across the 
screen. 
The Traditional mode allows the hardware device to display the entire text string. This mode displays the text 
string all at once without scrolling. 

 
Figure 4.11. Serial Device Settings Dialog Box 
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The Ethernet Device Settings allow you to specify the port and IP address for the hardware device, as shown in 
Figure 4.12.  

 
Figure 4.12. Ethernet Device Settings 

Window Attributes 
• Always on Top: Makes the marquee display visible on top of other open windows at all times. 
• Show Title Bar: Shows (checked) or hides (unchecked) the title bar of the marquee window. 

• Allow Resize: Resizes the marquee window horizontally while it is being displayed. 

• Allow Vertical Resize: Resizes the marquee window horizontally as well as vertically while it is being 
displayed. 

• Auto Hide: Automatically minimizes the marquee window after a message is displayed. 

• Background Color: Sets the background color for the marquee window. 

Scrolling Attributes 
• Speed: Sets the speed of the marquee message display. 

• Direction: Sets the direction of the marquee message display. 

• Minimum Space Between Alarms: Sets the minimum amount of space (as a percentage of viewing 
area) between alarm messages. 

Test Message 
This option allows you send a test message showing the configuration options you have selected, as shown in the 
example in Figure 4.13. 

 
Figure 4.13. Marquee Test Message 

Note: If you choose to have the Marquee Agent run on a remote node and that node is running on Windows 95 or 
Windows 98, then the Marquee Agent must be open on that computer for it to display messages. If the node is 
running on Windows NT or Windows 2000, it is not necessary to have the agent already open. 

4.5 Pager Agent 
The Pager Agent, shown in Figure 4.14, allows you to send alarm information using a message to a pager. The 
Pager Agent sends alarm information to a pager via dial-up modems. (Please see Appendix A for information 
about pager services.) 
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Pager Agent Configuration Fields 
The following configuration fields are available for the Pager Agent: 

• Pager Media Name: Enter a name for this pager configuration. 

• Node Name: Enter the node name for the computer from which you wish to send the e-mail messages. If 
this field is left blank, the e-mail messages will be sent from the computer that is running the Multimedia 
Server. Click the Browse button to search for a node. 

• Scheduling: If you are using scheduling, choose from the configured schedules on the drop-down list. 

• Pager Number: Enter the number of the pager to which you wish to send the message. Use the General 
Settings button in the Pager/SMS/GSM/TAP folder to configure pager services, dial-out numbers, 
modem properties, port settings, etc. (See the "Steps for Configuring the Pager Agent" section below for 
more information.) For details about pager service protocols, please see Appendix A. 

• Acknowledge Code: Enter the string you wish to use as the acknowledge code. 

 
Figure 4.14. Pager Agent 

• Use Template: You must choose a template to be used with the Pager Agent. The template determines 
the actual message that gets sent to configured pagers. You can select whether the message includes 
the timestamp of the alarm, the tag name that generated the message, the actual alarm message itself, 
and many other parameters. The Configurator includes a template, called Default Pager, created for 
sending alphanumeric pager messages. For more information about templates, please see Chapter 5. 

• Priority: This is used with roles. If more than one person is on schedule (or one person has more than 
one agent configured using his schedule), then the agent with the highest priority will be the one that is 
carried out. 

• Description: Allows you to add comments to the agent configuration. 

• TEST button: Sends a pager message to test your configuration. 
• Use GSM/PCS Service: Select the GSM/PCS service you wish to use with the Pager Agent from the 

drop-down list. 

• Use Modem/ISDN Service: Select a service to use with your modem or ISDN line from the drop-down 
list. 

• Apply button: Saves all changes to the configuration database. 

• Reset button: Clears all recently added information. 

• Add New Pager Media Item: Adds a new Pager Agent to be configured. Note that you can also add a 
new Pager Agent by right-clicking the Pager/SMS/GSM/TAP folder on the tree control and selecting New 
- Pager Contact from the pop-up menu. 
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Steps for Configuring the Pager Agent 
When configuring the Pager Agent, use the following procedure. (For advanced pager settings and more detailed 
information about configuring the Pager Agent, please see Appendix A.) 
Step 1: Configure a modem for your computer by going to the operating system's control panel and following the 
steps for configuring a modem. 
Step 2: Ensure that your modem is working correctly by using HyperTerminal™ or any third-party dial-up 
software.  
Step 3: In the  Multimedia Configurator, open the Alarm Configurations folder and the Multimedia Agents 
subfolder. Click on Pager/SMS/GSM/TAP, and then click on the General Settings button located on the right-
hand side of the window, as shown in Figure 4.15. 

 
Figure 4.15. Pager Agent: General Settings 

Step 4: Clicking the General Settings button launches the Multimedia Pager TAP/SMS dialog box, shown in 
Figure 4.16. Under Diagnostic Utilities, you can choose to enable the TAP log file, the Multimedia Pager TAP 
Diagnostic dialog box, and/or the Multimedia Pager SMS Diagnostic dialog box. The log file is only used for 
diagnostic utilities (limited to 10 KB). 

 
Figure 4.16. Multimedia Pager TAP/SMS Dialog Box 

When the display enters runtime mode and the Use GSM/PCS Service option is selected in the Pager Agent 
configuration field, the Pager SMS Diagnostic dialog box will open, as shown in Figure 4.17. 

 
Figure 4.17. Pager SMS Diagnostic Dialog Box 
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When the display enters runtime mode and the Use Modem/ISDN Service option is selected in the Pager Agent 
configuration field, the Pager TAP Diagnostic dialog box will open, as shown in Figure 4.18. Clicking the Open 
Log... button opens the TAP log file (if the log file was enabled in the TAP/SMS dialog box). 

 
Figure 4.18. Pager TAP Diagnostic Dialog Box 

Step 5: Click the Modem Configuration button to open the DERDACK® Message Master™ Configuration 
Software dialog box, shown in Figure 4.19. Select whether you wish to use modem/ISDN or GSM/PCS service 
for paging. 

 
Figure 4.19. DERDACK Message Master Configuration Software Dialog Box 

Step 6: Click the Config... button to open the Settings dialog box, shown in Figure 4.20. Fill out the information 
in the General, Ports, Services, and Messages tabs with the appropriate information. At any time, you can get 
help by clicking the Help button to launch the Message Master help documentation. 
Note: Figure 4.20 shows the configuration settings for GSM/PCS configuration. The Modem/ISDN configuration 
settings are slightly different. On the Defined Services tab of the Modem/ISDN configuration settings dialog box, 
if you create a new service, the country code for the service must be included in parentheses at the end of the 
service name. When specifying a telephone number for the service, there is a strict protocol for how you enter the 
number, which must conform to the following format. Parentheses, where shown, are necessary: 

+1 (area code) number. Example: +1 (800) 5551234 
For international calls, replace the '1' with the appropriate country code. See the Message Master help or 
Appendix A for more information. 
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Figure 4.20. DERDACK Message Master Configuration Settings Dialog Box 

Step 7: In the Multimedia Configurator, fill out all of the necessary configuration fields.  

Note: If no services are listed next to the two options for Modem/ISDN and GSM/PCS, you need to manually 
launch an application to install these services. (This application is normally executed at the end of the installation 
for AlarmWorX32 Multimedia.) The application, called SrvSetup.exe, is located in the "Bin/Pager" directory. Run 
this application, and at the first menu select "Services.inf." See Appendix A for more information. 

4.6 Telephony Agents 
Two separate agents are included under the Telephony folder of the Configurator tree control: the Call-in Agent 
and the Call-out Agent.  

4.6.1 General Settings 
To set the default settings for the Telephony Agents (Call-in and Call-out), click on the Telephony folder, as 
shown in Figure 4.21. If you do not see the General Settings, make sure that Dialog View is checked on the 
View menu. Configure the default settings for the Telephony Agents as described below. 

 
Figure 4.21. Telephony Agents: General Settings 
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Phone Lines 
• Number of Lines: Sets the total number of phone lines that will be used by the Phone Agents.  

Note: The number of lines specified must be less than or equal to the actual number of phone lines that 
will be used. If the number of lines specified in the Configurator is greater than the actual number of lines 
in use, the Call-in Server will work under the assumption that additional phone lines are available even 
though the lines do not actually exist. Although up to 20 lines are supported, the number of lines that can 
be used may be limited by the type of Dialogic board. See Appendix B for details. 
 
Note: The telephony agents currently support up to 20 phone lines. However, the agent has been tested 
with a maximum of four phone lines.  

• Incoming Calls: Specifies which phone lines will be reserved for incoming calls. 

• Outgoing Calls: Specifies which phone lines will be reserved for outgoing calls. 
Note: When specifying which phone lines will be reserved for incoming and outgoing calls, the first line 
will always be line "0". For example, suppose you will be using a total of three lines, as shown in Figure 
4.21. The first line is "0", the second line is "1", and the third line is "2". Since the first and second lines 
will be used for incoming calls, enter "0" and "1" in the Incoming Calls field, as shown in Figure 4.21. 
The third line will be used for outgoing calls, so enter "2" in the Outgoing Calls field, as shown in Figure 
4.21. 
Any phone lines that are not reserved will be used as general purpose lines (i.e. for either incoming or 
outgoing calls).  
Note: If you are using only one telephone line, you cannot reserve the single line for both incoming and 
outgoing calls. Therefore, to configure a single-line system, both the Incoming Calls field and the 
Outgoing Calls field should be left blank. 

Menus Security and Timeouts 
• Call-in PIN Protect: Specify a numeric password or PIN that users must enter prior to each menu in 

order to progress through the phone menus in the Call-in Agent.  
Note: This is different from the general security settings used for logging into the phone system. (The 
login settings are configured in the Call-in Agent tree control.) 

• Restrict same menu visits to : Limits the number of times a user can access the same menu through 
the Call-in Agent. This limits the overall time users can remain in the phone system to prevent users from 
tying up the phone lines. 

• Password Retries: Sets the number of times a user will be allowed to enter an incorrect password on 
the phone keypad. 

• Initial Key Timeout: Sets the number of seconds the phone will wait for a key press before retry. 

• Inter-Key Timeout: Sets the number of seconds allowed between key presses on the phone keypad 
before ending caller input. 

• Total Time: Sets the total consecutive time (in seconds) that a caller may spend in the same menu 
before timeout.  This includes the time the system uses to process and deliver the text-to-speech 
messages to the caller.   

Dialogic Configuration 
You must have a telephony card installed on the computer on which you are running the Telephony Agents (both 
Call-in and Call-out). AlarmWorX32 Multimedia supports Intel® Dialogic® boards. Dialogic boards do not work 
for Windows 98, so neither the Call-in Agent nor the Call-out Agent will work on Windows 98. You also 
need to have an analog phone line connected to the board. (Note: Digital lines are not supported.) Only Dialogic 
boards are supported for the current version of AlarmWorX32 Multimedia. Please see Appendix B for information 
about installing and configuring Intel Dialogic boards. For more information about purchasing and installing Intel 
Dialogic boards, please visit the Intel Web site at www.intel.com/network/csp/products/index_vp.htm. 



Multimedia Agents 
 

4.14 

4.6.2. Call-in Agent 
The Call-in Agent, shown in Figure 4.22, enables users to access OPC data over the phone. The Call-in Agent 
configuration sets up the voice and key entries and menu options based on information supplied from the 
Multimedia configuration database and the current state of OPC data or alarms and the security level of the user 
calling into the system. The Call-in Agent configuration is too extensive to be described in this section. For 
complete information about configuring settings for the Call-in Agent, please see Chapter 9. 
Note: The following Configurator features do NOT apply to the Call-in Agent: the Multimedia Configuration 
Wizard, action sets, and schedules. 
Note: Dialogic boards do not work for Windows 98, so the Call-in Agent will not work on Windows 98.  

 
Figure 4.22. Call-in Agent: General Settings 

4.6.3. Call-out Agent 
The Call-out Agent, shown in Figure 4.23, sends alarm messages out over the telephone. Note: Dialogic 
boards do not work for Windows 98, so the Call-out Agent will not work on Windows 98.  

 
Figure 4.23. Call-out Agent 

Call-out Agent Configuration Fields 
The following configuration fields are available for the Call-out Agent in the Configurator tree control under Local 
Phone, as shown in Figure 4.23. (Note: Local Phone is an example Call-out Agent configuration.) 

• Call-Out Media Name: Enter a name for the Phone Agent configuration. 

• Scheduling: If you are using scheduling, choose from the configured schedules on the drop-down list. 

• Phone Number To Call: Enter the phone number you want the agent to call. 

• Node To Use: Enter the node name for the computer from which you to run the Phone Agent. If this field 
is left blank, the Phone Agent will be run from the computer running the Multimedia Server. Click the 
Browse button to search for a node. 
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• Use Template: You must choose a template to be used with the agent. The template determines the 
actual message that gets sent to the phone number specified. The Configurator includes a template, 
called Default Telephone, created for sending call-out messages over the phone. For more information 
about templates, please see Chapter 5. 

• TEST button: Tests your call-out configuration. 

• Acknowledge Code: Enter the number you wish to use as the acknowledge code. 

• Priority: This is used with roles. If more than one person is on schedule (or one person has more than 
one agent configured using his schedule), then the agent with the highest priority will be the one that is 
carried out. 

• Retry: Sets the number of attempted calls to make to the specified phone number before timing out. 
• Delay between attempts: Sets the number of seconds between subsequent phone call retry attempts. 
• Description: Allows you to add comments to the agent configuration. 

• Apply button: Saves all changes to the configuration database. 

• Reset button: Clears all recently added information. 
• Add New Telephone Media Item: Adds a new Call-out Agent to be configured. Note that you 

can also add a new Call-out Agent by right-clicking the Call-out Agent folder on the tree 
control and selecting New - Phone Contact from the pop-up menu. 

4.7 Fax Agent 
The Fax Agent, shown in Figure 4.24, allows you to send alarm information using a fax machine. The fax agent 
supports class 1, most class 2, and class 2.0 fax standards. It is not possible to be more specific on the class 2 
standard because it was never a finalized standard. (Note: Color faxes are not supported.) 

Fax Configuration Fields 
The following configuration fields are available for the Fax Agent: 

• Fax Media Name: Enter a name for the Fax Agent configuration. 

• Node To Send Fax From: Enter the node name for the computer on which you wish to run the Fax 
Agent. If this field is left blank, the Fax Agent will be run on the computer that is running the Multimedia 
Server. Click the Browse button to search for a node. 

 
Figure 4.24. Fax Agent 

• Scheduling: If you are using scheduling, choose from the configured schedules on the drop-down list. 

• Send To Fax Number: Enter the fax number here. 
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• Acknowledge Code: This field is not supported. 

• Use Template: You must choose a template to be used with the agent. The template determines the 
actual message that gets faxed to the number specified. The Configurator includes a template, called 
Default Fax, created for sending messages to a fax machine. For more information about templates, 
please see Chapter 5. 

• Description: Allows you to add comments to the agent configuration. 

• Priority: This is used with roles. If more than one person is on schedule (or one person has more than 
one agent configured using his schedule), then the agent with the highest priority will be the one that is 
carried out. 

• TEST button: Sends a test fax based on the configuration settings. 
• Apply button: Saves all changes to the configuration database. 

• Reset button: Clears all recently added information. 

• Add New Fax Media Item: Adds a new Fax Agent to be configured. You can also add a new Fax Agent 
by right-clicking the Fax folder on the tree control and selecting New - Fax Contact from the pop-up 
menu. 

• Send Separate Cover Page: When this box is checked, the Fax Agent includes a cover page with the 
fax message. The fax template contains a Fax Cover Page field, which specifies a cover page design 
that will be used for all fax messages sent using the Fax Agent. The following fax file formats are 
supported: .pg, .cpe, and .fmf. For more information about templates, please see Chapter 5. 
 
Note: The location of the Fax Cover Page field in the fax template does not matter because the cover 
page is, by default, the first item to be sent in a fax message. However, if several cover pages are 
selected for a single template, the Fax Agent will use only the first cover page listed. 

4.8 Instant Messaging Agent 
The Instant Messaging Agent, shown in Figure 4.25, allows you to send and acknowledge alarm information 
using Microsoft MSN® Messenger Service. (For information about installing and configuring MSN Messenger 
Service, acknowledging alarms using MSN Messenger Service, and creating templates for the Instant Messaging 
Agent, please see Appendix E.)  

 
Figure 4.25. Instant Messaging Agent 



AlarmWorX Multimedia 
 

4.17 

Instant Messaging Configuration Fields 
The following configuration fields are available for the Instant Messaging Agent: 

• Instant Messaging Media Name: Enter a name for the Instant Messaging Agent configuration. 

• Scheduling: If you are using scheduling, choose from the configured schedules on the drop-down list. 

• Send To: For the Multimedia Instant Messaging Agent to work properly, MSN Messenger Service must 
be installed and running on the computer on which the Instant Messaging Agent is installed. The user 
name specified in the Send To field must also be an existing contact in the server computer's messaging 
client that is currently online.  

• Acknowledge Code: Enter the string you wish to use as the acknowledge code. (For 
information about acknowledging alarms using instant messaging, see Appendix E.) 

• Node To Send Message From: Enter the node name for the computer on which you wish to run the 
Instant Messaging Agent. If left blank, the Instant Messaging Agent will be run on the computer that is 
running the Multimedia Server. Click the Browse button to search for a node. 

• Use Template: You must choose a template to be used with the agent. The template determines the 
actual message that gets sent to instant message recipients. The Configurator includes a template, 
called Default Instant Messenger, created for sending instant messages. For more information about 
templates, please see Chapter 5. 

• Description: Allows you to add comments to the agent configuration. 

• Priority: This is used with roles. If more than one person is on schedule (or one person has more than 
one agent configured using his schedule), then the agent with the highest priority will be the one that is 
carried out. 

• TEST button: Sends a test instant message based on your configuration. 

• Apply button: Saves all changes to the configuration database. 

• Reset button: Clears all recently added information. 

• Add New Instant Messaging Media Item: Adds a new agent to be configured. Note that you can also 
add a new  Instant Messaging Agent by right-clicking the  Instant Messaging folder on the tree control 
and selecting New - Instant Messaging Media Item from the pop-up menu. 

4.9 Popup Agent 
The Popup Agent, shown in Figure 4.26, allows you to open and execute a file on a computer. For example, you 
can configure a Popup Agent to open Microsoft Internet Explorer and display alarm information within Internet 
Explorer.  
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Figure 4.26. Popup Agent 

Note: The Popup Agent is designed to launch other applications. The intent is that an operator will then close the 
applications when finished. The agent itself neither closes these applications nor limits the number of applications 
it will launch. Because of this, it is possible that an unmonitored station, using the Popup Agent, could launch so 
many applications as to run out of system resources. 

Popup Configuration Fields 
The following configuration fields are available for the Popup Agent: 

• Popup Media Name: Enter a name for the Popup Agent configuration. 

• Scheduling: If you are using scheduling, choose from the configured schedules on the drop-down list. 

• Node To Popup On: Enter the node name for the computer on which you wish to run the Popup Agent. 
If this field is left blank, the Popup Agent will be run on the computer that is running the Multimedia 
Server. Click the Browse button to search for a node. 

• Template Name: You must choose a template to be used with the agent. The template determines the 
actual message that gets displayed in the popup window. The Configurator includes a template, called 
Default Popup, created for sending messages using popup windows. For more information about 
templates, please see Chapter 5. 

• Description: Allows you to add comments to the agent configuration. 

• Priority: This is used with roles. If more than one person is on schedule (or one person has more than 
one agent configured using his schedule), then the agent with the highest priority will be the one that is 
carried out. 

• TEST button: Displays a test popup window based on your configuration. 
• Apply button: Saves all changes to the configuration database. 

• Reset button: Clears all recently added information. 

• Add New Popup Media Item: Adds a new agent to be configured. You can also add a new Popup Agent 
by right-clicking the Popup folder on the tree control and selecting New - Popup Item from the pop-up 
menu. 
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4.10 Video Agent 
The Video Agent, shown in Figure 4.27, allows you to use a video device to send a video or a snapshot to a 
computer providing alarm information.  

Video Configuration Fields 
The following configuration fields are available for the Video Agent: 

• Video Media Name: Enter a name for this Video Agent configuration. 

• Scheduling: If you are using scheduling, choose from the configured schedules on the drop-down list. 

• Play On Node: Enter the node name for the computer on which you wish to run the Video Agent. If left 
blank, the Video Agent will be run on the computer that is running the Multimedia Server. Click the 
Browse button to search for a node. 

• Snapshot Node: Enter the node name for the computer on which you wish to run the Video Agent 
Snapshot. If this field is left blank, the Video Agent Snapshot will be run on the computer running the 
Multimedia Server. Click the Browse button to search for a node. 

 
Figure 4.27. Video Agent 

• Template Name: You must choose a template to be used with the agent. The template determines the 
actual video file (.avi, .mpg, .mpeg, or .mov) or snapshot (image) file (.bmp, jpg, jpeg, or .gif) that gets 
displayed. The Configurator includes a template, called Default Video, created for sending messages 
using video. For more information about templates, please see Chapter 5. 

• Description: Allows you to add comments to the agent configuration. 

• Priority: This is used with roles. If more than one person is on schedule (or one person has more than 
one agent configured using his schedule), then the agent with the highest priority will be the one that is 
carried out. 

• Play: Plays the video for a specified number of times. 

• Maximum Play Time: Sets a maximum video play time (in minutes).  

• TEST button: Tests your video configuration settings. 

• Apply button: Saves all changes to the configuration database. 

• Reset button: Clears all recently added information. 

• Add New Video Media Item: Adds a new agent to be configured. 
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General Settings 
The following options are set for all video items within the Video folder. To change any of these options, click on 
the General Settings button while in the main Video folder, as shown in Figure 4.28. If you do not see the 
General Settings button, make sure that Dialog View is checked on the View menu. 

 
Figure 4.28. Video Agent: General Settings 

Clicking General Settings opens the Snapshot Configuration dialog box, shown in Figure 4.29.  

 
Figure 4.29. Snapshot Configuration Dialog Box 

The Snapshot Configuration dialog box contains the following options: 

• Display: Allows you to choose video display options. 

• Compression: Choose a component to use if you wish to compress the video files. 

• Format: Sets options such as color, mirror, flip, and size. 

• Source: Configures hardware settings based on the video driver you choose to use. 

• Video Driver: Choose a video driver to use. 

• Jpeg Settings: Select the quality level and the option to display in color or grayscale for snapshots. 
For information about video configuration settings, please see Appendix C. 
Note: The general settings for video agents may vary depending on which video capture device is used. General 
settings will only function if you have a video capture device (Web camera) installed on your computer. If no video 
capture device is found, you will get an error message informing you that the application could not find any video 
capture devices.  
If you are using a remote node for video capture, you will have to go to the remote node and change the settings 
for video capture on that remote node. If there is no Multimedia Configurator installed on your video capture node, 
then you can run the "MMXSnapshot.exe" in the "Bin'' directory to set the general settings.  
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4.11 P.A. Agent 
The P.A. Agent, shown in Figure 4.30, allows you to use a public address (PA) system device to announce 
alarms and events over a loudspeaker. The PA Agent configuration settings are directly tied to the telephony 
agent settings. The Call-out Agent configuration must be activated in order for the PA agent to work. A Dialogic 
board is also required for the PA agent. 

P.A. Configuration Fields 
The following configuration fields are available for the P.A. Agent: 

• P.A. Media Name: Enter a name for the configuration. 

• Scheduling: If you are using scheduling, choose from the configured schedules on the drop-down list. 

• Phone Number to Call: Enter a P.A. system access phone number. 

• Node Name: Enter the node name for the computer on which you wish to play the P.A. message. If this 
field is left blank, the sounds will be played on the computer running the Multimedia Server. Click the 
Browse button to search for a node. 

• Use Template: You must choose a template to be used with the agent. 

• Description: Allows you to add comments to the agent configuration. 

• Priority: This is used with roles. If more than one person is on schedule (or one person has more than 
one agent configured using his schedule), then the agent with the highest priority will be the one that is 
carried out. 

• Play: Plays the P.A. message a specified number of times. 

• Maximum Play Time: Sets a maximum play time for the message (in minutes).  

• TEST button: Plays a P.A. message to test your configuration. 

• Apply button: Saves all changes to the configuration database. 

• Reset button: Clears all recently added information. 

• Add New P.A. Media Item: Adds a new agent to be configured. Note that you can also add a new P.A. 
Agent by right-clicking the P.A. folder on the tree control and selecting New - P.A. Item from the pop-up 
menu. 

 
Figure 4.30. P.A. Agent Configuration Settings 
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5.1 

Media Templates 
5.1 Introduction to Media Templates 

When configuring a multimedia agent, you must select a media template to apply to that agent. Templates allow 
you to configure design elements, including what and how much information to display when presenting an alarm. 
A default template is available for each type of agent. You can use or modify any one of the default templates 
provided for you, or you can create a new template as follows: 

1. Right-click on the Media Templates folder on the tree control of the Multimedia Configurator screen and 
select New > Media Template, as shown in Figure 5.1. The Media Templates folder is located in the Alarm 
Configurations folder.  

 
Figure 5.1. Creating a New Media Template 

2. The new media template appears along with the configuration dialog box shown in Figure 5.2. In the 
Template Name field, enter a name for the template you are creating. 

3. Select which Template Type you wish to create. You can choose from e-mail, sound/text-to-speech, 
marquee, pager, phone, fax, instant messaging, PA, popup window, or video. 

 
Figure 5.2. New Media Template Configuration 
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4. Click on the Design Elements tab of the template configuration dialog box, shown in Figure 5.2. If you are 
configuring a template with an option to enter a subject field, you may do so by clicking on the … button to the 
right of the Subject field. This opens the Template Definition Wizard dialog box, shown in Figure 5.3, which 
contains a list of available field types to add. For a list of field types, please see the "Template Field Types" 
section later in this chapter. Choose a field type and select from the additional options under Field 
Properties; and then click Insert. If you wish to change the order of the fields or to delete a field, use the 
appropriate buttons to do so. The Insert Blank button will insert a line break. 

Note: Template configuration is for advanced users. It is recommended that you use the default templates 
that are provided with the Configurator. 

 
Figure 5.3. Template Definition Wizard Dialog Box 

 
5. Click on the Template Source Code tab in the template configuration dialog box. The Template Source 

Code tab, shown in Figure 5.4, displays all of the fields in an editable format. If you need to manually edit a 
field, you can do so here.  

Note: The Template Source Code tab is recommended for advanced users only. Do not modify any fields 
here unless you are absolutely sure of what you are doing. 

6. Click Apply on the template configuration dialog box to apply the changes. 

Note: For additional template settings, see Appendix B, Appendix C, and Appendix E. 

 
Figure 5.4. Media Template Configuration: Template Source Code Tab 
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5.2 Template Field Types 
The following is a list of all template field types. When configuring a media template, clicking the Insert button on 
the Design Elements tab of the template configuration dialog box, shown in Figure 5.2, to display which field 
types are available for that particular template type. 

Note: For more information about template field types, please see Appendix B, Appendix C, and Appendix E. 
 

 

Alarm Field:  Represents the components of OPC alarms; allows you to choose from a drop-down list of 
fields; allows you to enter a field width limit (enter zero for no limit); can be used as a text 
field with pager, e-mail, fax, popup, and instant messaging templates, or in sound, and 
phone (call-out) templates via text-to-speech conversion. 

 
E-mail Attachment: Represents any file that can be sent as an e-mail attachment; used with e-mail 

templates. 

 
Sound File:  Represents a sound file; allows you to choose from the included Sound Library or to add 

your own sound file (.wav, .mid) to the Sound Library. Can be used with sound and phone 
(call-out) templates. 

 
Delay:  Enters a value representing a time delay in milliseconds before the next template item will be 

activated; can be used with sound, phone, and video templates. 

 File:  Represents a file for the Popup Agent to process; used with popup templates. 

 URL:  Represents a URL for the Popup Agent to display; used with popup templates. 

 
SnapShot Capture:  Enters a value representing the amount of time the Video Agent will take to capture 

a video snapshot; used with video templates. 

 Picture File:  Represents an image file (.gif, .jpg); used with video templates. 

 Video File:  Represents a video file (.avi, .mpg, .mpeg, .mov); used with video templates. 

 Text:  Allows you to enter plain text; used by all media templates. 

 HTML Text:  Text embedded in HTML tags; used by marquee, popup, and video templates. 

 

Fax Cover Page:  This template field is a cover page design that will be used for all fax messages sent 
using the Fax Agent. The following fax cover page file formats are supported: .pg, 
.cpe, and .fmf. 

 
Note: The location of the Fax Cover Page field in the fax template does not matter because the cover page is, by 
default, the first item to be sent in a fax message. However, if several cover pages are selected for a single 
template, the Fax Agent will use only the first cover page listed. 

5.3 Templates and HTML 
This section is designed for advanced users who have some familiarity with HTML (Hyper Text Markup Language) 
and wish to see how HTML can be used in media templates. For more information on HTML, consult an HTML or 
Web-authoring tutorial. 
The templates for the Marquee, Popup, and Video agents can respond to simple HTML tags used to define the 
appearance of alarm data upon the agents' loading. If you are comfortable using HTML and are comfortable with 
the organization of the multimedia templates, you may find it simpler to write HTML directly into the Template 
Source Code field (see Figure 5.3) designed for advanced users. Information on how HTML is handled in each 
agent is shown below. 

5.3.1 Popup Agent 
All HTML text written in a popup agent's template is taken as is, written to an HTML file, and launched in Microsoft 
Internet Explorer. Alarm fields are translated into appropriate text and inserted into the HTML file wherever 
specified in the template. Table 5.1 shows the example provided for the default popup template. 
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Table 5.1. Popup Template Items 
 

HTML Command Function 

 $BASE_PATH$\MMXSounds\Alarm.wav 
Launches the file "Alarm.wav" using whatever installed media are capable of playing .wav 
files. 

 <html> Begins HTML content. 

 <title>MMX Alarm</title> Makes the title of the popup window "MMX Alarm." 

 <body bgcolor=#0000ff> Begins the body of HTML text and gives the popup window a blue background. ('#0000ff' is 
a coded way of specifying blue.) 

 <font size=6 color=yellow> Sets the font color to yellow and the font size to 6 (about 24 point). 

 [Alarm.Message] 
Shows the message text of the current alarm in the font style specified on the previous 
line. 

 </font> Ends yellow text. 

 </body> Ends body text. 

 </html> End HTML. 

5.3.2 Video Agent 
The Video Agent handles HTML text and alarm fields the same way that the Popup Agent handles them. The 
difference in the Video Agent's template is the inclusion and interpretation of images and video files. Whenever 
the Video Agent encounters an image or video in the template, it automatically embeds HTML code around the 
image or video, allowing Internet Explorer to recognize and display the item as it should be shown. Table 5.2 
shows the items contained in the default video template. 

Note: You will notice in this case that <html> and <body> have been omitted. For simple sections of HTML text 
like the one in this example, they are optional. Please see Appendix C for more information about video 
templates. 

 

Table 5.2. Video Template Items 
HTML Command Function 

 <title>Intruder Alert</title> Makes the title of the video popup page "Intruder Alert."' 

 <font color=red> Sets the type color to red.  

 <center><h1>Intruder Alert! </h1></center></font> Writes "Intruder Alert" in red type, centered and in "Heading 1" 
style. 

 <center><h2>[Alarm.Message] </h2></center> Writes the alarm message centered and in "Heading 2" style. 

 <table width = 100% border=1> <tr><td><center> 

 <h3>Authorized Employee</h3></center></td><td><center> 

 <h3>Last person to enter</h3></center></td></tr><tr><td><center> 

Creates a table with two columns. The left column is labeled 
"Authorized Employee," and the right column is labeled "Last 
person to enter." 

 $BASE_PATH$\SnapShots\Eng1.jpg 
Inserts the image "Eng1.jpg" in the table below "Authorized 
Employee."' 

 </center></td><td><center>  

 Snapshot capture (millisec.) 0 Takes a still image of what the Web cam is looking at and places 
the image to the right of "Eng1.jpg." 

 </center></td></tr></table> Closes the table. 

5.3.3 Marquee Agent 
Using HTML for the Marquee Agent is slightly different from standard HTML because the Marquee Agent does not 
load or display an entire Web page. The Marquee Agent uses HTML to determine the appearance of the text to be 
scrolled across the window. Since the Marquee Agent uses HTML only to modify the appearance of its text, it 
responds only to a limited set of HTML tags. The following is a list of useful HTML tags for the Marquee: <font>, 
<I>, <u>, <b>, <h1>, <h2>, <h3>, <body>, <blink>. All other HTML tags are completely ignored. If plain text is 
entered, or if alarm messages are entered into the template with no HTML around them, then the text will simply 
be displayed in plain, black, 10-point font. Table 5.3 shows the items contained in the default marquee template. 
All of the "'ignored" fields have been left in to demonstrate how one can copy and paste HTML code from an 
HTML editor directly into the template and still generate the desired text. 
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Note: The <body> field was used here to force the background to a different color. The Marquee Properties 
dialog box has a Background Color option on its property page. An HTML-specified background color overrides 
the Marquee's configured background color. 

 

Table 5.3. Marquee Template Items 
HTML Command Function 

 <HTML> Ignored. 

 <BODY bgcolor=#530210> Makes the background of the Marquee Agent dark 
red/maroon. 

 <DIV> Ignored. 

 <FONT face=dot-matrix size=6 color=green>[Alarm.Time] 
Shows the current time in dot-matrix font, green and 
size 6 (about 24 point). 

 [Alarm.Source] Shows the Alarm Source in the same font. 

 <FONT face=dot-matrix size=+1 color=red>[Alarm.Message]</FONT></FONT> 
Shows the Alarm Message in dot-matrix font, green, 
and size 7 (about 36 point). 

 </DIV> Ignored. 

 </BODY> Optional. 

 </HTML> Ignored. 
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6.1 

Schedules and Roles 
6.1 Introduction to Schedules 

The scheduling feature in AlarmWorX Multimedia allows you to configure an alarm action set so that an alarm 
message will be sent to a particular person only if that person is available according to his or her schedule. If you 
wish to use scheduling, you must configure the schedules before setting up your agents or alarm action set. 
Schedules are located under the System Objects tree control. 
Under the Schedules configuration folder on the tree control of the Multimedia Configurator screen, there are 
group schedules and personal schedules. You must set up a group schedule first, and then you may add 
personal schedules to the group schedule. Some example schedules are provided for you by default. 
There are two basic ways to use schedules: 

• You can have a group schedule that has a configured time calendar, and every personal schedule under 
that group follows that time calendar. Use this method when each person will have the same basic 
schedule. For example, this method is appropriate if your group schedule will be for a specific time shift 
during which every person works the same times. 

• The other way to use the schedules is to have a group schedule that does not have a configured time 
calendar and to configure each personal schedule with its own time calendar. Use this method when 
each person has a unique time schedule. Once you set up the time calendars, you can add or exclude 
specific dates and times from any group or personal schedule.  

6.2 Creating a New Schedule Configuration 
Use the following steps to configure a new schedule: 
1. Right-click on the Schedules folder in the tree control and select New > Group Schedule from the pop-up 

menu, as shown in Figure 6.1. 

 
Figure 6.1. Creating a New Group Schedule 

2. The group schedule configuration field will be displayed in the right-hand pane, as shown in Figure 6.2. 
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Figure 6.2. Configuring a New Group Schedule 

3. Type a name for the new group schedule, as shown in Figure 6.2. 
4. You will be setting up a time calendar for the whole group. Enter the scheduling information in the Periods 

Setup tab. You may click on the Calendar Preview tab to view the current schedule. For more information on 
the Periods Setup tab and the Calendar Preview tab, see the sections below. 

5. Click the Apply button to apply your changes. 

6. On the tree control, right-click on the group schedule you have just created and select New > Personal 
Schedule from the pop-up menu, as shown in Figure 6.3. 

 
Figure 6.3. Creating a New Personal Schedule 

7. Type a name (e.g. Chief Engineer) for the new personal schedule in the configuration field, as shown in 
Figure 6.4.  

8. Roles allow you to configure an alarm action set so that an alarm message will be sent to the person who is 
on schedule from a list of configured people. For example, if you want to call a shift supervisor when a certain 
alarm appears, you can set up a role called "Shift Supervisors." (Please see section 6.3 for information about 
configuring roles.) Then when the alarm occurs, the alarm message will be sent to whichever shift supervisor 
is on schedule. In order to associate a personal schedule with a role, you must select a role from the drop-
down list under Role, as shown in Figure 6.4.  

9. If you will be setting up a time calendar for this personal schedule, enter the scheduling information in the 
Periods Setup tab. You may click on the Calendar Preview tab to view the current schedule. Any group 
times that you configured will be included in every personal schedule under that group schedule and will 
appear in the calendar preview.  

10. Click the Apply button to apply your changes. 
Note: If you set up a time calendar in a group schedule and in a personal schedule, then that person's schedule 
will include all scheduled times from both the group schedule and the personal schedules. 
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Figure 6.4. Configuring a New Personal Schedule 

6.2.1 Setting up Periods 
Use the Periods Setup tab, shown in Figure 6.5, to set up either a group schedule or a personal schedule. The 
following recurrence patterns are available in the Periods Setup tab: Daily, Weekly, Monthly, and Yearly. You 
can specify a start date, a start time, duration, and a "recur on" date for each period. 

Daily Recurrence Pattern 
The daily recurrence pattern allows you to set up a time block for a daily recurring period, as shown in Figure 6.5. 
Click on a new row to add a new daily recurring time block. To delete a time block, click inside the far left gray cell 
for that block to highlight the entire row, and then press the Delete key. 

 
Figure 6.5. Periods Setup Tab 
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Start Date: The drop-down menu displays a calendar from which you can choose a start date, as shown in Figure 
6.6. 
Start Time: Type in the start time (followed by AM or PM) if your system is set up for 12-hour time, or just the time 
if your system is set up for 24-hour time. 

 
Figure 6.6. Calendar 

Duration: Click on the … button to the right of the Duration field on the Periods Setup tab to choose the number 
of hours and/or minutes you wish to have the time block last, as shown in Figure 6.7. 

 
Figure 6.7. Duration Settings 

Recur On: In this field, you can choose whether to have the period recur on every weekday or on every certain 
number of days. You can change the number of days by clicking on the far right side in the field to display a drop-
down menu.  

Weekly Recurrence Pattern 
The weekly recurrence pattern allows you to set up a time block for a weekly recurring period. Click on a new row 
to add a new weekly recurring time block. To delete a time block, click inside the far left gray cell for that block to 
highlight the entire row, and then press the Delete key on the keyboard. 
Start Date: The drop-down menu displays a calendar from which you can choose a start date, as shown in Figure 
6.6. 
Start Time: Type in the start time (followed by AM or PM) if your system is set up for 12-hour time, or just the time 
if your system is set up for 24-hour time. 
Duration: Click on the … button to the right of this field to choose the number of days, hours, and/or minutes you 
wish to have the time block last, as shown in Figure 6.7. 
Recur Every: The drop-down menu allows you to choose the number of weeks in which you wish have the time 
block recur. Check the day(s) on which you wish to have the time block recur. 

Monthly Recurrence Pattern 
The monthly recurrence pattern allows you to set up a time block for a monthly recurring period. Click on a new 
row to add a new monthly recurring time block. To delete a time block, click inside the far left gray cell for that 
block to highlight the entire row, and then press the Delete key. 
Start Date: The drop-down menu displays a calendar from which you can choose a start date, as shown in Figure 
6.6. 
Start Time: Type in the start time (followed by AM or PM) if your system is set up for 12-hour time, or just the time 
if your system is set up for 24-hour time. 
Duration: Click on the … button to choose the number of days, hours, and/or minutes you wish to have the time 
block last, as shown in Figure 6.7. 
Recur On: Click on the … button to display a dialog box that will let you choose when to have the time block 
recur, as shown in Figure 6.8. 
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Figure 6.8. Settings for Monthly Recurring Period 

Yearly Recurrence Pattern 
The yearly recurrence pattern allows you to set up a time block for an annually recurring period. Click on a new 
row to add a new yearly recurring time block. To delete a time block, click inside the far left gray cell for that block 
to highlight the entire entry, and the press the Delete key. 

 
Figure 6.9. Settings for Yearly Recurring Period 

Start Date: The drop-down menu displays a calendar from which you can choose a start date. 
Start Time: Type in the start time (followed by AM or PM) if your system is set up for 12-hour time, or just the time 
if your system is set up for 24-hour time. 
Duration: Click on the … button to choose the number of days, hours, and/or minutes you wish to have the time 
block last. 
Recur Every: Click on the … button to display a dialog box that will let you choose when you wish to have the 
time block recur, as shown in Figure 6.9. 

Included and Excluded Periods 
The Included Periods and Excluded Periods fields on the Periods Setup tab allow you to include or exclude a 
particular block of time from a schedule. Click on a new row to add a new time block to include or exclude. The 
start date and time as well as the end date and time are shown for each included or excluded period. To delete a 
time block, click inside the far left gray cell for that block to highlight the entire entry, and then press the Delete 
key.  

6.2.2 Calendar Preview 
The Calendar Preview tab, shown in Figure 6.10, allows you to view your scheduled time blocks in a calendar 
layout. You can review various time spans by clicking the Previous and Next buttons. To change the time span, 
click the arrow next to the Time Span to Preview field, and select a time span from the drop-down list. You can 
choose from 2 months, 4 months, 6 months, 8 months, 10 months, or a year. 
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Figure 6.10. Calendar Preview Tab for Scheduling 

Checking the Show Legend box will display a legend that indicates what each color represents, as shown in 
Figure 6.11. 
Moving the cursor over a particular date will display a ToolTip with all time blocks set for that day.  

 
Figure 6.11. Calendar Legend 

6.3 Working With Roles 
Roles allow you to configure an alarm action set so that an alarm message will be sent to the person who is on 
schedule from a list of configured people. For example, if you want to call a shift supervisor when a certain alarm 
appears, you can set up a role called "Shift Supervisors." Then when the alarm occurs, the alarm message will be 
sent to whichever shift supervisor is on schedule.  
If more than one person belongs to a role, alarm messages will be sent to all persons scheduled for the role. 
Recall that personal schedules (described earlier) allow for the configuration of one or more multimedia agents for 
each person in the role. If the people scheduled for the role use different multimedia agents, you can specify 
which multimedia agent will be used to notify each person. If multiple multimedia agents are configured for a 
single person in the role, you can also set a priority level to specify the "preferred" agent for that person.  

6.3.1 Configuring Roles 
To configure roles, use the following steps: 

1. Right-click on the Roles folder in the tree control of the Multimedia Configurator screen, and select New > 
Role from the pop-up menu, as shown in Figure 6.12. The Roles folder is located under the System Objects 
folder on the tree control.  
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Figure 6.12. Creating a New Role 

2. This opens the configuration field for roles in the right-hand pane of the Configurator screen. Type a name for 
the role, as shown in Figure 6.13. 

 
Figure 6.13. Configuring a New Role 

3. Click the Apply button to apply your changes. 

6.3.2 Using Roles 
To use a role, you must do the following: 

1. Assign the role to corresponding people in their personal schedules (see Figure 6.4). 

2. Assign these personal schedules to multimedia agents. For information about configuring multimedia agents, 
please refer to Chapter 4. 

3. Assign the role as an Action Destination in an alarm action set, if you want to send alarm messages to the 
role. For more information about configuring alarm action sets, please refer to Chapter 2. 

Note: This is where you can set a priority level to determine which multimedia agent will be active if more 
than one is scheduled to occur. 



Schedules and Roles 
 

6.8 

 

 

 



Chapter 7 
 

7.1 

Additional Settings 
7.1 Configuring Nodes 

The Multimedia Configurator allows you to link alarm configurations to one or more nodes. Because the 
Multimedia Server uses a separate thread for each alarm configuration, you can also link multiple alarm 
configurations to each node. 

To configure and link a node, use the following procedure: 

1. Right-click on the Nodes folder in the tree control of the Configurator screen and select New > Node from the 
pop-up menu, as shown in Figure 7.1. 

 
Figure 7.1. Creating a New Node 

2. Give the new node a name, as shown in Figure 7.2, or click the Browse button to select a node. 

 
Figure 7.2. Specifying the Node Name 

3. Click Apply. The new node will appear under the Nodes folder. 

4. Now you can link one or more alarm configurations to the node by right-clicking the node and selecting New > 
Link to Alarm Configuration from the pop-up menu, as shown in Figure 7.3.  

 
Figure 7.3. Creating a Link to an Alarm Configuration 

5. Select the configuration from the drop-down list of configurations in the Configuration Name field, as shown 
in Figure 7.4. You can link one or more alarm configurations to a single node. The default alarm configuration 
is linked to the node automatically when no other configurations are linked to the node. 
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Figure 7.4. Linking a Node to an Alarm Configuration 

7.2 Multiplying Items 
The Multimedia Configurator is equipped with the ability to multiply items in the tree control, including templates, 
filters, schedules, action sets, agent configurations, and alarm configurations. Multiplication provides a simple way 
of developing alarm configurations for which there are many similar items in a given category. To multiply an item, 
first select the item you wish to multiply. Then either right-click the item and select Multiply… from the pop-up 
menu, or select Multiply from the Edit menu. This opens the Multiply Item dialog box, shown in Figure 7.5.  

 
Figure 7.5. Multiplying an Item 

When the items are multiplied, they will all be given a base name followed by a number. The default base text is 
the name of the item selected for multiplication. To modify the base text, change the Base Text field appropriately. 
In the First Number field, specify the number to appear next to the first multiplied item. In the Number of Items 
field, specify how many items you wish to create. The Numeric Places field refers to the minimum length of each 
number to append. Values that take up less space than the specified amount of numeric places will have zeros 
before the number. For example, the configuration shown in Figure 7.5 will create three new action sets with the 
following names: 

• Marquee Action Set001 

• Marquee Action Set002 

• Marquee Action Set003 

Click the OK button to do the multiplication. 

7.3 Options 
To choose additional settings, select Options from the Tools menu. This opens the Options dialog box, which 
contains the following tabs: 

• General  

• Table(s) Management  

• Monitor View  

• Multimedia Assistant  
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7.3.1 General Tab 
The General tab of the Options dialog box, shown in Figure 7.6, contains the following options. 

Save regional settings in registry: Checking this option saves regional configuration settings in the registry so 
that they are applied each time you start the Configurator. This applies to the language settings as well as time 
and date settings. 

Automatically apply changes when selection is changed: Checking this option allows changes to the 
configuration database to be saved each time you switch dialogs without clicking on the Apply button or being 
shown a message asking if you would like to apply changes. 

Enable hover selection: Checking this option allows you to highlight an item by moving the mouse pointer over 
that item and keeping it there for a specified amount of time. 

 
Figure 7.6. Options Dialog Box: General Tab 

Automatically enable new alarm configurations on current node: If this option is checked, when a new alarm 
configuration is created the current node will be automatically added to the Nodes folder with a link to the alarm 
configuration. 

Base Path: Select a base directory for relative path names. Click the ... button to choose a directory. If this field is 
left blank (default), the folder containing this application's executable (.exe) file is assumed. 

7.3.2 Table(s) Management Tab 
The Table(s) Management tab of the Options dialog box, shown in Figure 7.7, controls how the Multimedia 
Server logs and stores data. 

 
Multimedia Journal Table 
Max Records: Sets the number of records that the Multimedia Server can store in the Journal Table before they 
are deleted or archived. 

Max Interval: Sets the maximum amount of time that the records are stored in the Journal Table before being 
deleted or archived. 
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Figure 7.7. Options Dialog Box: Table(s) Management Tab 

 

Archive Table(s) 
Max Tables: Sets the number of tables to archive before deleting the oldest table. 
Max Records: Sets the number of records to archive in a table. 
Max Interval: Sets how long to archive for before deleting the oldest archive. 
Archive Incomplete Incidents: When this box is checked, the Multimedia Server will log incidents or events to an 
archive table even if they have not yet been resolved. 
Node name to do the archiving: Choose a node for archiving records. Click the ... button to select a node. The 
Browse for Computer dialog box will open, as shown in Figure 7.8. Choose the desired node, and then click OK.  
Note: If you would like Journal Table records to be deleted and not archived, check Max Tables and set the field 
to "0." 

 
Figure 7.8. Choosing a Node for Archiving 
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7.3.3 Monitor View Tab 
The Monitor View tab of the Options dialog box, shown in Figure 7.9, allows you to configure the settings for the 
Runtime Monitor. You have the option to: 

• Select an Update Rate (in milliseconds). 

• Limit the number of records displayed.  

• Choose which fields are shown in the Runtime Monitor, as well as the order in which they are shown. To 
change the display order of a particular field, click on the field in the list box under Show Fields and then 
click the "up" and "down" arrows to the right to adjust its position. 

Note: For more information about the Runtime Monitor, please see Chapter 8. 

 
Figure 7.9. Options Dialog Box: Monitor View Tab 

7.3.4 Multimedia Assistant Tab 
For additional help, you can consult the Multimedia Assistant at any time by selecting Multimedia Assistant from 
the Help menu. Follow the instructions provided by the Multimedia Assistant. 
In the Multimedia Assistant tab of the Options dialog box, shown in Figure 7.10, you can choose whether you 
want the Multimedia Assistant to speak or only to show text instructions. 

 
Figure 7.10. Options Dialog Box: Multimedia Assistant Tab 
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8.1 

Runtime Operations 
8.1 Starting the Multimedia Server 

The majority of this user's guide is devoted to the configuration of alarms, alarm action sets, alarm filters, OPC 
subscriptions, multimedia agents, media templates, acknowledgement codes, schedules, roles, and nodes using 
the Multimedia Configurator. All of your configuration data are stored in your configuration database.  
Once you have completed the configuration of your database, you are now ready to connect the Multimedia 
Server to the database by starting the Multimedia Server. Before starting the Multimedia Server, be sure to test 
your multimedia agent configurations by using the TEST button in the configuration field for each agent. To enter 
the Multimedia Server into runtime mode, select Start Multimedia Server from the Action menu. The following 
events occur when you activate the Multimedia Server: 
1. The Multimedia Server reads all the alarm configurations in the multimedia configuration database.  
2. The Multimedia Server then subscribes to OPC Alarm and Events (AE) servers based on the subscriptions 

that you created in the configuration database.  
3. In turn, the OPC AE servers generate alarms back to the Multimedia Server. 
4. When the Multimedia Server receives alarms, it responds to those alarms according to the settings and alarm 

action sets that you configured in your database. 
5. Based on these action sets, the notification messages are then sent to a recipient (an operator or a group) via 

the configured multimedia agents. 

6. The recipient of the alarm message can then acknowledge the alarms using the configured multimedia device 
by entering an acknowledge code. 

8.2 Runtime Monitor 
When you start the Multimedia Server, you should verify that the server is connected to the configuration 
database. Use the Multimedia Runtime Monitor, shown in Figure 8.1, to determine whether a connection has 
been established. The Runtime Monitor enables you to view the activity of the Multimedia Server during runtime 
mode. To display the monitor, select Monitor View from the View menu. The monitor will be displayed at the 
bottom of the screen. Check the monitor to make sure the Multimedia Server is receiving alarms. 
The monitor lets you know what is going on in an active database and how the Multimedia Server is processing 
the alarms and the multimedia agents that you have configured. By default, the monitor displays the Time, Source, 
Message, Action Set, Action Destination, Action Status, and alarm acknowledgment status for the selected actions 
and alarms. You can choose which action sets and alarms to monitor by selecting from the Action Set to Monitor 
and Alarm Tags drop-down lists, respectively. Each incident for a particular agent is grouped by color. 
The Alarm Status conditions are: 

• Alarm: The Multimedia Server has received an alarm from the alarm OPC server. 

• Agent Done: The multimedia agent has successfully processed the request but has not completed the 
action. 

• Normal: The alarm has returned to normal. 

Note: For information about how to change the Runtime Monitor display settings, see the next section.  

 

Figure 8.1. Runtime Monitor  

There are three buttons in the runtime monitor, as shown in Figure 8.2: 
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Figure 8.2. Function Buttons for Runtime Monitor 

Refresh: Manually refreshes the journal table (besides the automatic refresh specified in the Monitor View tab of 
the Options dialog box). 

Delete: Deletes all records from the journal table (only if the Multimedia Server is not running). 

Export: Exports the data in the journal table to a text file. Clicking this button opens the Export Multimedia 
Journal dialog box, as shown in Figure 8.3. In the Export File Name field, specify the directory path and file 
name for the text file. Click the … button to browse for a directory. You can also choose to export archived journal 
data. 

 

Figure 8.3. Exporting Data to a Text File 

8.2.1 Adjusting Runtime Monitor Settings 
You can adjust the settings for the Runtime Monitor by selecting Options from the Tools menu. This opens the 
Options dialog box. The Monitor View tab of the Options dialog box, shown in Figure 8.4, configures the 
settings for the Runtime Monitor. You have the option to: 

• Select an Update Rate (in milliseconds) to determine how often the Multimedia Server will update the 
data that appear in the Runtime Monitor journal table. 

• Set a maximum number of records to be displayed in the Runtime Monitor.  

• Choose which fields are shown in the Runtime Monitor, as well as the order in which they are shown. To 
change the display order of a particular field, click on the field in the list box under Show Fields and then 
click the "up" and "down" arrows to the right to adjust its position. 
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Figure 8.4. Options Dialog Box: Monitor View Tab 

8.3 Table Management 
You can adjust the Journal data-logging settings for the Multimedia Server by selecting Options from the Tools 
menu. This opens the Options dialog box. The Table(s) Management tab of the Options dialog box, shown in 
Figure 8.4, allows you control how the Multimedia Server logs data to the journal and archive tables. 

Multimedia Journal Table 
Max Records: Sets the number of records that the Multimedia Server can store in the Journal Table before they 
are deleted or archived. 
Max Interval: Sets the maximum amount of time that the records are stored in the Journal Table before being 
deleted or archived. 

 

Figure 8.4. Options Dialog Box: Table(s) Management Tab 
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Archive Table(s) 
Max Tables: Sets the number of tables to archive before deleting the oldest table. 
Max Records: Sets the number of records to archive in a table. 
Max Interval: Sets how long to archive for before deleting the oldest archive. 
Archive Incomplete Incidents: When this box is checked, the Multimedia Server will log incidents or 
events to an archive table even if they have not yet been resolved. 
Node name to do the archiving: Choose a node for archiving records. Click the ... button to select a 
node. Choose the desired node, and then click OK.  
Note: If you would like Journal Table records to be deleted and not archived, check Max Tables and 
set the field to "0." 

8.4 Stopping the Multimedia Server 
You can stop the Multimedia Server at any time by selecting Stop Multimedia Server from the Action menu of 
the Multimedia Configurator. This exits runtime mode. You can also click the traffic light button on the toolbar. 
Note: You can also start/stop the Multimedia using the ProcViewTray tool tray. For more information, please see 
the ProcViewTray Help documentation. 
IMPORTANT NOTE: Once the Multimedia Server has been stopped, alarm messages will stop being issued to 
the alarm action destinations. 
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Call-in Agent Configuration 
9.1 Overview of the Call-in Agent 

The Call-in Agent enables users to access OPC data over the phone. The Call-in Agent configuration sets up the 
voice and key entries and menu options based on information supplied from the Multimedia configuration 
database, the current state of OPC data or alarms, and the security level of the user calling into the system.  
Note: The following Configurator features do NOT apply to the Call-in Agent: the Multimedia Configuration 
Wizard, action sets, and schedules. 

9.1.1 Call-in Agent Quick Start 
Configuring and using the AlarmWorX Multimedia Call-in Agent require the following steps: 
1. Install the Dialogic hardware. (See Appendix B for information about installing and configuring Intel Dialogic 

boards. For additional information about purchasing and installing Intel Dialogic boards, please visit the Intel 
Web site at www.intel.com/network/csp/products/index_vp.htm. 

2. Install the Dialogic drivers. (At the time of this writing, these drivers must be Dialogic version 5.1 with Service 
Pack 1.) 

3. Install the AlarmWorX Multimedia software.  
4. Configure the Dialogic card. During initial setup, it is recommended that the Dialogic Configuration 

Manager (DCM) be used for configuring and running the Dialogic drivers. (See the "Installing and Configuring 
Telephony Cards" section of Appendix B.) Open the DCM and select the Action menu.  If you are familiar 
with the card, use the Add Device option, or have the DCM detect the card using the Auto Detect Devices 
option.  

5. Start the Dialogic drivers. Highlight the configured Dialogic card from the graphical tree menu. Start the 
drivers by clicking the green start button. If the drivers fail to initialize the card, check the card type and 
settings. If problem persists, contact Dialogic for technical support. 

6. Plug an analog phone line into the primary channel (zero channel). At this time, you should verify that the 
phone number is correct, that the phone line is analog, and that it is a dedicated line. It is also a good idea to 
verify a phone number to call out to. (Note: Digital phone lines are not supported.) 

7. Launch the Multimedia Configurator by selecting Start > Programs > Smar ProcessView > AlarmWorX 
Multimedia > Multimedia Configurator. Click on the Phone folder on the tree control of the Configurator 
under Alarm Configurations/Multimedia Agents. For the Phone Agent General Settings (see the "Setting 
General Phone Agent Parameters" section below), set the number of phone lines to "1." Make sure that 
phone line "0" is not reserved for outgoing calls.  

8. Configure the Call-in Agent settings as described in Section 9.4 below. 
9. Enter the Call-in Agent into runtime mode by clicking the Start Call-in Agent button on the Call-in Agent's 

general settings. 
10. Call the number of the phone line attached to the Dialogic card. 

9.1.2 Tips and Troubleshooting 
1. Check to make sure the phone line is securely attached to the zero channel.  Dialogic boards support multiple 

channels, and it is relatively easy to connect the phone line to one of the other channels. 
2. It is best to try an analog phone for first time calling. There have been issues with the Dialogic card not 

detecting phone keys when using digital phones in speaker mode. 
3. Operation within a PBX (internal phone system) is dependent on the manner in which the PBX handles calls. 

A common example is where the phone seems to connect in the middle of the Multimedia messages. This is 
caused by a delay in connection. The PBX has taken the phone connected to the agent off the hook, thus 
starting the message, but has not connected the caller. A workaround for this is to add commas to the 
beginning of the message. In general, any PBX issue will be experienced by the Call-in Agent as if it were a 
normal user. 

4. Make sure that the channel being tested for the Call-in Agent is not being reserved for call-out. The Call-in 
Agent prevents incoming calls from being used on lines reserved for outgoing calls. 

5. Make sure that the number of lines does not exceed the number of working physical phone lines connected to 
the Dialogic card. The system uses the Number of Lines setting as an indication of the actual phone lines 
available. Setting this number higher than the number that actually exists causes the system to periodically 
use the lines that do not exist.  
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9.2 Setting General Telephony Agent Parameters 
Before you begin configuring the Call-in Agent, you must first set up the default parameters for the Call-in Agent. 
Click on the Phone folder on the tree control of the Configurator, as shown in Figure 9.1. If you do not see the 
General Settings, make sure that Dialog View is checked on the View menu. Configure the default settings as 
described below.  

 
Figure 9.1. Telephony Agents: General Settings 

9.2.1 Phone Lines 
Configure the following parameters for the phone lines you will be using for the Call-in Agent: 

• Number of Lines: Sets the total number of phone lines that will be used. 
Note: The number of lines specified must be less than or equal to the actual number of phone lines that 
will be used. If the number of lines specified in the Configurator is greater than the actual number of lines 
in use, the Call-in Server works under the assumption that additional phone lines are available even 
though the lines do not actually exist. Although up to 20 lines are supported, number of lines that can be 
used is limited by the type of Dialogic board.  The Call-in Agent only supports communication with one 
Dialogic card per PC. See Appendix B for details. 
Note: The Telephony Agents currently support up to 20 phone lines. However, the agent has been tested 
with a maximum of four phone lines. 

• Incoming Calls: Specifies which phone lines are reserved for incoming calls. 

• Outgoing Calls: Specifies which phone lines are reserved for outgoing calls. 
Note: When specifying which phone lines are reserved for incoming and outgoing calls, the first line is 
always line "0". For example, suppose you are using a total of three lines, as shown in Figure 9.1. The 
first line is "0", the second line is "1", and the third line is "2". Since the first and second lines are used for 
incoming calls, enter "0" and "1" in the Incoming Calls field, as shown in Figure 9.1. The third line is 
used for outgoing calls, so enter "2" in the Outgoing Calls field, as shown in Figure 9.1. 
Any phone lines that are not reserved are used as general purpose lines (i.e. for either incoming or 
outgoing calls 
Note: If you are using only one telephone line, you cannot reserve the single line for both incoming and 
outgoing calls. Therefore, to configure a single-line system, both the Incoming Calls field and the 
Outgoing Calls field should be left blank. 
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9.2.2 Menus Security and Timeouts 
Configure the following security and timeout parameters for the Call-in menus. 

• Call-in PIN Protect: Specify a numeric password or PIN that users must enter prior to each menu in 
order to progress through the phone menus in the Call-in Agent.  
Note: This is different from the general security settings used for logging into the phone system. (The 
login settings are configured in the Call-in Agent tree control branch.) 

• Restrict same menu visits to: Limits the number of times a user can access the same menu through 
the Call-in Agent. This limits the overall time users can remain in the phone system to prevent users from 
tying up the phone lines. 

• Password Retries: Sets the number of times a user is allowed to enter an incorrect password on the 
phone keypad. 

• Initial Key Timeout: Sets the number of seconds the phone waits for a key press before retry. 

• Inter-Key Timeout: Sets the number of seconds allowed between key presses on the phone keypad 
before ending caller input. 

• Total Time: Sets the total consecutive time (in seconds) that a caller may spend in the same menu 
before timeout.  This includes the time the system uses to process and deliver the text-to-speech 
messages to the caller.   

9.2.3 Dialogic Configuration 
You must have a telephony card installed on the computer on which you are running the Call-in Agent. 
AlarmWorX Multimedia supports Intel® Dialogic® boards. You also need to have an analog phone line connected 
to the board. Dialogic boards do not work for Windows 98, so the Call-in Agent will not work on Windows 
98.  (Note: Digital lines are also not supported.) Only Dialogic boards are supported for the current version of 
AlarmWorX Multimedia. Please see Appendix B for information about installing and configuring Intel Dialogic 
boards. For more information about purchasing and installing Intel Dialogic boards, please go to 
www.intel.com/network/csp/products/index_vp.htm. 
 

9.3 Organization of Call-in Agent Groups and Menus 
Click on the Call-in Agent folder under the Telephony tree control of the Configurator, as shown in Figure 9.2. 
This folder contains the configuration user interface for all call-in menus, which enable you to configure the 
options, key entries, and actions for the Call-in Agent.   

 
Figure 9.2. Call-in Agent Tree Control 

The Call-in Menus branch of the tree control contains both menu groups and individual menus, as shown in 
Figure 9.3. For information about various menu types, please see Section 9.6. 
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Figure 9.3. Hierarchy of Call-in Agent Tree Control 

Two menu groups, shown in Figure 9.4, are provided by default to help you get started with your configuration. 
The Prebuilt Samples group contains preconfigured menus that you can use as templates for starting your Call-in 
Agent configuration. The Tenant Callin group is an example group that contains several fully configured example 
menus and submenus that you can use as a guide in creating your Call-in Agent configurations for tenant call-in 
applications for office rooms.  
Configurator assigns an ID number for each group in the Base Menu ID field. Each of the menus that you create 
for the group is also assigned an ID number based on the Base ID for the group. Menu IDs can be used as key-in 
actions for key-in menus (described in Section 9.6). 

 
Figure 9.4. Default Call-in Menu Groups  

Each group may contain several Call-in menus and submenus, as shown in Figure 9.5. The menus are organized 
hierarchically, similar to the way directories and files are organized on your computer's hard drive. For information 
about various menu types, please see Section 9.6. 
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Figure 9.5. Default Call-in Menus 

9.3.1 Modifying and Copying Groups and Menus 
To save time, you can modify the default groups and menus and tailor them to your configuration. If you do not 
want to change the default groups and menus, you can also make a copy of them: 

1. Right-click on a group or menu and select Copy from the pop-up menu, as shown in Figure 9.6.  

 
Figure 9.6. Copying a Group or Menu 

 
2. Right-click the target folder and select Paste from the pop-up menu, as shown in Figure 9.7. 

 
Figure 9.7. Pasting a Group or Menu 
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3. The copy of the group or menu appears under the target folder, as shown in Figure 9.8. Rename the group or 
menu as desired. 

 
Figure 9.8. Copy of Group or Menu 

9.3.2 Creating New Menu Groups 
To create a new Call-in menu group: 

1. Right-click the Call-in Menus folder on the tree control of the Configurator and select New > Call-in Menu 
Group, as shown in Figure 9.9.  

 
Figure 9.9. Creating a New Call-in Menu Group 

2. The properties dialog box for the new group appears in the right-hand pane of the Configurator, as shown in 
Figure 9.10. 

 
Figure 9.10. Setting the Properties for the New Call-in Menu Group 

3. In the Menu Group Name field, type a name for the new group. The Configurator assigns an ID number for 
the group in the Base Menu ID field. Each of the menus that you create for the group is also assigned an ID 
number based on the Base ID for the group. Menu IDs can be used as key-in actions for key-in menus 
(described in Section 9.6). 
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9.3.3 Creating New Call-in Menus 
To create a new Call-in menu: 
1. Right-click a group in the Call-in Menus folder on the tree control of the Configurator and select New > Call-

in Menu, as shown in Figure 9.11.  

 
Figure 9.11. Creating a New Call-in Menu  

2. The properties dialog box for the new menu appears in the right-hand pane of the Configurator, as shown in 
Figure 9.12. 

 
Figure 9.12. Setting the Properties for the New Call-in Menu 

3. In the Menu Name field, type a name for the new menu. The Configurator assigns an ID number for the menu 
in the Menu ID field based on the Base ID number of the group in which the menu was created. 

4. Configure the menu settings as described in the sections below. 
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9.4 Configuring General Call-in Agent Settings 
Once you have set the default parameters for the Phone Agents, you are ready to begin configuring the Call-in 
Agent settings. Click on the Call-in Agent folder under the Phone tree control of the Configurator, as shown in 
Figure 9.13.  

 
Figure 9.13. Call-in Agent General Settings 

This folder contains the main configuration settings for the Call-in Agent. 
1. Under Main Menu, select a menu from the drop-down list that you want to use as the main menu for your 

Call-in system. This is the menu to which callers are returned by default. 
2. Under Default Start-up Menu, select a menu from the drop-down list that you want to use as the start menu 

for your Call-in Agent. The default start-up menu will most likely be the same as your main menu.  
Note: The drop-down lists under Main Menu and Default Start-up Menu contain only the top-level menus for 
each menu group. 

3. Under Menu Timeout Action, specify what happens after a system timeout occurs. From the drop-down list, 
select an action (e.g. "repeat," "return to main menu," or "hang up") or a menu that immediately follows a 
timeout. For example, if a caller does not respond within the initial key timeout period, the system times out 
and then redirects the caller to the menu or action that you specified. 

4. The report Diagnostic information to GenEvent check box is checked by default. All diagnostic information 
is reported to the GenEvent Server. This information can be viewed in the current alarm viewer, and provides 
a visual record of actions taken by the Call-in Agent. 

5. If you want to log diagnostic information to a text file, check the Write Diagnostic Information to 
MMXCall_in.log file check box. The MMXCall_in.log file is a standalone file used for debugging purposes 
only. 

6. The Alarm & Event OPC Subscription drop-down box allows you to select an alarm subscription to be used 
by the Call-in Agent while presenting OPC alarms. 

9.4.1 Server Options 
Clicking the Server Options button in the Call-in Agent general settings (Figure 9.13) opens the Call-in Agent 
Options dialog box, shown in Figure 9.14. This dialog box sets the parameters for the Call-in Server. 

9.4.1.1 Server Strings Tab 
The Server Strings tab allows you to customize predefined messages that the caller hears in certain situations. 
Use the Call-In Agent’s Message Type drop-down list to select a particular message type, and then edit the text 
associated with that message type in the Message Text field. Figure 9.14, for example, contains a message that 
a caller hears when the caller is denied access to a menu: "Insufficient security to access this menu." 
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Figure 9.14. Server Strings  

9.4.1.2 Flash Settings Tab 
The Flash Settings tab sets the parameters for the Flash Warning function in direct action menus, where you 
can optionally specify a reset value. The reset value is written to the same OPC tag after the specified time 
interval, resetting the OPC value written by the menu action. When the Flash Warning check box is checked in a 
direct action menu, the system switches, or "flashes", the OPC tag between the tag's current (write) value and its 
reset value before finally resetting the tag value.  
The Flash Settings tab, shown in Figure 9.15, sets the following parameters for the Flash Warning function in 
direct action menus:  
Lead Time: Sets the amount of time before the system starts the flash process.  The time is determined by taking 
the Reset Time (found on Direct Action menus) and subtracting the Lead Time.  For example, if the Reset Time 
is 1 hour and the Lead Time is 10 minutes, the flash process will start 10 minutes before the final reset (in this 
case, 50 minutes after the value was originally set). 
Time on: Sets the time period for each warning flash for the write value. 
Time off: Sets the time period for each warning flash for the reset value. 
Number of Flashes: Specifies how many times the system switches (flashes) between the tag's write value and 
reset value before resetting the value. 
For each setting, you can specify how many minutes, seconds, and milliseconds. 
Note: For information about configuring direct action menus, please see the "Menu Types" section below. 
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Figure 9.15. Flash Settings for Direct Action Menus  

9.4.2 Aliases 
The Call-in Agent can be configured to use an alias key for each user (caller). If using aliases, each caller uses a 
numeric alias key in the configuration. This is an ID number that the Call-in Agent uses to recognize the caller. 
Each alias key can be associated with numerous aliases, enabling you to customize settings for each user by 
associating the caller's alias key with certain parameters, such as which locations in the building the caller can 
access (e.g. room, floor). Alias names then can be used in Call-In menus to significantly reduce the number of 
necessary menus. 

When a caller dials into the system, the caller can be prompted to enter his or her alias key. If he or she then 
accesses a menu containing aliases, all aliases get resolved according to the caller’s alias key, and the caller gets 
control over OPC resources determined by his or her alias resolution. If another caller accesses the same menu 
with a different alias key, he or she would have access to yet another set of OPC points, as specified by his or her 
alias key in the alias table.  

To configure aliases, click the Alias Table button in the Call-in Agent general settings (Figure 9.13). The Call-in 
Alias Table appears, as shown in Figure 9.16. The table contains several columns. The Alias Key column lists 
each numeric alias key. The UserName column lists the name of the caller associated with each alias key. The 
Alias Key column and UserName column are fixed; neither can be deleted, and each alias key must be 
associated with a user name. (You can change the keys and user names in the columns, but the columns 
themselves cannot be deleted.) The remaining columns contain aliases (e.g. Bldg, Floor, and Room) that can be 
modified or removed as needed.  

 
Figure 9.16. Alias Table  
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9.4.2.1 Alias Key-in Actions 
A Key-in menu, such as the Get ID menu shown in Figure 9.17, is an example of when a caller would be asked 
to enter an alias key. The Enter Alias Key to Resolve Aliases option must be selected from the drop-down list 
under Key-in Action, as shown in Figure 9.17. For example, in the GetID key-in menu, the Introduction Phrase 
states "please enter your 8 digit ID." Thus, when a caller dials into the system, the caller is prompted to enter his 
or her alias key. If the system recognizes the caller's alias key, it resolves the user name and all other aliases 
associated with the alias key. For more information about configuring key-in menus, please see Section 9.6. 

Note: The Call-in Agent supports both alias login and the standard security login. The alias login uses the 
UserName alias column to log a caller into the agent. This only takes place if the alias key entry is specified in the 
key-in menu. When the caller accesses this menu and enters an alias key, the system uses the name associated 
with the UserName alias column for login purposes. The standard security login uses the security server password 
and the alias login UserName. The caller first enters an alias key, and then enters a security password. The name 
associated with the UserName alias column is sent to the security server as the login name. The security 
password entered is used as the login password. The security server will resolve this combination for security 
login.  

 
Figure 9.17. Alias Key-in Action 

9.4.2.2 Creating Alias Keys  
To add a new alias key to the table: 
1. Right-click a column and select Insert New Alias Key from the pop-up menu, as shown in Figure 9.18. 

 
Figure 9.18. Creating an Alias Key 

2. The new key appears under the Alias Key column, as shown in Figure 9.19. Type a number for the key (can 
be any number of digits) in the table row. 
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Figure 9.19. New Alias Key Added to Column 

9.4.2.3 Creating New Aliases 
To add a new alias to the alias table: 

1. To add a new alias to the alias table, right-click inside a column and select Insert New Alias from the pop-up 
menu, as shown in Figure 9.20. 

 
Figure 9.20. Creating a New Alias 

2. The New Call-in Alias dialog box appears, as shown in Figure 9.21. Enter a name for the new alias, and 
then click the OK button. 

 
Figure 9.21. Naming the New Alias 

3. The new alias column appears in the table, as shown in Figure 9.22. 
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Figure 9.22. New Alias Added to Table 

9.4.2.4 Deleting Alias Keys  
To delete an alias key, right-click the key and select Delete Alias Key from the pop-up menu, as shown in Figure 
9.23. 

 
Figure 9.23. Deleting an Alias Key 

9.4.2.5 Renaming Aliases 
To rename an alias: 
1. Right-click an alias and select Rename Alias from the pop-up menu, as shown in Figure 9.24. 

 
Figure 9.24. Renaming an Alias 

2. The Rename Call-in Alias dialog box appears, as shown in Figure 9.25. Enter a new name for the alias, and 
then click the OK button. 
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Figure 9.25. Typing a New Name for the Alias  

9.4.2.6 Deleting Aliases 
To remove an alias from the configuration, right-click an alias in the table and select Delete Alias from the pop-up 
menu, as shown in Figure 9.26. 
Note: The User Name alias cannot be deleted. 

 
Figure 9.26. Deleting an Alias 

9.5 Configuring Call-in Agent Menus 
Each menu group may contain one or more Call-in Agent menus or submenus. All menus contain the following 
general configuration settings at the top of the configuration dialog box, as shown in Figure 9.27. 

 
Figure 9.27. Basic Menu Configuration Settings 

• Menu Name: Type a name for the menu in this field (maximum of 256 characters). 

• Menu Type: Each menu contains an extensive configuration interface, which is divided into different menu 
types. Select from one of the following menu types:  
∗ Option Menu 

∗ Key-In Menu 

∗ Direct Action 

∗ Decision Menu 

∗ Alarm Menu 
For more information about configuring each kind of menu, please see the Section 9.6.  

• Menu ID: The Configurator assigns a unique ID number for each menu based on the Base ID number of the 
group in which the menu was created. Menu IDs can be used as key-in actions for key-in menus (described in 
Section 9.6). 

• Introduction Phrase: Enter the message (maximum of 256 characters) that the caller hears upon reaching 
the menu. The text is automatically converted to speech by the Call-in Agent. If you do not want to use a text 
message, you can instead select a sound file (.wav). You can also insert an alias name in this text (the alias 
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name appears inside double angle brackets: e.g. <<Floor>>). The Call-in Agent tries to resolve this alias 
according to the alias key that caller entered earlier in the call-in session.  
Note: You can use text-to-speech messages, sound files, and text messages with aliases. For information 
about selecting a sound file or an alias, see the "Inserting Sound Files" and "Inserting Aliases" sections 
below.  

9.5.1 Menu Progression and Sequence 
When configuring Call-in menus, it is important to keep in mind how you want the callers to progress through the 
menus so that callers can efficiently communicate with the Call-in Agent. In the Call-in Agent menu configuration, 
you can specify the sequence of the menus by defining actions or menus that immediately follow each event. 
The configuration for each menu type includes a Next Action/Menu field, shown in Figure 9.28, specifies the 
action or menu that results from each of the caller's actions or responses (i.e. key presses). From the drop-down 
list, you can select any available menu as well as the following actions: 

• Go back: Returns the caller to the previous menu. 

• Repeat: Repeats the current menu. 

• Hang up: Ends the current call-in session. 

• Go to start menu: Returns the caller to the start-up menu. 

• Go to main menu: Returns the caller to the main menu. 
If you select a menu from the drop-down list, the arrow to the right of the field is enabled, as shown in Figure 9.28. 
Clicking this arrow takes you to the menu you selected. 

 
Figure 9.28. Next Action/Menu Field 

9.5.2 Inserting Sound Files 
If you do not want to use a text-to-speech phrase or message, you can instead select a sound file (.wav). To insert 
a sound file: 
1. Click the ... button next to an appropriate field (the Introduction Phrase field is used here as an example) 

and select From Sound Library from the pop-up menu, as shown in Figure 9.29. 

 
Figure 9.29. Adding a Sound File to the Menu Configuration 

2. This opens the Sound Library dialog box, shown in Figure 9.30. Click the Add Sound File button to browse 
for .wav files. Click Open to add the selected file to the Sound Library. To listen to a file, highlight the file and 
click the Play button. To select an existing sound file from the Sound Library, highlight the entire row for that 
file, and then click the Select button. The selected sound file appears in the configuration field you selected. 
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Figure 9.30. Selecting Sound Files From the Sound Library 

3. The selected sound file is added to the Introduction Phrase field, as shown in Figure 9.31. 

 
Figure 9.31. Sound File Added to Configuration 

9.5.3 Inserting Aliases 
To insert a an alias into a text message: 

1. Click the ... button next to the appropriate field (the Introduction Phrase field is used here as an example) 
and select Insert Alias from the pop-up menu, as shown in Figure 9.32. 

 
Figure 9.32. Adding an Alias to the Menu Configuration 

2. This opens the Select Call-in Alias dialog box, as shown in Figure 9.33. Select the desired alias, and then 
click the OK button. The selected alias appears in the configuration field you selected. 
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Figure 9.33. Selecting an Alias  

3. The alias names that you selected (inside the double angle brackets: e.g. <<Floor>> and <<Room>>) are 
inserted at the current cursor position inside the text message field in the Introduction Phrase field, as 
shown in Figure 9.34.  
Note: If any portion of the text in the field was highlighted, the inserted alias name replaces that portion. 

 
Figure 9.34. Aliases Added to Configuration 

9.6 Menu Types 
When configuring Call-in menus, you can select from the following types of menus, as shown in Figure 9.35. 

• Key-in Menu: Contains a user-input menu with a string of digits followed by the pound key. 
• Decision Menu: Gets rerouted to another menu based on value of an OPC tag or expression. 
• Option Menu: Contains a list of user-configured menu choices. 
• Direct Action: Specifies a direct, predefined action to take place upon entering the menu. 

• Alarm Menu: Specifies a multimedia template and an alarm filter. 

 
Figure 9.35. Selecting Menu Types 

In describing these menu types, we will walk through various example menus from the Tenant Callin menu group, 
as shown in Figure 9.36. 
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Figure 9.36. Menu Types in Group 

9.6.1 Key-in Menus 
A Key-in menu, such as the Get ID example menu shown in Figure 9.37, is a menu that expects the caller to 
enter in a series of digits, followed by the pound (#) key. The keys entered serve as a search parameter for finding 
OPC tags, aliases, menu IDs, security names, or security passwords.  

 
Figure 9.37. Key-in Menu 

The Key-in Action specifies the search parameters. The caller can search for the following items: 

• Alias Key to Resolve Aliases: Compares the caller's input with a unique alias key. The caller is prompted to 
enter his or her alias key. If the system recognizes the caller's alias key, it resolves the user name and all 
other aliases associated with the alias key. 

• Search for Menu ID: Compares the caller's input with the unique ID number of an existing menu (e.g. 2025). 
If the menu ID exists, the caller is directed to the matching menu. 

• User ID for Security Server Name: Compares the caller’s input with a unique alias number.  This number is 
used to retrieve the UserName alias.  This string is then used in conjunction with User Password to create 
the Security Server user name and password.  The input is sent to the Security Server. 

• User Password for Security Server Password: Prompts the user for a password.  This value is used in 
conjunction with the User ID.  Both values are sent to the Security Server. This menu choice can only be used 
immediately after a User ID menu.   

For more information about configuring the Security Server see Section 9.8. 
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The Search Results group specifies what happens when the caller's search is either successful or unsuccessful. 
There are two possible results when doing a search on caller input: 

• A unique match 

• No matches  
For each of these possibilities, you can enter the text or select an alias or sound file to specify what the caller 
hears. You can also specify a menu to go to for each search result.   
No Match: Specifies the message text or sound that the caller hears. (e.g. "Sorry, that ID is invalid") if the search 
is unsuccessful (i.e. there is no match).  
Unique Match: Specifies the message text or sound that the caller hears if the search is an exact match. 
The Next Action/Menu field specifies the action or menu that immediately follows each search result. From each 
drop-down list, you can select any available menu as well as the following actions: 

• Go back: Returns the caller to the previous menu. 
• Repeat: Repeats the current menu. 

• Hang up: Ends the current call-in session. 

• Go to start menu: Returns the caller to the start-up menu. 

• Go to main menu: Returns the caller to the main menu. 
Note: For information about how to select sound files and aliases, please refer to the "Inserting Sound Files" and 
"Inserting Aliases" sections. 

9.6.2 Decision Menus 
A decision menu, such as the BranchSet example menu shown in Figure 9.38, transports a caller to another 
menu based on the true/false condition of an OPC tag or the result of an expression. 

 
Figure 9.38. Decision Menu 

The Next Action field specifies the action or menu that immediately follows the resolution of each OPC tag or 
expression that the caller accesses through the Call-in Agent. If the OPC tag or expression specified resolves to a 
nonzero value, or TRUE, the flow of execution goes to the menu specified in the Next Action drop-down list next 
to True. If the value is zero, or FALSE (or undefined), flow of execution goes to the menu specified in the Next 
Action drop-down list next to False.   
From each drop-down list under Next Action, you can select any available menu as well as the following actions: 

• Go back: Returns the caller to the previous menu. 
• Repeat: Repeats the current menu. 

• Hang up: Ends the current call-in session. 

• Go to start menu: Returns the caller to the start-up menu. 

• Go to main menu: Returns the caller to the main menu. 
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To specify an OPC tag or expression, click the Edit Expression button. This opens the Edit Expression dialog 
box, shown in Figure 9.39. The following options are available for editing OPC expressions: 

• Arithmetic  

• Relational  

• Logical  

• Bitwise  

• Functions  

• Tags  

Note: For complete information about using the Expression Editor, please refer to Chapter 2. 

 
Figure 9.39. Expression Editor 

To select an OPC tag, click the Tags button. This opens the OPC Tag Browser, as shown in Figure 9.40. Select 
an OPC tag from the Data Access tree control and then click OK. 

 
Figure 9.40. Selecting an OPC Tag From the Tag Browser 

9.6.3 Option Menus 
An option menu, such as the Rooms<900 example menu shown in Figure 9.41, contains a list of options that 
are presented to a caller. The option menu configuration allows you to do the following: 
• Enable or disable each phone key independently.  

• Determine what the caller hears (i.e. a message or a sound) when the caller is presented with various options 
upon reaching the menu (e.g. "Press 1 to turn on fan 1"). 

• Specify which menu option corresponds to each of the keys on a standard phone keypad (i.e. keys 0-9, #, 
and *). 
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• Specify what happens after the caller presses each key. 

 
Figure 9.41. Option Menu 

To enable keys for the menu: 
1. Check the check box next to each key you want to use for the menu. The field under Menu Phrase now becomes 

available. 
2. Under the Menu Phrase field for each enabled key, specify some text to be spoken or a sound file to be played. 

To select a sound file, click the ... button next to each key. The caller hears each of these items in the order in 
which they appear in the Configurator. 
In the example menu in the figure above, when a caller reaches the menu, the caller hears the following:  
"Press 1 to turn on fan 1." 
"Press 2 to turn off fan 1." 
"Press 3 to turn on light 1." 
"Press 4 to turn off light 1." 
"Press 5 to turn on fan 2." 
"Press 6 to turn off fan 2." 
"Press 7 to turn on light 2." 
"Press 8 to turn off light 2." 
"Press Pound to Hang Up." 

3. For each enabled key, you must specify an action or a menu to which the caller is directed upon pressing the key 
on the phone pad. The Next Action/Menu field specifies the action or menu that results when the caller presses 
the key. From each drop-down list, you can select any available menu as well as the following actions:  

• Go back: Returns the caller to the previous menu. 

• Repeat: Repeats the current menu. 

• Hang up: Ends the current call-in session. 
• Go to start menu: Returns the caller to the start-up menu. 

• Go to main menu: Returns the caller to the main menu. 
In the Invalid Key Stroke field, specify the message or sound a caller hears (e.g. "Invalid Key.") when the caller 
presses the wrong key.  

9.6.4 Direct Action Menus 
A direct action menu, such as the On Key 1 example menu shown in Figure 9.42, supplies quick updates and 
writes to and reads from OPC tags. In this example, the caller is directed to this direct action menu after pressing 
the "1" key on the pone pad (as defined by the Rooms<900 example option menu in the section above). Direct 
action menus allows for quick browsing to a specific OPC tag group (or server). The menu specifies that the caller 
is going to request a specific action (instead of browsing and searching through groups/tags). In this example, the 
caller pressed "1 to turn on fan 1." The direct action menu enables you to tell the Call-in Agent how to turn on fan 
1 by specifying OPC values.  
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Figure 9.42. Direct Action Menu 

1. Choose one of the following actions from the drop-down list under the Action field: 

• Write to an OPC tag: Writes a value to the OPC tag specified in the Action Destination Path field. Data 
to write can come from either the caller or a predefined constant. 

• Read the value of OPC tag: Gives the value of the OPC tag specified in the Action Destination Path. 
If the Confirm User Action check box is checked, the Call-in Agent asks whether the caller wants to 
proceed with the selected action before writing or reading the OPC value. 
Note: The Use last browsed-to or keyed-in point check box is not implemented in the current version. 

2. Under Action Destination Path, click the Browse button either to launch the OPC Tag Browser, which 
allows you to select an OPC Data Access tag, or to select an alias. 

3. Select from the following Write Parameters for OPC tags: 

• Write Constant Value: When this option is selected, the Call-in Agent automatically writes an OPC tag 
value (i.e. no action is required from the caller).  

• Prompt Caller for Value: When this option is selected, the caller must enter an OPC value using the 
phone keypad. [Note: The Star (*) key on the phone keypad can be used as a decimal point.] Enter the 
message text or select a sound file by clicking the ... button to specify the Call-in Agent’s prompt for 
entering the OPC value. 
Note: The Confirm Value Changed check box is not implemented in the current version. 
Reset Value: You can optionally specify a reset value, which is written to the same OPC tag after the 
specified time interval, resetting the OPC value written by this menu action. When Flash Warning is 
checked, the system switches the OPC tag between the tag's current (write) value and its reset value 
before finally resetting the tag value. The lead time, time off, time on, and number flashes are specified in 
the flash warning parameters set in the general Call-in settings. (Refer to the "Configuring General Call-in 
Agent Settings" section above.) 

4. Under the Action Status field, you must specify what the caller hears (message or sound) when the OPC 
read/write is a success or a failure. In this example, the action is successfully completed when fan 1 is 
turned on.  
You must specify an action or a menu to which the caller is directed upon success or failure. The field allows 
you to specify the action or menu that results when the caller presses the key. From each drop-down list 
under Next Action/Menu, select an available menu or one of the following actions:  

• Go back: Returns the caller to the previous menu. 

• Repeat: Repeats the current menu. 

• Hang up: Ends the current call-in session. 
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• Go to start menu: Returns the caller to the start-up menu. 

• Go to main menu: Returns the caller to the main menu. 

9.6.5 Alarm Menus 
An Alarm Menu is similar to an Option menu in that it contains a list of options that are presented to a caller. The 
option menu configuration allows you to do the following: 
• Enable or disable each phone key independently.  

• Determine what the caller hears (i.e. a message or a sound) when the caller is presented with various alarms 
upon reaching the menu. 

• Specify which menu option corresponds to each of the keys on a standard phone keypad (i.e. keys 0-9, #, 
and *). 

• Specify what happens after the caller presses each key. 

You can also specify a multimedia template (text-to-speech type) and an alarm filter. 

 
Alarm Menu 

For each enabled key, you must specify an action or a menu to which the caller is directed upon pressing the key 
on the phone pad. The Next Action/Menu field specifies the action or menu that results when the caller presses 
the key. From each drop-down list, you can select any available menu as well as the following actions:  

• Go back: Returns the caller to the previous menu. 
• Repeat: Repeats the current menu. 

• Hang up: Ends the current call-in session. 

• Go to start menu: Returns the caller to the start-up menu. 

• Go to main menu: Returns the caller to the main menu. 

• Play next alarm 

• Play previous alarm 

• Repeat last alarm 

• Play alarm at the top of the list 

• Refresh alarm list 

• Acknowledge current alarm 

• Acknowledge alarms played 
• Acknowledge all alarms 

• Play total number of alarm messages 

• Play total number of acknowledged messages 

• Play total number of messages in alarm state 

• Play total number of unacknowledged messages 
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• Play total number of operators' messages 

• Play total number of tracking messages 
In the Invalid Key Stroke field, specify the message or sound a caller hears (e.g. "Invalid Key.") when the caller 
presses the wrong key.  

9.7 Starting and Stopping the Call-in Agent 
When the Call-in Agent is in configuration mode, the Call-in Agent branch on the tree control appears as shown in 
Figure 9.43. Notice that the phone icon has a red mark on it, indicating that the Call-in Agent server is turned off. 

 
Figure 9.43. Call-in Agent in Configuration Mode 

9.7.1 Starting the Call-in Agent 
When your Call-in Agent configuration is complete, you must start the Call-in Agent server in order for callers to 
call in to the system.  
1. Click the Start Call-in Agent button on the general settings dialog, as shown in Figure 9.44.  

 
Figure 9.44. Starting the Call-in Agent 

2. As the Call-in Agent loads, a progress window appears, as shown in Figure 9.45.  

 
Figure 9.45. Call-in Agent Loading 

3. Once the Call-in Agent is running, you can call the number of the phone line attached to the Dialogic card to 
dial in to the system. The red mark over the phone icon in the tree control is now removed to indicate that the 
Call-in Agent is running, as shown in Figure 9.46. 
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Figure 9.46. Call-in Agent Running 

9.7.2 Stopping the Call-in Agent 
After you start the Call in agent, the Start Call-in Agent button changes to say Stop Call-in Agent. 
1. Click the Stop Call-in Agent button on the general settings dialog. 
2. As the Call-in Agent shuts down, a progress window appears. 

9.8 Security Administration 
The Multimedia Configurator includes a Security Administration tool (for the Call-in Agent only) that mimics the 
Security Configurator, enabling you to configure user IDs and passwords for the Security Server. Once you have 
configured security for the Call-in Agent, you can specify when callers must enter their user IDs and passwords in 
the key-in menu configuration by selecting one of the following key-in actions:  
• User ID for Security Server Name: Compares the caller’s input with a unique alias number.  This number is 

used to retrieve the UserName alias.  This string is then used in conjunction with User Password to create 
the Security Server user name and password.  The input is sent to the Security Server. 

• User Password for Security Server Password: Prompts the user for a password.  This value is used in 
conjunction with the User ID.  Both values are sent to the Security Server. This menu choice can only be used 
immediately after a User ID menu.   

To log into the Security Server, create entries in the Security Server.  Call-in entries must be a string name and a 
numeric password.  In the Call-in Agent, add an alias key with a UserName matching the string name in the 
Security Server.  Set up a Key-in menu with Key-in action: User ID for Security Server Name.  The unique match 
from this menu must be a second Key-in menu with Key-in action: User Password for Security Server 
Password.  This combination will log the user into the Security Server.  Hanging up will automatically log the user 
out. 
Note: For more information about Security Server settings, please refer to the Security Configurator and Security 
Login application Help documentation. For information about key-in menu settings, please see the Key-in Menus 
section above. 

9.8.1 Logging into the Security Administration Tool 
The Security Administration tool allows Security Server administrators to configure security setting for users and 
groups. You must enter an administrator password to use the Security Administration tool.  
1. Click the Security Administration button (lock icon) on the toolbar. The Security Server Administrator 

Login dialog box appears, as shown in Figure 9.47. Enter the Security Server Administrator's user name 
and password, and then click the OK button.  
Note: A default administrator password is specified during installation. You will use this password to gain 
administrator access to the Security Server for the first time. When a new user is added to the system with 
Administrator privileges, the default password is disabled. The default password remains disabled as long as 
there is at least one user with administrator privileges. The Multimedia security administration tool does not 
allow you to use a default administrator account. In other words, the "Administrator" security account must be 
created first with the regular Security Configurator. This must be created in Advanced security mode. For 
more information about security modes, please see the Security Configurator Help documentation. 



Call-in Agent Configuration 
 

9.26 

 
Figure 9.47. Logging Into the Call-in Agent Security Administration Tool 

2. The Security Administration console appears, as shown in Figure 9.48. The configuration console consists 
of two separate panes. Each pane has a tree control. The left tree is the Group View. Here the root nodes 
are groups, and the child nodes are the users that belong to the group. The right tree is the User View, in 
which the root nodes are users, and the child nodes are the groups that have been assigned to each user. 
Some example groups and users are shown in the figure below. 

 
Figure 9.48. Security Administration Console 

9.8.2 Configuring Users and Groups 
The Security Administration console, shown in Figure 9.49, enables you to create user profiles and groups to 
customize Call-in Agent restrictions on a per-user basis. The figure below shows some example users associated 
with various roles. 
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Figure 9.49. Configuring Security for Users and Groups 

The example roles are: 

∗ General Manager 

∗ Supervisors 
∗ Operators 

Each of these roles is associated with five different example users:  

∗ Aaron (Operator) 

∗ Alex (Supervisor) 

∗ Jeff (General Manager) 

∗ Jim (Operator) 

∗ John (Supervisor) 
 

You can associate users with various groups to help simplify and organize security management. This way all 
users associated with a particular group are bound to the restrictions or properties for that group. For example, 
both Jim and John are supervisors, associated with the Supervisors group, and Jeff is associated with the General 
Manager group. If there are certain Call-in menus that only the general manager and supervisors are allowed to 
view but the operators may not view, the security administrator can use the Security Administration console to lock 
the operators out of those menus. 
You can also configure properties for each user within a group. For example, both Aaron and Jim are operators 
and are therefore associated with the Operators group. However, Aaron's user properties may be configured 
separately from those of Jim so that each user within the group has unique security restrictions.  

9.8.3 Adding a New Security Group 
To add a new group to the Security Administration console: 

1. Click the Insert New Group button, as shown in Figure 9.50. 
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Figure 9.50. Adding a New Group 

2. This adds a new group under the Group View tree. The name is highlighted, as shown in the figure below. It 
is suggested that you change the name at this point before further editing. 

 
Figure 9.51. New Group Added to Group Tree 

9.8.4 Adding a New User Profile 
To add a new user profile to the Security Administration console: 
1. Click the Insert New User button, as shown in Figure 9.52. 

 
Figure 9.52. Adding a New User Profile 
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2. This adds a new user under the User View tree. The name is highlighted, as shown in Figure 9.53. It is 
suggested that you change the name at this point before further editing. 

 
Figure 9.53. New User Added to User Tree 

9.8.5 Deleting Users and Groups 
To delete a user or a group from Security Administration console, select the desired group in the Group View 
tree, or the desired user in the User View tree, and do the following: 
1. Right-click on the item and select Delete from the pop-up menu, as shown in Figure 9.54.  

Note: If you select a child item in the tree instead of a root item (i.e. you select a user in the group tree or a 
group in the user tree) and perform a delete as described above, you will remove the child item from the 
parent (dissociate the group from the user) but not actually delete it. 

 
Figure 9.54. Deleting Users and Groups 

2. You are then asked to confirm the deletion, as shown in Figure 9.55. Click OK to delete the user or group. 

 
Figure 9.55. Confirming Deletion of a User or Group 

9.8.6 Associating Users and Groups 
To associate a group with a user in the Security Administration console: 

1. Select the user to be associated under the User View tree. 

2. Right-click the group to be associated under the Group View tree and select Associate User & Group from 
the pop-up menu (or click the Associate User with Group button), as shown in Figure 9.56. 
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Figure 9.56. Associating Users and Groups 

3. When a user and group are associated, the user appears as a child item under the group tree in the left pane, 
and the group appears as a child item under the user tree in the right pane, as shown in Figure 9.57. In this 
example, the user "Jeff" has been associated with the group "General Manager." 

 
Figure 9.57. Viewing User and Group Associations 

9.8.7 Removing Associations Between Users and Groups 
To remove the association between a user and a group in the Security Administration console: 
1. Select the user child item under the desired group in the left pane, or select the group child item under the 

desired user in the right pane. 
2. Right-click the user or group to be dissociated and select Delete from the pop-up menu, as shown in Figure 

9.58. 
3. When the association is removed, the child user under the group in the left pane is removed, and the child 

group under the user in the left pane is removed. 
Note: Performing this operation never deletes the selected user or group. Only their association is removed. 

 
Figure 9.58. Dissociating Users and Groups 
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9.8.8 Editing Users and Groups 
To edit the properties assigned to a user or a group in the Security Administration console:  

1. Select the desired group in the group tree, or the desired user in the user tree. 

2. Right-click on the group or user and select Edit from the pop-up menu, as shown in Figure 9.59. 

 
Figure 9.59. Editing User and Group Properties 

This opens the Properties dialog box, shown in the figure below, which is used to configure a user or group. The 
Properties dialog box contains the following tabs:  

• Properties 

• Call-in Menus 

• Points 

• Time Sheet 
• Account Policy 

9.8.9 Configuring Properties for Users and Groups 
The properties for users and groups vary slightly. The group fields are a subset of the user fields. The following 
fields are for users, as shown in Figure 9.60. 
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Figure 9.60. Configuring User Properties 

 
Field Description 
User Name Short name that the user types when logging on to the system. 

Full Name The user's full name for reference only (optional). 

Description Optional. 

Password The password the user must type to log in to the Security Server. This field is case-
sensitive; no spaces are allowed. 

Verify Password If you change the Password field, you must type the exact same password into this field. 

User Must Change Password 
at Next Logon 

When checked, the user must change his or her password at the time of the next logon. 
This is often used when a new user created. The administrator enters a default password 
for the new user and checks this field to require a "real" password to be entered on first 
logon. 

User Cannot Change 
Password 

When checked, the user's password can only be changed from this dialog, and not from 
the Login Client. 

Account Disabled 
Checking this check box has the same effect as deleting the user without the permanence 
of an actual delete. The Account Disabled check box is checked by default, so you must 
uncheck this box in order to activate the user's account. 

Account Locked Out 

This field is normally unchecked and disabled. Should the account become locked out 
(see the account lockout description in the Account Policy tab), the field would be 
enabled and checked. From here, the administrator can uncheck the field to re-enable the 
user logon. 

Security System Administrator When checked, this user is allowed to log in as a Security System Administrator to 
configure all aspects of the security system. 

 
The following fields are for groups, as shown in Figure 9.61. 
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Figure 9.61. Configuring Group Properties 

 
Field Description 
Group Name Short name (no spaces) that uniquely identifies this group within the system. 

Description Optional. 

 

Note: The User Name and Password can be used as key-in actions key-in menus. 

9.8.10 Call-in Menus Security 
The Call-in Menus tab of the user and group properties dialogs, shown in Figure 9.62, sets the user and group 
access restrictions for specific configured call-in menus. To allow or restrict access, the security administrator 
must include or exclude certain projects and pages by doing the following: 

1. Click the Browse button under the Include or Exclude field. 
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Figure 9.62. Setting User and Group Access Restrictions for Call-in Menus 

2. This opens the Call-in Menus Browser dialog box, shown in Figure 9.63, which displays all available Call-in 
menus from the Configurator tree control. Simply select the menus that you wish to include to allow the user 
or group access (or exclude to prevent user or group access). Click OK. 

 
Figure 9.63. Selecting Call-in Menus To Include  

3. The selected menus now appear under the Include and Exclude fields, as shown in Figure 9.64. To remove 
menus, highlight the item and click the Delete button. Click Apply to save changes to the user or group 
properties. 



AlarmWorX Multimedia 
 

9.35 

 
Figure 9.64. Included and Excluded Call-in Menus 

9.8.11 Points 
A ProcessView application that is configured to send outputs to points in OPC servers will disable them if denied 
by the Security Server. As with the file names, OPC point names with or without wildcards are placed in include or 
exclude lists for each user or group. 

Before a ProcessView client outputs a process value to an OPC server, the unique string that identifies the OPC 
output point is sent to the Security Server to determine if the write should be allowed based on the currently 
logged-in user(s) and or the groups to which they belong. The Points tab of the Properties dialog box, as shown 
in Figure 9.65, is used to configure which OPC output points are allowed to be written to by users and groups. 

 
Figure 9.65. Points Configuration 
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The Points property page is divided into two sections, Include and Exclude. Each section contains an edit field 
and a list box. You can select strings by using the Browse buttons. Pressing the Enter key with the cursor in the 
edit field or clicking the Add button adds the edit field text to the list box. When an entry in the list box is selected, 
pressing the Delete key or clicking the Delete button deletes the selected entry. 
If you type a string in the Test String field, the Access Granted check box indicates if access would be given to 
the user if the access to the "test string" was requested. The test is made using only the include and exclude lists 
that are visible. 
During runtime, when a ProcessView client sends an OPC point string to the Security Server for access testing 
(granted or denied), the include and exclude lists are string compared as follows for each active user and group 
until access is granted: 

1. Compare the OPC point string with each string in the include list until a match is found. If no match is found, 
access is denied. 

2. If a match is found in the include list, compare the OPC point string with every string in the exclude list. If no 
match is found in the exclude list, access to the point is granted, and no further testing of active groups and 
users is performed. 

Note: The exclude list entries can only remove rights granted in their corresponding include list. For example if 
user Aaron belongs to the group Operators, and Operators grants access to OPC point xyz, adding point xyz to 
Aaron's exclude list has no effect. 

Wildcards and Pattern Matching 
The entries in the include and exclude lists allow pattern matching similar to the Visual Basic LIKE operator. Built-
in pattern matching provides a versatile tool for string comparisons. The pattern-matching features allow you to 
use wildcard characters, character lists, or character ranges, in any combination, to match strings.  
Text results in string comparisons are based on a case-insensitive textual sort order determined by your system's 
locale, for example: 
(A=a) < (À=à) < (B=b) < (E=e) < (Ê=ê) < (Z=z) < (Ø=ø)  
The following table shows the characters allowed in patterns and what they match:  

 
Character(s) in pattern Matches in string 

? Any single character. 

* Zero or more characters. 

# Any single digit (0 - 9). 

[charlist] Any single character in charlist. 

[!charlist] Any single character not in charlist. 

 
A group of one or more characters (charlist) enclosed in brackets ([ ]) can be used to match any single character 
in string and can include almost any character code, including digits. 
Note: The special characters left bracket ([), question mark (?), pound sign (#), and asterisk (*) can be used to 
match themselves directly only by enclosing them in brackets. The right bracket (]) cannot be used within a group 
to match itself, but it can be used outside a group as an individual character.  
In addition to a simple list of characters enclosed in brackets, charlist can specify a range of characters by using a 
hyphen (-) to separate the upper and lower bounds of the range. For example, [A-Z] in pattern results in a match if 
the corresponding character position in string contains any of the uppercase letters in the range A-Z. Multiple 
ranges are included within the brackets without any delimiters.  
The meaning of a specified range depends on the character ordering valid at run time (as determined by the 
locale setting of the system the code is running on). The range [A - E] matches A, a, À, à, B, b, E, e. Note that it 
does not match Ê or ê because accented characters fall after unaccented characters in the sort order.  
Other important rules for pattern matching include the following:  

• An exclamation point (!) at the beginning of charlist means that a match is made if any character except 
the ones in charlist is found in string. When used outside brackets, the exclamation point matches itself.  

• The hyphen (-) can appear either at the beginning (after an exclamation point if one is used) or at the end 
of charlist to match itself. In any other location, the hyphen is used to identify a range of characters.  

• When a range of characters is specified, they must appear in ascending sort order (from lowest to 
highest). [A-Z] is a valid pattern, but [Z-A] is not.  
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• The character sequence [] is ignored; it is considered a zero-length string.  

9.8.12 Time Sheet 
The Time Sheet property page allows time-of-day restrictions on an hourly basis for users and groups. For hours 
that are selected (highlighted) in the lists, access is allowed. For hours that are not selected, access is denied. 
Figure 6.66 shows a configuration that allows access from 8 AM to 4 PM each day. 

 
Figure 9.66. Time Sheet 

9.8.13 Account Policy 
The Account Policy property page is used to show how passwords must be used, and whether user accounts 
are automatically locked out after a series of incorrect login attempts. The base policy (i.e. the most restrictive) for 
the system is set in the default group (see the "Editing the Default Group" section). For users and groups other 
than the default group, each policy can selectively be enabled and set for that user or group. 
During runtime, if more than one policy setting is in effect, the least restrictive is used. For this reason, the policy 
set in the default group must be the most restrictive. Individual users and groups can be made less restrictive than 
the default, but never more restrictive. 
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Figure 9.67. Account Policy Configuration 

 
Field Description 

Maximum Password Age 
Sets a time limit for a password, after which the user must change to a new password. If 
this is selected, the Expires in value can range from 1 to 999 days. To make the password 
permanent, select Password Never Expires. 

Minimum Password Age 

Sets the period of time a password must be in effect before the user can change it. If this is 
selected, the value can range from 1 to 999 days. To allow the user to change the 
password at any time, select Allow Changes Immediately. 
Note: Do not allow immediate changes if a Password Uniqueness value is entered. 

Minimum Password Length 
In the At Least field, this specifies the fewest number of characters a password can 
contain. If this is selected, the value can range from 1 to 14 characters. If Permit Blank 
Password is selected, there is no minimum password length. 

Password Uniqueness 

The number of new passwords that must be used by a user account before an old 
password can be reused. If Remember Passwords is selected, the value can range from 
1 to 24 passwords. If Do Not Keep Password History is selected, there is no password 
uniqueness. 
Note: For uniqueness to be effective, an age value should be specified for Minimum 
Password Age (Allow Immediate Changes should not be selected). 

No Account Lockout When selected, user accounts are never locked out, no matter how many incorrect login 
attempts are made on a user account. 

Account Lockout 

If selected, all user accounts are subjected to lockout. If too many incorrect login attempts 
are made on a user account, no more than a specified amount of time between these, the 
account is locked out. 
If you select Account Lockout, you should also do the following: 

In Lockout After, type the number of incorrect login attempts that will cause the account 
to be locked. The range is 1 to 999. 

In Reset Count After, type the number of minutes that must pass between any two 
login attempts to ensure that a lockout will not occur. The range is 1 to 999. 

Click Duration and type the number of minutes that locked accounts will remain locked 
before automatically becoming unlocked. The range is 1 to 999. 
Or, select Forever in Lockout Duration to keep locked accounts locked out until an 
administrator unlocks them. 
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Field Description 

Password Complexity 

This option mimics the NT test for complexity. The password must: 

Not contain all or part of the user's account name. 

Be at least six characters in length. 

Contain characters from three of the following four categories:  
English upper case characters (A-Z) 

English lower case characters (a-z) 
Base 10 digits (0-9) 

Non-alphanumeric (For example, !,$#,%) 

Auto Logout If selected, sets the number of minutes from the time of user login, before the system 
automatically logs the user off. The range is 1 to 999 minutes. 

Logout Password 

To log out of the Security Server, the user specified in the User Name field of the Security 
Login dialog of the Security Login application must click the Log Out button, as shown in 
the figure below. When a Logout Password is required in the user's account policies, the 
user must type in his or her password when logging out. 

 

 
Figure 9.68. Security Login Dialog Box in Security Login Application 

9.8.14 Editing Default Group Settings 
The system default group (available in advanced security configuration mode only) is used to assign access 
rights that are granted regardless of whether any users are logged in. When the Security Server is first installed, 
the default group has full access to everything. The first step in configuring the security system is to remove most 
if not all access rights assigned to the default group. 

Note: You must configure the default group to have minimum access rights, because individual users and groups 
can only add access rights but can never remove rights already granted in the default group. 

1. To edit the default group, click the Default Group button in the Security Administration console, as shown in 
Figure 9.69. 

 
Figure 9.69. Editing the Default Group 
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2. This opens the Properties dialog box for the default group, as shown in the figure below. The same property 
pages used to edit ordinary groups are also used for the default group, with the following differences: 

• There is no Time Sheet property page. Default access is valid for all times. 

• Account Policy must be set in the default group, and there are two additional fields in this property 
page: Simultaneous Logins and Allow Auto NT Login. Checking the Simultaneous Logins box 
allows more than one user to be logged in to a single station at the same time. The effective access 
rights on that station become the sum of all rights of all logged in users. 

Note: See Editing Users and Groups for details about configuring group properties. See the Account Policy 
section above for details about user and group account restrictions. 

 
Figure 9.70. Default Group Properties 
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Pager Configuration 
A.1 Overview of Pager Services Configuration 

The Multimedia Configurator offers a Pager Agent that connects to a wide variety of pager services and supports 
the most popular paging protocols: 

• Tele Alphanumeric Protocol (TAP) 

• Simple Messaging Service (SMS) 
Other variations are supported as well, such as Paging Entry Terminal (PET), which is basically the same as TAP. 
The method through which a page is sent depends on the type of pager being used. For example, in the United 
States the predominant pager type uses TAP, and uses a standard modem to communicate. TAP pagers can also 
use Integrated Services Digital Network (ISDN) carriers. The Multimedia Configurator user interface calls out the 
use of “Modem/ISDN Service” (rather than specifying actual protocols used), as this is more straightforward for 
users to understand. 
Note:  It is the paging service and the Multimedia software that communicate via TAP; it is not something special 
in the modem itself.  Therefore, most ‘Hayes compatible” off-the-shelf modems should work for sending TAP 
messages. 
SMS pagers offer more sophisticated interaction. For example, they permit two-way paging. In the case of 
Multimedia, this allows users to send an “Acknowledge” back to the alarm system directly from the pager. SMS 
paging messages are not sent over a modem, but rather use the Global System for Mobile Communications 
(GSM) network. Again, rather than calling out the low-level protocols used, the Multimedia Configurator interface 
refers to the method of communication, and calls this “GSM/PCS Service.” 

A.1.1 Installation  
During the installation of AlarmWorX Multimedia, after checking the box for including the Pager Agent, you can 
select which paging services to include with the installation. There are two separate lists: one for the Modem/ISDN 
(TAP) pagers, as shown in Figure A.1, and one for GSM/PCS (SMS) pagers. Note that you can select more than 
one. Simply use Shift-Click to select a sequential set, or Ctrl-Click to select items that are not next to each other. 

 
Figure A.1. Modem / ISDN Services Setup 

A.1.2 Modem Configuration 
To configure your modem, use the following procedure: 
1. Plug in the modem hardware. 
2. From the Windows Control Panel, select Phone and Modem Options. 
3. Create or edit the dialing rules.  
4. Add the appropriate drivers for the modem hardware. 
5. Test the modem using a windows modem utility, such as HyperTerminal. 

Note: The actual dialog boxes vary between Windows operating systems. 
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A.2 Creating and Modifying Pager Services 
If you found your service in the list and have already installed it, you need not read this section. Instead, move on 
to the “Pager Configuration Settings” section below.  
If you did not find your service in the list, you can set up a new TAP or SMS pager service. You can also edit the 
parameters for an existing pager service (e.g., in case the access phone number for your service changes). 
1. Launch the Multimedia Configurator. 
2. Select Alarm Configurations - Multimedia Agents - Pager/SMS/GSM/TAP from the tree control on the left-

hand side, as shown in Figure A.2. 
3. Launch the services configuration by clicking the General Settings button in the Pager Agent configuration, 

shown in Figure A.2. 
4. The TAP/SMS diagnostics will be displayed, as shown in Figure A.3, giving you the option to view and log 

ISDN/GSM diagnostic messages during pager testing. 
5. Click the Modem Configuration button to launch the Message Master configuration. This opens the 

DERDACK Message Master Configuration dialog box, as shown in Figure A.4. Here you have two options: 
Message Master GSM/PCS and Message Master Modem/ISDN. To configure TAP services, select the 
Message Master Modem/ISDN option, and then click the Config... button. To configure SMS services, select 
the Message Master GSM/PCS option, and then click the Config... button (or double-click on the item in the 
list).  
Note: Click the Help button at any time to view the Message Master help documentation. 

 
Figure A.2. Setting Up Pager Services 

 
Figure A.3. TAP/SMS Diagnostic Utilities 

 
6. Click on the Defined Services tab (labeled Services for GSM) and look to see if your service is listed.  If it 

does appear in the list, you can select it. Click the Properties button to modify its parameters. 
Note: The TAP and SMS dialog option will hold the MMXPager open until the dialogs are closed. 
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Figure A.4. DERDACK Message Master Configuration Dialog Box 

A.3 TAP Configuration 
This section covers the details of creating and modifying a TAP pager service.  For details on SMS paging, see 
Section A.4. To configure TAP services, select the Message Master Modem/ISDN option (see Figure A.4), and 
then click the Config... button. The TAP Configuration dialog box will appear, as shown in Figure A.5. 
1. On the Dial Parameter and Modem Device tab, shown in Figure A.5, configure the following parameters. 

• Location: This is the location set when configuring the dialing rules (mentioned in the "Modem 
Configuration" section above.) 

• Device: Select the device for the modem hardware. 
Note:  We have found that many paging services (which must work with old technology modems for 
backwards compatibility) generally do not work with the out-of-the-box configurations of modern 
modems. Most often, the only change needed is to turn off the modem’s Error Control features.  

 
Figure A.5. TAP Configuration: Dial Parameter and Modem Device Tab 

This can be done with a Windows setting from the Control Panel.  Conversely, some very old modems 
with max. Baud rates less than 9600 sometimes do not work well with the new Windows interfaces 
(TAPI) used by the MMX software.  So make sure your modem is TAPI compliant.  Test to see if it works 
with HyperTerminal. 

• Timeout for modem devices: Select the re-initialization timeout for the modem (in seconds). 
Note: The Device Config.. button actives the Modem configuration used for the AlarmWorX Multimedia 
Pager Agent.   
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2. On the Send Options tab, shown in Figure A.6, configure the following parameters: 

• Attempts for resending messages in error cases: Select the number of times to retry in case of error. 

• Enable Check messages for invalid characters. 
• Check Replace invalid characters automatically if desired. 
 

 
Figure A.6. TAP Configuration: Send Options Tab 

 
3. On the Defined Services tab, shown in Figure A.7, check for your pager service provider. Verify that the 

service modem phone number is correct by selecting the service provider and clicking the Properties button. 
This opens the Services dialog box. The service provider number is located on the Additional tab in the 
Number for dial-up terminal field. 

 

 
Figure A.7. TAP Configuration: Defined Services Tab 
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Figure A.8. TAP Configuration: Diagnostics Tab 

 
4. On the Diagnostics tab, shown in Figure A.8, diagnostic support is available through the TAP dialog.  The 

Write communication log file check box should not be used. 

A.3.1 Setting up a New TAP Service 
The standard Multimedia pager installation includes many of preconfigured TAP services. If your particular service 
is not listed, you can add it by following a few simple steps. 
1. Launch the TAP configuration (as described above), and select the Defined Services tab, shown in Figure 

A.7. 
2. If your service is not listed, click the New button. 
3. On the General tab, shown in Figure A.9, configure the following parameters: 

• Enter a name for the new service.  

• Select Message transmission based on data connections. 
• Set the Protocol type field to TAP. 

• Pick a character set. 
Click the Next button to continue. 
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Figure A.9. Configuring a New TAP Service: General Tab 

4. On the Additional tab, shown in Figure A.10, configure the following parameters: 

• Number for dial-up terminal: Enter the service modem number. This is the phone number your modem 
will call to connect to the pager service provider.  Your service provider will need to inform you of this 
number, which must be in TAP format.  For the United States, the format is  
+1 (800) 2345678.  The international format is +44 (215) 2345678. 

• Maximum message length: Choose the maximum number of characters to display per message. 

• Password: Not necessary 

• Calling zone: Not necessary 
• Number of messages the carrier accepts at once: 1  
Click the Next button to continue. 
Note:  Find out (or simply test) whether your paging service can accept more than one message at a time. 
Quite often services do.  Entering a number greater than one may result in fewer modem dial-outs when 
multiple paging  

 
Figure A.10. Configuring a New TAP Service: Additional Tab 
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messages are queued up.  In other words, if five messages have to be sent out over the modem, and this 
parameter is set to 1, it must dial out five separate times, once for each pager message.  However, if this 
parameter is set to 5 and the paging service permits this, then only one dial-out session takes place, and all five 
messages are efficiently sent in that one phone call. 
5. On the Type tab, shown in Figure A.11, configure the following parameters: 

• Select the Type appropriate to the pager. Generally this is Alphanumeric. 
• UCP operation type: This is not applicable. 

• Check the Breakup larger messages automatically check box. 

• Maximum word wrap for breakup: Generally, choose a number that evenly divides into the number 
chosen for the maximum message length (in the Additional tab shown in Figure A.10). 

Click the Next button to continue. 

 
Figure A.11. Configuring a New TAP Service: Type Tab 

 
Figure A.12. Configuring a New TAP Service: Country Code Tab 
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In the Country Code tab, shown in Figure A.12, enter a country code if applicable. Click the Next button to 
continue. 

 
Figure A.13. Configuring a New TAP Service: Terminal Tab 

 
6. On the Terminal tab, shown in Figure A.13, select the modem driver from the drop-down list under the Used 

modem or ISDN device field.  
7. Click the Finish button to complete configuration of the new TAP service. Your new service is now available 

in the Defined Services list. 
 
Note: While it is a good idea to configure this dialog, modem configuration is actually done by using the 
Configure button on the Device tab (see Figure A.5). 

A.4 SMS Configuration 
This section covers the details of creating and/or modifying an SMS pager service. If you are using TAP, then you 
can skip this section. 
To configure SMS services, select the Message Master GSM/PCS option (see Figure A.4), and then click the 
Config... button. The SMS Configuration dialog box will appear, as shown in Figure A.14. On the Services tab, 
shown in Figure A.14, check for your pager service provider. Verify that the service modem phone number is 
correct by selecting the service provider and clicking the Properties button. This opens the Service Properties 
dialog box, shown in Figure A.15. For information about service properties, please see the "Setting up a New 
SMS Service" section below. 
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Figure A.14. SMS Configuration: Services Tab 

Note: If a message window appears stating:  “There is no port specified”, then you must first add and configure a 
port to use for SMS paging via the Ports tab.  You should have your SMS equipment connected to your 
appropriate COM port before completing the port configuration. 

A.4.1 Setting up a New SMS Service 
If your SMS service is not listed in the Services tab: 
1. Click the Add button, as shown in Figure A.14. This opens the Service Properties dialog box, shown in 

Figure A.15. 
2. On the General tab, shown in Figure A.15, configure the following parameters: 

• Name: Enter the name of the new service to be shown in the list of GSM/PCS services. 

• Port: Select the port the on which the GSM hardware is located. 
Note: If no port is configured, go to the Ports tab on the SMS Configuration Settings dialog box (see 
Figure A.14) and click the Add button to set up a port for GSM use. 

• SMSC: Enter the service modem number. Include a "+" before the first number. 

• Default Country Code: This is not applicable. 

• Default Prefix: This is not applicable. 
• Resend Attempts: Enter number of times to resend. 
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Figure A.15. SMS Service Properties: General Tab 

 
Figure A.16. SMS Service Properties: Splitting Tab 

 
3. On the Splitting tab, shown in Figure A.16, check the Splitting, Optimize Splitting, and Enumerate check 

boxes. 
4. On the Messaging tab, shown in Figure A.17, enter a string to add before the message (if this is necessary 

for your pager service). 
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5. Click the OK button. Your new service is now in the services list. 
6. On the General tab of the SMS Configuration dialog box, check both the Activate Outbox Spooler and the 

Activate Inbox Spooler check boxes, as shown in Figure A.18. 
 

 
Figure A.17. SMS Service Properties: Messaging Tab 

 

 
Figure A.18. SMS Configuration: General Tab 
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A.5 Pager Configuration Settings 
Once you have properly set up your pager service, you can complete the Pager Agent configuration by using the 
following procedure. For more information about Pager Agent configuration fields, please refer to Chapter 4. 
1. In the tree control in the left pane of the Multimedia Configurator screen, right-click Pager/SMS/GSM/TAP 

and select New - Pager Contact from the pop-up menu. 
2. Enter the Pager Media Name in the configuration field in the right pane. 
3. Enter the Pager Number. This is the phone number of the pager to contact, and is the same number you 

would use if you where paging from a touch-tone phone. 
4. Select a template from the drop-down list. 
5. If you are using a TAP pager, select Use Modem/ISDN Service and choose the service provider for your 

pager from the drop-down list. If you are using an SMS pager, select Use GSM/PCS Service and choose the 
service provider for your pager from the drop-down list. For an SMS Pager, also enter something in the 
Acknowledge Code field. This is used for “callbacks”, when the user makes use of two-way paging to 
acknowledge an alarm message back into the system. 
Note: If a new pager service has been added, click the Update Service List button to display the service in 
the drop-down list. If your pager service provider is not listed, you will need to go back and follow the steps for 
setting up pager services. 

6. Click Apply to save the changes. 
7. To test your configuration without having to actually trigger an alarm, click the TEST button. If you experience 

problems in getting Multimedia to successfully send a page, enable the diagnostic dialog and/or log file to see 
where within the paging sequence the problem is occurring. If you chose to enable the diagnostic utilities (see 
Figure A.3) when configuring your pager services, the diagnostic dialog boxes will appear. The SMS 
Diagnostic dialog box is shown in Figure A.19. If you are using TAP and you chose to enable the TAP log 
file (in Figure A.3), you can view the log file by clicking the Open Log button in the TAP Diagnostic dialog, 
shown in Figure A.20.  

 
Figure A.19. SMS Diagnostic Dialog Box 
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Figure A.20. TAP Diagnostic Dialog Box 

Note: Status updates take place after the dial attempt.  This does not affect single test cases.  For multiple pages, 
the status information will often be one page behind the current page attempt.  

A.6 Using the Multimedia Wizard for Pager Configuration 
Perhaps the easiest way to configure the Multimedia software to send out a message to a pager when an alarm 
occurs is to use the Multimedia Configuration Wizard. The following example explains how to create a simple 
pager configuration using this wizard.  
Note: You may also wish to explore the interactive Multimedia Assistant tutorial, which walks you through, using 
an animated talking teacher, the steps for creating alarm configurations. Choose Multimedia Assistant from the 
Help menu.  
Note: If your paging service was not available in the list at installation time, or you did not choose a service, define 
a paging service now. Refer to Section A.2 for details on how to define a service. This must be done before 
starting the wizard. Refer to Chapter 2 for details about alarm configurations. 
To start the Multimedia Configuration Wizard, click the button on the toolbar that looks like a magic wand starts, as 
shown in Figure A.21. (The wizard is also accessible from the Tools menu).  

 
Figure A.21. Launching the Multimedia Configuration Wizard 

 
The wizard will walk you through the following steps: 
 

Step 1 
The first step is to give this configuration a name, which will then appear in the left-hand tree control under Alarm 
Configurations once the wizard is complete.  Each configuration can contain multiple action sets (described later) 
performing different types of multimedia notification (e.g., paging, voice, email, etc.), but is tied to just one OPC 
Alarm and Event Subscription (described in the next step).  So, if you only have one alarm server, you will typically 
only need one configuration.  Enter a name for identifying this multimedia configuration ("HVAC Alarms" in this 
example), as shown in Figure A.22.  Click Next to continue to Step 2. 
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Fig. A.22. Naming the Alarm Configuration 

Step 2 
Step 2 specifies where alarms will come from.  For Smar installations, this will typically be the  Smar Alarm OPC 
Server, or possibly the  SmarModbus OPC Server Version 3.05. 
Basically the Multimedia Server subscribes to the OPC Alarm and Event server and receives all alarms made 
available by that server.  The Multimedia Server will then use the alarm filters to select subsets of these alarms to 
determine the messages for which paging messages will be sent. 
This is the same “subscription process” as is used for the Alarm Viewer ActiveX control to view the list of active 
alarms.  For further details about subscriptions, please review the AlarmWorX documentation that came with your 
ProcessView software. Also refer to Chapter 2, or see the Alarm Subscription section later on in this appendix. 
For this example, we will simply select the Smar Alarm OPC Server subscription already created in the database 
installed from the CD.  Select Use Existing OPC Subscription and choose the appropriate one from the drop 
down list, as shown in Figure A.23.  Then click Next to skip to Step 4. 
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Figure A.23. Creating a Subscription Set 

Step 3 
Step 3 is shown only if you elected to create a new OPC alarm subscription in Step 2. Since you chose an existing 
alarm subscription, this portion of the wizard is skipped. For details on creating a subscription outside the wizard, 
please refer to Chapter 2, or see the "Alarm Subscriptions" section later in this appendix. 

 

Step 4 
In Step 4, the wizard helps create what is known as an alarm Action Set.  This is a set of actions that the 
Multimedia Server will take whenever an alarm from that subscription occurs.  For example, one action set could 
not only page the security guard, but it could also send an e-mail message to the technician on duty, announce 
the message over a P.A. system, and fax the alarm to a remote center.  Here we will simply set up one entry for 
paging. 

Note: For more information about action sets, please refer to Chapter 2. 

First, give this action set a name ("SendPage" in the example below).  This name will appear in the tree under the 
alarm configuration once the wizard is complete. 
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Figure A.24. Defining Action Set Parameters 

Second, select what type of event will stop this action set from continuing through the list.  For action sets with 
multiple notification options configured (as mentioned above) the progression through those actions will be 
interrupted by the stop condition, and the remainder of the actions will not be executed.  For example, you could 
have the Multimedia Server stop sending messages once someone acknowledges the alarm, or perhaps when the 
alarm returns to normal.  Simply check the appropriate box(es), as shown in Figure A.24.  
Although there is also a third possible step shown for repeating the action set via the loop feature (e.g., keep 
paging someone every 20 minutes until the alarm returns to normal), this option will not be enabled for this action 
set. 
Click Next to continue to Step 5. 
 
Step 5 
The wizard then permits you to add an Alarm Filter for this action set.  While your OPC subscription may be 
receiving “ALL” the alarms generated by the OPC server, it is often necessary to specify which subset of those 
alarms will result in a message being sent to a pager.  That’s where an alarm filter is used.  For example, you 
could set it up such that only HI ALARMS will send a pager message.  Another filter might specify that only high 
priority alarms will initiate the sending of a pager message. 
Please refer to Chapter 2 for details about configuring alarm filters for Multimedia, or see the Alarm Filters 
section later in this appendix for more information on creating your own filters.  For complete details on the use of 
alarm filters and how to construct them with the various OPC Alarm and Events servers, please consult the 
AlarmWorX documentation. 
In this step of the wizard, you can either choose to create a brand new alarm filter, select an existing one, or forgo 
using any filter.  For this example, select one of the default filters installed automatically from the CD.  So, select 
the second option I want to use existing Alarm Filter, as shown in Figure A.25. 
Then, select from the drop-down list the filter labeled Radiation Level.   
Click Next to jump to Step 7. (Step 6, for creating new filters, is skipped). 
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Figure A.25. Choosing an Alarm Filter for the Action Set 

 

Step 6 
Step 6 is for configuring a new alarm filter, and is skipped in this example because an existing filter was selected 
in Step 5.  Refer to Chapter 2, or see the Alarm Filters section later in this appendix for more information on 
creating your own alarm filters for use within Multimedia. 

 

Step 7 
Each action set can actually execute multiple multimedia notification methods.  For example, when an alarm 
occurs you can configure Multimedia to first announce the alarm over the local P.A. speaker system, and then 
send out an alphanumeric pager message, then send out an e-mail message to five people, and then send a fax 
to a remote site — all triggered by the same alarm. 
Note:  Only those multimedia agents selected during the installation process will work. 
The wizard walks through setting up each action within the action set.  For purposes of this example, we will only 
define one action within this action set:  that of sending out a message to a pager. 
Make sure Sending pager message is selected in Step 7, as shown in Figure A.26. Then, click Next to continue 
on to the next step. 
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Figure A.26. Selecting Paging Action 

Step 8 
Step 8 of the wizard lets you choose to either use an existing Pager Agent definition or to create a new one. A 
Pager Agent defines to whom the message should be sent (e.g., the security guard’s pager number), and 
identifies the paging service protocol to use (e.g., PageNet service).   
For this example, we will walk through creating a new Pager Agent, so select Yes, create new 
Pager/SMS/GSM/TAP Agent configuration, as shown in Figure A.27.  
Then click the Next button to continue to Step 9. 

 
Figure A.27. Creating a New Pager Agent 
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Step 9 
Step 9 of the wizard defines the Pager Agent settings. 
First, enter a name to identify the pager recipient.  This name will be used to identify this Pager Agent in the left-
hand tree control under the Paging section once the wizard is complete. 
Next, select whether the pager message will be sent via GSM/PCS (for SMS type paging, popular in Europe and 
other areas around the world) or Modem/ISDN (for TAP paging, popular in the US and around the world).   
Select which paging service should be used from the drop-down list, as shown in Figure A.28.  Note: If your 
paging service is not listed here, select one of the services provided anyway for now.  Refer to Section A.2 for 
information about how to add new paging services to the Multimedia configuration. 
Finally, enter the Pager ID number associated with this person.  This may or may not be the same ID that you 
would normally use when dialing a numeric beeper from a phone.  Some paging services assign a different 
personal identification number (PIN) to pagers for use when alphanumeric messages are being sent via software 
(such as Multimedia) rather than just simple touch-tone keys on the phone.  Contact your paging service provider 
for details. 
Note: Please refer to Chapter 4 for details about Pager Agent configuration settings. 
Click Next to continue to Step 10. 
 

 
Figure A.28. Filling out the Pager Information 

 
Step 10 
A Media Template defined within Multimedia determines the actual message that gets sent to configured pagers.  
You can select whether the message includes the timestamp of the alarm, the tag name that generated the 
message, the actual alarm message itself, and many other parameters.  Multimedia already comes with a 
template created for sending alphanumeric pager messages.   
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Figure A.29. Using the Alarms Template to Define the Message 

 
For this example, simply select the option I want to use existing Media Template.  Then, make sure the Default 
Pager template is selected from the drop-down list, as shown in Figure A.29.   
Click Next to continue to Step 12. 
 
Step 11 
Step 11 (defining the media template) is skipped in this example, since an existing template was selected in Step 
10 above. Please refer to Chapter 5 for information about creating new media templates. 
 

Step 12 
Step 12 of the wizard permits you to define additional actions to be taken within this action set. As noted earlier, 
this can be used to have Multimedia also announce the same alarm message over a speaker, send e-mail 
messages, and more.   
For purposes of this example, select No, I don’t want to add any more Actions to Action Set ‘SendPage,’ as 
shown in Figure A.30.  
Click Next to continue to Step 13. 
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Figure A.30. Finalizing the Action Set 

 
Step 13 
The action set is now complete.  The wizard now permits you to add additional action sets with different 
notification methods and recipients to be defined. For purposes of this example, select No, I don’t want to add 
any more Action Sets, as shown in Figure A.31. 
Click Next to continue to Step 14. 
 

 
Figure A.31. Finalizing the Action Sets 
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Congratulations!  The wizard is now complete.  Click Finish to save the changes to your configuration, as shown 
in Figure A.32. 

 
Figure A.32. Finished With the Wizard 

A.6.1 Viewing the New Alarm Configuration 
The configuration information is automatically saved to the .mdb database file (Microsoft Access database file).  
Expanding the Alarm Configurations folder in the left-hand tree control of the Configurator shows the newly 
added HVAC Alarms configuration, as shown in Figure A.33.  Expanding that shows the SendPage action set 
just created using the wizard.  Clicking on the SendPage item will show its details on the right-hand side of the 
window, as shown in Figure A.33.  
In this action set, only one action is shown in the action set table:  that of sending a message using the Default 
Pager media template to the HVAC Technician.  And it only will do this for “Radiation Level” alarms. 

 
Figure A.33. Action Set Configuration Information 
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To view details on the configuration of the pager recipient configured in the wizard, expand the Multimedia 
Agents folder in the tree control, and then expand the Pager/SMS/GSM/TAP tree. Click on the HVAC 
Technician item, as shown in Figure A.34.  Its details are then shown on the right-hand side of the display. Here 
you can see the paging number defined during the wizard, as well as the paging service selected.   

 
Figure A.34. Pager Configuration Information 

 
The TEST button, shown in Figure A.34, can be used to verify that the paging service, modem, pager number, 
and other such parameters are correct before attempting to trigger pager messages based on actual alarms.  It 
helps separate issues of alarm subscription versus pager setup when troubleshooting a system for the first time. 
Other advanced options are available within Multimedia, including scheduling and roles.  For example, you can 
assign a complex schedule (complete with vacation time, recurring patterns, excluded periods, etc) and have an 
action set use that schedule when determining whether someone should be notified.  If you do assign a schedule 
to an agent, make sure the Ignore Schedule checkbox is NOT checked in the action set table. For details about 
configuring schedules and roles, please refer to Chapter 6.  

A.6.2 Starting the Multimedia Server 
To make the Multimedia Server use the setup information entered in the Configurator, the Server must be placed 
into “runtime” mode.  To start/stop the server, click the stoplight button on the toolbar, as shown in Figure A.35 
and Figure A.36, (or choose Start Multimedia Server from the Action menu). 

 
Figure A.35. Multimedia Server Toolbar Button – Server Stopped 

 
Figure A.36. Multimedia Server Toolbar Button – Server Running 

The Multimedia Configurator also offers a Monitor View for observing the triggering of multimedia actions by the 
Multimedia Server. To turn this on, either click on the Monitor button (looks like eye glasses) on the toolbar, or 
select Monitor View from the View menu. 

A.7 Alarm Filters 
As discussed in Step 5 of the Multimedia Configuration Wizard, the Multimedia Server receives all alarms 
subscribed to, and it uses alarm filters to narrow down the list to specify which subset of alarms will be used to 
initiate a multimedia action.  For example, one filter could specify that only HI ALARMS will send a page, while 
another filter might specify that only high priority alarms will initiate the sending of a page. 
Note: For details about creating alarm filters and expressions, please refer to Chapter 2. 
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A.7.1 Creating a New Filter 
This section walks through how to add a new filter to your Multimedia configuration.  
1. Expand the Alarm Inputs folder in the left-hand tree control of the Multimedia Configurator, and then expand 

the Alarm Filters folder. This shows all of the filters already defined in your system, as shown in Figure A.37. 

 
Figure A.37. Alarm Filters in the Multimedia Configurator 

 
2. Right-click the Alarm Filters folder and select New - Alarm Filter from the pop-up menu (or select from the 

Edit menu).  A new filter is inserted into the list. 
3. Enter a name that adequately describes the alarm filter being created.  For this example, we will set up an 

alarm filter that will trigger our Send Page action set only when an alarm with a Priority (Severity) greater than 
or equal to 500 occurs.  So enter as the name: Just Priorities (Severities) >= 500. 

4. Click the Edit button.  The alarm filter Edit Expression dialog box appears, as shown in Figure A.38. 

 
Figure A.38. Alarm Filter Expression Editor and Filter Wizard Selection 

5. Click the Tags button, and then select Advanced from the pop-up menu, as shown in Figure A.38. This 
shows a listing of all possible alarm attributes for use in your filter.   

6. Select Severity from the Alarm Tag window, as shown in Figure A.39, and then click OK. Note that the filter 
wizard then inserts into the Expression Editor workspace the necessary filter “code” of: {{Severity}} 
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Figure A.39. Alarm Attributes for Use in Filters 

7. To finish the filter, click on the Relational button and choose  >= Greater Than or Equal.  Next, type in 500.   
Note:  You did not necessarily have to click on all the buttons.  You could have simply typed in the 
expression:  {{Severity}} >= 500 directly in the text field.  However, using the buttons helps make sure the 
syntax is correct. 

8. Click OK to complete this filter. (Note: The expression editor will add an “x= “ in front of the expression to 
complete it for you). Your final alarm filter should appear as shown in Figure A.40. 

9. Finally, click the Apply button to save this filter.  It then gets placed alphabetically in the tree control, as 
shown in Figure A.40. It may now be used in the action set to limit which alarms will trigger the action(s). 

 

 
Figure A.40. Completed Alarm Filter 

 

A.7.2 Using Alarm Filters 
If you have a lot of alarm filters to create and use, you may elect to create them en-mass by first exporting an 
existing one (as a “template”) by selecting Export CSV from the File menu.  You can then use a spreadsheet, 
word processor, or other tool to replicate and create more filters.  Then simply re-import those filters into 
Multimedia. 
If desired, you can remove all other references in the CSV file, and only work on the #MMX_Filter section.  That 
way when you import that CSV file, only those filters are brought into your system. 
The filters can then be applied to each action set defined in your Multimedia configuration. 
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A.8 Alarm Subscriptions 
As mentioned earlier, the Multimedia Server subscribes to other alarm systems for current status information.  
Unless you are creating multiple subscriptions for many sites, or are networked to the machine running the OPC 
Alarm and Event server, the default subscriptions that were installed with Multimedia from CD should suffice. 
However, if you need to create your own subscription to an alarm server, this section will walk you through the 
basics within the context of the Multimedia System.  For complete details, you must consult the documentation 
that came with your alarming system. Also refer to Chapter 2 for more information about creating subscriptions. 
1. Expand the Alarm Inputs icon in the left-hand tree control of the Multimedia Configurator, and then expand 

the OPC Subscriptions folder. This shows all of the alarm subscriptions already defined in your system.   

 
Figure A.42. Inserting a New Alarm Subscription  

 

2. Right-click the OPC Subscriptions folder and select New - OPC Subscription from the pop-up menu, as 
shown in Figure A.42 (or, select from the Edit menu). A new subscription is inserted into the list. 

3. In the Subscription Name field, enter a name to identify the types of alarms coming from this alarm 
subscription (e.g., “All Alarms from Buildings 2 & 3”).  This name will be used when you assign a subscription 
to an alarm configuration. 

4. Click on the Subscribe/Edit button.  This opens a Subscriptions Properties window for defining the alarm 
subscription, as shown in Figure A.43.   

 
Figure A.43. Adding a New Subscription 

 
5. Each alarm subscription can actually contain links to multiple OPC Alarm and Event servers (e.g., you may 

need to link into both the Smar Alarm and Event Server as well as the Modbus Server in order to get all 
alarms in your system).   

6. To add a link, click the Add button.  Give the new entry a name. (This name will not appear or be used 
anywhere else; it is just a way of identifying this OPC Alarm and Event Server link).   

7. Click the Edit button.  Another pop-up window appears, allowing you to define the specific OPC Alarm and 
Event subscription.   

8. Click the Browse button and navigate to the appropriate OPC Alarm and Event server typically found in the 
“My Computer / Alarm & Event” path (unless you want to connect to a server on another PC on your network). 
Highlight the desired Alarm and Event server, as shown in Figure A.44. 
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Figure A.44. Selecting an Alarm and Event Server 

9. The selected server will now appear in the Event Server field of the Event Subscription dialog box, as 
shown in Figure A.45.  

 
Figure A.45. Defining the Alarm and Event Subscription 

While for this example it is not necessary to modify any of the details in any of the other tabs shown in this dialog 
box (hence all alarms will be delivered to Multimedia for notification), we will quickly go over two example settings 
that may prove useful.  
10. First, click on the Categories tab. If no categories appear in the right-hand Subscribed list, then “all” 

categories are used.  However, adding Digital to the list tells the OPC Alarm and Events server to deliver 
only those alarm messages to Multimedia.  This is a “first-pass” filter on the server side.  With this setup, none 
of the Analog Limit alarms will be sent to the Multimedia Server, freeing up the communication traffic.  Again, 
do this only if you just want digital alarms (otherwise leave this blank to subscribe to “all” alarms). 

 
Figure A.46. Alarm Server Categories 
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11. Click on the Attributes tab, shown in Figure A.47.  Here you can tell the OPC Alarm and Events Server to 
send additional information about each alarm.  For example, in Figure 4.47 the ACK COMMENT field has 
been added as Attribute 1. This will permit any comments the operator added during the alarm 
acknowledgement process to also be available to your multimedia templates for the notification messages to 
be sent out. 
Note:  You must do this for each event category you are subscribed to in order for it to be available for each 
alarm type.  

12. Click OK in the Event Subscription dialog box.  

 
Figure A.47. Additional Attributes for Alarm Server 

 
13. Click OK in the Subscription Properties dialog box to return to the Configurator screen.   
14. Click Apply to save your changes to the database. 
Note: To learn more about the additional subscription details found on the Types, Categories, Areas, Sources 
and Attributes tabs, please refer to Chapter 2, or consult the Alarm OPC Server's documentation. 

A.9 Troubleshooting Pager Configurations 
If you have any questions about the configuration of the Multimedia software, other than the OPC Alarm and 
Event subscription to third-party alarm servers themselves, please contact the Smar support center.  In general, 
all questions related to the Smar AlarmWorX Multimedia software will probably fall into this category. 

You may run into the scenario that Alarms do not appear to be triggering the multimedia notifications you have 
configured in the Multimedia Configurator. 

If you have made sure the Multimedia Server is indeed running, and that the configuration you are using is the 
active database, then follow these simple steps to determine whether to contact a third-party vendor or Smar:  

1. Take the OPC alarm subscription(s), and any alarm filters, defined in the Multimedia software and use those 
exact same configurations in the SMAR AlarmWorX Viewer ActiveX window.   

2. If the SMAR AlarmWorX Viewer ActiveX window is successfully showing your alarm conditions, the problem 
probably lies within the configuration of the Multimedia software, and so you should contact the SMAR 
technical support center.  But before you do, please work through the flow chart troubleshooting guide shown 
in Figure A.48. 

3. If the SMAR AlarmWorX Viewer ActiveX window does NOT successfully show your alarms coming in, the 
problem is with the subscription itself, or possibly the OPC server and/or the hardware generating the alarms.  
If that is the case, Smar technical support cannot be of assistance, and you must first get this running with the 
help of your vendor’s OPC Alarm and Event server technical support. 
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A.9.1 Troubleshooting Flow Chart 
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Figure A.48. Troubleshooting Flowchart 
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Advanced Telephony Settings 
B.1 Overview of Phone Agents Configuration 

To set the default settings for the Phone Agents, click on the Phone folder in the Multimedia Configurator, as 
shown in Figure B.1. If you do not see the General Settings, make sure that Dialog View is checked on the 
View menu. Please refer to Chapter 4 and Chapter 9 for information about general settings for the Phone 
Agents. 

 
Figure B.1. Telephony Agents: General Settings 

Dialogic Configuration 
You must have a telephony card installed on the computer on which you are running the Phone Agents (both Call-
in and Call-out). AlarmWorX Multimedia supports Intel® Dialogic® boards. Dialogic boards do not work for 
Windows 98, so neither the Call-in Agent nor the Call-out Agent will work on Windows 98. You also need to 
have an analog phone line connected to the board. (Note: Digital lines are not supported.) Only Dialogic boards 
are supported for the current version of AlarmWorX Multimedia. Please see Appendix B for information about 
installing and configuring Intel Dialogic boards. For more information about purchasing and installing Intel Dialogic 
boards, please visit the Intel Web site at www.intel.com/network/csp/products/index_vp.htm. 

B.2 Creating Call-out Templates 
The Multimedia Configurator provides a default media template for the Call-out Agent. To view this template, 
select Alarm Configurations - Media Templates - Default Telephone from the tree control. The telephone 
template field will be displayed in the right pane, as shown in Figure B.2.  
You can create a new template for the Call-out Agent by right-clicking the Media Templates folder in the tree 
control and selecting New - Media Template from the pop-up menu. Select the Phone radio button in the 
template configuration field in the right pane, as shown in Figure B.2. 
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Figure B.2. Default Template for Call-out Agent  

In the Design Elements tab of the template configuration dialog box, shown in Figure B.2, click the Insert button. 
This opens the Template Definition Wizard dialog box, shown in Figure B.3, which contains a list of available 
field types to add. (For a complete list of available field types, please refer to Chapter 5.) Choose a field type and 
select from the additional options under Field Properties, and then click Insert. If you wish to change the order of 
the fields or to delete a field, use the appropriate buttons to do so. The Insert Blank button will insert a line break.  
Two field types—Sound File and Delay—are used specifically for the Phone Agent templates. (These field types 
may also be used for video and/or sound / text-to-speech templates.) The Sound File field type allows you to 
select or add a sound file to the phone template.  

 
Figure B.3. Template Definition Wizard: Sound File 
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Figure B.4. Sound Library Dialog Box 

 
Clicking on the Sound Library button opens the Sound Library dialog box, shown in Figure B.4. Click the Add 
Sound File button to browse for .wav and .mid files. Click Open to add the selected file to the Sound Library. To 
listen to a file, highlight the file and click the Play button, as shown in Figure B.4. To select an existing sound file 
from the Sound Library, highlight the entire row for that file, and then click the Select button. The selected sound 
file will appear under Field Definition in the Template Definition Wizard dialog box. 
You can also set a delay for the templates by selecting the Delay field type in the Template Definition Wizard 
dialog box, as shown in Figure B.5. Under Field Properties, you can enter the delay time (in milliseconds) before 
the next template can be activated. Click the Insert button to add the delay to the list of template fields. 
 

 
Figure B.5. Template Definition Wizard: Delay  

 
All current template fields are displayed the Design Elements tab (see Figure B.3). The Field Definition for these 
template fields is also displayed in the Template Source Code tab, shown in Figure B.6, where you can 
manually edit a template field if desired. 
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Note: The Template Source Code tab is recommended for advanced users only. Do not modify any fields here 
unless you are absolutely sure of what you are doing. For more information about templates, please refer to 
Chapter 5. 

 

 
Figure B.6. Template Source Code Tab 

 
To save the changes to your template, click the Apply button in the phone template configuration field. Now you 
can go to the Phone Agent configuration field under the Multimedia Agents - Phone folder in the tree control of 
the Configurator and select your template from the Use Template drop-down list, as shown in Figure B.7. Be 
sure to click the Test button to test your configuration. 

 

 
Figure B.7. Selecting the Template in the Telephony Agent Configuration 



AlarmWorX Multimedia 
 

Ap.B5 

B.3 Intel Dialogic Boards 
Generally, any Intel Dialogic telephony card will work with the Phone Agent. It requires the proper installation of 
Intel Dialogic System Release Version 5.1 software as well as proper card installation and configuration. The 
Phone Agent uses Topaz tools for working with Intel Dialogic System Release Version 5.1 software. Topaz 
components are embedded in the Phone Agent. The following Intel Dialogic telephony cards have been tested: 

• D/4PCI (supports up to four phone lines) 

• Dialog/4 ISA (supports up to two phone lines) 

• ProLine/2V (supports up to two phone lines) 
 

Note: For more information about purchasing and installing Intel Dialogic boards, please visit the Intel Web site at 
www.intel.com/network/csp/products/index_vp.htm. 
 

 
Figure B.8. Welcome to Dialogic Setup Installation Screen 

B.3.1 Installing Intel Dialogic Boards 
This section describes the procedure for installing Intel Dialogic System Release Version 5.1 software.  
Note: Please refer to the Intel Dialogic help documentation for more information. 
1. Insert the Intel Dialogic System Release Version 5.1 CD. 
2. The Welcome to Dialogic Setup dialog box will appear, as shown in Figure B.8. Click the Next button to 

continue. 
3. The Registration dialog box will appear. Enter your name and your company's name. Click the Next button 

to continue. 
4. The Setup Options dialog box will appear. Select the Typical setup. Click the Next button to continue. 
5. The Destination Location dialog box will appear, as shown in Figure B.9.  Click the Browse button to select 

a directory for installation. Click Next. 
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Figure B.9. Choosing a Location for the Installed Files 

 
Figure B.10. Specifying the Program Group Folder 

 
6. The Program Group Folder dialog box will appear, as shown in Figure B.10. Specify a program folder, and 

then click the Next button to continue. 
7. The Selecting Options Summary dialog box will appear, listing the settings that you have chosen. To accept 

the settings, click the Next button. 
8. The installation will now copy files to your system. 
9. The Selection dialog box will appear, as shown in Figure B.11. Check the View Release Guide check box, 

and then click the Next button to complete installation. 
10. The Setup Complete dialog box will appear. It is recommended that you restart your computer. Click the 

Finish button to complete the installation. Now you are ready to install and configure a telephony card. 
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Figure B.11. Selection Dialog Box 

B.4 Installing and Configuring Telephony Cards 
This section covers the procedure for installing and configuring the Dialogic Proline/2V telephony card. (You can 
use other telephony cards if desired.) The following steps must be followed to ensure proper card installation and 
configuration. Click on the Help menu at any time to view the Dialogic help documentation.  
1. Install the Intel Dialogic Proline/2V card as it described in the manual, which can be found inside the card 

package.  
2. Start the Dialogic Configuration Manager, as shown in Figure B.12. 

 
Figure B.12. Dialogic Configuration Manager 
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Figure B.13. Add Hardware Wizard: Choosing the Telephony Card 

 
3. Select Add Device from the Action menu. This opens the Add Hardware Wizard dialog box, as shown in 

Figure B.13. Scroll down the list of cards under Family and select Proline. Then, under Model, select 
Proline/2V. Click the Next button to continue.  

4. Enter a unique name for the board, as shown in Figure B.14. Click the Next button to continue.  
 

 
Figure B.14. Add Hardware Wizard: Naming the Board 
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5. This opens the Properties dialog box for the telephony card, as shown in Figure B.15. On the System tab, 
select the correct memory address from the Parameter field. In this case it is "d2000", as shown in Figure 
B.15. Also choose the same interrupt number that was chosen during the actual card installation.   

 
Figure B.15. Dialogic System Properties 

 

 
Figure B.16. Dialogic Miscellaneous Properties 
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6. Click on the Misc tab on the Properties dialog box, as shown in Figure B.16. Verify that the configured 
parameters are correct. Then click Apply and OK. 

7. Figure B.17 shows how a properly configured Proline/2V card looks. Now you are ready to start the service. 

 
Figure B.17. Completed Card Configuration 

 
8. To start the service, click the Start Service (green circle) button on the Diagnostic Configuration Manager 

toolbar. This will start the Proline/2V telephony card, as shown in Figure B.18. The Status box will indicate 
whether the telephony card started successfully. Now you are ready to start using the Phone Agent. 

 
Figure B.18. Activated Telephony Card 
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B.5 Using the Dialogic Diagnostic Utility 
The Universal Dialogic Diagnostic Utility (UDDU) provides diagnosis of telephony card failure or other 
problems.  

 
Figure B.19. Universal Dialogic Diagnostic Utility Warning 

 
1. Go to "Program Files/Dialogic System Software/Universal Dialogic Diagnostics Utility" to start the UDDU. A 

message box will appear warning you that the UDDU is about to stop all configured and running Dialogic 
boards, as shown in Figure B.19. Click Yes to stop the Dialogic boards, in order for the UDDU to work 
properly. This opens the Universal Dialogic Diagnostics screen, shown in Figure B.20. 

 

 
Figure B.20. Universal Dialogic Diagnostics Utility Screen 

2. Check the Proline/2V check box, as shown in Figure B.20, and then click the Specify Tests button.  
3. This opens the Specify Tests dialog box, shown in Figure B.21. Choose the appropriate tests from the list, 

and then click OK.  
4. Click Run Tests, and then analyze the results. If you need any help, refer to the Dialogic help documentation. 
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Figure B.21. Specifying Diagnostics Tests for the Card 

 
Note: It is a good idea to test the Dialogic card has been installed and configured.  Dialogic provides several 
sample applications that can be used for this purpose.  The Voice Horoscope program is a good starting 
application.  To launch it, select Start > Programs > Dialogic System Software > Dialogic Sample Programs > 
Voice Horoscope.  Once the program is launched, select Channels > Open.  The program is now ready to 
receive phone calls.  If the Dialogic card is correctly installed, you should hear a response to a call. 
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Advanced Video Settings 
C.1 Configuring a Video Capture Device 

The Multimedia Video Agent allows you to send a video or a video snapshot to a computer providing alarm 
information. The general settings for video agents may vary depending on which device is used. General settings 
will only function if you have a video capture device (Web camera) installed on your computer. If no video capture 
device is found, you will get an error message informing you that the application could not find any video capture 
devices.  
If you are using a remote node for video capture, you will have to go to the remote node and change the settings 
for video capture on that node. If there is no Multimedia Configurator installed on your video capture node, then 
you can run the "bin/'MMXSnapshot.exe" to set the general settings.  
Although many different kinds of video capture devices can be used with the Video Agent, we will use the 
Logitech® QuickCam® video camera here as an example configuration. This example assumes that the Logitech 
QuickCam software has already been installed on the system. Once the video capture device is installed, go to 
the Alarm Configurations - Multimedia Agents - Video folder on the tree control of the Multimedia Configurator. 
Click on the General Settings button, as shown in Figure C.1. If you do not see the General Settings button, 
make sure that Dialog View is checked on the View menu. 

 
Figure C.1. Video Agent: General Settings 

C.1.1 SnapShot Configuration 
Clicking General Settings opens the Snapshot Configuration dialog box, shown in Figure C.2. The Snapshot 
Configuration dialog box contains the following options. 
 

Display 
Clicking the Display button in the Snapshot Configuration dialog box allows you to choose display properties for 
the video capture device. In this case, the display properties are not supported by Logitech QuickCam, so a 
message appears as shown in Figure C.3. 

 
Figure C.2. Snapshot Configuration Dialog Box 
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Figure C.3. Display Properties Not Supported 

 
Compression 
Clicking the Compression button in the Snapshot Configuration dialog box allows you to choose a component 
to use if you wish to compress the video files, as shown in the Video Compression dialog box in Figure C.4.  

 
Figure C.4. Video Compression Setup  

 
Format 
Clicking the Format button in the Snapshot Configuration dialog box allows you to set options such as color, 
mirror, flip, and size, as shown in Figure C.5. Choose the desired settings, and then click OK. 

 
Figure C.5. Video Settings: Format 
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Source 
Clicking the Source button in the Snapshot Configuration dialog box allows you to configure hardware settings 
based on the video driver you choose to use. As shown in Figure C.6, you can specify the brightness, hue, 
quality, exposure time, and light sensitivity. 

 
Figure C.6. Video Settings: Source 

 
Video Driver 
Clicking the Video Driver button in the Snapshot Configuration dialog box opens the Video Capture Selection 
dialog box, shown in Figure C.7. Select the video capture driver from the drop-down list.  

 
Figure C.7. Video Capture Driver Selection 
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JPEG Settings 
Clicking the Jpeg Settings button in the Snapshot Configuration dialog box allows you to select the quality level 
and the option to display in color or grayscale for snapshots, as shown in Figure C.8. 
Note: For details about Video Agent configuration fields, refer to Chapter 4.  

 
Figure C.8. Jpeg Image Settings for Video Camera 

 

C.2 Creating Video Templates 
The Multimedia Configurator provides a default template for the Video Agent. To view this template, select Alarm 
Configurations - Media Templates - Default Video from the tree control. The video template field will be 
displayed in the right pane, as shown in Figure C.9.  
You can create a new template for the Video Agent by right-clicking the Media Templates folder in the tree 
control and selecting New - Media Template from the pop-up menu. Select the Video radio button in the template 
configuration field in the right pane, as shown in Figure C.9. 

 
Figure C.9. Default Template for Video Agent  

 
In the Design Elements tab of the template configuration dialog box, shown in Figure C.9, click the Insert button. 
This opens the Template Definition Wizard dialog box, shown in Figure C.10, which contains a list of available 
field types to add. (For a complete list of available field types, please refer to Chapter 5.) Choose a field type and 
select from the additional options under Field Properties, and then click Insert. If you wish to change the order of 
the fields or to delete a field, use the appropriate buttons to do so. The Insert Blank button will insert a line break.  
Three field types—SnapShot Capture, Picture File, and Video File—are used specifically for the Video Agent 
templates. (Picture File and Video File field types may also be used for popup templates.)  
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Figure C.10. Template Definition Wizard: SnapShot Capture Field  

 

 
Figure C.11. Template Definition Wizard: Picture File Field  

 

SnapShot Capture 
In the SnapShot Capture field type in the Template Definition Wizard dialog box, you can set the amount of 
time (in milliseconds) during which the Video Agent will capture the video snapshot, as shown in Figure C.10. 
 
Picture Files 
In the Picture File field type in the Template Definition Wizard dialog box, shown in Figure C.11, you can 
choose a picture file (.jpg, .jpeg, .gif) for the Video Agent to display. Click the Browse button to select a file. You 
can also click the Select From Snapshot Library button to choose from a list of existing picture files.  
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Figure C.12. Template Definition Wizard: Video File Field  

 
Video Files 
The Video File field type in the Template Definition Wizard dialog box, shown in Figure C.12, is similar to the 
Picture File field. You can choose a video file (.avi, .mpg, .mpeg, .mov) for the Video Agent to display. Click the 
Browse button to select a file. You can also click the Select From Snapshot Library button to choose from a list 
of existing video files. 
This opens the Snapshot Library, shown in Figure C.13. To view an image in the Snapshot Library, highlight the 
row of that image, and then click the Play/Show button. You can also add existing images to the Snapshot Library 
by clicking the Add Snapshot button. This allows you to browse for an image to add. Select the image file, and 
then click Open. 

 
Figure C.13. Snapshot Library: Library Collection 
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Figure C.14. Snapshot Library: SnapShot Studio 

 
To add a brand new image to the Snapshot Library, click on the Snapshot Studio tab, as shown in Figure C.14. 
Select the appropriate video capture device from the Device Options field. You may also adjust the Video 
Source, Video Format, or Compression (as described above). The Capture Options field allows you to capture 
a single picture frame or to record a movie for a specified duration (in seconds).  
After all settings are configured, click the Capture Frame button. This captures the image shown in the window to 
the right. Save the captured picture or movie in .jpg or .avi format, respectively. Then you can add this snapshot to 
the library and use it later for video template modifications. 
 

Delay 
You can also set a delay for the templates by selecting the Delay field type in the Template Definition Wizard 
dialog box, as shown in Figure C.15. Under Field Properties, you can enter the delay time (in milliseconds) 
before the next template can be activated. Click the Insert button to add the delay to the list of template fields. 
All current template fields are displayed in the Design Elements tab (see Figure C.9). The Field Definition for 
these template fields is also displayed in the Template Source Code tab, shown in Figure C.16, where you can 
manually edit a template field if desired. You can also add HTML code to the template. 
Note: The Template Source Code tab is recommended for advanced users only. Do not modify any fields here 
unless you are absolutely sure of what you are doing. Refer to Chapter 5 for information about HTML commands 
for video templates. 
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Figure C.15. Template Definition Wizard: Delay  

 

 
Figure C.16. Template Source Code Tab 

 
To save the changes to your template, click the Apply button in the video template configuration field. Now you 
can go to the Video Agent configuration field under the Multimedia Agents - Video folder in the tree control of the 
Configurator and select your template from the Use Template drop-down list, as shown in Figure C.17. Be sure 
to click the Test button to test your configuration. 

 
Figure C.17. Selecting the Template in the Video Agent Configuration 
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Upsizing Databases 
D.1 Introduction to Database Upsizing 

You can upsize your Smar AlarmWorX Multimedia databases from Microsoft Access (.mdb) to MSDE, allowing 
you to take advantage of the powerful relationship database technology in MSDE. MSDE supports databases up 
to 2 GB with up to five concurrent users. This appendix provides instructions for upsizing databases from 
Microsoft Access to MSDE.  
Though the default Multimedia configuration database is a Microsoft Access database ("AWXMMX.mdb" file), both 
the Multimedia Configurator and the Multimedia Server are designed to work with SQL Server databases as well. 
In some cases (heavy alarm flow, etc.) the transition to a SQL Server database is required to make use of the 
better memory management, database security, robustness, and higher performance of SQL Server or MSDE. 

D.2 Using Universal Data Link Files 
The Multimedia Configurator connects to a SQL database by using the Microsoft Universal Data Link file (.udl). 
Files of this type contain OLE DB connection information that allows the application to create and manage 
connections to OLE DB databases. 

D.2.1 Creating a Universal Data Link File 
To create Universal Data Link file: 
1. Open Windows Explorer.  
2. Select the folder in which you want to save the .udl file. Right-click in the right (results) pane, and select New 

- Text Document from the pop-up menu.  
3. From the Tools menu, select Folder Options. On the View tab of the Folder Options dialog box, shown in 

Figure D.1, clear the Hide file extensions for known file types check box, and then click OK.  

 
Figure D.1. Windows Explorer: Folder Options Dialog Box 

 

4. Right-click on the text file you created in step 2 above, and then click Rename. Type the new file name using 
the .udl file extension. Press Enter. A warning may appear, explaining that changing file extensions may 
cause files to become unusable. Disregard this warning. You can store .udl files anywhere on your system or 
network. 
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5. Double click on the .udl file in Windows Explorer to display the Data Link Properties dialog box. On the 
Provider tab, shown in Figure D.2, select Microsoft OLE DB Provider for SQL Server.   

 
Figure D.2. Data Link Properties Dialog Box: Provider Tab 

 

 
Figure D.3. Data Link Properties Dialog Box: Connection Tab 

 
In the Connection tab, shown in Figure D.3, specify the SQL Server name, user name, password, and database 
name. Click OK to save OLE DB connection information in the .udl file. 
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D.3 Using the Microsoft Access Upsizing Wizard 
Microsoft Access 2000 installs a powerful Upsizing Wizard that allows you to upsize any existing .mdb database to 
SQL Server. Use the following procedure to upsize the Multimedia configuration database using the Upsizing 
Wizard: 
1. Run Microsoft Access 2000 and open the Multimedia configuration database file. The default database file is 

ProcessView\Bin\"AWXMMX.mdb". 
2. From the Tools menu, select Database Utilities - Upsizing Wizard, as shown in Figure D.4. At this point, 

Access may give you the option to install the wizard. Follow the installation steps, and then run the Upsizing 
Wizard from the Tools menu. 

 
Figure D.4. "AWXMMX.mdb" Database File  

3. Select the Create New Database option, and then click Next. 
4. Make sure your SQL Server is up and running. Select a server name from the SQL Server drop-down list. 

Specify the Login ID and Password of the SQL Server database administrator. Provide a name for the new 
SQL Server database. Click Next to continue. 

5. Use the >> button to bring all entries from the Available Tables list box into Export to SQL Server list box. 
Click Next to continue. 

6. In the Table Attributes group, check Indexes, Validation Rules, Defaults, and Table Relationships. Select 
the Use triggers radio button. In the data options, group select No, never for the table timestamp fields, and 
uncheck the only create the table structure check box. Click Next to continue. 

7. Click Finish. When the wizard finishes, close Microsoft Access. 
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Figure D.5. Multimedia Upsize and Repair Tool: Step 1 

D.3.1 Using the Multimedia Upsize and Repair Tool 
Now run the Multimedia configuration database Upsize and Repair Tool to verify the table structure of the newly 
created SQL Server database. The Upsize and Repair Tool will also fix some triggers and index problems that 
were skipped by the Microsoft Access Upsizing Wizard. The Upsize and Repair Tool is located on the SMAR 
Product CD under the "Tools/MMX_SQLUpsizing" folder. Open the "MMXSqlRepair.exe" file in this folder. 
1. When "MMXSqlRepair.exe" loads, click the Next button at the bottom of the dialog box, as shown in Figure 

D.5. 
2. Click the Log On SQL Server button to connect to the upsized database (the one created by the Access 

Upsizing Wizard), as shown in Figure D.6. Provide the administrative login name and password. When a 
connection to the SQL Server database is established, the traffic light indicator turns green, and the Next 
button becomes enabled. Click the Next button to continue. 

 
Figure D.6. Multimedia Upsize and Repair Tool: Step 2 

3. Click the Go! button to start the verification and repair processes. If the Upsize and Repair Tool discovers that 
any table is missing, it will create that table and provide default data. 

4. When the Upsize and Repair Tool finishes, it will prompt you to create a Universal Data Link (.udl) file. If for 
any reason the Upsize and Repair Tool fails to write the .udl file, the file can be created manually, as 
described in the "Creating a Universal Data Link File" section above. 
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5. Start the AlarmWorX Multimedia Configurator, and select Open from the File menu. Browse to the folder 
where you created the .udl file. Open the .udl file as you would open a regular .mdb database file. The 
Multimedia Configurator will recognize the connection information and connect to the upsized configuration 
database. Select Make Active from the File menu. If the Multimedia Server is already running, click the 
Server Update button on the toolbar. 

D.4 Upsizing an Existing Microsoft Access Database 
You can upsize an existing Microsoft Access (.mdb) Multimedia database by exporting a .csv file. This upsizing 
method does not require installation of Microsoft Office 2000. 
1. Start the Multimedia Configurator and open the .mdb configuration database that you want upsize. Select 

Export CSV from the File menu, and choose the .csv file for temporary storage of configuration data, as 
shown in Figure D.7. Click OK. 

2. Use the SMAR MSDE Manager Tool to create a new empty SQL Server (or MSDE) database. 
Note: The MSDE Manager (MSDE Manager.exe) is installed in the ProcessView/Bin directory during 
ProcessView installation. If you have a stand-alone AlarmWorX Multimedia installation, you will need to 
install the MSDE Manager manually by running the ProcessView installation and selecting the TrendWorX 
component from the list of components to install. 

3. Run the Multimedia Configuration Database Upsize and Repair Tool ("MMXSqlRepair.exe") on the database 
created in step 2 above. 

4. Click the Next button at the bottom of the form. 
5. Click the Log On button to connect to the newly created database. Provide the administrative login name and 

password. When a connection to the SQL or MSDE database is established, the traffic light indicator turns 
green, and the Next button becomes enabled. Click Next. 

6. Click the Go! button. When the Upsize and Repair Tool finds that no tables exist in the database, it will create 
the proper table structure with the necessary relationship data. 

7. When the Upsize and Repair Tool finishes, it will prompt you to create a Universal Data Link file. If for any 
reason the Upsize and Repair Tool fails to write the .udl file, the file can be created manually, as described in 
the "Creating a Universal Data Link File" section above. 

 
Figure D.7. Exporting Configuration Data to a .csv File 

 
8. Start the AlarmWorX Multimedia Configurator, and select Open from the File menu. Browse to the folder 

where you created the .udl file. Open the .udl file as you would open a regular .mdb database file. The 
Multimedia Configurator will recognize the connection information and connect to the newly created database. 
You will see only top level (folder) items in the Configurator's tree control at this point.  



Upsizing Databases  
 

Ap.D6 

9. Select Import CSV from the File menu, and browse to the folder where you saved the .csv file in step 1 
above, as shown in Figure D.8. Make sure you use the same delimiter option that was used while exporting 
the .csv file. Check all check boxes in the Import Settings group. 

10. Open the .csv file you saved file in step 1 above. The exported data will be copied to the currently edited 
database. Select Make Active from the File menu. If the Multimedia Server is already running, click the 
Server Update button on the toolbar. 

 
Figure D.8. Importing Configuration Data From a .csv File 

D.5 Auto-Starting the SQL Service 
When upsizing databases, you must set the SQL service to auto-start: 
1. Double click on the SQL Server icon in the system tray to open the SQL Server Service Manager, as shown 

in Figure D.9. 
2. Make sure that Auto-start service when OS starts check box is checked.  
3. Close the SQL Server Service Manager dialog. 

 
Figure D.9. Auto-Start Enabled for SQL Service 

 



Appendix E 
 

 Ap.E1 

Instant Messaging and E-Mail 
E.1 Installing MSN Messenger Service 

The Instant Messaging Agent allows you to send and acknowledge alarm and event information using MSN® 
Messenger Service. In order to use the Instant Messaging Agent, you must download and install the MSN 
Messenger Service from the MSN Web site at http://messenger.msn.com/.  
1. When the download is completed, run the "mmssetup.exe" file and follow the instructions provided by the 

installation wizard.  

 
Figure E.1. Messenger Service License Agreement 

2. Read the Messenger Service 3.6 License Agreement, as shown in Figure E.1. If you agree with the terms, 
click the Yes button to continue. The installation will copy files to your system. 

3. You will have to restart your computer before the new settings will take effect. The installation will ask you if 
you want to restart the computer. Click the Yes button. 

4. When your computer restarts, the MSN Messenger Service Welcome screen will appear, as shown in Figure 
E.2. Click the Next button to continue. 

 
Figure E.2. MSN Messenger Service Welcome Screen 
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5. The next screen will ask you to sign in using a Microsoft Passport, as shown in Figure E.3. If you have a 

Hotmail user account with Microsoft, you can use that account as your Passport. If you do not have a 
Passport, click the Get a Passport Button. This will take you to the MSN Messenger Service Web site, where 
you can sign up for a Passport. Enter the required information in the user profile fields, and follow the 
instructions provided.  

 
Figure E.3. Signing up for a Passport 

6. Once you have established a Passport, you will be asked to provide your Passport for the installation, as 
shown in Figure E.4. Enter your Sign-in name and Password. Click the Next button to continue. 

 

 
Figure E.4. Entering Your Passport Information 

 
7. A dialog box will appear informing you that the setup is complete. Click the Finish button to sign in to MSN 

Messenger Service. 
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E.2 Configuring MSN Messenger Service 
Once you have signed in, the MSN Messenger Service dialog box will open, as shown in Figure E.5. Select 
Options from the Tools menu. This opens the Options dialog box, shown in Figure E.6. 
Note: To get more information, you can view the MSN Messenger Service help documentation at any time by 
selecting Help Topics from the Help menu. 

 
Figure E.5. Messenger Service Dialog Box 

 

 
Figure E.6. Messenger Options: Personal Tab 
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In the Personal tab of the Options dialog box, enter the name that you want to use, as shown in Figure E.6. You 
can also edit your user profile and change the font of your message text. Click the Help button for additional 
information.  

 
Figure E.7. Messenger Options: Preferences Tab 

 
In the Preferences tab of the Options dialog box, you can configure the general settings and determine how you 
are alerted when you receive a message, as shown in Figure E.7. By clicking the Browse button, you can also 
select the folder in which incoming files will be stored. Click the Help button for additional information as needed. 
Click OK when you are finished. 

 
Figure E.8. Adding a New Contact to MSN Messenger Service 
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The changes to your settings will take effect the next time you sign in to MSN Messenger Service. To add a new 
contact to MSN Messenger Service, select Add a Contact from the File menu. This will open a wizard that 
enables you to configure a new contact, as shown in Figure E.8. Click the Next button to continue. 
Enter the complete e-mail address of the contact you would like to add, as shown in Figure E.9. Click the Next 
button to continue. A dialog box will appear informing you that e-mail address of the contact you entered has been 
added to your list of contacts. Click the Finish button to close the Add a Contact wizard. The contact will be 
added to the MSN Messenger Service screen. 
For information on how to acknowledge alarms using the MSN Messenger Service, see the "Acknowledging 
Alarms" section below. 
Note: For the Instant Messaging Agent to work, MSN Messenger Service must be installed and running on the 
computer on which the Instant Messaging Agent is installed. The user name specified in the Send To field of the 
Instant Messaging Agent configuration in the Multimedia Configurator must also be an existing contact in the 
server computer's messaging client that is currently online.  
Note: Adding e-mail contacts to MSN Messenger is for instant messaging only. It does not affect the e-mail 
contacts you have configured for the E-mail Agent in the M-Alarm Multimedia Configurator.  

 
Figure E.9. Entering the Contact's E-mail Address  

E.3 Creating Instant Messaging Templates 
When configuring the Instant Messaging Agent in the Multimedia Configurator, you must select a template to 
apply to that agent. Templates allow you to configure design elements, including what and how much information 
to display when presenting an alarm. You can use or modify any one of the default templates or create a new 
template. 
The Multimedia Configurator provides a default template for the Instant Messaging Agent. To view this template, 
select Alarm Configurations - Media Templates - Default Instant Messenger from the tree control. The instant 
messenger template field will be displayed in the right pane, as shown in Figure E.10. 
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Figure E.10. Default Template for Instant Messaging Agent 

 

 
Figure E.11. Template Definition Wizard 

 
You can create a new template for the Instant Messaging Agent by right-clicking the Media Templates folder in 
the tree control and selecting New - Media Template from the pop-up menu. Select the MS Instant Messaging 
radio button in the template configuration field in the right pane, as shown in Figure E.10. 
In the Design Elements tab of the template configuration dialog box, shown in Figure E.10, click the Insert 
button. This opens the Template Definition Wizard dialog box, shown in Figure E.11, which contains a list of 
available field types to add. (For a complete list of available field types, please refer to Chapter 5.) Choose a field 
type and select from the additional options under Field Properties, and then click Insert. If you wish to change 
the order of the fields or to delete a field, use the appropriate buttons to do so. The Insert Blank button will insert 
a line break. 
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All current template fields are displayed in the Design Elements tab (see Figure E.10). The Field Definition for 
these template fields is also displayed in the Template Source Code tab, shown in Figure E.12, where you can 
manually edit a template field if desired.  

 
Figure E.12. Template Source Code Tab 

 
Note: The Template Source Code tab is recommended for advanced users only. Do not modify any fields here 
unless you are absolutely sure of what you are doing.  
 
For information about how to acknowledge alarms using the MSN Messenger Service, see the "Acknowledging 
Alarms" section below. 

E.4 Creating E-mail Templates 
The E-mail Agent allows you to send and acknowledge alarm and event information using an e-mail message. 
When configuring the E-mail Agent, you must select a template to apply to that agent. Templates allow you to 
configure design elements, including what and how much information to display when presenting an alarm. You 
can use or modify any one of the default templates or create a new template. 
The Multimedia Configurator provides a default template for the E-mail Agent. To view this template, select Alarm 
Configurations - Media Templates - Default E-mail from the tree control. The e-mail template field will be 
displayed in the right pane, as shown in Figure E.13. 
You can create a new template for the E-mail Agent by right-clicking the Media Templates folder in the tree 
control and selecting New - Media Template from the pop-up menu. Select the E-mail radio button in the 
template configuration field in the right pane, as shown in Figure E.13. 
In the Design Elements tab of the template configuration dialog box, shown in Figure E.13, click the Insert 
button. This opens the Template Definition Wizard dialog box, shown in Figure E.14, which contains a list of 
available field types to add. (For a complete list of available field types, please refer to Chapter 5.) Choose a field 
type and select from the additional options under Field Properties, and then click Insert. If you wish to change 
the order of the fields or to delete a field, use the appropriate buttons to do so. The Insert Blank button will insert 
a line break. 
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Figure E.13. Default Template for E-Mail Agent 

The Template Definition Wizard dialog box gives you the option of sending files as attachments to e-mail 
messages, as shown in Figure E.14. Click the Browse button to choose a file to attach. Select the file and then 
click OK. The file pathway will appear in the Field Definition section. 
All current template fields are displayed in the Design Elements tab (see Figure E.13). The Field Definition for 
these template fields is also displayed in the Template Source Code tab, shown in Figure E.15, where you can 
manually edit a template field if desired.  
Note: The Template Source Code tab is recommended for advanced users only. Do not modify any fields here 
unless you are absolutely sure of what you are doing.  
For information about how to acknowledge alarms using e-mail, see the "Acknowledging Alarms" section below. 

 
Figure E.14. Template Definition Wizard 
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Figure E.15. Template Source Code Tab 

E.5 Acknowledging Alarms Using E-mail and Instant Messaging 
You can acknowledge alarms using the Instant Messaging Agent and E-mail Agent by referencing the 
Acknowledge Code, or PIN, that you specified in the configuration for each agent. (For details about configuration 
fields for the Instant Messaging Agent and the E-mail Agent, please refer to Chapter 4.) For example, in the 
configuration field for the Instant Messaging Agent shown in Figure E.16, the Acknowledge Code is "12345."  
Once your alarm configuration is complete and the Multimedia Server is started, you can use this code to 
acknowledge alarms sent by the Multimedia Server. The Multimedia Server sends messages based on the 
templates you created for the Instant Messaging Agent and the E-mail Agent.  
For the Instant Messaging Agent, the Multimedia Server sends alarms via the MSN Messenger Service. For the E-
mail Agent, the Multimedia Server sends alarms via e-mail messages using, for example, Microsoft Outlook. An 
example alarm message is shown below. 
4/8/01 9:50:57 AM 
Tag: BugsAttack 
Condition: Limit 
Subcondition: HI 
Message: Too many Bugs 

 
||3d6efc37-79d8-11d4-846d-00104b6fd496|| 
||bb7ee6fa-2c1d-11d5-8146-0050da1bf676|| 

This alarm message is based on the following multimedia template: 
 
{{4:Time,80}} 
Tag: {{3:Source}} 
Condition: {{10:ConditionName}} 
Subcondition: {{11:SubconditionName}} 
Message: {{6:Message,100}} 
 
Each alarm message includes one or more Global Unique Identifiers, or GUIDs. A GUID is a string of characters 
surrounded by the symbol '||', as shown in the example above. In this case, the Multimedia Server included the 
following two GUIDs: 
 

3d6efc37-79d8-11d4-846d-00104b6fd496 
bb7ee6fa-2c1d-11d5-8146-0050da1bf676 
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Figure E.16. Configuration Field for Instant Messaging Agent 

 
Figure E.17. Acknowledging an Alarm Using MSN Messenger Service 

 
To acknowledge the alarm in MSN Messenger Service, copy and paste the two GUIDs into the "Send" field and 
append the Acknowledge Code, or PIN, to them, as shown in Figure E.17. In this example, the Acknowledge 
Code is "12345." Click the Send button to send the alarm acknowledgement back to the Multimedia Server.  
For the E-mail Agent, the method for acknowledging alarms in e-mail messages is similar to the method described 
above. When the E-mail Agent receives an alarm e-mail message from the Multimedia Server, you can 
acknowledge the alarm by replying to the e-mail message. As described above, copy and paste the GUIDs into 
the body of the e-mail reply and append the Acknowledge Code, or PIN, to the GUIDs.   
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E.6 Modifying E-mail Support 
The Email agent uses HKEY_LOCAL_MACHINE\SOFTWARE\SMAR\Awx32\AWXMMX32\MMXMail\ReadDelete 
registry setting for modifying e-mail acknowledge support.   
ReadDelete = 1 – Prompts the E-mail Agent to read all inbox e-mails.  e-mails are marked read.  No e-mails are 
deleted.  This mode is good for development and testing purposes. 
ReadDelete = 2 - Prompts the E-mail Agent to read all inbox e-mails.  e-mails are marked read.  Deletes all read 
e-mails.  Provides improved operation times and should be used with a deployed system requiring acknowledge 
support. 
ReadDelete = 3 - Prompts the E-mail Agent to read all inbox e-mails.  E-mails are marked read.  Deletes all e-
mails with acknowledge string.  Used when the e-mail agent shares the e-mail account with another application.  
Not recommended for a deployed system. 
ReadDelete = 4 – E-mail Agent does not read any e-mails.  This mode disables the acknowledge string and 
acknowledge support.  This mode is ideal for deployed systems not making use of e-mail acknowledge support. 
 
Occasionally the E-mail Agent will trigger the following dialog message: 
“Either there is no default mail client or the current mail client cannot fulfill the messaging request.  Please run 
Microsoft Outlook and set it as the default mail client.*Microsoft Outlook“ 
This message is set by the Windows operating system.  It can be disabled by modifying the following registry 
value from: 
HKEY_LOCAL_MACHINE\SOFTWARE\Clients\Mail\ PreFirstRun 
 
to 
 
HKEY_LOCAL_MACHINE\SOFTWARE\Clients\Mail\ PreFirstRun1. 
 
In addition the registry value 
HKEY_LOCAL_MACHINE\SOFTWARE\Clients\Mail\ (Default)  
 
Display the name of the default e-mail application.  The default e-mail application can be modified by either 
changing the registry string or using Microsoft Internet Explorer (specifically Tools > Internet Options > 
Programs > Email). 
 
The E-mail Agent will only operate on e-mail messages in the e-mail programs default folder. For example, a reply 
with an acknowledge code will only be seen if sent to the default e-mail programs folder (Inbox for Microsoft 
Outlook). If you set up your e-mail program to reroute your mail to other various folders, the E-mail Agent might 
not read the incoming e-mail message. 
Note: You must have a MAPI-compliant third-party e-mail program on the computer from which you are sending 
e-mails. Microsoft® Outlook is an example of a MAPI-compliant third party e-mail program. Microsoft Outlook 
Express can also be used and can be downloaded for free from Microsoft. However, unlike Outlook, Outlook 
Express will only work with POP3 e-mail servers. It is not necessary to have the e-mail program actively running 
on a Windows NT or Windows 2000 operating system. It is, however, necessary to have the e-mail program 
actively running on a Windows 98 operating system. Outlook 2002 and Outlook Express version 6 require 
additional security settings in order for the E-mail Agent to work properly. For more information, go to 
http://www.microsoft.com/office/ork/xp/appndx/appa11.htm. 
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